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U.S. Government prime contract or subcon-
tract, Software is delivered and licensed as
“Commercial computer software” as
defined in DFAR 252.227-7014 (June 1995),
oras a “commercial item” as defined in FAR
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1987). U.S. Government users will receive
no greater than Limited Rights as defined in
FAR 52.227-14 (June 1987) or DFAR
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e Hergeéllerbescheinigung
GEAUSCHEMISSION
Lpa<70dB
am Arbeitsplatz
normaler Betrieb
nach DIN 45635 T. 19

* Manufacturer’s Declaration
ACOUSTIC NOISE EMISSION
Lpa< 70dB
operator position
normal operation

per 1SO 7779

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme ?Hla norme NMB-001 du Canada.

This product complies with the WEEE Directive (2002/96/EC) marking requirements.
The affixed label indicates that you must not discard this electrical/ electronic product
in domestic household waste.

Product Category: With reference to the equipment types in the WEEE Directive
Annex |, this product is classed as a “Monitoring and Control instrumentation”
product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Agilent office, or see
www.agilent.com/environment/product/ for more information.

EasyEXPERT is a trademark of Agilent Technologies. Microsoft and Windows are registered trademarks of Microsoft
Corporation. All other trademarks are the property of their respective owners.
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Safety Summary

The following general safety precautions must be observed during all phases of
operation, service, and repair of this instrument. Failure to comply with these
precautions or with specific warnings elsewhere in this manual may impair the
protections provided by the equipment. In addition, it violates safety standards of
design, manufacture, and intended use of the instrument. Agilent Technologies, Inc.
assumes no liability for customer’s failure to comply with these requirements.

Agilent B1500 complies with INSTALLATION CATEGORY Il for mains input and
INSTALLATION CATEGORY | for measurement input terminals, and POLLUTION
DEGREE 2 defined in IEC 1010-1.

Agilent B1500 is an INDOOR USE product.

LED in Agilent B1500 is Class 1 in accordance with IEC 825-1. CLASS 1 LED PRODUCT.

*  GROUND THE INSTRUMENT

This is Safety Class | instrument. To minimize shock hazard, the instrument chassis
and cabinet must be connected to an electrical ground. The power terminal and the
power cable must meet International Electrotechnical Commission (IEC) safety
standards.

« DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE

Do not operate the instrument in the presence of flammable gases or fumes.
Operation of any electrical instrument in such an environment constitutes a
definite safety hazard.

+  KEEP AWAY FROM LIVE CIRCUITS

Operation personnel must not remove instrument covers. Component replacement
and internal adjustments must be made by qualified maintenance personnel. Do
not replace components with power cable connected. Under certain conditions,
dangerous voltages may exist even with the power cable removed. To avoid
injuries, always disconnect power and discharge circuits before touching them.

« DO NOT SERVICE OR ADJUST ALONE

Do not attempt internal service or adjustment unless another person, capable of
rendering first aid and resuscitation, is present.



« DO NOT SUBSTITUTE PARTS OR MODIFY INSTRUMENT

Because of the danger of introducing additional hazards, do not install substitute
parts or perform any unauthorized modification to the instrument. Return the
instrument to a Agilent Technologies Sales and Service Office for services and
repair to ensure that safety features are maintained.

«  DANGEROUS PROCEDURE WARNINGS

Warnings, such as example below, precede potentially dangerous procedures
throughout this manual. Instructions contained in the warnings must be followed.

WARNING Dangerous Voltage, capable of causing death, are present in this instrument. Use
extreme caution when handling, testing, and adjusting.
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Safety Symbols

The general definitions of safety symbols used on equipment or in manuals are listed
below.

Instruction manual symbol: the product will be marked with this symbol when it is
necessary for the user to refer to the instruction manual in order to protect against
damage to the instrument.

Indicates dangerous voltage and potential for electrical shock. Do not touch terminals
that have this symbol when instrument is on.

Protective conductor terminal. For protection against electrical shock in case of a fault.
Used with field wiring terminals to indicate the terminal which must be connected to
ground before operating equipment.

Frame or chassis terminal. A connection to the frame (chassis) of the equipment which
normally includes all exposed metal structures.

Indicates earth (ground) terminal.

Alternating current.

Direct current.

STANDBY (Supply).

Means INSTALLATION CATEGORY I. Measurement terminals on the rear panel comply
with INSTALLATION CATEGORY I.

The warning sign denotes a hazard. It calls attention to a procedure, practice, condition
or the like, which, if not correctly performed or adhered to, could result in injury or
death to personal.

The caution sign denotes a hazard. It calls attention to an operating procedure,
practice, condition or the like, which, if not correctly performed or adhered to, could
result in damage to or destruction of part or all of the product.



HIGH VOLTAGE SHOCK HAZARD

Agilent B1500 can force dangerous voltages (200 V for HPSMU, and 100 V for
MPSMU/HRSMU) at the force, guard, and sense terminals. To prevent electric
shock hazard, the following safety precautions must be observed during the use of
Agilent B1500.

Use athree-conductor AC power cable to connect cabinet (if used) and Agilent
B1500 to an electric ground (safety ground).

If you do not use Agilent 16442 Test Fixture, make sure to connect the Interlock
terminal to a switch that turns off when the shielding box access door is opened.

Confirm periodically that interlock function works normally.

Before touching the connections of the force, guard, and sense terminals, turn
Agilent B1500 off and discharge any capacitors whenever possible. If you do
not turn Agilent B1500 off, complete “al” of the following items, regardless of
any Agilent B1500 settings.

e Terminate measurement by pressing Stop key, confirm that the M easurement
statusindicator is not lit.

* Confirm that the High Voltage indicator is not lit.
« Open the shielding box access door (open the Interlock terminal).
« Discharge any capacitorsif the capacitance is connected to an SMU.

Warn workersin the vicinity of Agilent B1500 about dangerous conditions.
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PRECAUTIONS POUR COMMOTION A HAUTE TENSION

Une tension dangereuse (max. £ pour HPSMU; 200 Vdc, max. £ pour MPSMU/
HRSMU; 100 Vdc) émanant du dispositif Agilent B1500 peut étre sortie aux bornes
deforce, d'appareil de protection ou de détection. L es précautions suivantes doivent
étre obserées contre commoation électrique accidentelle:

Mettre alaterre le dispositif Agilent B1500 au moyen du céble d'alimentation
tripolair.

En cas de hors service du dispositif d'essai, FIXTURE Agilent 16442, connecter
les bornes de verrouillage (Interlock) de fagon a ce que soit ouverte lorsque le
couvercle de la boite de blindage est ouvert.

Essayer périodiquement le fonctionnement normal de verrouillage.

Avant de toucher la partie connexion a partir des bornes de force, d'appareil de
protection et de détection, mettre horstension le dispositif Agilent B1500. Et, en
cas de condensateurs connectés au circuit de mesure, décharger ces
condensateurs. Lorsgue I'alimentation n'est pas mise horstension, les 4
instructions suivantes doivent étre exécutées:

«  Finir lamésure en appuyant sur latouche “ Stop”; verifier que I'indicateur
“Measurement” n'est pas allumé.

e Sassurer que soit allumé I'indicateur d'alarme de la haute tension.

e OQuvrir le convercle de la boite de blindage (Ouvrir les bornes de
verrouillage).

» En cas de condensateurs connectés a SMU, décharger les condensateurs.

Alerter d'autres personnes autour de vous contre le danger de haute tension.



Achtung! Gefahrliche Spannung

Von den Gerédten Agilent B1500 kénnen Spannungen an den Anschllissen “Force,
Guard und Sense” von bis zu 200 V ausgehen. Um elektrischem Schlag vorzubeu-
gen, ist bel der Beniitzung der Geréte Agilent B1500 folgendes zu beachten:

Erden Sie das K abinett (fallsverwendet) sowie die Geréte Agilent B1500 mittels
dreiadriger Netzleitungen.

Wenn die Mef3fassung, Agilent 16442, zwar angeschlossen, jedoch nicht
verwendet wird, schlief3en Sie die Verriegelungsklemme (Interlock) so an, daf3
bei gedffnetem Deckel die Stromzufiihrung zu Agilent 16442 auf jeden Fall
unterbrochen wird.

Vergewissern Sie sich regelmafdig dal? die Verriegel ungsfunktion korrekt
arbeitet.

Schalten Sie die Gerdte Agilent B1500 aus, und entladen Sie ale Kapazitaten
bevor Sie die Anschllsse “ Force, Guard und Sense” beriihren. Falls Sie die
Geréte Agilent B1500 nicht ausschalten, fiihren Sie unabhéngig von den
Geréteeinstellungen folgende Schritt durch:

« Beenden Sie die gegenwartige Messung durch Driicken der Stop Taste (die
Measurement Leuchtdiode erlischt).

» Vergewissern Sie sich dal3 die Hochspannungswarnlampe erloschen ist.

« Offnen Sie den Deckel der Mef¥fassung Agilent 16442 (die
Verriegelungsklemme (Interlock) 6ffnen).

« Entladen Sie alle an SMUs angeschlossenen Kondensatoren (falls
vorhanden).

Informieren Sie Personen in unmittelbarer Néhe der Geréte Agilent B1500 tiber
die Gefahrlichkeit der bestehenden Hochspannung, und sichern Sie den Zugang
zum Prifplatz zum Schutz Dritter.



Precautionary Statement

Agilent B1500 Semiconductor Device Analyzer operates in the Microsoft Windows XP
Professional environment. Agilent B1500 requires Agilent EasyEXPERT software, a
specially-designed Windows XP application program.

e About guarantee and support for Agilent B1500

Agilent Technologies guarantees and supports the performance of Agilent B1500
for the same condition as the preload condition when shipped from the factory.

» About updating Agilent EasyEXPERT and the Windows Update

Agilent Technologies confirms the operation of Agilent EasyEXPERT patch
programs and important Windows security patches, and provides recommended
update information. Visit Agilent B1500 support site, download the patches, and
perform the software update.

»  About Windows XP application programs and peripherals (including driver)

Using commercial products on Agilent B1500 is your responsibility. Agilent
Technologies cannot provide compatibility information for commercial products. If
problems arise, perform Agilent B1500 system recovery.

» About servicing

Bench repair service is available at your nearest Agilent Technologies service
center. Be aware that the B1500 configuration might be updated to the latest one
without notice because of support issues.

The internal hard disk drive (HDD) might be initialized during servicing. If
peripherals are connected, they will be removed.

When Agilent B1500 is returned, the internal HDD might be initialized. Peripherals
will be returned separately.

+ Other notes

+ Back up the internal HDD to prevent loss of data by accident or failure.
+ Protect Agilent B1500 from computer viruses.

« If you connect Agilent B1500 to the network, take care to protect it from
computer virus.



Working in Comfort

To optimize your comfort and productivity, it is important that you set up your work area
correctly and use your instrument properly. With that in mind, we have developed some
set-up and use recommendations for you to follow based on established ergonomic
principles. Improper and prolonged use of keyboards and input devices are among
those tasks that have been associated with repetitive strain injury (RSI) to soft tissues
in the hands and arms. If you experience discomfort or pain while using the instrument,
discontinue use immediately and consult your physician as soon as possible. For more
information on RSI you may wish to consult the About Repetitive Strain Injury section.
Please study the recommendations described below. Included there are references to
relevant parts of international standards, regulations and guidelines, such as IS0 9241
and the European Community Display Screen Equipment directive. You may also wish
to consult your employer’s human resources department or other relevant departments
for guidance specific to your company.

About Repetitive Strain Injury

Because your comfort and safety are our primary concern, we strongly recommend
that you use the instrument in accordance with established ergonomic principles and
recommendations. Scientific literature suggests that there may be a relationship
between injury to soft tissues -especially in the hands and arms- and prolonged
improper use of keyboards or other equipment requiring repeated motions of the
hands and forearms. This literature also suggests that there are many other risk
factors that may increase the chance of such injury, commonly called Repetitive Strain
Injury.

What is RSI?

Repetitive Strain Injury (RSI -also known as cumulative trauma disorder or repetitive
motion injury) is a type of injury where soft tissues in the body, such as muscles,
nerves, or tendons, become irritated or inflamed. RSI has been a reported problem for
those who perform repetitive tasks such as assembly line work, meatpacking, sewing,
playing musical instruments, and computer work. RSI also has been observed in those
who frequently engage in activities such as carpentry, knitting, housework, gardening,
tennis, windsurfing and lifting children.

What causes RSI?

The specific causes of RSI have not been established. Nevertheless, the incidence of
RSI has been associated with a variety of risk factors, including:

+ Too many uninterrupted repetitions of an activity or motion.



* Performing an activity in an awkward or unnatural posture.
* Maintaining static posture for prolonged periods.

* Failing to take frequent short breaks.

» Other environmental and psychosocial factors.

In addition, there have been reports associating the occurrence of RSI with the use of
keyboards, mice, and other input devices. Also, certain medical conditions, such as
rheumatoid arthritis, obesity and diabetes, may predispose some people to this type of
injury.

What if | experience discomfort?

If you are experiencing any discomfort, seek professional medical advice immediately.
Typically, the earlier a problem is diagnosed and treated, the easier it is to resolve.

Mice and Other Input Devices

Various aspects of using mice and other input devices may increase your risk of
discomfort or injury. Observing the following recommendations may reduce that risk.

+ Try to keep your hand, wrist, and forearm in a neutral position while using your
mouse or other input device.

+ If you use your thumb to rotate the ball on a trackball or spaceball, keep it in a
relaxed, natural shape, and maintain a neutral posture in your hand, wrist, and
forearm.

+ Hold the mouse gently by draping your fingers over it. Keep your hand relaxed and
fingers loose. Do not grip the mouse tightly.

+ It takes very little pressure or force from your fingers to activate the buttons or
scroll wheel on your mouse, scrolling mouse, trackball, or other input device.
Using too much force can place unnecessary stress on the tendons and muscles
in your hands, wrists, and forearms.

+ If you are using a scrolling mouse, be sure to keep your fingers and hand in a
relaxed, neutral position when activating the scroll wheel. Also, this type of mouse
features software that can minimize the number of mouse movements or button
clicks.

* When using a mouse, trackball, or other input device, position it as close to the
keyboard as possible, and keep it at the same level as you do not have to stretch
while using it.

» Be sure to keep your mouse and trackball clean. Regular removal of accumulated
dust and dirt helps ensure proper tracking and reduces unnecessary hand and
wrist motions.



In This Manual

This manual describes the front panel operation, installation, and functions of Agilent
Technologies B1500. This manual consists of the following chapters:

Chapter 1, “Getting Started”
This chapter describes the basic operations of Agilent B1500.
Chapter 2, “Introduction”

This chapter describes overview, specifications, accessories and options of
Agilent B1500.

Chapter 3, “Installation”

This chapter explains how to install Agilent B1500, and how to connect the device
under test to a test fixture.

Chapter 4, “Using EasyEXPERT"

This chapter provides the reference information of Agilent EasyEXPERT software.
Chapter 5, “Classic Test Definition”

This chapter provides the reference information of the classic test definition.
Chapter 6, “Application Test Definition”

This chapter provides the reference information of the application test definition.
Chapter 7, “Function Details”

This chapter explains the several functions and initial settings of Agilent B1500.
Chapter 8, “Built-in Programming Tool”

This chapter provides information about the built-in mathematical functions and
read out functions.

Chapter 9, “If You Have a Problem”

This chapter explains how to solve a problem if you encounter any problem, and
describes error codes. This chapter also describes how to perform the system
recovery and the data backup/recovery.

Chapter 10, “Application Library and Utilities”



NOTE To get the latest firmware/software/electronic manuals/support information, visit
Agilent Technologies support site (http://www.home.agilent.com), and click
Additional Test & Measurement Products > Parametric Test, click Semiconductor
Parameter/Device Analyzer Series, and click B1500A Semiconductor Device Analyzer.
You can reach Agilent B1500A support site.




Online Documents

The following electronic documentation files are stored in Agilent B1500°s internal
hard disk drive. The files provide the information of how to use Agilent B1500 and
Agilent EasyEXPERT software.

Folder: C:\Program Files\Agilent\B1500\Documents

+  B1500_help.chm

A part of Agilent B1500A User's Guide. This is the online help that can be opened
from the Help menu on the EasyEXPERT main screen.

+  B1500_Self Trng.mht
Agilent B1500A Self-paced Training Manual that can be opened by a browser



Utilities
The following utility programs are stored in Agilent B1500’s internal hard disk drive.
For details, see “Application Library and Utilities” on page 10-1.

» License Management Tool

This is the GUI based program used to manage the license of the EasyEXPERT
Plus edition and the Desktop EasyEXPERT Plus edition.

» Setup File Converter

This is the GUI based program used to convert Agilent 4155/4156 setup file (MES
file) and create the EasyEXPERT setup file (.XTS file).

*  Prober Control Scripts

Execution files that can be used to control the chuck movement of a prober. For
details, see the readme file.

+ SetupFileConverter.exe

This is the script version of the Setup File Converter.

+ sleep.exe

Execution file that can be used to put a wait time in the test execution flow of an
application test.

«  XSLT Filters

XSLT filters that can be used by the Export in My Format function. They are filter
files for changing the format of the test result record.

NOTE The utility programs are just sample. If the samples damage your devices, Agilent
Technologies is NOT LIABLE for the damage. And the operation is not guaranteed.
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Getting Started

This chapter describes the basic operations of Agilent B1500A. Before learning the
product details, let’s try to use the B1500A briefly. The operations need the
B1500A, power cable, and USB keyboard only (USB mouse and stylus pen are
optional).

During the operations, you will not connect device under test. Open all
measurement terminal.

This chapter consists of the following sections.

e “To Turn On/Off B1500A”

e “ToLaunch EasyEXPERT”

* “ToUseApplication Test Mode”
* “ToUseClassic Test Mode"

* “To Perform Measurement”

* “ToUseAnaysis Tools
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Getting Started
To Turn On/Off B1500A

To Turn On/Off B1500A

When turning the B1500A on

Open the measurement terminals at the device side when turning the B1500A on.
Also disconnect the device from the measurement terminals and open the
measurement terminals after the test. If you leave the connection with the device,
the device may be damaged by unexpected operations or charge-up of measurement
cables.

If you use the B1500A at the first time

If thisisthe first time to turn Agilent B1500 on after the delivery, you need to
perform the initial setup of the B1500. See “Inspection and Installation” on page
3-6. After theinitial setup and if no users are added, you can automatically logon as
“Agilent B1500 User” account without password.

If Start EasyEXPERT button is not displayed

Select All Programs > Start EasyEXPERT from the Start menu. The
Start EasyEXPERT button will be displayed.
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To Turn On/Off B1500A

To Turn B1500A On

Connect the power cable from Agilent B1500A to an AC power outlet.

Connect the USB keyboard to the B1500A. Optionally, connect the USB mouse
to the B1500A.

Press the Standby switch (lower right corner of the front panel). Windows,
measurement module initialization, and self-calibration will start. For the
Windows logon screen, log on Windows.

After logging on, the Start EasyEXPERT button will be displayed on the screen.

€ B1500A M=%

File Option

Start EasyEXPERT

To Turn B1500A Off

Press the Standby switch (lower right corner of the front panel). Windows will be
shutdown and the B1500A will become the standby state.

' <%~ Agilent Technologies B1500A
File Data Display Help
# [Gangory__~| @14V B |
g e # |Device Parameters
§ Polarity: [ic: 0] Wi [losom )
X Temp: [FSocz 1§
]
§ v
= Library - | [Fest Parameters Extended Setup -
F] gy
y| =| -
8 | vnsnacy.. Drain: [FriuzeR <]
j‘“:' vésar: oV §]
&2 vdstop: [200v 8]
\‘.h;nsaucg.‘ vdstep: 1y 8]
Secondary Sween
. Vostart: Fii 4] Subs: [SIDTE ¥
[ ] Vgstop: [200v @] Vsubs: [17 0]
PR Ch vastep: [fon o 8]
| Loy o 3]
& e: [ v]
i =
cabrreq ( )
{ s
=
] =] [ Fleg [ Setup Name [ Date | Count [ Device 1D | Remarks 2 —_—
» Id-vd 11/21j2007 3:54:06 AM 2 N
{ s Id-vd 11/21/2007 3:53:52 AM 1
| i 1d-vd 11/20/2007 7:36:04 AM 3
- 1d-vd 11/20/2007 4:22:03 AM 2 G
T 0y asenn e . —
| 5 Mol Disalay ON [ sty Orr (50 zmo0er (B Ao Eiperier 3] Ao Rececd O
{ . Vb s
L]
Touth Pased O ) L
- wevon o s v e a == g
e e R e e M ()
. , . .
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Getting Started
To Turn On/Off B1500A

Agilent B1500A has the following front panel user interface.
« Siop

Stops the present measurement or source output immediately.
* Rotary knob

Rotating the knob moves the marker on the graph window, or
increases/decreases/changes the value in the active entry field.

Pressing the knob sets or enters the value.
» Softkeys

Seven softkeys are available. Used to select one for the entry field specified or
the dialog box. They are also used to recall the test definitions (pre-defined test
setups).

* Touch Panel Off
Enables or disables the touch screen operation.
o Standby switch

Turnsthe B1500A on. Pressing the button in the ON state makes the B1500A in
the standby state.

* LCD Off
Enables or disables the LCD panel. LED lights when the LCD is disabled.
* Auto, -, +, Menu

Four keys are available for the display adjustment. Press Auto to perform
adjustment automatically. Use - , +, and Menu to adjust manually.

Agilent B1500A also requires Agilent EasyEXPERT software as its graphical user
interface. You can operate Agilent EasyEX PERT by using the touch panel. Use your
fingers, stylus pen, and so on for the touch panel operation. The USB keyboard and
the USB mouse are also available for operating the EasyEX PERT.
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To Launch EasyEXPERT

To Launch EasyEXPERT

1. Click the Start EasyEXPERT button, and wait until the EasyEXPERT main
screen or workspace selection screen is displayed.

€ B1500A =Jo)Ed

File Option

Start EasyEXPERT

NOTE Workspace is the space created in Agilent B1500A’s internal hard disk drive, and is
used to store the test setup, test result data, and so on. The workspace can be created
and allocated for each user.

2. If thisisthefirst timeto start the EasyEXPERT, or if no workspace exists, a
workspace will be created automatically.

Skip to “To Use Application Test Mode” on page 1-10 or “To Use Classic Test
Mode” on page 1-12.

3. If only one workspace exists, the B1500A displaysthe screen asshown in Figure
1-1.

Skip to “If Only One Workspace Exists’ on page 1-7.

4. |If two or more workspaces exist, the B1500A displays the screen as shown in
Figure 1-3.

Skip to “To Select Workspace” on page 1-9.
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Figure1-1

Getting Started
To Launch EasyEXPERT

If Only One Workspace Exists
For the screen as shown in Figure 1-1, perform the following steps.

1. If you do not want to create a workspace, select the Yes radio button and click
OK.

Skip to “To Use Application Test Mode” on page 1-10 or “To Use Classic Test
Mode” on page 1-12.

2. If youwant to create aworkspace, select the No radio button and click Next. The
B1500A displays the screen as shown in Figure 1-2.

Skip to “To Create Workspace” on page 1-8.

If Only One Workspace Exists

Fle Help

You have used this instrument previously. Do you want to
continue working on the previous setups and data ?

& Yes, I want to continue working on the previous setups
and data.

" No, I want to start a new session.

Note: Even if you start a new session, you can still
access setups and data from previous sessions.
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To Launch EasyEXPERT

To Create Wor kspace

For the screen as shown in Figure 1-2, perform the following steps. To cancel
creating workspace, click Prev.

1. Enter the name of the new workspace into the above-entry field.

Check Allow other usersto access this workspace box if you want to create a
public workspace that is opened for all users.

2. If you are the owner of the existing workspace, you can change the name of the
existing workspace.

If you want to rename the existing workspace, enter the name into the
bel ow-entry field.

Check Allow other usersto access this workspace box if you want to set itto a
public workspace that is opened for all users.

3. Click OK.
Skip to “To Use Application Test Mode” on page 1-10 or “To Use Classic Test
Mode” on page 1-12.

Figure1-2 To Create Workspace

Fle Help

Agilent EasyEXPERT software manages setups and data in

known as "Worksp ." Since you want to
start a new session, you should create a new Workspace
with a distinctive name. Please specify a name for the new
Workspace:

[Ontitied =
I~ Allow other users to access this Workspace.

You can also rename a previously defined Workspace:

El

¥ Allow other users to access this Werkspace.

Prev oK
< ==
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Getting Started
To Launch EasyEXPERT

To Select Workspace

For the screen as shown in Figure 1-3, perform the following steps. This example
selects the workspace named as Demo Workspace that is a public workspace that is
opened for al users.

1. Select Public Workspaces owned by other users radio button.

2. Click Demo Workspace to select it.

3. Click Continue.

Skip to “To Use Application Test Mode” on page 1-10 or “To Use Classic Test
Mode” on page 1-12.

To Select Workspace

Fle Hep

B1500A Semiconductor Device Analyzer with EasyEXPERT Software

Please choose the target Workspace below.

A Workspace is an of data and ication tests. It includes test setups, test

results, graphical plots, and user-customized application tests. You have three options when

starting a session in EasyEXPERT:
1. Create a new Workspace from scratch.
2. Open and use an existing Workspace that you previously created. Continue 3
3. Oopen and use a public Workspace that has been previously published.

Target Workspace |

¢ Create a new Workspace

Workspace Name: \ E]

[~ Allow other users to access this Workspace.
Open an existing Workspace

" Your Workspaces:
Name Scope
analyzerl Private

Public Workspaces owned by other users:

£

Name OQwner
Demo Workspace English
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Figure1-4

[ Quick Test | classic Test | Applicaton Test

Getting Started
To Use Application Test Mode

To Use Application Test Mode

For the screen as shown in Figure 1-4, perform the following procedure.

Display Example of EasyEXPERT Main Screen

File Data Display Help.

Category

OBt

[ CMOs
[] Discrete
[w] Exercise

[ Memary
[ MixedSignal

Library

=
)
Trng Idvd
Wih
bl
IliFl
Charge
Pumping 4T

Q

Demo-5-M...
Endurance
Ll
= A

=
Trng
Cag-vg
bl

T idud

43

-

[ GenericTest

KN

v ] <

=

el choose test categoties from the left area.

=1 Choose an application test object from the left area.

¥

Save

A

Recall

1. Select atest definition on the EasyEXPERT main screen while the Application

Test tab has been selected. Thetab isin the leftmost column on the screen.

a. Set the Category areato change thetest definitionslisted in the Library area.
For example, check the CMOS only.

b. Select atest definition at the Library area. For example, click 1d-Vg and
Select button sequentially. The 1d-V g screen is displayed. See Figure 1-5.

2. Change the test conditions at the Test Parameters area on the main screen as

shown in Figure 1-5.

For exampl e, the following steps change the sweep range of voltage output.

a SetVgStarttoO0 VandVgStepto0.2 V.
b. VsubsStepto-1.0 V.

1-10
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To Use Application Test Mode

To enter the value, use the USB keyboard or the screen/numeric keyboard opened by
clicking the button to the right of the entry field.

See “To Perform Measurement” on page 1-14 to start measurement.

NOTE Test Definitions
Test definitions are the built-in test setups that have been defined and stored in the
EasyEXPERT as the application library. The EasyEXPERT contains more than two
hundred test definitions. You can execute the test without modifications. Also you
can create your own test setup/definition by making any changes. All furnished test
definitions are just sample. Agilent Technologiesis NOT LIABLE for any damages
caused by the samples.
Figure 1-5 Display Example of Application Test Setup Screen
Category - _@!Id-Vg Setup Name: |Id-Vg ﬁ ‘
Q BT _+ | |Device Parameters ‘
E% Polarity: |Nch Ei Lg: ilDD nm El Wg: llD.D um EI
‘ EE};?wr;iszest o Temp: p50des 8] IdMax: [10.0ma |
[ Mermaory

[ MixedSignal =]

Library - | Test Parameters Extended Setup -
il
Id-Yq pulse ”»
Drain: |SMU4:HR vl
ne 3
Iﬁ IntegTime: [MEDIUM =] vd: 200V 8] B
IEIJ_V[Q . G Secondary Sweep
pulse[2
. Primary Sweep Subs: |SMUE|:MF‘ vl
it Gate: |5MU3!HRJ’-* 'I vsubsStart: |D W Ei ]
=%
Z +
YgStart: |—SDD iy EI VsubsStop: I—l.DD Y EI
YgStop: |2.DD W EI ¥subsStep: I—2DD it El
YgStep: |50 i EI E
=%
Source: !SMUE:HRJ’.! vI
o) |id—\tg g
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Figure 1-6

IQuick Testl Classic Test  spplication Test

Getting Started
To Use Classic Test Mode

ToUseClassic Test Mode

The following procedure performsthe I/V Sweep classic test setup.

1. Click the Classic Test tab on the main screen. The tab isin the leftmost column
on the screen.

2. Click I/V Sweep and Select button sequentially. The I/V Sweep Channel Setup
screen is displayed. See Figure 1-6.

3. Set the Channel Setup parameters as shown in Table 1-1.

4. Click the Measurement Setup tab and set the parameters as shown in Table 1-2.
5. Click the Display Setup tab and set the parameters as shown in Table 1-3.

To enter the value, use the USB keyboard or the screen/numeric keyboard opened by
clicking the button to the right of the entry field.

Display Example of 1/V Sweep Channel Setup Screen

I Sweep

Pt
Channel ...

Fael
IV List
Sweep

e

N/

IVt

Sarmpling

r

C-Y Sweep

Switching
Matrix ...

[

=] @|1/V Sweep Setup Name: [ij Sweep =
Channel Setup |Measurement Setup | Function Setup | Auto Analysis Setup I Display Setup I
Channel Definition |
addsmu | addspcu| pekte| o | Down | -I
Unit: ¥ Name: I Name: Mode: Function: |
@ [sMULHP =l | || =|[vara =l |
0 [sMuziHR/AS =2 ElE v =|jconsT =l i
0 [sMUZ:HR/AS R4 |IE] 5] || =ljcomsT =l
o [5MU4HR e = [14 E[COMMON v ||cONST =l ”
2
3
04
b
g
(=%
__| |Miscellaneous Variables
Time Stamp Name: I g Index Name: I Q
= =
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Table 1-1

Table 1-2

Table1-3

Getting Started
To Use Classic Test Mode

See “To Perform Measurement” on page 1-14 to start measurement.

I/V Sweep Channel Setup

Unit V Name | Name Mode? Function
SMUL V1 1 \ VARL
SMJ2 V2 |2 Vv CONST

a. Channel output mode. Set 1 or | PULSE for the current output and volt-
age measurement. Set V, VPUL SE, or COMMON for the voltage output
and current measurement.

I/V Sweep M easurement Setup

VAR1 Timing Constants
Unit SMUL Hold 0s Unit SMJ2
Name V1 Delay 0s V Name V2
Direction Singl e | Name |2
Linear/Log | LI NEAR Mode Y
Sart oV Source oV
Sop 1V Compliance | 100 mA
Sep 10 nv
No of Step 101
Compliance | 100 mA
Pwr Comp OFF Sweep CONTI NUE AT ANY status
I/V Sweep Display Setup
Name Sharing Scale Min M ax
X V1 (None) Li near oV 1V
Y1 11 (None) Li near -1 pA 1 pA
Agilent B1500 User’s Guide, Edition 7 1-13



Figure1-7

Getting Started
To Perform Measurement

To Perform M easurement

1. Click the Single button (upper right on the main screen) to start measurement.
This opens the Data Display window and starts a single sweep measurement.

After the measurement, the measurement datais displayed on the Data Display
window. For the measurement after performing “ To Use Classic Test Mode” on
page 1-12, you will have the test result as shown in Figure 1-7. Thisisthe
|eakage current measurement result because all measurement terminal is opened
for performing the procedures described in this chapter.

2. If the automatic data record function has been set to ON (Auto Record ON), Test
Result Editor appears on the lower area of the screen when the measurement is
completed. See “To Use Test Result Editor” on page 1-15.

Display Example of Data Display Window

€ 11V Sweep - Agilent EasyEXPERT M =

 File Edit View Marker Cursor Line Text Pointer Window Help

Setup Name: |W Sweep X

X-Y Graph Plot Properties... | |

3% Agilent
1p
800 f
600 f
400 f
200f
0
-200f
-400
-600 f
-800 f
1p

200 f /div

11 (A)

.U 100m 200m 300m 400m 500m 600m 700m 800m 900m 1

VL (V) 100 m /div
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Getting Started
To Perform Measurement

To Use Test Result Editor

The Test Result Editor provides the following GUI to set aflag and remarks to the
test result record.

Save Flags: | Important Valid Questionable

Delete Remarks: ‘ E 0K

* Save button and Delete button

Divides test records into groups, Save and Delete.

Test recordsin Save-group are always listed in the lower area of the
EasyEXPERT main screen.

Test records in Delete-group can be listed when Results > Filter >
Show Deleted Datais checked.

» Fags buttons

The following buttons are available. You can set one of the following flags.

e Important ! button
Sets the important flag (!) to the test result record.
» Valid # button
Setsthe valid flag (#) to the test result record.
¢ Questionable ? button
Sets the questionable flag (?) to the test result record.
*  Remarksfield

You can enter charactersinto thisfield. The characters will be recorded as the
Remarks value of the test result record.

* OK bhutton
Applies the setup on the Test Result Editor, and closes this dialog box.

Agilent B1500 User’s Guide, Edition 7 1-15



Getting Started
To Use Analysis Tools

To Use Analysis Tools

The Data Display window provides several analysis functions.

View menu: used to adjust the graph scale.
Marker menu: used to display and control the marker.
Cursor menu: used to display and control the cursor.

Line menu: used to display and control the lines.

When the marker, cursor, and lines are effective, their parameters are also displayed
on the X-Y Graph Plot area.

Figure 1-8 is an example displaying marker, tangent line, and regression line on the
test result graph shown in Figure 1-7. You can read position of the marker and the
active cursor, and interrupt and gradient of the active line.

Figure 1-8 Display Example of Analysis Tools
€ 1I/V Sweep - Agilent EasyEXPERT o
 File Edit View Marker Cursor Line Text Pointer Window Help
7 1 > ST 1 -8CEo| N T L =
2R D-QQ X(ll- RN - FA-Ei
Setup Name: |L"V Swieep X
X-Y Graph Plot Properties... | |
X5 Agilent CURSOR( 9.2616020000E-001 V 2.9727600000E-013 A - j
MARKER( 5.6000000000E-001V 6.0000000000E-014 A -—-- )
1p
= Intercept: Intercept:
S 800f 5.00000 fA e
Gradient: Gradient:
S o00f 2.000000E-015
400 f
200
0
-200 f
= 00f
= -00f
-800
1p Intercept: -2.37975 V
100m 200m 300m 400m 500m 600m 700m 800m 900m 1
VL (V) 100 m /div

1-16 Agilent B1500 User’s Guide, Edition 7



| ntroduction




NOTE

NOTE

Introduction

This chapter describes the basic functions and features of Agilent B1500A
Semiconductor Device Analyzer, and consists of the following sections:

e “Overview”

*  “Front View”

* “Rear View”

* “Measurement Units”

» “Specifications’

» “Accessories and Options’

Application Library

Agilent B1500A hasinstalled Agilent EasyEXPERT software as the user interface.
The EasyEXPERT contains an application library that is a set of test definitions. The
application test can be performed by selecting a test definition and setting the test
condition for the actual DUT (device under test).

All test definitions are just sample. If the samples damage your devices, Agilent
Technologiesis NOT LIABLE for the damage.

Utility

The folder C:\Program Files\Agilent\B1500\EasyEX PERT\Utilities stores the
following sample programs.

e Prober control programs

e 4155/4156 setup file converter

e dleep.exe program

For more details, see Chapter 10, “Application Library and Utilities.”
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Overview

Agilent B1500A Semiconductor Device Analyzer is the new generation one box
solution for the semiconductor device DC/AC parametric measurement and analysis
application. You can perform measurement and analysis easily and effectively on
the Microsoft Windows environment with intuitive graphical user interface, touch
screen LCD panel, keyboard, and mouse by using Agilent B1500A.

Agilent B1500A provides the DC voltage/current output capability, the DC
voltage/current measurement capability, and the AC signal output and impedance
measurement capability. So you can perform the current-voltage sweep
measurement and the capacitance-voltage sweep measurement for example by one
instrument. You can also analyze the measurement result characteristics graph by
using several tools such as markers, cursors, and lines.

Also, in the GPIB remote control mode, you can control the B1500A from an
external computer by using Agilent FLEX command set that is the common
language for Agilent semiconductor DC measurement instruments. So you can reuse
the measurement program created for Agilent 4155/4156/E5260/E5270.
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e Agilent B1500A Semiconductor Device Analyzer

Mainframe that provides the ground unit (GNDU) and ten empty slots for the
measurement facilities, and Agilent EasyEXPERT software for the operating
environment. The EasyEXPERT is the GUI based measurement control and
analysis software runs on the Microsoft Windows X P Professional.

The B1500A is equipped with the 15 inch LCD with touch panel, hard disk
drive, DVD-ROM/CD-ROM/CD-RW drive, and USB/LAN/GP-IB interfaces.
The USB keyboard, the USB mouse, and the stylus pen are available as option.

» Agilent B1510A HPSMU module

High power source/monitor unit module. Occupiestwo dots.
* Agilent B1511A MPSMU module

Medium power source/monitor unit module. Occupies one dot.
* Agilent B1517A HRSMU module

High resol ution source/monitor unit module. Occupies one slot. Needs Agilent
E5288A ASU to perform atto level current measurement or automatic switching
of the measurement resource connection.

* Agilent B1520A MFCMU module

Multi frequency capacitance measurement unit module. Occupies one slot.
Needs Agilent N1301A-100 SCUU to perform automatic switching of the
measurement resource connection.

* Agilent B1525A SPGU module

High voltage semiconductor pulse generator unit module. Occupies one slot. Up
to five modules can be installed in one B1500A mainframe. One module
provides two output channels. Needs Agilent 16440A and 16445A to perform
automatic switching of the measurement resource connection.

* Agilent B1530A WGFMU module and Agilent B1531A RSU

Waveform generator/fast measurement unit module and the remote-sense and
switch unit. Occupies one slot. Up to five modules can be installed in one
B1500A mainframe. One module provides two channels. See Agilent B1530A
User’s Guide for using the WGFMU.

» Agilent 16440A SMU/Pulse Generator Selector

Used to switch the measurement resource connected to the DUT. The
measurement resource can be SPGU or SMU. Needs the 16445A adapter to use
the selector. One selector provides two switching channels.
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e Agilent 16445A Selector Adapter

Used to connect the 16440A selector to the B1500A. Two selectors can be
connected.

e Agilent E5288A ASU

Atto sense and switch unit (ASU). Used to enable the 1 pA range for the atto
level current measurement, also switch the measurement resource connected to
the DUT. The measurement resource can be HRSMU or the instrument
connected to the AUX terminal.

* Agilent N1301A-100 SCUU

SMU CMU unify unit (SCUU). Used to switch the measurement resource
connected to the DUT. The measurement resource can be CMU or one of two
SMUs connected to the SCUU.

* Agilent N1301A-200 GSWU

Guard switch unit (GSWU). Needs the SCUU to use the GSWU. Effective for
the accurate impedance measurements by connecting the guard lines between
CMU high and low near the DUT.

Agilent EasyEXPERT Software

Agilent EasyEXPERT software is a specially-designed Windows XP application
program for controlling Agilent B1500A. The EasyEXPERT provides the easy and
effective measurement and analysis environment with intuitive graphical user
interface (GUI), touch screen LCD panel, keyboard, and mouse. Some of the
functions are listed below.

» Single measurement, repeat measurement, and append measurement
e Switching matrix control
Supported models:

e Agilent B2200A/B2201A switching matrix

* Agilent E5250A switching matrix with ES252A (EasyEXPERT Plus edition)
» Measurement/setup data management by workspace
» Graph display and analysis with markers, cursors, and lines; and auto analysis

» Dataimport/export capability, data output by CSV/XML format, and graph
output by EMF/BMP/GIF/PNG format

* Maintenance; self-test and self-calibration
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The EasyEXPERT has the following measurement execution environments.

» Application test

* Classic test

*  Quick test

The EasyEXPERT contains an application library that supports typical
measurements for CMOS devices, TFT, BJT, memory, nanotechnology devices such

as CNT FET, and so on. The application library includes more than two hundred test
definitions.

You can perform measurements by choosing the best one for your device under test
(DUT) from the application libraries, and modifying and executing it. Modification
isreally simple. For example, it will be completed by changing the output voltage
only to DUT terminals. And the setup with your modifications can be saved and
recalled as your setup (My Favorite Setup).

You can perform measurements by using the user interface similar to the
semiconductor parameter analyzers such as Agilent 4156C. The setup can be made
by entering values into the setup tables used for the measurement module control.
And it can be saved and recalled as your setup (My Favorite Setup). This
measurement environment provides the following functions.

e 1/V Sweep

e Multi Channel I/V Sweep
e |I/V List Sweep

e 1/V-t Sampling

o« C-V Sweep

» SPGU Control

e Switching Matrix Control
+ Direct Control

The Direct Control test mode is used to control the measurement modules directly
by using the B1500A GPIB control commands and perform measurement. For the
control commands, see “Agilent B1500A Programming Guide”.

You can execute the test setups saved in a preset group (My Favorite Setup)
sequentialy.
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Front View

This section describes the front view of Agilent B1500A.
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1. Standby switch

Turnsthe B1500A on. Pressing the button in the ON state makes the B1500A in
the standby state. The green LED lights when the B1500A isin the ON state.

When turning the B1500A on

Open the measurement terminals at the device side when turning the B1500A on.
Also disconnect the device from the measurement terminals and open the
measurement terminals after the measurement. If you leave the connection with the
device, the device may be damaged by unexpected operations or charge-up of
measurement cables.

2. HDD access indicator

This green LED lightsin the access status of HDD or DVD-ROM/CD-ROM/
CD-RW drive. Do not turn the B1500A off during this LED lights.
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OSD buttons

LCD Off enables or disables the LCD panel. The green LED lights when the
LCD isdisabled.

Four keys are available for the display adjustment. Press Auto to perform
adjustment automatically. Use - , +, and Menu to adjust manually.

USB interfaces

USB, 2 ports. For keyboard, mouse, and so on. USB keyboard and USB mouse
are available as option.

LCD panel

15inch TFT XGA display, 1024 x 768 resolution. Displays the Windows screen,
Adgilent EasyEXPERT software window, and so on. Touch screen operation is
available when the Touch Panel Off indicator does not light.

About screen adjustment

If you find swinging or flickering in screen while you use thisinstrument, perform
the screen adjustment. In most cases, the symptoms can be resolved by pressing the
Auto button below the LCD panel. The Auto button is used to start the automatic
screen adjustment. Also the manual screen adjustment is available by using the
adjustment menu displayed by pressing the Menu button.

6.

10.

Stop key

Stops the present measurement or source output immediately.

High voltage status indicator

This red LED lights when a source channel applies morethan = 42 V.
Measurement status indicator

This green LED lights when a measurement channel performs measurement.
Rotary knob

Works on Agilent EasyEXPERT environment. Rotating the knob moves the
marker on the graph window, or increases/decreases/changes the value in the
active entry field. Pressing the knob sets or enters the value.

Softkeys

Seven softkeys are available for Agilent EasyEXPERT environment. Used to
select an aternative for the entry field specified or the dialog box.
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11. DVD-ROM/CD-ROM/CD-RW drive
For data backup, B1500A update, or data transfer.

12. Touch Panel Off key
Works on Agilent EasyEXPERT environment. Enables or disables the touch
screen operation. The green LED lights when the touch screen is disabled.

To disable the touch panel

Use Touch Panel Device Properties, and remove the check from the Enabled box on
the Advanced tab screen. The Touch Panel Device Properties dialog box can be
opened by selecting Gunze TPDD > Adjust Settings from Windows program menu.
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Rear View

This section describes the rear view of Agilent B1500A.

1. Seria number

You need this serial number when using Agilent Technologies telephone
assistance program.

2. LED statusindicator

For troubleshooting. Followings are some examples.

e Both LEDsturn off:

B1500A isin the standby state and Standby switch is OFF position.
¢ OnelLED turnsgreen:

Power supply works normally.
e Both LEDsturn orange:

B1500A isin the standby state and Standby switch is ON position.
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3. LINE input receptacle
AC power cable is connected to this receptacle.
4. GPIB interface

Use an Agilent 82357A USB/GPIB interface or Agilent 10833A/B/C/D GPIB
cable to connect to an external computer or equipment.

5. Module slot

Ten slots are available for installing the modules. Several kinds of module can
beinstalled in the B1500A. However, the allowable number to install is different
by the module type. See“Measurement Units’ on page 2-16. Also, thereisarule
for the installation order by the module type. See Chapter 3, “Installation.”

If the WGFMU isinstaled, the following condition must be satisfied by the
modulesinstalled in the B1500A.

Total rating (sum of ratings set to modules) < 60

Rating of module: HPSMU 14, MPSMU 2, HRSMU 2, CMU 7, SPGU 12,
WGFMU 10

For example, if the B1500A installstwo HPSM U, one CMU, and two WGFMU,
the total rating is 2x14+7+2x10=55.

6. Circuit Common and Frame ground terminas
g

Normally, connect the terminals together by using the shorting bar (Agilent part
number 5000-4206). For floating measurement, remove the shorting bar.

For floating measurement, do not apply voltage more than +42 V to the Circuit
Common terminal. Failure to heed this caution may result in damage to the B1500A.

If the Circuit Common terminal is not connected to the frame ground terminal
(for floating measurement), a potential shock hazard may present. Do not
touch any of measurement circuit at any time while a floating measurement is
in progress.

7. Zero Check terminal
Ground reference point of the B1500A.
The Zero Check terminal can be used for the service purpose only. For the B1500A

normal operation, leave this terminal open and do not connect anything to this
terminal. Connecting anything can damage the B1500A.
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8. GNDU termind

0V constant voltage source. Used for the reference of measurement ground.
Triaxial connector.

9. LAN interface
RJ45 connector.
10. USB interfaces

USB, 2 ports. For keyboard, mouse, or peripherals. USB keyboard and USB
mouse are available as option.

11. Ext Trig terminals

Two BNC connectors, one for trigger input, and one for trigger output. For
details about the trigger function, see Programming Guide.

12. Digita 1/0 terminal

DSUB 25 pin connector. Can be used for the trigger input/output terminals or an
interface to control an external relay circuit and so on. For details, see
Programming Guide. This connector is also used to connect Agilent 16445A
selector adapter.

A 13. Interlock termina

Used in conjunction with the interlock function of the B1500A. If the Interlock
terminal is open, maximum SMU output is limited to £42 V. Be sure to connect
thisterminal to the 16442B test fixture or connector plate before performing
measurement. If you use a connector plate, you must install an interlock circuit.
For details on how to install the interlock circuit, see “ To Make an Interlock
Circuit” on page 3-29.

WARNING Danger ous voltage of up to the maximum voltage of SM Us may be present at
force, guard, and senseterminalsif the Interlock terminal is closed.
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13 1211 10 9 8 6

/N A. GNDU/ADC
Ground unit and A/D converter module. Alwaysinstalled in the B1500A.
A B. SPGU module

The semiconductor pulse generator unit (SPGU) has the Output 1 and Output 2
terminals and the following terminals to synchronize the operation between
SPGUs or with an external equipment.

Ref Out/Sync Out: Connect to the Ref In/Sync In of the slave SPGU.
Ref In/Sync In: Connect to the Ref Out/Sync Out of the master SPGU.

Trig Out: Connect to the trigger input terminal of the equipment synchronized
with the SPGU output.

CAUTION Connect the Ref Out/In, Sync Out/In, and Trig Out terminals to the specified
terminal properly. Connecting to the other terminal may result in damage to the
SPGU.
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CAUTION

In the EasyEXPERT operation mode, the SPGU outputs can be specified by the
PG number. PG1 and PG2 are assigned to the Output 1 and Output 2 terminals
of the SPGU at the lowest position. And the following PG numbers are assigned
to the outputs of the upper SPGUs in sequence. Use the PG number |abel
furnished with the B1500A or equivalent to identify the SPGU channel number.

. WGFMU module

The waveform generator/fast measurement unit (WGFMU) hasthe Ch 1 and Ch
2 terminals and the following terminals to synchronize the operation between
WGFMUSs or with an external equipment.

Sync Out: Connect to the Sync In of the slave WGFMU.
Sync In: Connect to the Sync Out of the master WGFMU.

Trig Out: Connect to the trigger input terminal of the equipment synchronized
with the WGFMU output.

Connect the Sync Out/In, and Trig Out terminals to the specified terminal properly.
Connecting to the other terminal may result in damage to the WGFMU.

Connect the connection cable between the WGFMU and the RSU (remote-sense and
switch unit) before turning the B1500A on. Changing the cable connection in the
power on state may damage the WGFMU and RSU. See Agilent B1530A User’s
Guide for cable connection and usage.

A D. SMU module

NOTE

The source/monitor unit (SMU) hastwo triaxial connectors, force and sense, for
the Kelvin connections. The HRSMU (high resolution SMU) also provides a

D-sub connector (To ASU terminal) which is used to connect the dedicated ASU
(atto sense and switch unit). The HPSMU (high power SMU) occupiestwo slots.

In the EasyEXPERT operation mode, the SMUs can be specified by the SMU
number. SMU1 is assigned to the SMU at the lowest position. And the following
SMU numbers are assigned to the upper SMUs in sequence. Use the SMU
number label furnished with the B1500A or equivalent to identify the SMU
number.

To use the ASU, connect the connection cables between the HRSMU and the
dedicated ASU before turning the B1500A on.
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WARNING There are potentially hazar dous voltages (200 V for HPSMU, and 100 V for
MPSMU/HRSMU/ASU) present at the Force, Sense, and Guard terminals of
Agilent B1500A. To prevent electrical shock, the following safety precautions
must be observed during the use of the B1500A.

a. Useathree-conductor AC power cableto connect the cabinet (if used)
and the B1500A to an electrical ground (safety ground).

b. If you do not usethe 16442B test fixture, you must install and connect an
interlock circuit that opensthe Interlock terminal when the shielding
box access door isopened.

c. Confirm periodically that the interlock function works normally.

d. Beforetouching the connectionson the Force, Guard, and Sense
terminals, turn the B1500A off and discharge any capacitors. If you do
not turn the B1500A off, complete all of the following items, regardless
of the B1500A settings.

* Pressthe stop key to set the module output off.

e Confirm that the High Voltage indicator isnot lit.

» Open the shielding box access door (open the Interlock terminal).
» Discharge any capacitors connected to an SMU.

e. Warn personsworking around the B1500A about dangerous conditions.

A E. CMU module

The multi frequency capacitance measurement unit (MFCMU) has four coaxial
connectors, Lcur, Lpot, Hpot, and Hcur, for the four-terminal pair connection.
The Hcur and Hpot have to be connected together at aterminal of the device
under test (DUT). Also the Lcur and Lpot have to be connected together at the
other terminal of the DUT. Then, the guard lines of four-terminal pair must be
connected together.

CAUTION Do not apply voltage more than +25 V to the MFCMU input terminals. Failure to
heed this caution may result in damage to the module.
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M easur ement Units

Agilent B1500A can be equipped with the following measurement modules.

“GNDU - Ground Unit”
“B1510A High Power SMU”
“B1511A Medium Power SMU”
“B1517A High Resolution SMU”
“B1520A Multi Frequency CMU”
“B1525A High Voltage SPGU”
“B1530A WGFMU”

See “Using EasyEXPERT” on page 4-1 for the functions available for Agilent
EasyEXPERT software. See Programming Guide for the functions available for the
GPIB remote mode. See Agilent B1530A User’s Guide for using the WGFMU.

GNDU - Ground Unit

Agilent B1500A is equipped with the ground unit (GNDU). The GNDU isa0V
constant voltage source, and used for the reference of measurement ground. Also the
GNDU cansink upto + 4.2 A, so it is effective for using the HPSMU (high power
SMU). Figure 2-1 isasimplified circuit diagram of GNDU.

Simplified GNDU Circuit Diagram

0
GNDU
Force

-1 <

Common
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About SMU

Source/monitor unit (SMU) can apply DC voltage or current, and can measure DC
current or voltage. Figure 2-2 isasimplified SMU circuit diagram. The SMU can
perform the following operations:

e Apply voltage and measures current
* Apply current and measures voltage
» Apply voltage and measures voltage

* Apply current and measures current

To select the SMU operation mode in the GPIB remote condition, enter the CMM
command.

Simplified SMU Circuit Diagram

Compliance

The SMU has a compliance feature that limits output voltage or current to prevent
damage to the device under test. When the SMU applies voltage, you can specify
current compliance. When the SMU applies current, you can specify voltage
compliance. For details about the compliance, refer to “SMU Compliance” on page
7-53.
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B1510A High Power SMU

This section describes typical specification of the high power source/monitor unit
(HPSMU) for Agilent B1500A. Maximum four modules can be installed in one
mainframe.

e Maximum voltage, current, output power: £ 200V, + 1 A, 20W
e Minimum range: 2V, 1 nA

*  Output/measurement value and resol ution: see Table 2-1 to Table 2-4.
HPSMU Output and M easurement Ranges

Current (mA)

1000

B 500

U UL > Voltage (V)
40 20|20 40
100 -125 100

-200 200

B -500

-1000
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Table 2-2

HPSMU Output Voltage Ranges and Resolutions
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Renge Output Velue Remiution | Current
2V 0< V<2V 100 pVv + 1000 mA
20V 0< V| < 20V 1mV + 1000 mA
40V 0< [V|] < 40V 2mv + 500 mA
100 V 0< V| < 100V 5mV + 125 mA
200V 0< V| £ 200V 10 mv + 50 mA
HPSMU Output Current Ranges and Resolutions
Range Output Value Riltlljrt]% n M\j\(;(litg;em
1nA 0< |I] £115nA 50 fA +200V
10 nA 0< || £ 115nA 500 fA +200V
100 nA 0< || £ 115nA 5pA +200V
1pA 0< |I| £ 1L15pA 50 pA +200V
10 pA 0< |I| £ 115pA 500 pA +200V
100 pA 0< |I| < 115uA 5nA +200V
1mA 0< I £ 115mA 50 nA +200V
10 mA 0< || £ 115mA 500 nA +200V
100 mA 0< |I| < 50mA 5uA +200V
50mA < |I| < 115mA 5uA +100V
1A 0< |Il £ 50mA 50 pA +200V
50mA < |I| < 125mA 50 pA +100V
125mA < |I| < 500 mA 50 pA + 40V
500mA < Il < 1A 50 pA +20V
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Table 2-3 HPSMU M easurement Voltage Values and Resolutions

Range M easur ement M easurement Resolutions
Value® High Speed ADC | High Resolution ADC

2V 0< V[ < 22V 100 puV AN
20V 0< |V|< 22V 1mv 20 pv
40V 0< V| < 44V 2mv 40 uVv
100 V 0< V| < 110V 5mV 100 pV
200V 0< |V| < 200V 10 mV 200 puV

Table 2-4 HPSMU M easurement Current Values and Resolutions
M easurement Resolutions

Range | Measurement Value?

High Speed ADC | High Resolution ADC
1nA 0< |I] £ 115nA 50 fA 10fA
10 nA 0< || £ 115nA 500 fA 10 fA
100nA | 0 < I £ 115nA 5 pA 100 fA
1pA 0< || £ 1.15pA 50 pA 1pA
10pA | 0< Il £ 115pA 500 pA 10 pA
100pA | 0 < Il £ 115pA 5nA 100 pA
1mA 0< || £115mA 50 nA 1nA
10mA | 0< Il £ 115mA 500 nA 10 nA

100mA | 0 < I <115mA 5pA 100 nA
1A 0< |l £ 1A 50 pA 1 pA

a. Thiscolumn is applied to the auto ranging or the limited auto ranging. For
fixed ranging, maximum measurement value is Range column value.
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B1511A Medium Power SMU

This section describes typical specification of the medium power source/monitor
unit (MPSMU) for Agilent B1500A.

e Maximum voltage, current, output power: + 100V, £ 100 mA, 2 W
e Minimumrange: 0.5V, 1 nA

*  Output/measurement value and resol ution: see Table 2-5 to Table 2-8.

MPSMU Output and M easurement Ranges

Current (mA)
A

100

| | | | > Voltage (V)

-100 100

-100
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Table 2-5

Table 2-6
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MPSMU Output Voltage Ranges and Resolutions

Range Output Value ReS:ct)Itlith]i%n MC?(: rmmu':n
05V 0< [V| < 05V 25 pV + 100 mA
2V 0< |V|< 2V 100 pV + 100 mA
5V 0< V| < 5V 250 puV + 100 mA
20V 0< V| 20V 1mV + 100 mA
40V 0< V| 20V 2mv + 100 mA
20V < V| £ 40V 2mv +50 mA

100V 0< V| 20V 5mv + 100 mA
20V < |V| < 40V 5mvV +50 mA

40V < V| £ 100V 5mv +20mA

MPSMU Output Current Ranges and Resolutions
Range Output Value Rgﬂﬁ% n M\Z(litr;];em
1nA 0< |I| £ 115nA 50 fA +100V
10 nA 0< || < 115nA 500 fA +100V
100 nA 0< |I| £ 115nA 5pA +100V
1pA 0< |l £ L15pA 50 pA +100V
10 pA 0< |I| £ 115pA 500 pA +100V
100 pA 0< |I| £ 115uA 5nA +100V
1mA 0< Il £ 115mA 50 nA +100V
10 mA 0< || < 115mA 500 nA +100V
100 mA 0< || < 20mA 5uA +100V
20mA < |I| < 50mA 5uA + 40V
50mA < [I| < 100 mA 5pA +20V
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Table 2-7 MPSMU M easurement Voltage Values and Resolutions
Range M easur ement M easurement Resolutions
Value® High Speed ADC | High Resolution ADC
05V | 0< |V|]< 055V 25 puV 0.5 uv
2V 0< V| < 22V 100 pV 2 uv
5V 0< V| < 55V 250 pV 5uV
20V 0< V< 22V 1mv 20 uv
40V 0< |V|< 44V 2mv 40 pVv
100V | 0< V| < 100V 5mV 100 pV
Table 2-8 MPSMU M easurement Current Values and Resolutions
Range M easurement M easurement Resolutions
Value® High Speed ADC | High Resolution ADC
1nA 0< || <115nA 50 fA 10 fA
10nA 0< | £ 115nA 500 fA 10fA
100nA | 0 < |I| < 115nA 5pA 100 fA
1pA | 0< Il € 1.15pA 50 pA 1pA
10pA | 0 < |I| £ 115uA 500 pA 10 pA
100pA | 0 < |I| £ 115pA 5nA 100 pA
1mA |0< |I| £ 1.15mA 50 nA 1nA
10 mA 0< |l £ 115mA 500 nA 10 nA
100mA | 0 < |I| £ 100 mA 5uA 100 nA

a. Thiscolumn is applied to the auto ranging or the limited auto ranging.
For fixed ranging, maximum measurement val ue is Range column value.
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Figure 2-5
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B1517A High Resolution SMU

This section describes typical specification of the high resolution source/monitor
unit (HRSMU) for Agilent B1500A.

e Maximum voltage, current, output power: + 100V, £ 100 mA, 2 W
e Minimum range: 0.5V, 10 pA (1 pA when the E5288A ASU is used)

*  Output/measurement value and resol ution: see Table 2-9 to Table 2-12.

HRSMU Output and M easurement Ranges

Current (mA)
A

100

| | | | > Voltage (V)
-40 -20 20 40

-100 100

-100
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Table 2-10

HRSMU Output Voltage Ranges and Resolutions

Introduction
Measurement Units

Range Output Value Remiution | Current.
05V 0< [V|< 05V 25 uv + 100 mA
2V 0< V] 2V 100 pVv + 100 mA
5V 0< V] 5V 250 pv + 100 mA
20V 0< V| £ 20V 1mv + 100 mA
0V 0< V£ 20V 2mv + 100 mA
20V < V| £ 40V 2mv =50 mA

100V 0< V£ 20V 5mv + 100 mA
20V < V| £ 40V 5mv 50 mA

40V < |V| £ 100V 5mVv 20 mA

HRSMU Output Current Ranges and Resolutions

e | owputvave | S0 | Memr
1pA 2 0< |I] £ 115pA 1fA +100V
10 pA 0< |l] £ 115pA 5fA +100V
100 pA 0< |l £ 115pA 5fA +100V
1nA 0< | £ 115nA 50 fA +100V
10nA 0< |I] £ 115nA 500 fA +100V
100 nA 0< |I] £ 115nA 5pA +100V
1pA 0< |l £ 115pA 50 pA +100V
10 pA 0< |I| £ 115uA 500 pA +100V
100 pA 0< |I] £ 115pA 5nA +100V
1 mA 0< Il £ 115mA 50 nA +100V
10 mA 0< Il £ 115mA 500 nA +100V
100 mA 0< Il £ 20mA 5pA +100V
20mA < |l £ 50mA 5uA +40V

50mA < |I] £ 100 mA 5uA 20V

a. Available when the E5288A Atto Sense and Switch Unit (ASU) is used.
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Table 2-12
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HRSMU M easurement Voltage Values and Resolutions

Range M easurement M easurement Resolutions
Value® High Speed ADC | High Resolution ADC
05V | 0< |V|< 055V 25 uv 0.5 uV
2V 0< V< 22V 100 pV 2V
5V 0< V< 55V 250 pV 5V
20V | 0< V< 22V 1mv 20 pv
OV | 0< v < 4v 2mv 40 pv
100V | 0< V[ < 100V 5mV 100 pV

HRSMU Measurement Current Values and Resolutions

Range M easurement M easurement Resolutions
Value® High Speed ADC | High Resolution ADC
1pAP [0 < Il < 115pA 100 aA 100 aA
10 pA 0< | £ 115pA 1fA 1fA /400 aA °
100pA | 0 < || < 115pA 51A 2 A /500 A b
1nA | 0< || £ 1.15nA 50 fA 10 fA
10nA | 0< |I| < 11.5nA 500 fA 10 fA
100nA | 0 < |I| < 115nA 5 pA 100 fA
1pA | 0< |l £ 115uA 50 pA 1 pA
10pA | 0 < |I| £ 115uA 500 pA 10 pA
100pA | 0 < |I| < 115uA 5nA 100 pA
1mA |0< Il < 1.15mA 50 nA 1nA
10mA |0 < |I| < 11.5mA 500 nA 10 nA
100mA | 0 < |I| < 100mA 5 pA 100 nA

a. Thiscolumn is applied to the auto ranging or the limited auto ranging.
For fixed ranging, maximum measurement value is Range column value.
b. Available when the E5288A Atto Sense and Switch Unit (ASU) is used.
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NOTE To connect ASU

The specifications are satisfied and guaranteed for the exclusive combination of the
ASU and the HRSMU. So confirm the serial number of the ASU and connect it to
the dedicated HRSMU properly.

To connect the ASU, see “To Connect ASU” on page 3-17.

To confirm the serial number, see “ASU” on page 4-43.

NOTE Before using 1 pA range

The measurement channel connected to the ASU supportsthe 1 pA range. To usethe
1 pA range, set the 1 pA fixed range or the 1 pA limited auto ranging.

The B1500A automatically performs the compensation of the data measured by the
1 pA range and returns the compensated data. You can use either the pre-stored
offset data or the pre-measured offset data.

To measure the offset data, perform the self-calibration before starting the
measurement for a DUT. This offset data is temporarily memorized until the
B1500A isturned off. See “Module Self Calibration” on page 4-35.
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B1520A Multi Frequency CMU

This section describes typical specification of the multi frequency capacitance
measurement unit (CMU) for Agilent B1500A. The CMU performs the impedance
measurement and returns the specified measurement data such as Cp-G. Only one
module can be installed in one mainframe.

Measurement parameters. See Table 2-13.

All measurement parameters are supported by Agilent B1500A in the GPIB
remote mode. However, Agilent EasyEXPERT software supports the Cp-G,
Cp-D, Cs-Rs, and Z-6 measurements only.

AC signal, output frequency:
1kHzto5MHz

Setting resolution: 1 mHz (1 kHz to), 10 mHz (10 kHz to), 0.1 Hz (100 kHz to),
or 1Hz (1 MHzto 5 MHz)

AC signal, output level:

10 mVrmsto 250 mVrms, 1 mV resolution

DC bias:

Oto+ 100V

Setting resolution: 1 mV (0to £ 25 V) or 5mV (to+ 100 V)

DC bias> + 25V is available when using the SMU CMU unify unit (SCUU).
M easurement range:

For the fixed ranging mode, measurement range (impedance range) must be
specified to perform measurement. Table 2-14 shows the available measurement
ranges and the corresponding impedance value. And Figure 2-6 shows the
calculation example of the impedance vs frequency characteristics of a
capacitive load. Use these information to decide the measurement range.

Impedance Z is calculated by the following formula.
Z=1/(2nfC)
where f isfrequency (Hz) and C is capacitance (F).
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M easurement Parameters
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Primary Parameter

Secondary Parameter

R (resistance, Q)

X (reactance, Q)

G (conductance, S)

B (susceptance, S)

Z (impedance, Q)

0 (phase, radian)

Z (impedance, Q)

0 (phase, degree)

Y (admittance, S)

0 (phase, radian)

Y (admittance, S)

0 (phase, degree)

Cp (parallel capacitance, F)

G (conductance, S)

Cp (parallel capacitance, F)

D (dissipation factor)

Cp (parallel capacitance, F)

Q (quality factor)

Cp (parallel capacitance, F)

Rp (parallel resistance, Q)

Cs (series capacitance, F)

Rs (series resistance, Q)

Cs (series capacitance, F)

D (dissipation factor)

Cs (series capacitance, F)

Q (quality factor)

Lp (paralel inductance, H)

G (conductance, S)

Lp (paralel inductance, H)

D (dissipation factor)

Lp (paralel inductance, H)

Q (quality factor)

Lp (parallel inductance, H)

Rp (parallel resistance, Q)

Ls (seriesinductance, H)

Rs (series resistance, Q)

Ls (seriesinductance, H)

D (dissipation factor)

Ls (seriesinductance, H)

Q (quality factor)
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Table 2-14 Measurement Range for Fixed Ranging M ode
M easurement range (impedance range)
Impedance Z
1kHz< f<200kHz | 200kHz<f<2MHz | 2MHz<f<5MHz
0< Z<100Q 50Q 50Q 500
100Q< Z<300Q 1000 100 Q 100
300Q< Z2<1kQ 300 Q 300 Q 300 Q
1kQ< Z<3kQ 1kQ 1kQ 1kQ
3kQ < Z<10kQ 3kQ 3kQ 3kQ
10kQ < Z<30kQ 10kQ 10 kQ
30kQ < Z<100kQ 30kQ 30 kQ
100 kQ < Z<300kQ 100 kQ2
300kQ< Z 300 kQ
Figure 2-6 Impedance vs Frequency Characteristics of Capacitive Load, Calculation
Example
10TQ
17Q ] 300 k<2 range 3 kQ
100 GQ 1] 1
10 6Q R B = AR B o= range
16Q eSS muaRll ] \‘N__“‘ ]
100 MQ S Rt T T [ 1004F
10 MQ T T T R
IMQ Pl | [ Tt | Tl | T ——= 101F
100 kQ — T T \\j ”]10 fE
N 10 ke — --—-? — | ::—? — e | -:-? -y 10 pF
3 1k EEEE T Tl P
e \\5555— \\§~~~~ \\5555_ 100 pF
% 100 Q \\.“‘ 3 —\\\.“ H ——T 1] H — 1nF
2 10 - - A — "
E o - 1| i —~— 1| ] 4 ] 10 nF
100 mQ T e e
10 mQ Tt 1:] ﬁi
1 mQ T T
100 pe F——ad e T | e | [H00uF
0o L] — 1 —~—L 1 mF
o 1| 1| — |
1 H.Q Wmeec —] | Bmns | \i 10 mF
100 O 50 Q range iy \5100 mF
10nQ 1F
1 kHz 10 kHz 100 kHz 1 MHz 5 MHz
Frequency f
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Figure 2-7
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B1525A High Voltage SPGU

This section describes key specification of the high voltage semiconductor pulse
generator unit (SPGU) for Agilent B1500A. Maximum five modules can be
installed in one mainframe.

Number of output channels: 2 channels per module

Output impedance: 50 O

Output level: 0to + 40 V (open load), + 20V (50 Q load), 1 mV resolution
SPGU operation mode:

PG (pulse generator) or ALWG (arbitrary linear waveform generator)
Channel output operation mode:

Free run, duration, or pulse count (PG mode)/sequence count (ALWG mode)
PG output mode:

2-level pulse or 3-level pulse, for each channel

Pulse timing parameters:

Period: 20 nsto 10 s, 10 nsresolution

Width: 10 nsto period- 10 ns, resolution 2.5 ns or 10 ns (transition time > 8 us)
Delay: 0 to period- 20 ns, resolution 2.5 ns or 10 ns (transition time > 8 us)

Transition time (leading time or trailing time): 8 nsto 400 ms, resolution 2 ns or
8 ns (transition time > 8 us)

Pulse switch, which is more durabl e than mechanical relays, and better suited for
frequent switching applications.

Automatic voltage level adjustment by specifying load impedance of DUT

SPGU Simplified Circuit Diagram

50 Q Pulse switch 50 Q Pulse switch

\O—> Output 1 \O—> Output 2
PG 2-level PG 2-level
or 3-level or 3-level
or or
A/\ ALWG A/\ ALWG
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B1530A WGFMU

This section describes typical specification of the waveform generator/fast
measurement unit (WGFMU) for Agilent B1500A. Maximum five modules can be
installed in one mainframe.

Number of channels: 2 channels per module
Function:

Voltage output and current or voltage sampling measurement with minimum
sampling interval of 5 ns

Current measurement range: 1 pA, 10 uA, 100 pA, 1 mA, 10 mA
Operation mode: PG mode, Fast IV mode, DC mode
PG mode:

ALWG (arbitrary linear waveform generator) voltage output and voltage
measurement (VFVM). The output voltage will be divided by the internal 50 O
resistor and the load impedance.

Output level: -5V to 5V

Minimum pulse width: 100 ns

Fast IV mode:

ALWG voltage output and current or voltage measurement (VFIM or VFVM).
Output level: 0to- 10V, 0t0 10V, -5V to5V

Minimum pulse width: 300 ns

DC mode:

DC voltage output and current or voltage measurement (VFIM or VFVM).
Output level: 0to- 10V, 0t0 10V, -5V to 5V

WGFMU Simplified Circuit Diagram

PG mode |

L/ Ch1 S R / Ch2
RSU output RSU output
—o ALWG —o

L. T e N

Fast IV mod L T Fast IV mode
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Specifications

This section lists specifications and supplemental information for the B1500A and
its associated modules. The specifications are the standards against which the
B1500A and its associated modules are tested. When the B1500A and any of its
associated modules are shipped from the factory, they meet the specifications. The
“supplemental” information and “typical” entriesin the following specifications are
not warranted, but provide useful information about the functions and performance
of the instrument.

Hardware

e “Specification Conditions”

*  “Mainframe”’

« “MPSMU/HRSMU"

s “ASU”

 “HPSMU”

e “SMU Common Specifications”

e “SMU Supplemental Information”

« “MFCMU"

¢ “SCUU/GSWU”"
e “HV-SPGU"

* “Selector”

» “Selector Adapter”
e “WGFMU/RSU”
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Specification Conditions

The measurement and output accuracy are specified at the rear panel connector
terminals when referenced to the Zero Check terminal. The B1530A WGFMU
measurement and output accuracy are specified at the output terminal of the RSU.
Accuracy is specified under the following conditions:

1
2
3.
4

. Ambient temperature change less than + 1 °C after self-calibration execution,

8.
9.

Temperature: 23°C+5°C
Humidity: 20 % to 60 %
After 40 minutes warm-up followed by self-calibration

not applicable for MFCMU

M easurement made within one hour after self-calibration execution,
not applicable for MFCMU and WGFMU

Calibration period: 1 year

SMU integration time setting:

1 PLC (1 nA to 1 A range, voltage range)

20 PLC (100 pA range)

50 PLC (1 pA to 10 pA range)

Averaging of high speed ADC: 128 samplesper 1 PLC
SMU filter: ON

SMU measurement terminal connection: Kelvin connection

10. WGFMU load capacitance: 25 pF or less

Agilent Technologies is responsible for removing, installing, and replacing the
B1500A modules. Contact your nearest Agilent Technologiesto install and calibrate
the B1500A modules.
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The B1500A supportsten dots for plug-in modules.
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Slots . M easurement
Module ; Range of operation .
occupied resolution
B1510A HPSMU 2 - 200V to 200V, 2V, 10fA
-1AtolA
B1511A MPSMU 1 - 100V to 100V, 0.5uV, 10fA
- 100 mA to 100 mA
B1517A HRSMU 1 - 100V to 100V, 05uV, 1fA
- 100 mA to 100 mA
E5288A ASU? - - 100V to 100V, 0.5V, 0.1fA
- 100 mA to 100 mA
B1520A MFCMU 1 1kHzto5MHz 0.035 fErm<?
B1525A HV-SPGU +40V (80 Vp-p) 50 uVv
B1530A WGFMU PG Mode: - 3V to 0.014 % of the
3V,-5Vto5V range®

Fast IV Mode: - 3V
to3V,-5Vto5V,
OVtol0V,-10Vto
ov

a. The E5288A Atto Sense and Switch Unit (ASU) is connected with the
B1517A High Resolution SMU (HRSMU).

b. Dispersion of measurement values when connecting aDUT 10 pF to the
measurement terminals under the measurement condition of frequency
1 MHz, signal level 250 mVac, and measurement time 1 PLC. The dis-
play resolution is 0.000001 fF at 1 fF order by 6 digits display.

c. Display resolution

* Maximum module configuration

The B1500A can contain up to 4 dual-slot SMUs (HPSMUs) and 2 single-slot
SMUs (MPSMUs and/or HRSMUS); it can contain up to 10 single-slot SMUs
(MPSMUs and/or HRSMUs); and it can contain any combination of dual-slot
and single-slot SMUs between these two extremes. Only one single-slot
MFCMU can be installed per B1500A mainframe. Up to five single-slot
HV-SPGUs can beinstalled per mainframe. Up to five single-slot WGFMUs can
be installed per mainframe.

Agilent B1500 User’s Guide, Edition 7
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When one or more WGFMU modules are installed in the B1500A mainframe,
the following table applies. Multiply the values given below by the number of
installed modules of that type and add the products together. The sum of the
products must be less than or equal to 59 for the configuration to be permissible.

MPSMU 2
HRSMU 2
HPSMU 14
MFCMU 7
HV-SPGU 12
WGFMU 10

» Maximum voltage between common and ground
<+ 42V

»  Ground unit (GNDU)

The GNDU is furnished standard with the mainframe.

Output voltage: 0V + 100 pV

Maximum sink current: £ 4.2 A

Output terminal/connection: Triaxial connector, Kelvin (remote sensing)

L oad capacitance: 1 pF, supplemental information

Cable resistance: supplemental information

<

Terminal Cableresistance
Sense <10Q
Force <1Q(s< 16A)
<07Q(16A<Is< 20A)

0350 (20A< Is < 42A)

where Isisthe current being sunk by the GNDU.
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MPSMU/HRSMU

MPSMU: Medium Power Source/Monitor Unit
HRSMU: High Resolution Source/Monitor Unit

» Voltage range, resolution, and accuracy
See Table 2-15 for high resolution ADC and Table 2-17 for high speed ADC.

e Current range, resolution, and accuracy
See Table 2-16 for high resolution ADC and Table 2-18 for high speed ADC.

Specified measurement resolution is limited by fundamental noise limits.

Introduction
Specifications

Minimum displayed resolutionis 1 aA at 1 pA range by 6 digits. Measurements
made in the lower ranges can be greatly impacted by vibrations and shocks.

These specifications assume an environment free of these factors.

e Power consumption

Voltage source mode;

Voltagerange (V) Power consumption? (W)
0.5 lcx 20
2 lcx 20
5 Icx 20
20 lcx 20
40 Icx 40
100 Icx 100

a. Icisthe current compliance setting.

Current source mode:

Voltage compliance? (V)

Power consumption® (W)

Ve < 20 lox 20
20< Vc £ 40 lo x 40
40< Vc < 100 lo x 100

a. Vcisthe voltage compliance setting.
b. loisthe output current.

Agilent B1500 User’s Guide, Edition 7
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Table 2-15 Voltage range, resolution, and accuracy (high resolution ADC)
Range Force M easurement Force accuracy M easurement accuracy | Maximum
resolution resolution +(%+mV)?2 *(%+mV)2 current
+05V 25 pV 05V +(0.018 + 0.15) +(0.01 +0.12) 100 mA
2V 100 pV 20V +(0.018 + 0.4) +(0.01 + 0.14) 100 mA
+5V 250 pVv 5uV +(0.018 + 0.75) +(0.009 + 0.25) 100 mA
+20V 1mv 20 pv +(0.018 + 3) +(0.009 + 0.9) 100 mA
+40V 2mv 40 pv +(0.018 + 6) +(0.01 + 1) b
+100V 5mV 100 pVv +(0.018 + 15) +(0.012 + 2.5)
a. *(% of output/measured value + offset valuein mV)
b. 100 mA (Vo< 20V),50mA (20V <Vo< 40V), 20 mA (40 V < Vo), Vo isthe output voltage.
Table 2-16 Current range, resolution, and accuracy (high resolution ADC)
Range rel:ocI)Lct:?on Mreg Lﬁgﬁm Force accuracy +(%+A+A)2 Measurement aC(;uracy Maximum
+(%+A+A) voltage
+1 pAP 1fA 0.1fA +(0.9+15E°15) +(0.9+12E°15) 100V
+10 pA°© 5fA 04fAP/1fA | +(0.46+3E+Vox1EY) +(0.46+15E 5+vox1E1) | 100V
+100 pA°® 5fA 05fAP/2fA +(0.3+1E B3+Vox 1 E'19) +(0.3+3E 4+ Vox1E16) loov
+1nA SOfA 10fA +(0.1+3E 13+Vox 1E19) +(0.1+2E 1B+Vox1E15) 100V
+10nA | 500fA 10fA +(0.1+3E 2+Vox 1E14) +(0.1+1E 2+ Vox 1E14) 100V
+100 nA 5pA 100fA +(0.05+3E 1 +Vox1E13) +(0.05+2E 1 +Vox1E13) 100V
+1pA 50 pA 1pA +(0.05+3E10+Vox1E1?) +(0.05+1E%+Vox1E1?) loov
+10pA | 500 pA 10pA +(0.05+3E %+Vox1E1Y) +(0.04+2E%+Vox1E™1Y) 100V
+100 pA 5nA 100 pA +(0.035+15E %+Vox 1E19) +(0.03+3E%+Vox1E19) 100V
+*1mA 50 nA 1nA +(0.04+15E8+Vox1E™9) +(0.03+6E 8+Vox1E9) loov
+10mA | S00nA 10nA +(0.04+15E "+Vox1E8) +(0.03+2E "+Vox1E9) 100V
+100 mA 5uA 100 nA +(0.045+15E %+Vox1E ") +(0.04+6E 8+Vox 1E7) d
a. *(% of output/measured value + fixed offset in A + proportiona offsetin A), Vo is the output voltagein V.
b. Available when Agilent E5288A Atto Sense and Switch Unit (ASU) is used.
c. Availablefor HRSMU.
d. 100V (lo< 20mA), 40V (20mA <lo< 50 mA), 20V (50 mA < 10), lo isthe output current.
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Table 2-17 Voltage range, resolution, and accuracy (high speed ADC)
Range Force M easurement Force accuracy M easurement accuracy | Maximum
resolution resolution +(%+mV)?2 *(%+mV)2 current
+05V 25 pV 05V +(0.018 + 0.15) +(0.01 + 0.25) 100 mA
£V 100 pV 20V +(0.018 + 0.4) +(0.01+0.7) 100 mA
5V 250 uV 5V +(0.018 + 0.75) +(0.01 +2) 100 mA
+20V 1mv 20 uv +(0.018 + 3) +(0.01 + 4) 100 mA
+40V 2mv 40 pv +(0.018 + 6) +(0.015 + 8) b
+100V 5mV 100 pVv +(0.018 + 15) +(0.02 + 20)
a. *(% of output/measured value + offset valuein mV)
b. 100 mA (Vo< 20V),50mA (20V <Vo< 40V), 20 mA (40 V < Vo), Vo isthe output voltage.
Table 2-18 Current range, resolution, and accuracy (high speed ADC)
Range rel:ocl)lt’ft:?on Mr'e;S(;JI I’uizﬁnt Force accuracy +(%+A+A)* Measurement aC(;uracy Maximum
+(%+A+A) voltage
+1 pAP 1fA 0.1fA +(0.9+15E°15) +(1.8+12E15) 100V
+10 pA°© 5fA 04fAP/1fA | +(0.46+3E+Vox1EY) +(0.5+15E P+Vox1E17) loov
+100 pA® 5fA 05fAP/2fA +(0.3+1E 1B3+Vox 1 E16) +(0.5+4E 14+\Vox1E16) loov
+1nA S0fA 10fA +(0.1+3E B3+Vox 1E15) +(0.25+3E 13+Vox1E19) 100V
+10nA 500 fA 10fA +(0.1+3E 2+Vox1E14) +(0.25+2E 2+Vox1E14) loov
+100 nA 5pA 100fA +(0.05+3E 1 +Vox1E13) +(0.1+2E L+Vox 1E13) 100V
+1pA 50 pA 1pA +(0.05+3E10+Vox1E1?) +(0.1+2E 104+ Vox1E12) loov
+10 pA 500 pA 10pA +(0.05+3E%+Vox1E' 1) +(0.05+2E%+Vox 1E' 1) 100V
+100 pA 5nA 100 pA +(0.035+15E %+Vox 1E19) +(0.05+2E8+Vox1E19) 100V
+*1mA 50 nA 1nA +(0.04+15E8+Vox1E™9) +(0.04+2E "+Vox 1E9) loov
+10mA | 500nA 10nA +(0.04+15E "+Vox1E8) +(0.04+2E8+Vox 1E8) 100V
+100 mA 5uA 100 nA +(0.045+15E %+Vox1E ") +(0.1+2E>+Vox1E7) d
a. *(% of output/measured value + fixed offset in A + proportiona offsetin A), Vo is the output voltagein V.
b. Available when Agilent E5288A Atto Sense and Switch Unit (ASU) is used.
c. Availablefor HRSMU.
d. 100V (lo< 20mA), 40V (20mA <lo< 50 mA), 20V (50 mA < 10), lo isthe output current.
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ASU
ASU: Atto Sense and Switch Unit
» Maximum voltage, AUX path
100 V (AUX input to AUX common)
100 V (AUX input to circuit common)
42 V (AUX common to circuit common)
e Maximum current, AUX path
0.5 A (AUX input to Force output)
e Band width (at -3 dB), AUX port
30 MHz, supplemental information

NOTE Connect ASU to dedicated HRSM U

The specifications are satisfied and guaranteed for the exclusive combination of the
ASU and the HRSMU. So confirm the serial number of the ASU and connect it to
the dedicated HRSMU properly.

NOTE Connection path control

Disable source output of the SMU and other instrument connected to the ASU
inputs before controlling the ASU connection path.
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HPSMU

HPSMU: High Power Source/Monitor Unit

» Voltage range, resolution, and accuracy

See Table 2-19 for high resolution ADC and Table 2-21 for high speed ADC.

e Current range, resolution, and accuracy
See Table 2-20 for high resolution ADC and Table 2-22 for high speed ADC.

Introduction
Specifications

Specified measurement resolution is limited by fundamental noise limits.

e Power consumption

Voltage source mode:

Voltage range (V) Power consumption? (W)
2 lcx 20
20 lcx 20
40 Ic x 40
100 Icx 100
200 Icx 200

a. Icisthe current compliance setting.

Current source mode:

Voltage compliance? (V)

Power consumption® (W)

Ve < 20 lox 20
20 < Vc £ 40 lo x 40
40 < Vc < 100 lo x 100
100< Vc < 200 lo x 200

a. Vcisthe voltage compliance setting.

b. loistheoutput current.

Agilent B1500 User’s Guide, Edition 7
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Table 2-19 Voltage range, resolution, and accuracy (high resolution ADC)
Range Forc? Meaqunmt Force accuracy Measurement accuracy | Maximum
resolution resolution *(%+mV)2 *(%+mV)2 current
+2V 100 pV 2uv +(0.018 + 0.4) +(0.01 + 0.14) 1A
+20V 1mv 20 pv +(0.018 + 3) +(0.01 + 0.14) 1A
+40V 2mv 40 uv +(0.018 + 6) +(0.01 + 1) 500 mA
+100V 5mV 100 pV +(0.018 + 15) +(0.012 + 2.5) 125 mA
+200V 10 mv 200 pV +(0.018 + 30) +(0.014 + 2.8) 50 mA

a. £(% of output/measured value + offset value in mV)

Table 2-20 Current range, resolution, and accuracy (high resolution ADC)
Range Forc.e Measuremmt Force accuracy (% +A+A)2 Measurement aczuracy Mevmum
resolution resolution (% +A+A) voltage
*1nA 50 fA 10fA +(0.1+3E B+Vox1E19) +(0.1+3E B+Vox1E ) 200V
+10nA 500 fA 10fA +(0.1+3E 12+ \VVox 1E14) +(0.1+25E 13+Vox 1E14) 200V
+100 nA 5pA 100fA +(0.05+3E L +Vox1E13) +(0.05+25E 12+Vox 1E713) 200V
+1pA 50 pA 1pA +(0.05+3E1%+Vox 1E12) +(0.05+1E 1%+Vox1E1?) 200V
+10 pA 500 pA 10pA +(0.05+3E%+Vox1E 1Y) +(0.04+2E%+Vox 1E' 1) 200V
+100 pA 5nA 100 pA +(0.035+15E%+Vox 1 E'19) +(0.03+3E%+Vox1E19) 200V
1 mA 50 nA 1nA +(0.04+15E8+Vox1E9) +(0.03+6E8+Vox 1E9) 200V
+10mA 500 nA 10nA +(0.04+15E "+Vox 1 E8) +(0.03+2E "+Vox 1E9) 200V
+100 mA 5uA 100 nA +(0.045+15E 6+Vox1E ) +(0.04+6E 5+Vox 1E7) b
1A 50 pA 1pA +(0.4+3E*+Vox1E) +(0.4+15E5+Vox1E)

a. £(% of output/measured value + fixed offset in A + proportional offset in A), Vo is the output

voltagein V.
b. 200V (lo< 50 mA), 100V (50 mA <lo< 125mA), 40V (125 mA < lo < 500 mA),
20V (500 mA <lo< 1 A), loisthe output current.
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Table 2-21 Voltage range, resolution, and accuracy (high speed ADC)
Range Forcg Meaqunmt Force accuracy Measurement accuracy | Maximum
resolution resolution *(%+mV)2 *(%+mV)2 current
2V 100 pv 2uv +(0.018 + 0.4) £(0.01+0.7) 1A
+20V 1mv 20 uv +(0.018 + 3) +(0.01 + 4) 1A
+40V 2mv 40 pv +(0.018 + 6) +(0.015 + 8) 500 mA
+100V 5mv 100 puv +(0.018 + 15) +(0.02 + 20) 125 mA
200V 10mv 200 uv +(0.018 + 30) +(0.035 + 40) 50 mA
a. £(% of output/measured value + offset value in mV)
Table 2-22 Current range, resolution, and accuracy (high speed ADC)
Range Forcg Measuremmt Force accuracy (% +A+A)2 Measurement aczuracy Mevdmum
resolution resolution (% +A+A) voltage
*1nA SOfA 10fA +(0.1+3E 13+Vox 1E19) +(0.25+3E 13+Vox 1E19) 200V
+10nA 500 fA 10fA +(0.1+3E12+Vox 1E14) +(0.25+2E 2+Vox 1E14) 200V
+100 nA 5pA 100 fA +(0.05+3E 1+Vox 1E13) +(0.1+2E 1+Vox 1E13) 200V
+1pA 50 pA 1pA +(0.05+3E 10+Vox 1E™1?) +(0.1+2E"10+Vox 1E™?) 200V
+10 pA 500 pA 10pA +(0.05+3E%+Vox1E1) +(0.05+2E %+Vox1E1Y) 200V
+100 pA 5nA 100 pA +(0.035+15E %+Vox1E10) +(0.05+2E8+Vox 1E10) 200V
1 mA S0 nA 1nA +(0.04+15E 8+Vox1E9) +(0.04+2E "+Vox1E9) 200V
+10mA | 500nA 10nA +(0.04+15E "+Vox1E®) +(0.04+2E 6+Vox1E8) 200V
+100 mA 5uA 100 nA +(0.045+15E 6+Vox1E ) +(0.1+2E2+Vox 1E ) b
1A 50 pA 1pA +(0.4+3E*+Vox1E) +(0.5+3E*+Vox1E9)

a. £(% of output/measured value + fixed offset in A + proportional offset in A), Vo is the output
voltagein V.

b. 200V (o< 50 mA), 100V (50 mA < lo< 125mA), 40V (125mA < lo< 500 mA),

20V (500 mA <lo< 1 A), loisthe output current.
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SMU Common Specifications

»  Output terminal/connection

Dual triaxial connector, Kelvin (remote sensing)

» Voltage/current compliance (limiting)

The SMU can limit output voltage or current to prevent damaging the device
under test.

Voltage compliance:

0V to+ 100V (MPSMU, HRSMU)

0V to + 200V (HPSMU)

Current compliance:

+ 10 fA to + 100 mA (HRSMU with ASU)
+ 100 fA to + 100 mA (HRSMU)

+ 1 pA to + 100 mA (MPSMU)
+1pAto+ 1A (HPSMU)

Compliance accuracy:

Same as the current or voltage set accuracy.

+  About measurement accuracy

RF electromagnetic field and SMU measurement accuracy

Voltage and current measurement accuracy can be affected by RF
electromagnetic field strengths greater than 3 V/m in the frequency range of
80 MHz to 1 GHz. The extent of this effect depends upon how the
instrument is positioned and shielded.

Induced RF field noise and SMU measurement accuracy

Voltage and current measurement accuracy can be affected by induced RF
field noise strengths greater than 3Vrms in the frequency range of 150 kHz
to 80 MHz. The extent of this effect depends upon how the instrument is
positioned and shielded.

*  Pulsed measurement

Width: 500 usto 2 s
Period: 5msto5s

2-44

Agilent B1500 User’s Guide, Edition 7



Introduction
Specifications

Period > Width+2 ms (when Width < 100 ms)
Period > Width+10 ms (when Width > 100 ms)
e Resolution: 100 us
Pulse setting accuracy (fixed measurement range), supplemental information
e Width: 0.5% + 50 us
e Period: 0.5% + 100 us

SMU Supplemental Information

Maximum allowabl e cabl e resistance (Kelvin connection)
Sense: 10 Q

Force: 10Q (< 100 mA), 1.5Q (> 100 mA)

Voltage source output resistance (Force line, Non-Kelvin connection)
0.2 Q (HPSMU)

0.3 Q (MPSMU, HRSMU)

Voltage measurement input resistance: > 1013 Q

Current source output resistance: > 1013 Q (at 1 nA range)
Current compliance setting accuracy (for opposite polarity)
For 1 pA to 10 nA ranges: Setting accuracy + 12 % of range
For 100 nA to 1 A ranges: Setting accuracy * 2.5 % of range
Maximum capacitive load

For 1 pA to 10 nA ranges. 1000 pF

For 100 nA to 10 mA ranges: 10 nF

For 100 mA and 1 A ranges: 100 uF

Maximum guard capacitance

900 pF (HPSMU, MPSMU, HRSMU)

660 pF (HRSMU with ASU)

Maximum shield capacitance

5000 pF (HPSMU, MPSMU, HRSMU)

3500 pF (HRSMU with ASU)
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e Maximum guard offset voltage
+1mV (HPSMU)
+3mV (MPSMU, HRSMU)
+4.2mV (HRSMU with ASU, lout < 100 pA)
» Noise characteristics (filter ON)
Voltage source: 0.01 % of V range (rms.)
Current source: 0.1 % of | range (rms.)
* Overshoot (filter ON), typical
Voltage source: 0.03 % of V range
Current source: 1 % of | range
» Range switching transient noise (filter ON)
Voltage ranging: 250 mV
Current ranging: 70 mV
» Slew rate: 0.2 V/us (maximum)
» Voltage range, resolution, and accuracy (high speed ADC)
See Table 2-23.
» Current range, resolution, and accuracy (high speed ADC)
See Table 2-24.

Specified measurement resolution is limited by fundamental noise limits.
Minimum displayed resolutionis 1 aA at 1 pA range by 6 digits.

M easurements made in the lower ranges can be greatly impacted by vibrations
and shocks. These specifications assume an environment free of these factors.
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Table 2-23 Voltage range, resolution, and accuracy (high speed ADC), supplemental
information
M easurement | Measurement accur acy Measurement | Measurement accuracy
Range - Range -
resolution *(%+mV)?2 resolution +(%+mV)?2
+05V b 25 v +(0.01 + 0.25) +40V 2mv +(0.015 + 8)
+2V 100 uV +(0.01 +0.7) +100 V 5mvV +(0.02 + 20)
45\ b 250 puVv +(0.01+2) +200V © 10 mv +(0.035 + 40)
20V 1mv +(0.01 + 4)

a *(% of reading + offset value in mV). Averaging is 128 samplesin 1 PLC.
b. Available for MPSMU/HRSMU.
c. Availablefor HPSMU.

Table 2-24 Current range, resolution, and accuracy (high speed ADC), supplemental
information
M easur ement M easurement accur acy Measurement| Measurement accuracy
Range . Range .
resolution +(%+A+A)R resolution +(%+A+A)2
+1pAP 0.1fA +(1.8+12E19) +10 pA 500 pA +(0.04+2E%+Vox 1E1Y)
+10pA © 1fA +(0.5+15E +Vox1EY) || #100 A SnA +(0.03+2E8+Vox1E19)
+100 pA© 5fA +(0.3+3E 4+ Vox1E19) 1 mA 50 nA +(0.03+2E "+Vox1E9)
t1nA SO fA +(0.1+3E 3+Vox 1E19) +10mA 500 nA +(0.03+2E 6+Vox1E®)
+10nA 500 fA +(0.1+2E2+Vox1E4) || £100mA 5pA +(0.04+2E %+Vox1E7)
+100 nA 5pA +(0.05+2E 1 +Vox1E13) +1Ad 50 pA +(0.4+3E*+Vox1E©)
+1pA 50 pA +(0.05+2E 1%+ Vox1E1?)
a. *(% of reading + fixed offset in A + proportiona offset in A), Vo isthe output voltagein V.
b. Available when Agilent E5288A Atto Sense and Switch Unit (ASU) is used.
c. 10 pA and 100 pA ranges are available for HRSMU with or without ASU.
d. Available for HPSMU.
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MFCMU
MFCMU: Multi Frequency Capacitance Measurement Unit

* Measurement functions

Measurement parameters. Cp-G, Cp-D, Cp-Q, Cp-Rp, Cs-Rs, Cs-D, Cs-Q,
Lp-G Lp-D, Lp-Q, Lp-Rp, LsRs, LsD, Ls-Q, R-X, G-B, Z-0, Y-6

Ranging: Auto or fixed

Measurement terminal: Four-terminal pair configuration, four BNC (female)
connectors

Cablelength: 1.5 m or 3 m, automatic identification of accessories

e Testsignd

Frequency

Range: 1 kHzto 5 MHz

Resolution: 1 mHz (minimum)

Accuracy: + 0.008 %

Output signal level

Range: 10 mVrmsto 250 mVrms

Resolution: 1 mVrms

Accuracy:

+ (10.0 % + 1 mVrms) at the measurement port of the MFCMU

+ (15.0 % + 1 mVrms) at the measurement port of the MFCMU cable (1.5m
or 3.0 m)

Output impedance: 50 Q, typical

Signal level monitor

Range: 10 mVrmsto 250 mVrms

Accuracy (open load):

+ (10.0 % of reading + 1 mVrms) at the measurement port of the MFCMU

+ (15.0 % of reading + 1 mVrms) at the measurement port of the MFCMU
cable (1.5mor 3.0m)
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* DC biasfunction

DC bias
Range: 0to+ 25V
Resolution: 1 mV

Accuracy: £ (0.5 % + 5.0 mV) at the measurement port of the MFCMU or
the MFCMU cable (1.5 mor 3.0 m)

Maximum DC bias current, supplemental information:

Impedancerange (Q2) Maximum DC biascurrent (A)
50 10x103
100 10x10°3
300 10x10°3
1x10° 1x10°3
3x10° 1x10°3
10x10° 100x10°®
30x10° 100x10°®
100x10° 10x10°
300x10° 10x10°

Output impedance: 50 Q, typical
DC bias monitor
Range: 0to+ 25V

Accuracy (open load): * (0.2 % of reading + 10 mV) at the measurement
port of the MFCMU or the MFCMU cable (1.5 m or 3.0 m)

*  Sweep characteristics

Available sweep parameters. DC bias voltage, oscillator level, frequency
Sweep type: linear, log

Sweep mode: single, double

Sweep direction: up, down

Number of measurement points; maximum 1001
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* Measurement accuracy

M easurement accuracy at the measurement port of the MFCMU or the MFCMU
cable (1.5mor 3.0m)

e |Z| accuracy: £ E (%)
* 0 accuracy: = E/100 (radian)
e Caccuracy:
+E (%) at Dx< 0.1
+ Ex(1+Dx?)Y2 (%) at Dx > 0.1
* D accuracy:
+ E/100 at Dx < 0.1
+ Ex(1+Dx)/100 at Dx > 0.1
« G accuracy:
+ E/Dx (%) at Dx < 0.1
+ Ex((1+Dx?)/Dx )Y2 (%) at Dx > 0.1
where,
Zx: Impedance measurement value (Q2)
Dx: Measurement value of D
E=Ep +(Zs /12X + Yo' x |ZX]) x 100 (%)
Ep =EpL + Eposc *+ Ep (%)
Yo =YoL*Yosc+Yo(S
Zs =Zg +ZosctZs(Q)

For the parameter value, see Table 2-25 to Table 2-27. Calculation example of
the measurement accuracy is aso shown in Table 2-28.

Specification conditions:
¢ Temperature: 23°C+£5°C
e Integrationtime: 1 PLC or 16 PLC
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Table 2-27

Parameters Eposc, ZOSC
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Oscillator level
Vosc mV

Eposc %

ZOSC mQ

125< Vosc < 250

0.03x(250/Vosc- 1)

5x(250/Vosc- 1)

64 < Vosc< 125

0.03x(125/Vosc- 1)

5x(125/Vosc- 1)

32< Vosc< 64

0.03x(64/Vosc- 1)

5x(64/Vosc- 1)

Vosc< 32

0.03x(32/Vosc- 1)

5x(64/Vosc- 1)

Vosc is oscillator level in mV.

ParametersEp;, Yo, Zg.

Cablelength Ep. % YoL NS Zg mMQ
15m 0.02+3xf/100 750%f/100 5.0
3m 0.02+5xf/100 1500xf/100 5.0

f isfrequency in MHz. If measurement cable is extended, open compensation,

short compensation, and |oad compensation must be performed.

ParametersYOSC, Yo, Ep, ZS

Frequency f Hz Yosc NS Yo nS Ep % ZsmQ
k< f< 200k | 1x(125/Vosc- 0.5) 15 0.095 5.0
200k < f< 1M | 2x(125/Vosc- 0.5) 3.0 0.095 5.0
IM< f< 2M 2x(125/Vosc- 0.5) 3.0 0.28 5.0
2M < f 20x(125/Vosc- 0.5) 30.0 0.28 5.0
Vosc is oscillator level in mV.
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Table 2-28 Example of calculated C/G measurement accuracy
Frequency CMea;ured C Accuracy 2 Measured G Accuracy @
apacitance Conductance

5MHz 1pF +0.61% 3uS +192nS
10 pF +0.32% 31uS +990nS

100 pF +0.29 % 314 uS +9uS

1nF +0.32% 3mS +99uS

1MHz 1pF +0.26 % 628 nS +16nS
10 pF +0.11% 6 1S +71nS
100 pF +0.10% 63 uS + 624 nS

1nF +0.10 % 628 uS +7uS

100 kHz 10 pF +0.18% 628 nS +11nS
100 pF +011% 6 uS + 66 NS
1nF +0.10% 63 uS +619nS

10nF +0.10% 628 uS +7uS

10 kHz 100 pF +0.18% 628 nS +11nS
1nF +011% 6 uS + 66 nS
10nF +0.10% 63 uS +619nS

100 nF +0.10% 628 uS +7uS

1kHz 100 pF +0.92% 63 nS +6nS
1nF +0.18% 628 nS +11nS

10 nF +011% 6 uS + 66 NS
100 nF +0.10% 63 uS +619nS

a. The calculation examples are specified under the conditions Dx = 0.1, 1 PLC integration time,
30 mVrmstest signal level, and at four-terminal pair port of MFCMU.
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SCUU/GSWU
SCUU: SMU CMU Unify Unit
GSWU: Guard Switch Unit

The SCUU multiplexes the outputs from two SMUs (MPSMUs and/or HRSMUSs)
and the CMU. The SCUU outputs are two sets of Kelvin triaxial ports (Force and
Sense). The SCUU also alows the SMUsto act as DC bias sources in conjunction
with the CMU. Special cables are available to connect the SMUs and CM U with the
SCUU, and an auto-detect feature automatically compensates for the cable length
going to the SCUU.

The GSWU contains arelay that automatically opens for IV measurements and
closes for CV measurements, forming a guard return path to improve CV
measurement accuracy.

e Supported SMU: MPSMU and HRSMU
+ SCUU
e Inputs
Triaxial port: Forcel, Sensel, Force2, and Sense2
BNC port: for MFCMU
Control port: for MFCMU
¢ Outputs
Triaxial port: Forcel/CMUH, Sensel, Force2/CMUL, and Sense2
Control port: for GSWU
LED: SMU/CMU output status indicator
e Docking mode
Direct and indirect mode
+ GSWU
e Input
Control port: for SCUU
Mini pin plug port: Guardl and Guard?2
¢ Output
LED: Connection status indicator
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e SCUU supplemental information

SMU path
Offset current: < 20 fA
Offset voltage: < 100 uV at 300 sec
Closed channel residual resistance: < 200 mQ
Channel isolation resistance: > 10%° Q
CMU path
» Testsigna
« Signal output level additional errors (CMU bias, open load):
+ 2 % (direct docking)
+ 7 % (indirect docking)
» Signa output level additional errors (SMU bias, open load):
+ 5% (direct docking, > 10 kHZz)
+ 10 % (indirect docking, > 10 kHz)
e Output impedance: 50 Q, typical
» Signal level monitor additional errors (open load):
+ 2 % (CMU bias), direct docking
+ 5% (SMU bias), direct docking
+ 7% (CMU bias), indirect docking
+ 10 % (SMU bias), indirect docking
» DChbiasfunction
» DC voltage bias (CMU bias)
Range: 0to+ 25V
Resolution: 1 mV
Additional errors (for CMU bias): £ 100 uV (open load)
» DC voltage bias (SMU bhias)
Range: Oto + 100V

Resolution: 5 mV
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Additional errors (for SMU voltage output accuracy): + 100 pV
(open load)

e DC bias monitor additional errors (open load):
+ 20 mV, direct docking
+ 30 mV, indirect docking
e Output impedance: 50 Q, typical
» DC output resistance: 50 Q (CMU bias), 130 O (SMU bias)
* Measurement accuracy

Impedance measurement error is given by adding the following
additional error Ee to the MFCMU measurement error.

Ee=+ (A +Zs/ |Zx| + Yox [Zx] ) x 100 (%)

Zx: Impedance measurement value (Q2)

A: 0.05 % (direct docking) or 0.1 % (indirect docking)
Zs:500 x (1 +f) mQ (f: frequency in MHZ)

Yo: 1 +f x 10 nS (direct docking, x 2 for indirect docking)

When the measurement terminals are extended by using the
measurement cable, the measurement accuracy is applied to the data
measured after performing the open/short/load correction at the DUT
side cable end.

Specification conditions:
¢ Temperature: 23°C+5°C
e Integrationtime: 1 PLC or 16 PLC

Agilent B1500 User’s Guide, Edition 7 2-55



Figure 2-9

Introduction
Specifications

HV-SPGU
HV-SPGU: High Voltage Semiconductor Pulse Generator Unit

Number of output channels: 2 channels per module
Modes: pulse, constant, and free run

Standard pulse mode

e Twolevel pulse

e Threelevel pulse per one channel

e Pulseperiod: 30nsto 10 s

Delay range: 0st09.99 s

Delay resolution: minimum 2.5 ns

Output count: 1 to 1,000,000

Voltage monitor minimum sampling period: 5 us
Trigger output

Level: TTL

Timing: Synchronized with pulse period

Trigger width: Pulse period x 1/2 (pulse period < 10 us), maximum 5 us (pulse
period > 10 ps)

Pulse range and pulse parameter: See Table 2-29.
Pulse/DC output voltage and accuracy: See Table 2-30.

SPGU pulse setup parameters

p Tperiod y

[delay Twidth

N L4h]
Vpeak + — 4 —|— — — ———

Vamp
0,
Vbase 1 EA’ ____________
‘T’
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Table 2-29 Pulserange and pulse parameter
Item Value?
Freguency range 0.1 Hzto 33 MHz
Pulse period Programmable range | 30 nsto 10 s
Resolution 10ns
Minimum 100 ns(Vamp < 10V)
Accuracy +1% (+0.01%P)
Pulse width Programmable range | 10 nsto (period - 10 ns)
Resolution 25ns(Trand Tf < 8 us)
10 ns(Tr or Tf > 8 us)
Minimum 50 ns (25 ns, typical) at Vamp < 10V
Accuracy +(3%+2ns)
Transition time (leading time | Programmable range | 8 nsto 400 ms

Tr and trailing time Tf) ©

Resolution

2ns(Trand Tf < 8 ps)

8ns(Tror Tf > 8 pus)

Minimum (typical)

<15ns(Vamp< 10V)

Minimum 20ns(Vamp< 10V)
30ns(Vamp< 20V)
60 ns (Vamp > 20 V)
Accuracy -5%to5%+ 10ns(Vamp< 10V)
-5%t05%+20ns(Vamp< 20V)
Output relay switching time® | Open/close <100 ps

a. Unless otherwise stated, all specifications assume a 50 Q termination.

b. Typica minimum. Thisisthe supplemental information.

¢. Thetime from 10 % to 90 % of Vamp which is the amplitude of output pulse.
d. Thetime it takes the open state relay to open or close.
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Pulse/DC output voltage and accur acy

Item Value Condition
Output voltage (Vout) -20Vto+20V 50 Q load
-40V to+40V open load
Accuracy 2 *+(0.5%+50mV) open load
Amplitude resolution 0.2mV (+ 10V range) 50 Q load
0.8 mV (£ 40V range)
0.4 mV (x 10 V range) open load
1.6 mV (x 40V range)
Output connectors SMA
Source impedance 500b
Short circuit current 800 mA peak (400 mA average®)
Overshoot/pre-shoot/ringing @ | % (5% + 20 mV) 50 Q2 load
Output limit Monitoring over current limit

a. At 1 usafter completing transition.
b. Typica (+ 1 %)
c. Specification condition: N x 0.2 + Itotal < 3.0 A where, N isthe number

of installed HV-SPGUSs, and Itotal is DC current output by al modules
(including HV-SPGUS)

d. Following the specified condition with transition time.

* ALWG (arbitrary linear waveform generator) function

Arbitrary linear waveform generator (ALWG) mode

Output complex waveform per one channel of HV-SPGU

Define multi-level pulse and multi-pulse waveform including open state
pulse with ALWG GUI editor

Sequential pulse waveform from user-defined pulse waveform

1024 points per one channel
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Programmable timing range: 10 nsto 10 s, 10 ns resolution

SPGU supplemental information

Pulse width jitter: 0.001 % + 150 ps

Pulse period jitter: 0.001 % + 150 ps
Maximum slew rate: 1000 V/us (50 Q load)
Noise: 10 mVrms (at DC output)

Advanced feature;

Voltage monitor: The HV-SPGU has a voltage monitor function to measure
the voltage at the DUT terminal.

M easurement accuracy (open load): £ (0.1 % of reading + 25 mV)
M easurement resolution: 50 pV

Note: Specified at 1 PLC (20 ms = (5 us sample + 5 psinterval)x 2000
samples)

Voltage compensation: The HV-SPGU can measure the impedance of DUT
and adjust the output voltage according to the DUT impedance.

ALWG setup table and pattern example

Point Time Voltage
Pattern ! 0 00V
< 2 50 ns 0.0V
P3\ | P4 3 70 ns 15.0V
15 ‘T'\ - o 2 100 ns 15.0V
10 | | | | ‘ 5 200 ns 0.0V
| | | | 6 300 ns 0.0V
\ \ \ \ 7 320 ns 100V
W (7 l P5 P6 l P9 P10 g 200 s 100V
\ \ \ \ \ 9 450 ns 0.0V
500

T 500 ns 00V

ALWG complex waveform example

Pattern1 x 1 | Pattern2 x 5 A, Pattern3 x 1 A

Agilent B1500 User’s Guide, Edition 7 2-59



Introduction
Specifications

Selector

Agilent 16440A SMU/pulse generator selector switches either aSMU or PGU to the
associated output port. You can expand to four channels by adding an additional
16440A. The PGU port on channel 1 provides a“PGU OPEN” function, which can
disconnect the PGU by opening a semiconductor relay. Agilent B1500A and
16445A are required to use the 16440A.

The following specifications data is specified at 23°C + 5 °C (73 °F =+ 9 °F) and
50 % relative humidity.

e Channel configuration: 2 channels (CH 1 and CH 2). Can add the additional 2
channels (CH 3 and CH 4) by adding another 16440A (selector expander).

Input Output
Channel 1 (CH 1) 2 (SMU and PGU 3) 1
Channel 2 (CH 2) 2 (SMU and PGU) 1
Channel 3 (CH 3)° 2 (SMU and PGU 3 1
Channel 4 (CH 4) ° 2 (SMU and PGU) 1

a. PGU channels 1 and 3 have a built-in series semiconductor relay.
b. Available when a selector expander isinstalled.

» Voltage and current range

Input port Maximum voltage (V) Maximum current (A)
SMU 200 1.0
PGU 40 022

a. Thisis peak-to-peak ac current.

Selector Adapter

Agilent 16445A selector adapter is required to control and to supply DC power to
the 16440A selector.

» Power requirement: 100 to 240 V, 50/60 Hz
e Maximum volt-amps (VA): 20 VA
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WGFMU/RSU
WGFMU: Waveform Generator/Fast M easurement Unit
RSU: Remote-sense and Switch Unit

The WGFMU is a self-contained modul e offering the combination of arbitrary linear
waveform generation (ALWG) with synchronized fast current or voltage (1V)
measurement. The ALWG function allows you to generate not only DC, but also
various types of AC waveforms. In addition to this versatile sourcing capability, the
WGFMU can also perform measurement in synchronization with the applied
waveform, which enables accurate high-speed IV characterization.

e Number of output channels: 2 channels per module
» Maodes: Fast 1V, PG (pulse generator), DC, and SMU pass-through

e Measurement functions, voltage forcing, voltage measurement, and current
measurement: See Table 2-31.

» Voltage measurement accuracy, resolution and noise: See Table 2-32.
e Current measurement accuracy and resolution: See Table 2-33.
» Voltage force accuracy, resolution, and timing: See Table 2-34.
* RF electromagnetic field and WGFMU measurement accuracy

Voltage and current measurement accuracy may be affected by RF
electromagnetic field of strength over 3 V/m at frequencies 80 MHz to 1 GHz
and 1.4 GHzto 2.0 GHz, and 1 V/m at frequencies 2.0 GHz to 2.7 GHz. The
extent of this effect depends upon how the instrument is positioned and shielded.

+ RSU
e Output terminal
» Connector: SMA
» Source impedance: 50 Q) (nominal), at DC output in PG mode
e SMU path
e  Maximum voltage: £ 25V
+  Maximum current: + 100 mA
* V Monitor terminal
» Connector: BNC
e Source impedance: 50 Q (nominal), at DC output
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TheV Monitor terminal outputs a buffered signal equal to 1/10 of the Output
terminal voltage (into a 50 Q load).

« WGFMU to RSU cable length

The WGFMU and RSU are connected by a special composite cable. The
following configurations are available.

e 3m
e 5m
e 15m

e 2.4 m + connector adapter + 0.6 m
e 4.4 m + connector adapter + 0.6 m

Note: The connector adapter is used when routing the cable through the prober’s
connector panel.

* ALWG function: See Table 2-35.
» Trigger output
Level: TTL
Trigger width: 10 ns
Generated synchronoudly with ALWG waveform.

o Software

e Instrument library for WGFMU control (supported operating systems:
Microsoft Windows XP Professional SP2 and Vista Business SP1)

e NBTI and general-purpose EasyEXPERT Application Tests

e Sample programs (NBTI and general-purpose measurement using WGFMU
and RTS data analysis)

WGFMU supported prober vendors
Cascade Microtech
Suss MicroTec
Vector Semicon

Note: The maximum number of installable RSUs for a given prober depends
upon the available space. Please contact your local sales representative for
details on connecting and mounting the WGFMU and RSU.
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Measurement functions, voltage forcing, voltage measurement, and current

measurement
Mode Function V force V measure | measure
ranges ranges ranges

Fast IV V force/l me | -3Vto+3V, | -5Vto+5V, | 1uA, 10 A,
asure, -5Vto+5V, | -10Vto 100 pA,
V force/V me | -10V to0V, +10V 1mA, 10 mA
asure OVto+10V

PG V forcelV me | -3V to+3V, -5Vto+5V -
asure -5Vto+5V

DC V force/lme | -3Vto+3V, | -5Vto+5V, | 1uA, 10 uA,
asure, -5Vto+5V, | -10Vto 100 pA,
V forcelV me | -10V o0V, +10V 1mA, 10 mA
asure OVto+10V

SMU pass Measurement | Maximum - Maximum

through using SMU +25V + 100 mA

Voltage measurement accur acy, resolution, and noise

Accuracy + 0.1 % of reading £ 0.1 % of range
(independent of the range or mode)

Resolution? 680 uV (-5Vto+5Vrange), 1.4mV (- 10V to
+10V)

Noise 4 MV, - 5V to +5 V range)®

a. Canvary at most 5 % based on the result of calibration
b. Into an open load. Without averaging.

Current measurement accuracy and resolution

Accuracy + 0.1 % of reading £ 0.1 % of range
(independent of the range or mode)
Resolution? 0.014 % of range

a. Display resolution. Can vary at most 5% based on the results of calibra-

tion.
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Table 2-34 Voltage for ce accuracy, resolution, and timing

V force (Fast IV mode) -5Vto+5V,-10Vto0OV,0V to+10V

V force (PG mode) -5V to+5V (openload),- 25V to+2.5V
(50 © load)

Accuracy + 0.1 % of setting + 0.1 % of range?P

Resolution® 96 uV (- 3V to+3V), 160 uV (al ranges except
for-3V to+3V)

Overshoot/undershoot + (5% + 20 mV)¢

Rise/fall time -5%¢t0 (+5 % + 10 ns) of setting®

Pulse period timing accuracy | +0.1 % of settingf

Pulse width timing accuracy | + (3% + 2 ns)9

a. Independent of the range or the mode. The load impedance must be > 1
MQ (1 pA range) or > 200 kQ (all other current ranges) for Fast IV
mode, or > 1 MQ for PG mode.

b. Excludes noise (by averaging over 10,000-time sampling) or transient
behavior (by waiting for a sufficient time)

¢. Canvary at most 5 % based on the result of calibration

d. Trise (10-90 %) and Tfall (90-10%) >16 nswith the 1.5 m cable, >32 ns
with 3 m cable, or >56 nswith 5 m cable (PG mode, 50 Q |oad)

e. Trise (10-90 %) and Tfall (90-10 %) >24 ns (PG mode, 50 Q load)

f. For the minimum 100 ns period (PG mode, 50 Q load)

g. For the minimum 50 nswidth (PG mode, 50 Q load)

Table 2-35 ALWG function

M aximum number of vectors 2048

Maximum number of sequences | 512

Maximum number of loop counts | 1 tg 1012

Length of avector 10 ns to 10,000 swith 10 nsresolution
Sampling rate 5ns, or 10 nsto 1 swith 10 nsresolution
Hardware averaging 10 nsto 20 mswith 10 nsresolution
Hardware memory About 4 M data points/channel (typical)
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Agilent EasyEXPERT Software

Functions

» Operation mode

Application test mode
Classic test mode

Quick test mode

» Key functions

Categorized and predefined application test library
GUI-based application test editor

Savelrecall My Favorite setups

Define/customize application library

Execute measurement (single/repeat/append)
Quick test execution

Direct control (GPIB FLEX)

Savelrecall measurement data and settings

Test result data management

Import/export device definition, measurement settings, my favorite setup,
measurement data, and application library

Graph plot display/analysis/printing
Switching matrix control

Workspace management

Self-test, self-calibration, diagnostics

Application library

Sample application tests are supplied for the following categories. They are subject
to change without notice.

Structure, CMOS, Bipolar (BJT), Memory, Mixed Signal Device, TFT, Discrete,
Reliability, Power Device, Nanotechnol ogy, Utility
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M easur ement mode details

Agilent B1500A supports the following measurement modes:

Staircase sweep

Multi-channel sweep (EasyEXPERT does not support VAR1')
Pulsed sweep

Staircase sweep with pulsed bias

IV sampling

High speed IV sampling

CV sweep

C-t sampling

C-f sweep

List sweep

Linear search (supported by FLEX command)
Binary search (supported by FLEX command)

Each SMU can be set to VAR (primary sweep), VAR2 (secondary sweep), VARL'
(synchronous sweep), or CONST (constant voltage/current source).

VAR1

Primary sweep controls the staircase (DC or pulsed) voltage or current sweep.
Maximum number of VARL steps: N4 = 1001

VAR2

Subordinate linear staircase or linear pulsed sweep. After primary sweepis
completed, the VAR2 unit output value is changed.

Maximum number of VAR2 steps: N, = 1001 (condition: 1 < N; x N, < 128128)
VARY

Staircase or pulse sweep synchronized with the VAR sweep. Sweep is made
with a user specified ratio and offset values.

VARI =axVAR1+b
“a" isthe user specified ratio, and “b" isthe user specified offset value.
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+ CONST

A source unit can be set as a constant voltage or current source depending on the
unit.

e Staircase sweep measurement mode

Forces swept voltage or current, and measures DC voltage or current. One
channel can sweep current or voltage while up to ten channels can measure
current or voltage. A second channel can be synchronized with the primary
sweep channel as an additional voltage or current sweep source.

Number of steps: 1 to 1001

Sweep mode: linear or logarithmic (1og)

Sweep direction: single or double sweep

Hold time: 0 to 655.35 s, 10 ms resolution

Delay time: 0to 65.5350 s, 100 ps resolution
* Pulsed sweep measurement mode

Forces pulsed swept voltage or current, and measures DC voltage or current. A
second channel can be programmed to output a staircase sweep voltage or
current synchronized with the pulsed sweep output.

»  Staircase sweep with pulsed bias measurement mode

Forces swept voltage or current, and measures DC voltage or current. A second
channel can be programmed to output a pulsed bias voltage or current. A third
channel can be synchronized with the primary sweep channel as an additional
voltage or current sweep source.

» Sampling (time domain) measurement mode
Displays the time sampled voltage/current data (by SMU) versus time.
Sampling channels: up to 10
Sampling mode: linear or logarithmic (log)

Sampling points: 1 to 100,001/(number of channels) for linear sampling, 1 to
1 + (number of datafor 11 decades) for log sampling

Sampling interval range: 100 ps + 20 ps x (number of channels- 1) to 2 msin
10 psresolution, or 2 msto 65.535 sin 1 msresolution

Hold time, bias hold time: - 90 msto - 100 psin 100 usresolution, 0to 655.35 s
in 10 msresolution
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M easurement time resolution:; 100 ps
e Standby mode

SMUsin “ Standby” remain programmed to their specified output value even as
other units are reset for the next measurement.

* Current offset cancel

This function subtracts the offset current from the current measurement raw
data, and returns the result as the measurement data. This function is used to
compensate the error factor (offset current) caused by the measurement path
such as the measurement cables, manipulators, or probe card.

» Timestamp
The B1500A supports atime stamp function utilizing an internal quartz clock.
Resolution: 100 ps

» Other measurement characteristics

e Measurement control:
Single, repeat, append, and stop
e SMU setting capabilities:

Limited auto ranging, voltage/current compliance, power compliance,
automatic sweep abort functions, self-test, and self-calibration

Arithmetic and analysis functions

*  User functions
Up to 20 user-defined functions can be defined using arithmetic expressions.

Measured data and pre-defined variables can be used in the computation. The
results can be displayed on the LCD.

e Arithmetic operators

+, -, *, /[, abs (absolute vaue), at (arc tangent), avg (averaging), cond
(conditional evaluation), delta, diff (differential), exp (exponent), integ
(integration), Igt (logarithm, base 10), log (logarithm, base €), mavg (moving
average), max, min, sqrt, trigonometric function, inverse trigonometric function,
and so on

e Physical constants

Keyboard constants are stored in memory as follows:
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e (@ Electron charge, 1.602177E- 19 C

» k: Boltzman’s constant, 1.380658E- 23

« ¢ (e): Dielectric constant of vacuum, 8.854188E- 12
Engineering units

The following unit symbols are also available on the keyboard.

a(10%8), f (1019, p (1019, n (109, uor 1 (10°%), m (10°3), k (10%), M (10%), G
(109, T (10%9), P (10'9)

Analysis capabilities

Overlay graph comparison

Graphical plots can be stored and overlaid.

Scale

Auto scale and zoom

Marker

Marker to min/max, interpolation, direct marker, and marker skip
Cursor

Direct cursor

Line

Two lines, norma mode, grad mode, tangent mode, and regression mode

Auto analysisfunction

On agraphics plot, the markers and lines can be automatically located using the auto
analysis setup. Parameters can be automatically determined using automatic
analysis, user function, and read out functions.

Data variable display
Up to 20 user-defined parameters can be displayed on the graphics screen.
Analysis functions

Up to 20 user-defined analysis functions can be defined using arithmetic
expressions.

Measured data, pre-defined variables, and read out functions can be used in the
computation. The results can be displayed on the LCD.
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Read out functions

The read out functions are built-in functions for reading various values rel ated to
the marker, cursor, or line.

Graph plot

Display mode

Data display window can be printed. Only X-Y graph can be printed.

Graph plot file

Graph plot can be stored as image data to clip board or mass storage device.

File type: bmp, gif, png, emf

Output

Display mode

X-Y graph, list, and parameter

X-Y graph display

X-axis and up to eight Y-axis. Linear and log scale. Real time graph plotting.
List display

Measurement data and cal cul ated user function data are listed in conjunction
with VAR1 step number or time domain sampling step number. Up to 20 data
sets can be displayed.

Other functions

Import/export files

File type: Agilent EasyEXPERT format, XML-SS format, CSV format
Data storage

Hard disk drive, DVD-ROM/CD-R/CD-RW drive

Interfaces

GPIB, interlock, USB (USB 2.0, 2 ea. on front, 2 ea. on rear),
LAN (100BASE-TX/10BASE-T), trigger in/out, digital 1/0
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e Trigger /O
Only available using GPIB FLEX commands.

Trigger in/out synchronization pul ses before and after setting and measuring DC
voltage and current. Arbitrary trigger events can be masked or activated
independently.

» External instruments supported by EasyEXPERT Standard edition:
Supported by switching matrix GUI: B2200A, B2201A

Supported by application tests: E5250A (E5252A cards), 4284A/E4980A,
81110A, 3458A

» External instruments supported by EasyEXPERT Plus edition:
All external instruments supported by EasyEXPERT Standard edition
Also supported by switching matrix GUI: E5250A (E5252A cards)

Furnished Software
» Prober control execution files
» Desktop EasyEXPERT software with license-to-use for Standard edition

e 4155/56 setup file converter tool (supported operating systems: Microsoft
Windows 2000 Professional, XP Home, XP Professional, and Vista Business)

»  VXIplug&play driver (supported operating systems. Microsoft Windows 2000
Professional and XP Professional)

Agilent B1500 User’s Guide, Edition 7 2-71



Introduction
Specifications

Agilent Desktop EasyEXPERT Software

Desktop EasyEXPERT is the same software that is built-in to the PC-based Agilent
B1500A Semiconductor Device Analyzer, except that it runs on a standalone PC.
Just like standard EasyEXPERT, Desktop EasyEXPERT supports all aspects of
parametric test, from basic manual measurements to test automation across a wafer
in conjunction with a semi-automatic wafer prober.

Features and benefits

Large application test library

Desktop EasyEXPERT comes with over 200 application tests conveniently
organized by device type, application, and technology. Many of these
application tests will run on the 4155/4156 without modification, and you can
easily edit and customize the furnished application tests to fit your specific
needs.

Offline capability

Desktop EasyEXPERT can berunin either online or offline mode. In the offline
mode you can perform tasks such as analyzing data and creating new application
tests. Thisfrees up your existing analyzer from being needed for devel opment
work and enables you to use it for its primary purpose: making measurements.

GUI-based classic test mode

Desktop EasyEXPERT offers a classic test mode that maintains the look, feel,
and terminology of the 4155/4156 user interface. In addition, it improves the
4155/4156 user interface by taking full advantage of Microsoft Windows GUI
features.

Easy test sequencing

A GUI-based Quick Test mode enables you to perform test sequencing without

programming. You can select, copy, rearrange and cut-and-paste any application
testswith afew simple mouse clicks. Once you have selected and arranged your
tests, simply click on the measurement button to begin running an automated test
sequence.

Prober control

All popular semi-automatic wafer probers are supported by Desktop
EasyEXPERT. You can define wafer, die, and module information for probing
across an entire wafer. You can also combine wafer prober control with either
Quick Test mode or an application test based test sequence to perform multiple
testing on various devices across the wafer.
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e Automatic data export

Desktop EasyEXPERT has the ability to automatically export measurement data
inreal time, in avariety of formats. You can save datato any drive connected to
the PC. If you wish, you can export data to a network drive and view test results
on your desktop PC as your instruments are performing the testing in your lab.

System requirements
The following are the minimum requirement for executing Desktop EasyEXPERT.

Operating system | Microsoft Windows XP Microsoft Windows Vista

and servicepack | Professiona SP2 Business SP1

Processor Intel Celeron 2 GHz Vista certified PC with 1 GB

memory

Memory 512 Megabytes DDR266

Display XGA 1024x768 (SXGA 1280%x1024 recommended)

HDD 1 GB free space on the C drive, 10 GB (30 GB
recommended) free space on adrive for test setup/result
data storage.

.NET Framework | Microsoft NET Microsoft .NET Framework
Framework Ver 2.0 Ver 3.0
Redistributable Package
Microsoft .NET
Framework 2.0 SP1

IO libraries Agilent 10 Libraries Suite 15.0 (for online mode)

» Supported GPIB I/F (for online mode):

B1500A 4155B/C, 4156B/C
Agilent 82350B Supported Supported
Agilent 82357A Not supported Supported
Agilent 82357B Not supported Supported
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Supported instruments:
B1500A, 4155B, 4156B, 4155C, and 4156C

Supported 4155/4156 firmware: HOSTC: 03.08 or later and SMUC: 04.08 or
later

External instruments supported by Desktop EasyEXPERT Standard edition:
Supported by switching matrix GUI: B2200A, B2201A

Supported by application tests: E5250A (E5252A cards), 4284A/E4980A,
81110A, 3458A

External instruments supported by Desktop EasyEXPERT Plus edition:
All external instruments supported by Desktop EasyEXPERT Standard edition
Also supported by switching matrix GUI: E5250A (E5252A cards)

Supported 4155/4156 functionality

Desktop EasyEXPERT Standard edition:

I/V Sweep, B2200A/B2201A switching matrix GUI control
Desktop EasyEXPERT Plus edition:

The following functions are additionally supported.

1/V-t Sampling except thinned out mode, VSVMU except differential voltage
measurement using VMU, PGU (41501B), E5250A/E5252A switching matrix
GUI control

Setup converter tool

In addition to Desktop EasyEXPERT, Agilent supplies afree setup converter
tool that runs on any Windows-based PC. Thistool can convert 4155 and 4156
setup files (file extension MES or DAT) into equivalent Desktop EasyEXPERT
classic test mode setup files.
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General Specifications

Temperature range

Operating +5°Cto+40°C

Storage -20°Cto+60°C

Humidity

Operating 20 % to 70 %RH, non-condensing
Sorage 10 % to 90 %RH, non-condensing
Altitude

Operating 0to 2,000 m (6,561 ft.)

Sorage 0to 4,600 m (15,092 ft.)

Power requirement: 90 to 264 V, 47 to 63 Hz
Maximum volt-amps (VA): 900 VA
Regulatory compliance

EMC IEC61326-1:+A1/ EN61326-1:+A1
AS/NZS 2064.1
Safety CSA C22.2 N0.1010.1-1992

IEC61010-1:+A2/ EN61010-1:+A2
UL3111-1:1994

Certification: CE, CSA, NRTL/C, C-Tick

Dimensions

B1500A: 420 mm (W) x 330 mm (H) x 575 mm (D)

N1301A-100 SCUU: 148 mm (W) x 75 mm (H) x 70 mm (D)
N1301A-200 GSWU: 33.2 mm (W) x 41.5 mm (H) x 32.8 mm (D)
E5288A ASU: 132 mm (W) x 88.5 mm (H) x 50 mm (D)

B1531A RSU: 45.2 mm (W) x 70 mm (H) x 82 mm (D)

16440A Selector: 250 mm (W) x 50 mm (H) x 275 mm (D)
16445A Selector adapter: 250 mm (W) x 50 mm (H) x 260 mm (D)
Weight

B1500A (empty) 20 kg, B1510A 2.0 kg, B1511A 1.0 kg, B1517A 1.2 kg,
E1520A 1.5Kkg, E1525A 1.3 kg, E1530A 1.3 kg, E1531A 0.13 kg, E5288A 0.5
kg, N1301A-100 0.8 kg, N1301A-200 0.1 kg, 16440A 1.1 kg, 16445A 1.0kg
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Accessories and Options

Agilent B1500A is furnished with the following accessories.

* Power cable, 1 ea

* Manua CD, 1ea

» Desktop EasyEXPERT CD-ROM, 1 ea.

» License-to-use for Desktop EasyEXPERT Standard edition, 1 license

» Software CD-ROM (including V XIplug& play driver and utility tools), 1 ea.
» Disk set for Agilent 4155B/4155C/4156B/4156C firmware update, 1 set

*  SMU number label for the B1500A installed with SMU, 1 sheet

* PG number label for the B1500A installed with SPGU, 1 sheet

2-76 Agilent B1500 User’s Guide, Edition 7



Introduction
Accessories and Options

Table 2-36 lists the options and the available accessories for Agilent B1500A.

Table 2-36 Optionsand Accessories
N,\l/ljrc’)ndbe;,r Option Item Description
B1500A Semiconductor Device Analyzer
B1500A-050 | 50 Hz power line frequency
B1500A-060 | 60 Hz power line frequency
B1500A-A6J | ANSI Z540 compliant calibration
B1500A-UK6 | Commercia cal. certificate w/ test data
B1500A-ABA | Paper manual set, English
B1500A-ABJ | Paper manual set, Japanese
B1510A High Power Source/Monitor Unit module (HPSMU)
B1511A Medium Power Source/Monitor Unit module (MPSMU)
B1517A High Resolution Source/Monitor Unit module (HRSMU)
B1520A Multi Frequency Capacitance Measurement Unit module (MFCMU)
B1525A Semiconductor Pulse Generator Unit module (SPGU)
B1530A Waveform Generator/Fast Measurement Unit (WGFMU)
B1531A Remote-sense and Switch Unit (RSU)
B1540A Agilent EasyEXPERT software
B1540A-001 | Standard
B1540A-002 | Adds support instrument (E5250A/E5252A switching matrix is supported)
B1541A Agilent Desktop EasyEXPERT software
B1541A-001 | Standard
B1541A-002 | Adds support instrument and function (E5250A/E5252A switching matrix

is supported, and 4155/4156 support function is expanded)
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M odel

Number Option Item Description
E5288A Atto Sense and Switch Unit (ASU)
E5288A-001 | Add triaxial and D-sub cables, 1.5 m
E5288A-002 | Add triaxial and D-sub cables, 3m
N1253A Accessories for Digital 1/0
N1253A-100 | Digita 1/0O T-cable
N1253A-200 | Digitd I/0 BNC Box
N1254A Accessories
N1254A-100 | GNDU to Kelvin Adapter
N1254A-107 | Triax(m)-Triax(f) Adapter
N1254A-108 | ASU Magnetic Stand
N1300A CMU cable
N1300A-001 | 1.5mlength
N1300A-002 | 3 mlength
N1301A Accessoriesfor CMU
N1301A-100 | SMU CMU Unify Unit (SCUU)
N1301A-102 | SCUU cable, 3m
N1301A-110 | SCUU magnetic stand
N1301A-200 | Guard Switch Unit (GSWU)
N1301A-201 | GSWU cable, 1.5 m
N1301A-202 | GSWU cable, 3m
16435A Interlock cable adapter (B1500 type to BNC)
16440A SMU/Pulse Generator selector
16440A-001 | Control cable, 1.5m
16440A-002 | Control cable, 3.0 m
16440A-003 | Control cable, 40 cm for second selector
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Number Option Item Description

16442B Test fixture
16442B-010 | Add triaxial cables, 1.5m, 4 ea
16442B-011 | Addtriaxia cables, 3m, 4 ea.
16442B-800 | Extrablank teflon board
16442B-801 | Universal socket module, 0.1 inch pitch, with 10 pins
16442B-802 | Universal socket module, 0.075 inch pitch, with 10 pins
16442B-803 | Universal socket module, 0.05 inch pitch, with 10 pins
16442B-810 | Extrapin set (for universal socket module, 10 pins.)
16442B-811 | Extrawire set (mini bananato pin plug, 6 ea.)
16442B-812 | Extrawire set (pin plug to pin plug, 6 ea.)
16442B-813 | Extrawire set (mini bananato mini clip, 6 ea.)
16442B-814 | Extrawire set (mini bananato mini banana, 6 ea.)
16442B-821 | Socket module, 4-pin TO package
16442B-822 | Socket module, 18-pin DIP package
16442B-823 | Extrasocket module, 28-pin DIP package
16442B-890 | Extraaccessory case

16444A Accessories for B1500A
16444A-001 | USB keyboard
16444A-002 | USB mouse
16444A-003 | Stylus pen

16445A Selector adapter for 16440A
16445A-001 | Control cable (B1500 to 16445A), 1.5 m
16445A-002 | Control cable (B1500 to 16445A), 3.0 m
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Number Option Item Description
16493G Digital 1/0 connection cable
16493G-001 | 1.5 mlength
16493G-002 | 3mlength
16493J Interlock cable
164933001 | 1.5mlength
164933-002 3 mlength
164933-003 5 mlength
16493K Kelvin triaxial cable (B1500 to B1500)
16493K-001 | 1.5mlength
16493K-002 | 3mlength
16493L GNDU cable
16493L-001 | 1.5mlength
16493L-002 | 3 mlength
16493L-003 | 5mlength
16493M Triaxial and D-sub cablesfor ASU
16493M-001 | 1.5mlength
16493M-002 | 3 mlength
16493N GNDU cable for B2200 Kelvin input
16493N-001 | 2mlength
16493P SPGU output connection cable (SMA to BNC)
16493P-001 | 1.5mlength
16493P-002 | 3 mlength
16493Q SPGU- SPGU connection cable (SMA to SMA)
16493Q-001 | 8 cmlength
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16493R Accessories for WGFMU
16493R-001 | 60 cm cable between WGFMU and RSU
16493R-002 | 2.4 m cable between WGFMU and RSU
16493R-003 | 3 m cable between WGFMU and RSU
16493R-004 | 5 m cable between WGFMU and RSU
16493R-005 | 4.4 m cable between WGFMU and RSU
16493R-006 | 1.5 m cable between WGFMU and RSU
16493R-101 | 5cm SSMC-SSMC cable for current return path
16493R-102 | 7 cm SSMC-SSMC cable for current return path
16493R-202 | 20 cm SMA-SSMC cable between RSU and DC probe
16493R-302 | 20 cm SMA-SMA cable between RSU and RF probe
16493R-801 | WGFMU connector adapter (male-female)
16493R-802 | Magnet stand for RSU

16494A Triaxial cable
16494A-001 | 1.5mlength
16494A-002 | 3 mlength
16494A-003 | 80 cm length
16494A-004 | 40 cm length
16494A-005 | 4 mlength

16494B Kelvin triaxia cable (B1500 to E5250)
16494B-001 | 1.5 mlength
16494B-002 | 3 mlength
16494B-003 | 80 cm length
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16495F Connector plate w/ 12xtriax., Interlock, GNDU
16495F-001 | Bulkhead feedthrough connectors (female to female)
16495F-002 | Connectorsto contacts for soldering

16495G Connector plate w/ 24xtriax., Interlock, GNDU
16495G-001 | Bulkhead feedthrough connectors (female to female)
16495G-002 | Connectorsto contacts for soldering

16495H Connector plate w/ 6xtriax., 6xcoax., Interlock, GNDU
16495H-001 | Bulkhead feedthrough connectors (female to female)
16495H-002 | Connectorsto contacts for soldering

16495J Connector plate w/ 8xtriax., 4xcoax., Interlock, GNDU
164953001 | Bulkhead feedthrough connectors (female to female)
164953002 | Connectorsto contacts for soldering

16495K Connector plate with universal cable holder
16495K-001 | Connector plate with rubber holder
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Installation

This chapter describes how to install Agilent B1500A and accessories.

“Requirements”

“Inspection and Installation”

“Installing Accessories’

“Mounting Connectors”

“Connecting Measurement Devices’

“Capacitance Compensation When Using Switching Matrix”
“Maintenance”

“About Plug-in Modules’

To change the GPIB address of the B1500A, see “ To Change GPIB Address’ on
page 3-9. To control external GPIB devices from the B1500A/EasyEXPERT, see
“To Enable System Controller” on page 3-10.

There are potentially hazar dous voltages (200 V for HPSMU, and 100 V for
MPSMU/HRSMU/ASU) present at the Force, Sense, and Guard terminals of
Agilent B1500A. To prevent electrical shock, the following safety precautions
must be observed during the use of the B1500A.

Use a three-conductor AC power cableto connect the cabinet (if used)
and the B1500A to an €electrical ground (safety ground).

If you do not use the 16442B test fixture, you must install and connect an
interlock circuit that openstheInterlock terminal when the shielding box
access door isopened.

Confirm periodically that the interlock function works normally.

Before touching the connections on the Force, Guard, and Sense
terminals, turn the B1500A off and dischar ge any capacitors. If you do
not turn the B1500A off, complete all of the following items, regar dless of
the B1500A settings.

* Pressthe sop key to set the module output off.

e Confirm that the High Voltage indicator isnot lit.

e Open theshielding box access door (open the Interlock terminal).
» Discharge any capacitor s connected to an SMU.

Warn personsworking around the B1500A about danger ous conditions.

3-2
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Requirements
This section contains information on:

* “Power Requirements’

* “Operating Environment”

e “Storaging/Shipping Environment”
* “Ventilation Requirements”

*  “Power Cable’

Power Requirements

The B1500A can operate from any single-phase AC power source supplying 90 to
264V at 47 to 63 Hz. The maximum power consumption is 900 VA.

Operating Environment

The B1500A is specified to operate within the following environmental conditions:
Temperature: 5°Cto40°C

Humidity: 20 % to 70 % RH, non-condensing

Altitude: 0to 2,000 m (6,561 ft.)

Soraging/Shipping Environment

The B1500A is specified to store/ship within the following environmental
conditions:

Temperature: -20°Cto60°C
Humidity: 20 % to 90 % RH, at 40 °C, non-condensing
Altitude: 0to 4,600 m (15,092 ft.)
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Ventilation Requirements

The B1500A has cooling fans. To ensure adequate airflow, make sure that there is
sufficient clearance around the cooling fans: 6 inches (150 mm) behind, 3 inches (70
mm) on the sides, and 0.5 inch (12 mm) above and below.

If the airflow isrestricted, the internal operating temperature will be higher. This
may reduce the instrument's reliability, or cause the thermal -protection circuits to
turn the instrument off.

Power Cable

Before applying AC line power to the B1500A, ensure that the correct power cable
is used.

In accordance with international safety standards, thisinstrument is equipped with a
three-prong power cable. When connected to an appropriate AC power outlet, this
cable grounds the instrument frame. The type of power cable shipped with each
instrument depends on the country of destination. Refer to the following table for
Agilent part numbers of the power cables available.

If the plug on the cable does not fit the power outlet, or the cableis to be attached to
aterminal block, cut the cable at the plug end and re-wireit. Thiswork should be
performed by a qualified electrician, observing all local electrical codes.

The color coding used in the cable will depend on the cable supplied. If a new plug
isto be connected, it must meet local safety requirements and include the following
features:

» adequate load-carrying capacity (see “ Specifications’ on page 2-33.)

e ground connection

e cableclamp

For protection from electrical shock, do not interrupt the power cable ground.
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Plug: BS 1363/A,
250V, 10A
Cable: 8120-4420,
8120-1351

¢ Plug: AS3112, 250V,
10A

¢ Cable: 8120-4419,
8120-1369

e  Plug: CEE 7 sheet
VII, 250V, 10 A

» Cable: 8120-4519,
8120-1689

Plug: NEMA 5-15P,
125V, 10A

Cable: 8120-6825,
8120-1378,
8120-1395

Plug: NEMA 6-15P,
250V, 10A

Cable: 8120-3996,
8120-0698

¢ Plug: SEV 1011, 250
V,10A
e Cable 8120-2104

e Pug: SR 107-2-D1,
250V, 10A
e Cable: 8120-2956

Plug: IS1293 and IS
6538, 250V, 10 A
Cable: 8121-1582,
8120-4211

Plug: JIS C 8303,
125V, 12 A
Cable: 8121-0743,
8120-4753

¢ Plug: Israel Sl 32, 250
V,10A
e Cable: 8120-5182

e  Plug: IRAM 2073-
10A,250V, 10 A
« Cable: 8120-6870

Plug: CEI 23-16, 250
V,10A
Cable: 8120-6978

Plug: GB 1002 figure
3,250V, 10A
Cable: 8120-8376

¢ Plug: SANS 164-1,
250V, 10 A

¢« Cable: 8121-0564,
8120-4211

e Plug: CNS10917-2,
125V, 10A

e Cable: 8121-1635,
8120-6825

Plug: CS 0017:2003,
250V, 10A

Cable: 8120-8871,
8120-0674,
8121-1638
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I nspection and I nstallation
This section describes what to do when you receive the B1500A and accessories.

1. Inspect the shipment. See “To Inspect B1500 and Accessories’.

2. Verify the B1500A operation and perform initial setup. See “ To Perform Initial
Setup”.

3. Install the B1500A in the appropriate place. See “Requirements’ on page 3-3.
To use the B1500A briefly, see “ Getting Started” on page 1-1.

To change the Windows logon setting, see “To Change Windows Logon Setting” on
page 3-9.

To change the GPIB address of the B1500A, see “ To Change GPIB Address’ on
page 3-9.

To allow the B1500A/EasyEXPERT to control external GPIB devices, see“To
Enable System Controller” on page 3-10.

To Inspect B1500 and Accessories
Perform the following inspections when the B1500A and accessories arrive at your
site.

1. Before unpacking any components, inspect all boxes for any signs of damage
that might have occurred during shipment, such as:

e dents

e scratches

e cuts

e water marks

If you suspect any damage, notify your local Agilent Technologies sales or
service office.

2. When you open the boxes that contain the B1500A and accessories, check the
components against the contents lists attached to the boxes.

If anything is missing, notify your local Agilent Technologies sales or service
office.
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To Perform Initial Setup
After you receive the B1500A, perform the following setup.

1
2.

Make sure that the Standby switch is set to off.

On the B1500A rear panel, connect the Circuit Common terminal to the frame
ground terminal by using a shorting-bar.

If you use Agilent 16444A-001 USB keyboard and/or the 16444A-002 USB
mouse, connect it to an USB port of the B1500A.

Connect the power cable from the B1500A to an AC power outlet.

5. Open the measurement terminals and press the Standby switch to turn on the

10.

11

12.

13.

14.

B1500A.

If the B1500A is operating correctly, the power-on self-test is automatically
performed. If problems arise, see “If You Have a Problem” on page 9-1.

Wiait for the Welcome to Microsoft Windows screen. On the screen, select the
Next button.

For the message How should dates and currency appear?, set asfollows:

* | liveclosest to thisregion: (for example, United States)
« | type mostly in thislanguage: (for example, English)
* | usethistype of keyboard: (for example, US)

If you use the 16444A-001 USB keyboard, select US.
Select the Next button.

For the message What time zone are you in?, select your present location (for
example, Pacific Time (US & Canada); Tijuana). Then select the Next button.

For The End User License Agreement, select Yes, | accept. Then select the Next
button.

For the message Help protect your PC, select Not right now. Then select the
Next button.

For the message What's your computer’s name?, do not anything. Just select the
Next button.

For the message What's your Administrator password?, do not anything. Just
select the Next button.

For the message Checking your internet connectivity, select the Skip button.
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15. For the message Thank you!, select the Finish button.
Theinitia setup is completed by restarting Windows.
To use the B1500A briefly, see “ Getting Started” on page 1-1.
After theinitia setup, the B1500A internal Windows has the following setup:

* Location: United States
» Language: English
» Keyboard: English (US)
» Time Zone: Pacific Time (US & Canada); Tijuana
* Network connection: none
» Computer name: Unique name set by factory
You can change the computer name after the initial setup. It must be unique.
» Password of Administrator: not defined
You can set the password after the initial setup. If you set it, do not forget it.
» Pre-defined users: Administrator, Agilent B1500 User, and AgilentOnly
You can add users after the initial setup. Add users as you need.

Agilent B1500 User is the account for automatic logon. Password is not set to
this account.

AdgilentOnly isthe account for Agilent service personnel. Do not delete this
account. This account is password protected.

NOTE Other Windows setup
You can set other setup of Windows after the initial setup. It is your responsibility.

If you connect Agilent B1500 to the network, take care to protect it from computer
virus.

NOTE Agilent Technol ogies cannot guarantee the performance and provide compatibility
information for all B1500s under several conditions. If problems arise, perform
Agilent B1500 system recovery. To perform recovery, see “B1500A System
Recovery” on page 9-19.
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To Change Windows L ogon Setting

Agilent B1500A initially enables Windows automatic logon. If you want to change
this setting, select All Programs > Control Auto Logon from the Start menu. Control
Auto Logon is displayed on the browser. Then click one of the following buttons on
the browser and follow the setup script.

» Enable Auto Logon
» Disable Auto Logon

If you set a password for the user account Agilent B1500 User, disable the automatic
logon.

To Change GPIB Address

When Agilent B1500A is shipped from the factory, the GPIB addressis setto 17. To
change the GPIB address, perform the following procedure.

1. If the EasyEXPERT software is running, terminate it as shown below:

a. Select the menu function File > Exit on the EasyEXPERT main screen.
b. Click [x] at the upper right corner of the Start EasyEXPERT button.

2. Select All Programs > Agilent IO Libraries Suite > Agilent Connection Expert
from the Start menu. Agilent Connection Expert window appears.

3. Atthelnstrument I/O on this PC area, select GPIBO, and click the Change
Properties... button. Agilent 82350 PCI GPIB Interface - GPIBO window

appears.
4. Changethe GPIB Address value.

5. Remove the check from the Auto-discover instruments connected to this
interface box.

6. Click the OK button on Agilent 82350 PCI GPIB Interface - GPIBO window.

7. Onthe Reboot Required dialog box, click the Reboot Now button, and reboot
the B1500A.
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To Enable System Controller

To allow Agilent B1500A/EasyEXPERT to control external GPIB devices, perform
the following procedure.

1. If the EasyEXPERT software is running, terminate it as shown below:

a. Select the menu function File > Exit on the EasyEXPERT main screen.
b. Click [x] at the upper right corner of the Start EasyEXPERT button.

2. Select All Programs > Agilent IO Libraries Suite > Agilent Connection Expert
from the Start menu. Agilent Connection Expert window appears.

3. Atthelnstrument I/O on this PC area, select GPIBO, and click the Change
Properties... button. Agilent 82350 PCI GPIB Interface - GPIBO window

appears.

4. Setthe GPIB Address value to 21 that isthe typical address number for the
system controller.

5. Check the System Controller box.

6. Remove the check from the Auto-discover instruments connected to this
interface box.

This disables the automatic device detection. So the Connection Expert cannot
detect the instruments connected to the GPIB interface by itself.

7. Click the OK button on Agilent 82350 PCI GPIB Interface - GPIBO window.
8. Onthe Reboot Required dialog box, click the Reboot Now button, and reboot
the B1500A.

To Disable System Controller

If the B1500A isthe system controller, you cannot control the B1500A by using an
external computer. To disable the system controller, change the steps 4 and 5 for
setting the GPIB Address value to not 21 and removing the check from the System
Controller box, and perform the procedure to the step 8.
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I nstalling Accessories

This section describes how to install the B1500A and accessories. Additional
information regarding airflow can be found in the “ Ventilation Requirements” on

page 3-4.

This section describes how to:

* “To Connect 16442B Test Fixture”
* “To Connect Connector Plate”

» “To Connect ASU”

* “To Connect SCUU/GSWU"

» “To Connect GNDU Adapter”

* “To Interconnect SPGUS’

Before connecting accessory to MFCMU

Turn the B1500A off before connecting the SCUU, the SCUU cable, or the CMU
cableto the MFCMU.

There are potentially hazar dous voltages of up to £ 100 V (M PSM U/HRSM U)
or + 200V (HPSMU) at the Force, Sense, and Guard terminals. To prevent
electrical shock, do not expose theselines.

To prevent electrical shock during use, install an interlock circuit (see
page 3-29) and connect the I nterlock cable (see page 3-16).

The GNDU can sink current of upto 4.2 A. Use Agilent 16493L GNDU cable to
connect the GNDU to atest fixture or a connector plate.

Do not use normal triaxial cable (Agilent 16494A) because the maximum current
rating of the cableis1 A.

Never connect the Guard terminal to any output, including circuit common, chassis
ground, or any other guard terminal. Doing so will damage the SMU.
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To Connect 16442B Test Fixture

See this section if you use Agilent 16442B Test Fixture. This section describes how
to set up the 16442B and how to connect the B1500A to the 16442B.

To Set up 16442B

You can stabilize the 16442B as shown in the figure below.

L

1. Put astabilizer on both sides of the test fixture.
2. Attach each stabilizer to the unit with aflathead screw.

To Connect 16442B

Use the cables shown in Table 3-1 to connect from the B1500A connectors to the
16442B’s rel ative connectors.

Making non-Kelvin connection

The Force terminals can be used to force and measure DC voltage or current. If you
want to simplify the cable connections, open the Sense terminals and connect the
Force terminals only to the test fixture by using the triaxial cables.

If you make the Kelvin connection, use both Force and Sense terminals. Connecting
the Force and Sense lines together at the terminal of the device under test minimizes
the measurement error caused by the residual resistance of the connection cables.
The Kelvin connection is effective for the low resistance measurement and the high
current measurement.
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Cables 164‘.128 B1500A Terminals
Terminals
Agilent 16493J Interlock Cable, 3mor 1.5 m Intlk Interlock
Agilent 16493L GNDU Cable, 3mor 1.5m GNDU GNDU
Agilent 16493K Kelvin Triaxial Cable, 3m SMU1 SMU Force
or 1.5 m, for the Kelvin connection
SMU2 Sense
Up to 3 SMUs can be connected to the
16442B by the Kelvin connection. SMU3 SMU Force
SMuU4 Sense
SMU5 SMU Force
SMU6 Sense
Adgilent 16494A Triaxial Cable, 3mor 1.5m, SMU1 SMU Force
for the non-Kelvin connection
SMU2 SMU Force
SMU3 SMU Force
SMuU4 SMU Force
SMU5 SMU Force
SMU6 SMU Force
Agilent N1300A CMU Cable?, 3mor 1.5m PGU1 | CMU | Hcur/Hpot
PGU2 Lcur/Lpot

a. To extend the four-terminal pair (4TP) connection to the 16442B inputs,
connect the Heur and Hpot cables together and the Lcur and L pot cables
together by using the BNC T-type adapter (female-female-male, Agilent
part number 1250-2405), then connect them to the 16442B inputs.

To extend the 4TP connection to the socket module inputs, connect the
cablesto the PGU1, PGU2, VSU1, VSU2, VMUL1, or VMU2 connector
individually, and connect the Hcur and Hpot terminal s together and the
Lcur and L pot terminals together at the socket module inputs.
It is ok to leave open the ground wire extended from the CMU cable.

Agilent B1500 User’s Guide, Edition 7

3-13



NOTE

Table 3-2

Installation
Installing Accessories

To Connect Connector Plate

The available connector plates are listed in Table 3-2. Option 001 provides the
through connectors except for the Interlock connector that provides the soldering
patterns at the back side. For the option 002, the back of each connector is designed
for soldering. For connector plate installation information, refer to Agilent 16495
Installation Guide.

For the 16495H/J, the insulator is inserted between the panel and the outer
conductor of Triax connectorBNC connectors.

Use the cables shown in Table 3-3 to connect from the B1500A connectors to the
connector plate’s relative connectors. For the cable connections from the connector
plate to the DUT interface such as manipulator and probe card, see “Mounting
Connectors’ on page 3-27 as reference.

Making non-Kelvin connection

The Force terminals can be used to force and measure DC voltage or current. If you
want to simplify the cable connections, open the Sense terminals and connect the
Force terminals only to the connector plate by using the triaxial cables.

If you make the Kelvin connection, use both Force and Sense terminals. Connecting
the Force and Sense linestogether at the terminal of the device under test minimizes
the measurement error caused by the residual resistance of the connection cables.
The Kelvin connection is effective for the low resistance measurement and the high
current measurement.

Connector Plates

M odel Option Item Connectors

16495F | 16495F-001 | Triax. (f-f) x12, GNDU (f-f) x1, Interlock (f) x1

16495F-002 | Triax. (f) x12, GNDU (f) x1, Interlock (f) x1

16495G | 16495G-001 | Triax. (f-f) x24, GNDU (f-f) x1, Interlock (f) x1

16495G-002 | Triax. (f) x24, GNDU (f) x1, Interlock (f) x1

16495H 16495H-001 | Triax. (f-f) x6, Coax. (f-f) x6, GNDU (f-f) x1, Interlock (f) x1

16495H-002 | Triax. (f) x6, Coax. (f) x6, GNDU (f) x1, Interlock (f) x1

16495) | 164953001 | Triax. (f-f) x8, Coax. (f-f) x4, GNDU (f-f) x1, Interlock (f) x1

164953002 | Triax. (f) x8, Coax. (f) x4, GNDU (f) x1, Interlock (f) x1

16495K 16495K-001 | Connector plate, rubber holder
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Cables connector | 51560 Terminals
Plate
Agilent 16493J Interlock Cable, 3mor 1.5m Intlk Interlock
Agilent 16493L GNDU Cable, 3mor 1.5m GNDU GNDU
Agilent 16493K2Kelvin Triaxial Cable, 3m or
1.5 m, for the Kelvin connection odd number Force
16495F provides the inputs 1 to 12 (6 Kelvin). SMU
16495H provides the inputs 1 to 6 (3 Kelvin). even number Sense
16495J provides the inputs 1 to 8 (4 Kelvin).
Agilent 16494A Triaxia Cable, 3mor 1.5m,
for non-Kelvin connection odd number
16495H provides the inputs 1 to 6. or SMU Force
even number
16495J provides the inputs 1 to 8.
Agilent N1300A CMU Cable®, 3mor 1.5m odd number Heur/Hpot
or cMuU
16495H provides the inputs 7 to 12. even number L cur/Lpot
16495J provides the inputs 9 to 12.

a. UseAgilent 16494B Kelvin Triaxial Cable to connect to Agilent E5250A
Low Leakage Switch Mainframe or the connector plate for Agilent 4142B
Modular DC Source/Monitor by the Kelvin connection.

b. To extend the four-terminal pair (4TP) connection to the connector plate
inputs, connect the Heur and Hpot cables together and the Lcur and L pot
cables together by using the BNC T-type adapter (female-female-male, Agi-
lent part number 1250-2405), then connect them to the connector plateinputs.
To extend the 4TP connection to the DUT interface, connect the cables to the
connector plates input connectors individually, and connect the Heur and
Hpot terminal s together and the Lcur and L pot terminalstogether onthe DUT

interface. See Figure 3-17.

It is ok to leave open the ground wire extended from the CMU cable.
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Connecting the interlock terminal

The B1500A provides the Interlock connector to prevent you from receiving an
electrical shock from high voltage (more than £ 42 V). If the Interlock connector is
open, the B1500A cannot force high voltage morethan + 42 V.

When using the 16442B test fixture, connect the I nterlock connectors together using
the 16493J interlock cable.

If you use the 16495F/G/H/J connector plate, your own connector plate, or your own
test fixture, make an interlock circuit as shownin “To Make an Interlock Circuit” on
page 3-29. Then connect the B1500A Interlock connector to the external interlock
connector by using the 16493J interlock cable.

If you use a connector plate or test fixture that has a BNC coaxia connector for the
interlock connector, connect the BNC interlock connector to the B1500A interlock
terminal asfollows:

* Required Parts:

Model No. Quantity Description
Agilent 16435A 1 Interlock Cable Adapter
Agilent 16493 1 Interlock Cable
* Procedure:

1. Connect the Interlock connector on the B1500A rear pandl to the interlock
cable adapter using the 16493J interlock cable.

2. Connect theinterlock cable adapter to the BNC interlock connector using the
coaxial cable furnished with the 16435A.
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NOTE

Figure 3-1

Required parts

To install 16495K

Installation
Installing Accessories

To Connect ASU

Agilent E5288A Atto Sense and Switch Unit (ASU) will add the 1 pA range to the

high resolution SMU (HRSMU) when it is connected between the HRSMU and the
device under test (DUT). The ASU also provides the input selection function when

instruments are connected to the SMU input and the AUX input.

For the installation of the ASU and the connection to the DUT interface (probe card,
manipulators, and so on), contact your favorite prober vender. The prober vender
will have the solutions. Dimensions of the ASU are 132 mm (W) x 88.5 mm (H) x
50 mm (D) excluding the connectors.

Image of ASU Installation

Shielding box
CMU Return
CMU Return .
16495K DUT interface 16495K
[ ASU _ ASU

To B1500A/CMU < N

<

* Agilent 16495K Connector plate

» Agilent 16493M ASU cable

* Agilent N1300A CMU cable or Agilent 16048D/E test |eads

» Agilent N1254A-108 Magnet stand

» BNC cable, coaxia cable, manipulator, wire, and so on

Fix the 16495K plate to the shielding box or something that will cover the DUT
interface. See Agilent 16495 Installation Guide. The 16495K isthe plate that hasthe

mechanism to block the light from the cable hole used to pass the cablesin the
shielding box.
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To install ASU

To connect
B1500A

NOTE

To connect other
instrument to AUX

Installation
Installing Accessories

1
2.
3.

Fix the ASU in the shielding box. The ASU must be fixed to the best position for
accessing its connectors. Agilent N1254A-108 Magnetic Stand will be useful for
fixing the ASU.

Pass the 16493M (D-sub cable, triaxial cable), N1300A CMU cable, 16048D/E
test leads, BNC cable and so on through the cable hole of the 16495K. They will
be connected between the ASU and the instruments

Connect the D-sub cable to the ASU D-sub connector.
Connect the triaxial cable to the ASU Force terminal.
Connect the cable to the ASU CMU-cur/AUX Interminal. See Figure 3-2.

* For the MFCMU, connect the N1300A CMU cable.
e For Agilent 4284A LCR meter, connect Agilent 16048D/E test leads.

» For the instrument other than the MFCMU or the 4284A, connect the BNC
cable to the CMU-cur/AUX In terminal. And open the CM U-pot terminal or
cover it by using the BNC open cap.

Adjust the cable length in the shielding box, and catch in the cables by using the
cover of the 16495K.

Connect the cable extended from the DUT interface to the ASU output terminal.
For the non Kelvin connection, open the Sense terminal or cover it by using the
triaxial open cap.

Turn the B1500A off.

Connect the D-sub cable from the ASU to the HRSMU D-sub connector.
Connect the triaxial cable from the ASU to the HRSMU Force terminal.

The specifications of the ASU are guaranteed while it is connected to the exclusive
HRSMU. Confirm the serial number of the ASU, and connect it properly. See
“ASU” on page 4-43.

To connect the instrument other than the MFCMU or the 4284A:

1. Turn the instrument off.

Connect the BNC cable from the ASU CMU-cur/AUX In terminal to the
instrument. Prepare an adapter if the instrument’s input/output connector is not
BNC.
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Figure 3-2

Figure 3-3

Installation

Installing Accessories

To Connect ASU
ASU #1
To CMU Hc <«—— CMU-cur/AUX In
Hp <—— CMU-pot
Force/CMU/AUX —> To DUT
Force <«—{ Force Sense —>
To SMU
} From SMU
D-sub <—— From CMU Return/AUX Common
ASU #2
L CMU-cur/AUX In CMU Return/AUX Common
To CMU
Lp <«— CMU-pot
Force/CMU/AUX | — To DUT
Force «—— Force Sense |
To SMU D-sub <—— From SMU

To Set Shorting Bar

o

Shorting bar .
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To connect Perform the following procedure to connect the MFCMU or the 4284A. See Figure
MFCMU/4284A to  3-2 and Figure 3-3.
AUX

Prepare a shorting bar furnished with the ASU. The shorting bar is effective for
reducing the offset capacitance caused by connecting a measurement terminal to the
chuck of awafer prober.

1. Turn the instrument off.

2. Preparetwo ASUs (#1 and #2) and two shorting bar. And perform the following
procedure for each ASU.

a Disconnect the triaxial cable from the ASU if it is connected to the ASU
Force terminal.

b. Facethe concave side of the shorting bar to front.
¢. Slide the shorting bar from the right side of the connectors.

3. Connect the cable to the instrument. For the MFCMU, use the N1300A CMU
cable. For the 4284A, use the 16048D/E test |eads. It is ok to |eave open the
ground wire extended from the cable.

4. Connect the high potential (Hp) cable of the test leads to the ASU #1 CMU-pot
terminal.

5. Connect the high current (Hc) cable to the ASU #1 CMU-cur/AUX In terminal.
The shorting bar is fixed to the ASU #1 by the step 5 and 6.

6. Connect thetriaxial cable from the HRSMU #1 Force terminal to the ASU #1
Force terminal.

7. Connect the low potential (Lp) cableto the ASU #2 CMU-pot terminal.

8. Connect the low current (Lc) cable to the ASU #2 CMU-cur/AUX Interminal.
The shorting bar is fixed to the ASU #2 by the step 8 and 9.

9. Connect thetriaxial cable from the HRSMU #2 Force terminal to the ASU #2
Force terminal.

10. Prepare the connection wire (both pin terminals) furnished with the ASU and
connect it between the CMU Return terminals of the ASU #1 and ASU #2
together.

NOTE About ASU output cables

To perform capacitance measurements accurately, the cable length between DUT
and the ASU output must be as short as possible.
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NOTE

Figure 3-4

Required parts

Installation
Installing Accessories

To Connect SCUU/GSWU

Agilent N1301A-100 SMU CMU Unify Unit (SCUU) is used to switch the module
(CMU or SMU) to be connected to the DUT. The SCUU is available for the
MPSMU and HRSMU.

Agilent N1301A-200 Guard Switch Unit (GSWU) is used to connect the CMU high
and low guard lines together near the DUT. The connection is broken when the
SCUU isinthe SMU connection state. The GSWU is effective for the accurate
impedance measurement.

For the installation of the SCUU/GSWU and the connection to the DUT interface
(probe card, manipulators, and so on), contact your favorite prober vender. The
prober vender will have the solutions. Dimensions of the SCUU are 148 mm (W) x
75 mm (H) x 70 mm (D). Dimensions of the GSWU are 33.2 mm (W) x 41.5 mm
(H) x 32.8 mm (D).

Image of GSWU I nstallation

Shielding box Wire from CMU Guard

GSWU
16495K DUT interface

1od
ad
od
od
aod
od

To B1500A/

SCuU Prober

» Agilent 16495K Connector plate

e Agilent N1301A-201/202 GSWU cable (if GSWU is used)

» Agilent N1301A-102 SCUU cable (if SCUU is not attached to the MFCMU)
» Agilent N1301A-110 Magnet stand (if GSWU is used)

» BNC cable, coaxia cable, manipulator, wire, and so on
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To install 16495K  Fix your necessary 16495 connector plates to the shielding box or something that

Before starting

Figure 3-5

will cover the DUT interface. See Agilent 16495 Installation Guide. For the GSWU
installation, the 16495K isrequired. It isthe plate that has the mechanism to block
the light from the cable hole used to pass the cables in the shielding box.

1. GSWU isfurnished with wires (2 ea.) for the connection between the GSWU

and the DUT interface Guard terminal. If it istoo short to connect them, prepare
additional wire.

2. Turn the B1500A off.

To Connect SCUU/GSWU

SCUU

He a—|
ToCMU  HP «—  Forcel/CMUH
(slot N) le o«

lp <« Sensel

ToSMu Forcel « |
(slot N-1) Sensel «— Sense2

ToSMU Force2 « | Force2/CMUL
(slot N-2) Sense? «—
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SCUU/GSWU 1

NOTE

To connect
SCUU/GSWU 2
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To attach the SCUU to the B1500A:

1. Attach the SCUU to the B1500A rear panel connectors for the MFCMU in the
slot N and two SMUs in the slots N-1 and N-2 (N: integer, 3 to 10).

Connection will be easy by bringing the control connectors together before
bringing the BNC connectors.

2. Fix the GSWU in the shielding box. The GSWU must be fixed to the best
position for accessing its connectors.

3. Passthe GSWU cable (Agilent N1301A-201/202) through the cable hole of the
16495K. And connect it between the SCUU and the GSWU.

4. Adjust the cablelength in the shielding box, and catch in the cables by using the
cover of the 16495K.

5. Connect the proper cables from Forcel/CMUH and Force2/CMUL to the 16495
connector plates or the DUT interface. See Figure 3-5.

For the Kelvin connections, also connect the proper cables from Sensel and
Sense? to the 16495 connector plates or the DUT interface.

6. Connect the wires (furnished, 2 ea.) to the GSWU.

7. Connect one of the wiresto the Guard terminal extended from CMUH of SCUU.
Then the wire should contact the Guard terminal as close to the device as
possible.

8. Connect another one to the Guard termina extended from CMUL of SCUU.
Then the wire should contact the Guard terminal as close to the device as
possible.

About SCUU output cables

To perform capacitance measurements accurately, the cable length between DUT
and the SCUU output must be as short as possible.

1. Attach an end of the SCUU cable (Agilent N1301A-102) to the SCUU.

Connection will be easy by putting the SCUU and the cable connection box on
the flat table, and bringing the control connectors together before bringing the
BNC connectors.

If the SCUU isfixed inside the shielding box, pass the SCUU cable through the
cable hole of the 16495K.
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Fix the SCUU inside or outside the shielding box. The SCUU must be fixed to

the best position for accessing its connectors. Agilent N1301A-110 Magnetic

Stand will be useful for fixing the SCUU.

. Attach the other end of the SCUU cable to the B1500A rear panel connectorsfor

the MFCMU intheslot N and two SMUsin the slots N-1 and N-2 (N: integer, 3
to 10).

Connection will be easy by bringing the control connectors together before
bringing the BNC connectors.

Fix the GSWU in the shielding box. The GSWU must be fixed to the best
position for accessing its connectors.

. Connect the GSWU cable (Agilent N1301A-201/202) between the SCUU and

the GSWU.

If the SCUU is fixed outside the shielding box, pass the GSWU cable through
the cable hole of the 16495K.

. Adjust the cable length in the shielding box, and catch in the cables by using the

cover of the 16495K.

. Connect the proper cablesfrom Forcel/CMUH and Force2/CMUL to the 16495

connector plates or the DUT interface. See Figure 3-5.

For the Kelvin connections, also connect the proper cables from Sensel and
Sense? to the 16495 connector plates or the DUT interface.

. Connect the wires (furnished, 2 ea.) to the GSWU.
. Connect one of the wiresto the Guard terminal extended from CMUH of SCUU.

Then the wire should contact the Guard terminal as close to the device as
possible.

10. Connect another one to the Guard terminal extended from CMUL of SCUU.

Then the wire should contact the Guard terminal as close to the device as
possible.

About SCUU output cables

To perform capacitance measurements accurately, the cable length between DUT
and the SCUU output must be as short as possible.
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Figure 3-6

Table 3-4

To Connect GNDU Adapter

The ground unit (GNDU) output is the single triaxial connector. Agilent
N1254A-100 GNDU to Kelvin Adapter enables to change it to the dual triaxial
connector. Connect the adapter to the GNDU connector on the rear panel, then
connect aKelvin triaxial cableto extend the GNDU terminal. Maximum current is

restricted when the Kelvin triaxial cableis used. See Table 3-4.

Agilent N1254A-100 GNDU to Kelvin Adapter

Agilent N1254A-100 GNDU to Kelvin Adapter

<:| @ Force

Triaxial (male)

Sense

Common

To GNDU connector

Kelvin Triaxial Cableand Maximum Current

Installation

Installing Accessories

H—>

Dual Triaxial (female)

B—>

To 16493K Kelvin triaxial cable

M odel No. or Description M aximum
Option Item P Current
16493K-001 1.5 mKelvin Triaxial Cable 3.0A
16493K-002 3mKelvin Triaxia Cable 26 A
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Figure 3-7

CAUTION
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To Interconnect SPGUs

If multiple SPGUs have been installed, connect the SPGUSs by using the following
parts. See Figure 3-7.

e SPGU-SPGU connection cable16493Q, (number of SPGUs- 1)x2 ea.
*  SMA open cap, 4 ea.

SPGU Module Connection Example, Four Modules
SMA open cap 164930 SMA-SMA cable

° H) Z)@ "3 0
D Do9 e
Pl owous  owpaz A\ ‘I

Slave SPGU @ ®

O} :
k aToh si'éisa T e |
9 © Deode
| (gj A% Output 1 Outpus 2 M ‘I
3 ngitent s1525a - = 1
695" ¢ O Doo g
Master SPGU —e= _(5’ _'_- -Jlth.-. Rl 0t ___"fi o Sim f:l _ s\--Ir-« Ouepyit 1 c.:p-l.v. 2 A ‘,
Trig Out | Ref In | Sync In | Output 2

Ref Out Sync Out Output 1

If multiple SPGUs have been installed, connect the SPGUs as shown in Figure 3-7.
This connection makes it possible to perform the synchronous output by the
multiple SPGU channels. In this figure, the master SPGU is the module which
outputs the reference signal and the slave SPGU s are the modules which follow to
the reference signal.

The Trig Out terminal must be connected to the trigger input terminal of the external
equipment to make the synchronized operation of it.

Connect the Ref Out/In, Sync Out/In, and Trig Out terminals to the specified
terminal properly. Connecting to the other terminal may result in damage to the
SPGU.
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M ounting Connectors

Previous sections described how to install the avail able accessories, and Agilent
16495 Installation Guide provides the information on how to install connector
plates on the shielding box. However, you may choose to mount connectors directly
on your own connector plate or test fixture.

To do this, you will need to make connector holes and mount the connectors
yourself. This section contains information on connector hole dimensions.

To mount connectors:

1. Select the appropriate parts for your application. See Table 3-5.
2. Make the holes and mount the connectors. See Table 3-6.

For Kelvin connections, use Agilent 16493K Kelvin triaxial cable. The Kelvin
triaxial cablerequiresaKelvin triaxial connector, which has two connector
holes and three screw holes.

3. Build theinterlock circuit shownin “To Make an Interlock Circuit” on page
3-29.

4. Attach cables from the connectors to the DUT (device under test). See “To
Connect GNDU Output” on page 3-32, “To Connect SMU Output” on page
3-33, and “To Connect MFCMU Output” on page 3-39.
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Table 3-5 Recommended Parts
Usage Agilent Part No. Description
Making an interlock 1252-1419C Interlock Connector (6 pin, female)
areutt 3101-0302 or 3101-3241 | Switch
1450-0641 LED (Vgz21V @Ilg=10mA)
8150-5680 Wire
Connecting GNDU 1250-2457 Triaxial Connector (female)
et 8121-1189 or 8150-2639 | Coaxia Cable or Wire
Connecting SMU to 1250-2457 Triaxial Connector (female)
PuT 8121-1191 Low Noise Coaxial Cable
ConnectingMFCMU | 1250-0118 BNC Connector (female)
toDUT
8120-0367 Coaxia Cable (50 Q)
8150-0447 Wire
Table 3-6 Dimensions of Connector Holes

Kelvin Triaxial Connector (in mm)

Triaxial Connector (in mm)

2113

/

S,

103

BNC Connector (in mm)

Interlock Connector (in mm)

as

L'el

»12.8

ol

—_

|18
7 ew

w
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A ToMakean Interlock Circuit

Theinterlock circuit is designed to prevent electrical shock when a user touches the
measurement terminals.

CAUTION You must install an interlock circuit on a shielding box to prevent hazardous
voltages when the door of the shielding box is open.

Figure 3-8 shows the pin assignments of the interlock connector that should be
mounted on a connector plate or test fixture.

Figure 3-8 Interlock Connector Pin Assignments
O O1 \
O O Interlock
5 O switch T
4 3 LED
Plug side view Wiring side view
WARNING Potentially hazar dous voltages may be present at the Force, Guard, and Sense

terminalswhen theinterlock terminals are shorted.
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Installing theinterlock circuit

Install the interlock circuit as follows:

1. Mount two mechanical switches on your shielding box, so that the switches
close when the door of the shielding box is closed, and open when the door is
opened. For the dimensions of the switch, see Figure 3-10 and Figure 3-11
below.

2. Mount an LED on your shielding box. For the dimensions of the LED, see
Figure 3-9.

3. Usewireto connect the two switches in series between pin number 1 and 2 (or
3) of the interlock connector. See Figure 3-8.

4. Usewireto connect the LED between pin number 4 and 5 (or 6) of the interlock
connector. See Figure 3-8.

If Agilent B1500A Interlock connector is connected to the interlock circuit, Agilent
B1500A SMU cannot force more than + 42 V when the door is open. When the door
isclosed, it can force morethan £ 42 V.

When more than + 42 V isforced from an SMU, the LED lightsto indicate high

voltage output.
Figure 3-9 Dimensions of the LED (Agilent part number 1450-0641)
@6
——
—— —

0l
Ll

\
@5 |
5.6

Units: mm

(~) spoyie) —ou_—_|
(+) apouy —
! G
[
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Figure 3-10 Dimensions of the Interlock Switch (Agilent part number 3101-0302)

2l | o]

6.35

8'¢C

‘9[17‘

H0 youms

uo Youms
TGl

\
e =
T ol

7) No S
com N/

27.8 10
Units: mm 37.8

eol
6°Gl
8'81

Figure 3-11 Dimensions of the Interlock Switch (Agilent part number 3101-3241)

10.2 4.3 | \ |

21.5 10.9

O
)
3.2
Switch off
Switch on I N
2.0 (
O}i:l
07

( J
\ 3.4

Units: mm 27.8 6.8

?3.1

1
\&
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To Connect GNDU Output

The GNDU output connection examples are shown in Table 3-7

GNDU Output Connections

Kelvin connections

non-K elvin connections

Use alow-noise coaxial cable (Agilent part number
8121-1189) from the connector to the prober,
socket, or DUT as shown.

To cancel the effects of cable resistance, connect the
Sense line and Force line as close as possible to the
terminal of the DUT.

Short the Sense and Force on the connector as
shown below. Measurement data will include the
residual resistance of the connection wire.

Use AWG 22 single-strand insulated wire
(Agilent part number 8150-2639) from the
connector plate to the prober, socket, or DUT.

For a quick connection where measurement
accuracy is not critical, connect only Forceto the
DUT, without shorting the Sense and Force. With
this connection, the measurement data will
include residua resistance from the connection
cable between the GNDU and the connector
plate.

Common
| _lForce
l Sense
l to
ﬁ—'fﬂ”
]
Ll [LI< Insulator \
< Plate Coaxial cable

Triaxial connector

Common

— |- l Force
l Sense

l to

J » DUT
elnsul\N

1 Wire
< Plate

Triaxial connector

CAUTION

Use Agilent 16493L GNDU cable to connect the GNDU to your connector plate or

test fixture. Do not use thetriaxial cable. The GNDU israted for up to 4.2 A, while
the maximum current rating of the triaxial cableis 1 A.
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Figure 3-12
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To Connect SMU Output

The SMU output connection examples are shown in Table 3-8.

Potentially hazardous voltages, up to + 100V (MPSMU/HRSMU) or + 200 V
(HPSMU), are present at the Force, Sense, and Guard terminals.

To prevent electrical shock, do not expose these lines.

Before turning Agilent B1500A on, connect the Interlock terminal to an
interlock circuit.

Before you touch any connectionsto these terminals, turn Agilent B1500A off,
disconnect the power cable, and dischar ge any capacitors.

Never connect the Guard terminal to any output, including circuit common, chassis
ground, or any other guard terminal. Doing so will damage the SMU.

Low-Noise Coaxial Cable

For the extended measurement paths over the connector plate, use low-noise coaxial
cable (Agilent part number 8121-1191). This cable can maximize the guard effects
and minimize the impression of the external noise.

Figure 3-12 shows the cutting example of this cable. Key point is the isolation
between the conductive layer and the center conductor. So, cut and trim the end of
the cable as shown in this figure by using a cutter and so on.

Coaxial Cable Cutting Example

Cover here using sleeve

Insulator (black)
l min 2 mm Center conductor
(for Force/Sense signal)

v,v,v,

3
oo
%%

v,v,

K
9%

(Loe%e!

2

X

K
KX
K

Outer conductor 4T

(for Guard signal)

approx. 10 to 15 mm

Insulator (clear)

Conductive layer (black)
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Table 3-8 SMU Output Connections

Kelvin connections

non-Kelvin connections

Use low-noise coaxia cable (Agilent part number
8121-1191) from the connector to the prober,
socket, or DUT as shown.

See Figure 3-13 and Figure 3-15 for the ASU and
SCUU connections respectively.

To cancel the effects of cable resistance, connect
the Sense line and Force line as close as possible to
the DUT terminal.

To prevent oscillations, do not use cables longer
than 1.5 m.

Use low-noise coaxial cable (Agilent part number
8121-1191). The following figureis for the
connection using Kelvin triaxial cable.

For the connection using triaxial cable, connect
the cable to the Force terminal only.

In this connection, measurement datawill include
residual resistance from the connection cable.

See Figure 3-14 and Figure 3-16 for the ASU and
SCUU connections respectively.

7

to

Yo

Triaxial Common Coaxial cable DUT Triaxia
connector connector
-—lGumd ]
l Sense
L| | J< Insulator 1
< Plate < Plate
NOTE To Minimize Leakage Current

For the highly accurate current forcing and measurements, surround all force and
sense lines by a guard as far as possible, and physically stable the cables with tape.
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Figure 3-13 ASU Output Kelvin Connection

Guard

CMH
or Force

<— Coaxial cable

to DUT 1 or
DUT 1 high terminal

ASU
#1

Sense

| O CMU Return

< Guard

% CMU Return

CML
or Force

to DUT 2 or
DUT 1 low terminal

ASU
#2

Common

Sense

L Guard

The ASU inputs can be connected to the instruments by using a control cable, a
triaxia cable, and two coaxial cables. The cables can be connected to the ASU
inside the shielding box through the 16495K plate.

The ASU outputs should be connected to the DUT by using coaxial cablesand wires
as shown above.

When a SMU is used for the measurements, the Kelvin paths will work as same as
Table 3-8.

When afour-terminal pair (4TP) instrument is used, the sense lines can be ignored.
And aKelvin path is used for the high signal, and the other oneis used for the low
signal. For the accurate impedance measurements, awire must be connected
between the ASU#1 CMU Return and the ASU#2 CMU Return.

If the 4TPinstrument is not used, you can ignore the CMH, CML, CMU Return, and
the DUT1 high and low terminals.
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ASU Output non-Kelvin Connection

Guard

CMH

or Force <—Coaxial cable

ASU
#1
to DUT 1 or

Sense DUT 1 high terminal

| O CMU Return

< Guard

~o CMU Return

to DUT 2 or
DUT 1 low terminal

CML
or Force

ASU
#2

Sense

Guard

The ASU inputs can be connected to the instruments by using a control cable, a
triaxial cable, and two coaxial cables. The cables can be connected to the ASU
inside the shielding box through the 16495K plate.

The ASU outputs should be connected to the DUT by using coaxial cablesand wires
as shown above.

When a SMU is used for the measurements, the Kelvin paths/force lines will work
as same as Table 3-8. Then the sense lineis not extended to the DUT.

When afour-terminal pair (4TP) instrument is used, the sense lines can be ignored.
And aforcelineisused for the high signal, and the other one is used for the low
signal. For the accurate impedance measurements, awire must be connected
between the ASU#1 CMU Return and the ASU#2 CMU Return.

If the 4TPinstrument is not used, you can ignorethe CMH, CML, CMU Return, and
the DUT1 high and low terminals shown above.
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SCUU Output Kelvin Connection

A+ Guard
l Force 1 or CMH to GSWU

|

Common to DUT 1 or

11 | Guard DUT 1 high terminal

l Sense 1

Insulator ———>

Plate ——

Guard
l Force 2 or CML to GSWU

to DUT 2 or
DUT 1 low terminal

<— Coaxial cable

/

Triaxial connector ||

The SCUU should be connected to the DUT by using coaxial cables and wires as
shown above. Also the SCUU should be connected to the GSWU inside the
shielding box by using a control cable through the 16495K plate.

When a SMU is used for the measurements, the Kelvin paths will work as same as
Table 3-8.

When the MFCMU is used, the sense lines can be ignored. And aKelvin path is
used for the CMU high, and the other one is used for the CMU low. For the accurate
impedance measurements, wires must be connected to the GSWU from the CMH
guard and the CML guard as near as possible to the DUT.
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Installation
Mounting Connectors

SCUU Output non-K elvin Connection

+ 1 Guard
l Force 1 or CMH to GSWU

Common to DUT 1 or
DUT 1 high terminal

to GSWU

Insulator —> Sense 1

Plate ——

4+ Guard
l Force 2 or CML

to DUT 2 or
DUT 1 low terminal

<—Coaxial cable

/

Triaxial connector

The SCUU should be connected to the DUT by using coaxial cables and wires as
shown above. Also the SCUU should be connected to the GSWU inside the
shielding box by using a control cable through the 16495K plate.

When aSMU is used for the measurements, the Kelvin paths/force lines will work
as same as Table 3-8. Then the sense lineis not extended to the DUT.

When the MFCMU is used, the sense lines can be ignored. And aforcelineis used
for the CMU high signal, and the other one is used for the CMU low signal. For the
accurate impedance measurements, wires must be connected to the GSWU from the
CMH guard and the CML guard as near as possible to the DUT.
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Installation
Mounting Connectors

To Connect MFCMU Output

The MFCMU output connection exampleis shown in Figure 3-17. This connection
isfor the MFCMU without the SCUU. Then Agilent N1300A-001/002 CMU cable
should be used for the connection between the MFCMU and the connectors you
mount. It is ok to leave open the ground wire extended from the CMU cable.

MFCMU Output Connection

— t0 DUT 1
high terminal
Insulator —>
Plate ————>]
> to DUT 1
low terminal

/

BNC connector Coaxial cable

The Heur/Hpot/L cur/L pot lines should be connected to the DUT as shown above.

Use a50 Q coaxial cable (Agilent part number: 8120-0367) for the
Hcur/Hpot/L cur/Lpot lines connection. Use awire for the guard connection.
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Connecting M easurement Devices

This section describes how to connect device under test (DUT) to the 16442B test
fixture, and how to connect cables to the connector plate.

If you use awafer prober, see wafer prober manuals.

Note that you must set the module output off when connecting or disconnecting
DUTs. If not, the DUTs may be damaged.

To set the module output off, press the Stop key.

This section has the following descriptions:

e “Using Test Fixture”

» “Using Connector Plate”

Kelvin connection and non-K elvin connection

To make the Kelvin connection, use both Force and Sense terminal's. Connecting the
Force and Sense lines together at the terminal of the DUT (device under test)
minimizes the measurement error caused by the residual resistance of the
connection cables. The Kelvin connection is effective for the low resistance
measurement and the high current measurement.

If you want to simplify the cable connections, open the Sense terminals and use the
Force terminals only. Thisisthe non-Kelvin connection. The Force terminals can be
used to force and measure dc voltage or current.
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Using Test Fixture

1. Pressthe stop key to set the module output off.

2. Select a proper socket module for your DUT, then set the socket module on the
test fixture.

Mount your DUT on the socket module.

4. Connect between the socket module and the test fixture by using the proper test
leads.

5. Closethelid of the test fixture.

To force more than + 42 V, close the lid of the test fixture. Otherwise, the
interlock function will stop Agilent B1500A output.

To connect between the socket module and the test fixture, you can use test leads
that have the following terminals:

* Miniature banana-to-miniature banana
* Miniature banana-to-pin plug

* Miniature banana-to-miniature clip

Do not connect or disconnect your DUT while Agilent B1500A isforcing voltage or
current. Otherwise, your DUT may be damaged.

Do not touch the terminals of the test leads. Oil, perspiration, and dirt prevent good
electrical contact, deteriorate insulation, and degrade measurement accuracy.
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Connections for High Current Measurements

When you force or measure a large current, you may want to use aKelvin (4-wire)
connection to eliminate the residual resistance effects of test leads and contacts. For
example, you can use the following connections as Kelvin connections on the test

fixture.

Examples: Kelvin Connection

Force

Guard

)

Sense

Guard

)

| SMU(+200V 1A Max) |

Force Sense
Guard Guard

Force

Guard

3 (Selected)

Sense
Guard

To cancel the effects of the residual resistance, test |eads must be connected as close

as possible to the DUT.

Drain

Gate [ Substrate

Source
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Using Connector Plate

This section provides the information useful for connecting cables and probing
needles to a connector plate.

* “To Reduce Leakage Current”

e “To Measure Low Resistance”

To Reduce Leakage Current

To reduce the leakage current caused by connection cables, the guard technique is
effective. Connect the probing needles to the terminals of the connector plate by
using coaxial cables as shown below:

1. At end of cable, connect coaxial center conductor to force terminal of connector
plate, and connect coaxia outer conductor to guard terminal of connector plate.

2. At another end, connect coaxial center conductor to tail of the probing needle.
Never connect the outer conductor at this cable end.

Extend the outer conductor as close as possible to the probing needle.

Example

The following example connection can be used to reduce the leakage current.
Extend the outer conductor as close as possible to the probing needle. Thisalso
reduces the induced noise.

Outer conductor

Center conductor

. Probing needle
Coaxial cable

Connector plate

A~
Contact pad—\;

Do not touch theguard terminal with bare hands because you may be shocked
by high voltage. The potential of the guard terminal is equal to the output
voltage.

Never connect the guard terminal to any other output, including circuit common,
frame ground, or the terminals of any other unit. Doing so may damage the unit.
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Guarding

Guarding reduces the leakage current between the measurement points and
instrument. This isimportant when you measure low current.

The following figure shows the theory of guarding. The buffer amplifier (x1) keeps
the potential of the guard conductor at the same potential as the force conductor, so
current does not flow between the force and guard conductors. Therefore, the
current measured by SMU is same as current at measurement point because no
current is leaked.

A

é} Guard Force DuT

Buffer

3-44 Agilent B1500 User’s Guide, Edition 7



Installation
Connecting Measurement Devices

To Measure Low Resistance

When you measure alow resistance, high current flows through the DUT. This high
current increases the measurement error caused by the residual resistance of cables.
To cancel the effect of thisresistance, you can use Kelvin connections (4-wire),
which means the force and sense lines are extended separately to the DUT.

Connect the probing needles to the terminals of the connector plate by using test
leads or coaxial cables. Following instruction uses the coaxial cables:

1. At end of cable, connect coaxial center conductor to force terminal of connector
plate, and connect coaxia outer conductor to guard terminal of connector plate.

2. At another end, connect coaxial center conductor to tail of the probing needle.
Never connect the outer conductor at this cable end.

Extend the outer conductor as close as possible to the probing needle.
Repeat 1 and 2 for the sense terminal of connector plate.

4. Contact the probing needles from force and sense terminals as close as possible
to the DUT.

Example

The following example connection can be used to measure low resistance. The sense
lineis extended to the probing pad, and contacts the force line through the pad, so
the voltage drop due to the residua resistance caused by cables and test leadsis
canceled.

Probing needle

Contact pad

Connector plate

Contact pad

This example uses test leads. To reduce the leakage current, use coaxial cables.
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Kelvin Connection

Kelvin connections give good measurement results when you force high-current.
The following figure shows the equivalent circuits for Kelvin and non-Kelvin
connections.

» For the non-Kelvin connection, the voltmeter measures the voltage drop of
resistancesr gy, Rpyt, and r po.

» For the Kelvin connection, the voltmeter measures the voltage drop of resistance
RpuT only. The impedance of the voltmeter is very high, so the voltage drop of
resistancesr g; and r g, can be ignored.

Rout Rout
r r
F1 F2 r
% "H fs1 s2 F2
(a) non-Kelvin connection (b) Kelvin connection

The Kelvin connection is effective even when forcing voltage. The voltage drop due
to the residual resistance of the forcelinewiring isfed back to the voltage sourcevia
a comparator in the sense line. The input impedance of comparator is high, and
current flow into the sense line is very low. So output error is not significant if the
sense line wiring has aresidual resistance of 10 Q or less. Therefore, the specified
voltage appears at the sense point (point where sense line contacts force line)
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Capacitance Compensation When Using
Switching Matrix

When the capacitance/conductance measurement is performed through Agilent
B2200A/B2201A/E5250A switching matrix, Agilent B1500A measures the
capacitance/ conductance of the path including a DUT (device under test), matrix
switches, extension cables and so on. So, the data measured by the B1500A isfar
from the DUT’s capacitance/conductance.

Agilent EasyEXPERT provides the functions used to compensate the data measured
in the environments described in “Required Conditions’ on page 3-48. This section
explains how to perform compensation.

*  “Required Conditions”

* “To Create Compensation Data File’

Corrected data by the function is not guaranteed. But typical data (supplemental
data) is as follows.

Capacitance measurement accuracy (typical): £1 % +0.5 pF

Thistypical dataisfor the following measurement conditions:

Measurement frequency: 1kHzto5MHz

M easurement range: Maximum 1000 pF

Measurement terminal: At the end of Agilent 16494A/B/C cable connected to
the switch module output terminals.

The typical data does not apply to anything extended from the 16494A/B/C cable.
The conditions described in “ Required Conditions” on page 3-48 must be satisfied.
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Required Conditions

The following conditions must be satisfied to use the capacitance compensation
function. For the instrument connections, see Figure 3-18.

Setting of the MFCMU

« Range of the measurement frequency: 1 kHzto 5 MHz

* Measurement function: Cp-G, Cp-D, Cs-Rs, or Z-Th. Thereis no limitation.
e Cadlibration

Perform the MFCMU open calibration at the end of the measurement paths
in front of the switching matrix inputs. If you also perform the short
calibration (optional), prepare the BNC thru adapter (Agilent part number
1250-0080, 1 ea.).

« Total cable length of both Hc-Hp side and Lc-Lp side must be the same.
Switching matrix input ports

Use Agilent N1300A CMU cableto connect the MFCMU. The BNC-T adapters
(2 ea., Agilent part number 1250-2405 for each) are required to connect between
the Hc and Hp terminals and between the Lc and L p terminals. Connect the
Hc-Hp cable and the Lc-Lp cable asfollows. It is ok to leave open the ground
wire extended from the CMU cable.

Hc-Hp: Input 13 (B2200A/B2201A) or AUX INPUT CV1 (E5250A)
Lc-Lp: Input 14 (B2200A/B2201A) or AUX INPUT CV2 (E5250A)
Switching matrix output terminals

Use the Agilent 16494A triaxial cable to extend the outputs to the connector
plate or the Agilent B2220A probe card interface (only for B2200A/B2201A).
For the Kelvin connection, use the Agilent 16494B/C Kelvin triaxial cable.

Ahead of the connector plate
Recommended cable: Agilent part number 8121-1191 Triaxial cable

You can also use another type of triaxial cable, coaxia cable, or combination of
these.

To approximate the capacitance/conductance of the DUT, you need to obtain the
appropriate compensation coefficients for your measurement environment, and
create your compensation datafile. See Figure 3-18.
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In Figure 3-18, C1 (DATA04), C2H (DATAO05), C2L (DATAO06), C3H (DATAOQ7),
C3L (DATAOB) are the compensation coefficients defined in the compensation data
file. where, CxH isfor the path connected to the MFCMU Hc-Hp terminal, and CxL
isfor the path connected to the MFCMU Lc-Lp terminal.

When Agilent B2220A probe card interface is used, obtain the coefficients for C3x,
and create your compensation datafile. In this case, probe card will be used for the
C3x path.

When the connector plate is used, obtain the coefficients for C2x and C3x, and
create your compensation datafile. In this case, triaxial cable with connector plate
will be used for the C2x path. And coaxial cable with positioner will be used for the
C3x path.

For abtaining the compensati on coefficients and creating the compensation datafile,
see “To Create Compensation Data File” on page 3-50.

Figure 3-18 Extension Cablesand Compensation Coefficients

Agilent B1500A/MFCMU Perform open calibration at this plane.
Short calibration is optional.

Agilent N1300A C2H, C3H, DATAO05, DATAOQ7: for CMH path
+ BNC-T adapters C2L, C3L, DATA06, DATAO08: for CML path
Low High

Agilent B2220A (C2H, DATAO5, need update)
(C2L, DATAO06, need update)

to CMLl/ l/to CMH

[Case 1. Probe card interface | ="
Case 1 is not available
I,:,:l 5 Agilent 16494A/C — for E5250A.
(C1. DATADA, fixed) <=—=—> Probe card etc.

(C3H, DATAO7, need update)
(C3L, DATAOQS, need update)

Slel_lel o o o D [Case 2. Connector plate |
ol|lof{lo]|o]] |0 © o ooooooo—.—l\
Agilent 16494A/B 0009999
Agilent B2200A with B2210A or gilen _ -
Agilent B2201A with B2211A or (C1, DATAQ4, fixed) | Agilent 18495F/G | b et conial
Agilent E5250A with E5252A l> Extended triaxial cables and positioners
B2210A outputs or cables (C3H, DATAO7, need update)
B2211A outputs or with connector plate  (C3L, DATA08, need update)
E5252A outputs (C2H, DATAO5, need update)

(C2L, DATAOQG, need update)
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To Create Compensation Data File

This section explains how to create the compensation data file. To perform the
capacitance compensation, enter the file name of the compensation datafile to the
User Compensation Data File field of the “Extended Configuration” on page 4-46.

1. Createatextfile(e.g. C:\temp\c_data.txt) that contains the information as shown

below.

* For B2200A/B2201A:

MB
MH
ML
Cl
C2H
C2L
C3H
C3L

B e I S

ES

Compensation data

Mother Board
Matrix Path High
Matrix Path Low
Agilent Triax Cable
I/F or User Triax cable High
I/F or User Triax cable Low
or User Coax cable High

or User Coax cable Low

Probe card
Probe card
Probe card
Probe card

format version 1.0

B2210A
CABLE

Cl

C2H
C2L
C3H
C3L

The 15th line specifies the used switch module, B2210A or B2211A.

The 16th line specifies the DUT interface, PCIF or CABLE. PCIF indicates
that Agilent B2220A probe card interfaceis used. CABLE indicates that the

RN N O

.000000e+00
.430000e+00
.490000e+00
.300000e-01
.007000e-01
.007000e-01
.140000e-01
.140000e-01

connector plate is used.

The lines C2H to C3L should be modified for each measurement

gOs s 0oy 3

.250000e-08
.310000e-07
.970000e-07
.250000e-06
.000000e-07
.000000e-07
.440000e-07
.440000e-07

[ e R S

file for B2210A/Cable connection/3m triax cable

.940000e-11
.930000e-10
.920000e-10
.600000e-10
.000000e-11
.000000e-11
.300000e-10
.300000e-10

environment. See Table 3-9. Do not modify the other lines.

EasyEXPERT provides the template of the compensation datafile for the
B2200A/B2201A. See Table 3-11. Select and use the template suitable for your

measurement environment.
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e For E5250A:

E5250A

REVISION
#
DATAQOO
DATAOL
DATAQ02
DATAO3
DATAO4
DATAQOS
DATAO6
DATAQ7
DATAO8
DATAO9

#
#
# CAUTION :
#
#

C Compensation coefficient data table

Do not add or delete "REVISION" line and "DATAxx" line.
Change the value for R,L,C of DATA05,06,07 or 08.

A.03.00

R [ohm] L [H] C [F]

74.65E-3 140.00E-9 58.44E-12 Frame Path 1
75.41E-3 90.00E-9 67.13E-12 Frame Path 2

231.41E-3 450.00E-9 178.85E-12
177.56E-3 390.00E-9 135.45E-12
100.70E-3 400.00E-9 80.00E-12
100.70E-3 400.00E-9 80.00E-12
100.70E-3 400.00E-9 80.00E-12
114.00E-3 544.00E-9 130.00E-12
114.00E-3 544 .00E-9 130.00E-12
0.00E-3 0.00E-9 1.20E-12

Card Path High

Card Path Low

Triax Cable [/m]
User Triax Cbl H [/m]
User Triax Cbl L [/m]
User Coax Cbl H [/m]
User Coax Cbl L [/m]
Stray Capacitance

He o H H H HE HE HE A HE

# END of Data

The lines DATAQ5 to DATAQ08 should be modified for each measurement
environment. See Table 3-9. Do not modify the other lines.

Table 3-9 Compensation Coefficientsand M odifications

Compensation
coefficients

Modifications of data file

C2H
(DATAOS)

caL
(DATAO6)

For the connector plate, changethe R, L, C valuesin thelines.
The value must be changed to the R, L, C values of the

C2H (DATAO05) path and the C2L (DATAO06) path (triaxial
cable with connector plate) shown in Figure 3-18.

For Agilent B2220A probe card interface, do not modify the
lines.

C3H
(DATAO7)

c3L
(DATAO08)

ChangetheR, L, C valuesin the lines. The value must be
changed tothe R, L, C values of the C3H (DATAQ7) path and
the C3L (DATAO08) path shown in Figure 3-18.

For the connector plate, the coaxial cable with positioner will
be the appropriate path.

For Agilent B2220A probe card interface, the probe card will
be the appropriate path.
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2. MeasuretheR, L, C values of the for C2H (DATAO05), C2L (DATAQ6),
C3H (DATAQ7), and C3L (DATAO08) by using the MFCMU. See “To obtain
compensation coefficients” on page 3-53.

After the measurements, calculate the per meter value of the R, L, C, and record
them into the following table.

Compensation Explanation

coefficients

R (Q) L (H) C(F)

C2H
(DATAO05)

caL
(DATAO6)

C3H
(DATAO7)

C3L
(DATAO08)

3. Launch atext editor and open the compensation datafile created at step 1.

ChangetheR, L, C values of the C2H (DATAQ05), C2L (DATAQ6),
C3H (DATAOQ7), and C3L (DATAO08) lines to the values recorded at step 2.
Do not change any other lines.

4. Savethefile asyour compensation datafile (e.g. C:\temp\my_env_1.txt).

To perform the capacitance compensation, enter the file name of the
compensation datafile to the User Compensation Data File field of the
“Extended Configuration” on page 4-46, and execute the measurement.

Before starting measurement, perform the CMU calibration. See “CMU
Calibration” on page 4-37. Also see “C-V Sweep Measurement” on page 7-19.
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To obtain compensation coefficients

Obtain the compensation coefficients as shown bel ow.

1. Select the measurement frequency (Fmeas) used for the capacitance
measurement of a device under test (DUT), and set it to the MFCMU. The
coefficients must be measured at the same frequency.

2. Perform the MFCMU open calibration at the measurement terminal. Optionally,
perform short calibration if you want.

3. SeeTable 3-10 and Figure 3-19, and set the MFCMU.

4. Connect the path/cable corresponding to C3H (DATAQ7) shown in Figure 3-18
to the MFCMU. Then measure and record the R, L, and C values.

5. Connect the path/cable corresponding to C3L (DATAO08) to the MFCMU. Then
measure and record the R, L, and C values.

6. If you use the connector plate, perform the following procedure.

a. Connect the path/cable corresponding to C2H (DATAQ5) to the MFCMU.
Then measure and record the R, L, and C values.

b. Connect the path/cable corresponding to C2L (DATAO06) to the MFCMU.
Then measure and record the R, L, and C values.

R, L, C Measurement Conditions

Par ameter Frequency Function Terminals
R 1kHzto 5 MHz 2 - AandB
C PARALLEL AandC

a. R, L, Cof al coefficients must be measured with the same frequency setting.

b. For triaxial cable, connect B to F directly, and measure L between A and E.
For coaxial cable, ignore E and F, and connect B to D directly, and measure
L between A and C.

Compensation Coefficient M easurement Terminals of Extended Cables

GUARD (C) GROUND (E) GROUND (F) GUARD (D)
) Insulator
/‘ Triaxial Cable
FORCE or SENSE (A) FORCE or SENSE (B)
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Table 3-11 Template Compensation Data Files for B2200A/B2201A
M easurement environment that template tar gets
Filename? Switch DUT Coefficientsto
module Cable’ | | ortace | bemodified
<path>\b2210a\pcif\triax\3m.data B2210A 16494A-002 B2220A C3H and C3L
<path>\b2210a\pcifitriax\4m.data 16494A-005
<path>\b2210a\pcif\kelvin\3m.data 16494C-002
<path>\b2210a\pcif\kelvin\dm.data 16494C-005
<path>\b2210a\cable\triax\1_5m.data 16494A-001 | 16495F/G | C2H, C2L,
<path>\b2210a\cable\triax\3m.data 16494A-002 C3H, and C3L
<path>\b2210a\cable\triax\4m.data 16494A-005
<path>\b2210a\cable\kelvin\1_5m.data 16494B-001
<path>\b2210a\cable\kelvin\3m.data 16494B-002
<path>\b2210a\cable\kelvin\dm.data 16494C-005
<path>\b2211a\pcif\triax\3m.data B2211A 16494A-002 B2220A C3H and C3L
<path>\b2211a\pcif\triax\4m.data 16494A-005
<path>\b2211a\pcif\kelvin\3m.data 16494C-002
<path>\b2211a\pcif\kelvin\4m.data 16494C-005
<path>\b2211a\cable\triax\1_5m.data 16494A-001 | 16495F/G | C2H, C2L,
<path>\b2211a\cable\triax\3m.data 16494A-002 C3H, and C3L
<path>\b2211a\cable\triax\dm.data 16494A-005
<path>\b2211a\cable\kelvin\1_5m.data 16494B-001
<path>\b2211a\cable\kel vin\3m.data 16494B-002
<path>\b2211a\cable\kel vin\dm.data 16494C-005

a. <path>: \Program Files\Agilent\B1500\EasyEX PERT\B220xA \ccdata
b. Model number of the cable connected between the switch module and the DUT interface.
c. Agilent B2220A probe card interface or Agilent 16495F/G connector plate.
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M aintenance

Maintenance should be performed periodically to keep Agilent B1500A in good
condition.

Cleaning

Before performing cleaning, turn off the instrument, and disconnect power cable
from the rear panel. Use a dry cloth to clean the external case parts.

To prevent electrical shock, do not perform cleaning when the instrument is turned
on, and do not use awet cloth.

Self-test and Diagnostics

Agilent B1500A provides the following functions to check the operation. Perform
the following functions as necessary. Open the measurement terminals to perform
self-test, self-calibration, or diagnostics.

o Sdf-test
Refer to “Modules’ of “Configuration” on page 4-41.
» Self-calibration
Refer to “ Calibration” on page 4-35.
» Diagnostics
Refer to “Main Frame” of “Configuration” on page 4-41.

If problems arise, contact Agilent Technologies. Also see “Before Shipping to
Service Center” on page 9-12.

Calibration

Calibration and adjustments must be performed periodically so that the instruments
satisfy the specifications, and keep a good condition. It is recommended to perform
the calibration once ayear at least. For the calibration and adjustments, contact
Agilent Technologies. Trained service personnel will perform the calibration and
adjustments. Also see “Before Shipping to Service Center” on page 9-12.
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About Plug-in Modules

Agilent Technologies is responsible for the module installation of Agilent B1500A.
Contact Agilent Technologies for the modul e installation. Then send the following
equipment and accessories to Agilent Technologies.

» B1500A
» Plug-in modulesto beinstalled
* ASU, for installing the exclusive HRSMU or retrofitting ASU only

» Connection cable between ASU and HRSMU, for installing the exclusive
HRSMU or retrofitting ASU only

* RSU, forinstalling WGFMU
» Connection cable between RSU and WGFMU, for installing WGFMU

For returning ASU or RSU, do not forget to notify the combination of the unit,
connection cable, and module channel.

To prevent electrical shock, turn off Agilent B1500A and remove the power
cable before removing the connection cables.

About B1500A which supports SPGU and WGFMU

SPGU and WGFMU are supported by the B1500A serial numbered JPA0Nxxxxx and
later. The other B1500A needs the mainframe upgrade to support the module.
Contact Agilent Technol ogies to upgrade the B1500A.

Module locations after servicing

After the moduleinstallation, upgrade, and so on, the B1500A will be returned with
the module configuration decided by the rule shown in Table 3-12. If you want to
change the module locations, consult the service personnel before servicing.
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Table 3-12

Installation
About Plug-in Modules

Module Type and L ocations

Module locations when the B1500A is shipped from the factory are shown in Table
3-12. Thistable shows the relative locations by the modul e types.

If the SPGUs are installed, the SPGUs must be installed in the slots from the slot
number 1. And if the SPGU and the WGFMU are not installed and the HPSMUs are
installed, the HPSMUs must be installed in the slots from the slot number 1. Then
the same type of modules must be installed in the contiguous slots.

For example, if the module configuration istwo HPSMU, two MPSMU, and one
CMU, the B1500A will be shipped with the HPSMUSs of the slots 1 to 4, the
MPSMUs of thedots 5 to 6, the CMU of the slot 7, and the blank panels of the dots
8to 10.

Module Installation Rule

Slot Number and L ocation Module Type

10 top B1520A Multi Frequency CMU

B1511A Medium Power SMU

B1517A High Resolution SMU

B1510A High Power SMU

_ _ B1530A WGFMU
1 : B1525A High Voltage SPGU
0 bottom GNDU/ADC (adways installed)
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Using EasyEXPERT

This chapter provides the reference information of Agilent EasyEXPERT software
that isthe graphical user interface of Agilent B1500A.

e “Start EasyEXPERT”

»  “Workspace Configurator”

» “Main Screen”

» “Application Test”

e “Quick Test”

*  “Repeat Measurement Setup”
*  “Organize Preset Group”

o “Cadlibration”

» “Configuration”

» “Switching Matrix Operation Panel”
» “Standby Channel Definition”
» “DataDisplay”

* “Preview”

» “Text File Export settings’
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NOTE

Using EasyEXPERT

To start EasyEXPERT, see “ Start EasyEXPERT” on page 4-4 and “Workspace
Configurator” on page 4-5.

To perform application test setup, see “Application Test” on page 4-27.
To perform classic test setup, see “ Classic Test Definition” on page 5-1.
To perform quick test setup, see “ Quick Test” on page 4-29.
To perform measurement, see “Main Screen” on page 4-10.

To display measurement data and perform dataanalysis, see“ Data Display” on page
4-51.

To perform self-test or diagnostics, see “Configuration” on page 4-41.
To perform self-calibration, see “ Calibration” on page 4-35.

To control Agilent B2200A/B2201A/E5250A switching matrix connection, see
“Switching Matrix Operation Panel” on page 4-48.

To set the standby channels and the standby mode, see “ Standby Channel
Definition” on page 4-50.

To define your application test, see “ Application Test Definition” on page 6-1.

Touch Screen Operation

If you use touch screen operation than mouse, change the font size of menu. Font
size 14 is recommended for the touch screen operation.

Open the Control Panel, select Appearance and Themes, and select Display to open
the Display Properties dialog box. Select the Appearance tab, and click the
Advanced button to open the Advanced A ppearance dialog box. On the dialog box,
set Item to Menu, and set the Sze of Font to 14.
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Start EasyEXPERT
File menu

Option menu

Using EasyEXPERT
Start EasyEXPERT

Sart EasyEXPERT

The Start EasyEXPERT window is displayed by selecting the Start EasyEXPERT
icon on Windows desktop or Start EasyEXPERT in the Start menu. This window
provides the following graphical user interface.

€ 815004 =JoEd

File Option

Start EasyEXPERT

This button launches EasyEX PERT.
Exit closes the Start EasyEXPERT window.

EasyEXPERT Database provides the following two functions.

» Backup EasyEXPERT Database

Opens the EasyEXPERT Database Backup Creation Wizard used to make
backup of the EasyEXPERT database. You can make backup easily by following
the wizard. Required time depends on the database size.

* Restore EasyEXPERT Database

Opens the EasyEXPERT Database Restoration Wizard used to restore the
EasyEXPERT database backup. You can restore the backup easily by following
the wizard. Required time depends on the database size.

EasyEXPERT Database is the folder used to store your test setup data and such.
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Using EasyEXPERT
Workspace Configurator

Wor kspace Configurator

Workspace means the space created in Agilent B1500A’s internal hard disk drive,
and is used to store the test setup, test result data, and so on. The workspace can be
created and allocated for each user.

The workspace configurator will run after you launch Agilent EasyEXPERT. The
workspace configurator displays a screen used to select the workspace you use.
There are three types of display, depending on the number of existing Workspace.

» “If thereis no workspace”
» “If thereis one workspace”

» “If there are Workspace more than two”

If thereisno workspace

EasyEXPERT will automatically create aworkspace and display the EasyEXPERT
main screen.

File Dk Display  Help
E Category - |\
s [Cem B =
E [ CMOS 0 T
= [ Discrete Run Option
2 | Exercise b <=1 Choose test categories from the left area, Baine '”__1[
= |0 GeneicTest ik
&1 Memary Device ID:
-g [ Mixedsignal ¥
= — = My Favorite Setup~
E - Exercise -
3| B 7 -
3 ng_ld_\/d =l choose an application test object from the left area. > L]
= Yih 1d-wd
Al 5 = =
i :
Charge n
Pumping 4T ihigmiar
£ -
Dermo-S-N... e
Endurance 1w
dal B « E—
=]
0 = | il
Trng i}
5 Trng Id-vd
Cogg =
Ll A ———
T I8 s
Trng
» E| |
A~ |F\ag |Setup MName | Date |Coumt |Device () |Remark5 |
»
)
£ =
i
=
Initial Workspace Wulti Display OFF [ ] Standby OFF 0] ShU Zero OFF [, Auto Export OFF [ %] Auto Recard ON
—_ s - =D =
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Workspace Configurator

If thereisoneworkspace

You will see amessage asking you if you want to create aworkspace or not. Select
one of the following radio buttons.

File Help

You have used this instrument previously. Do you want to
continue working on the previous setups and data ?

« Yes, I want to continue working on the previous setups
and data.

' No, I want to start a new session.

Note: Even if you start a new session, you can still
access setups and data from previous sessions.

* Yes, | want to continue working on the previous setups and data.

This button must be selected if you do not want to create a new workspace, and
want to use the workspace previously used.

The OK button will work to open the EasyEXPERT main screen.
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Using EasyEXPERT
Workspace Configurator

* No, | want to start a new session.

This button must be selected if you want to create a new workspace, and want to
useit instead of the workspace previously used. If you select No, the label of the
OK button will change to Next.

The Next button will work to display the following entry fields used to set the
workspace name.

e Entry field for the name of the new workspace

« Entry field for the new name of the existing workspace
Thisfield is available only for the owner of the existing workspace.

Check the Allow other users to access this workspace box to create a public
workspace that is opened for all users.

The OK button creates and/or renames the workspace, and opens the
EasyEXPERT main screen.

The Prev button cancel s the workspace creation and returns the screen message
to the previous one.

Fie Help

Agilent EasyEXPERT software manages setups and data in
enclosures known as "Workspaces.” Since you want to
start a new session, you should create a new Workspace
with a distinctive name. Please specify a name for the new
Workspace:

[untited =

I Allow other users to access this Workspace.

You can also rename a previously defined Workspace:

=

I¥ Allow other users to access this Workspace.

«r
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If there are Workspace more than two
You will see the message as shown in the following example.

File Help

B1500A Semiconductor Device Analyzer with EasyEXPERT Software

Please choose the target Workspace below.

A Workspace is an enclosure of data and application tests. Tt includes test setups, test
results, graphical plots, and user-customized application tests. You have three options when
starting a session in EasyEXPERT:
1. Create a new Workspace from scratch.
2. Open and use an existing Workspace that you previously created. Continue 5%
3. Open and use a public Workspace that has been previously published.

Target Workspace |

¢ Create a new Workspace

Workspace Name: | =
I” Allow other users to access this Workspace.

Open an existing Workspace

" Your Workspaces:
Name Scope
analyzerl Private

Public Workspaces owned by other users:

E

Name Owner
Demo Workspace English
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Workspace Configurator

» Create a new Workspace

This button must be selected if you want to create a new workspace. Enter the
name of the new workspace in the Workspace Name field.

Check the Allow other users to access this workspace box to create a public
workspace that is opened for all users.

* Open an existing Workspace
e Your Workspace

This button must be selected if you want to open your workspace. Select the
name to specify the workspace to open.

» Name: Workspace name
» Scope: Private (only for owner) or Public (for all users)

The Manage Workspaces button opens Workspace Manager that allows you
to delete, rename, or make a copy of the specified workspace. Select the
workspace name and click a button.

» Delete: Deletes the selected workspace.
» Rename: Renames the selected workspace.
» Duplicate: Makes a copy of the selected workspace.
» Public: Changes the scope of the selected workspace to Public.
» Close: Closes the Workspace Manager.
» Public Workspace owned by other users

This button must be selected if you want to open a public workspace created
by another user. Select the name to specify the workspace to open.

» Name: Workspace name
e Owner: Owner of the workspace
» Continue

This button displays the main screen with the specified workspace.

Agilent B1500 User’s Guide, Edition 7 4-9



Using EasyEXPERT
Main Screen

Main Screen

The EasyEXPERT main screen will be displayed after the workspace is specified or
created by the workspace configurator. The main screen provides several tools and
functions described in this section.

e “Main Screen GUI”

“Run Option”

» “DataDisplay Manager”
» “DataDisplay Properties’
* “Test Result Editor”

* “Test Results Data Filter”

*  “Exportin My Format”

* “Test Results Data Folder Export”
* “Test Results Data Auto Export”

“Test Results Data Properties’

File DataDisplay  Help

Category  ~
] BIT -
] cMos

[ Discrete

¥ Exercse T Choose test categories from the left area,

[ GenericTest Count: |0 ]

O Memory Device ID:
] MixedSignal =]

Library My Favorite Setup-

CBE

Trng Ievd
wih

Exercise -

| uick Test | classic Tﬁtl Application Test

¥
s

=1 Choose an application test object from the left area.

e
FltF
Charge
Purping 4T

Q

Dema-S-N...
Endurance
Al
- 1]
A
Trng
Cggvg
Al

Save

A

o
Trng d-vd

Recall

[T | biral
Trng
L

|Flag |SetuD MName |Date |Coumt |Device D |Remarks |

bl )]

Results

Initial Workspace [ ki Display OFF  [[b] Standby OFF 0] SMU Zero OFF 5] Auto Export OFF | ] Adta Record O
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File menu

Data Display menu

Help menu

Application Test

Classic Test

Quick Test

Using EasyEXPERT

Main Screen

Main Screen GUI

Provides the following four functions.

Import Test Setup... Opens adialog box used to specify atest setup to
import.

Export Test Setup... Opens adialog box used to specify adestination
file for exporting the present test setup.

Close Workspace Closesthe work space and returns to the workspace
configurator.

Exit Exits the EasyEXPERT software.

Provides the following three functions.

Show Data Display Opens “Data Display (page 4-51)" used to display
the test result data.

Manage Data Display... Opens“ Data Display Manager (page 4-19)” used to
control the appearances of the Data Display
windows.

Default Data Display

Properties... Opens “Data Display Properties (page 4-20)" used
to set the default setting of the Data Display
window.

Provides the following three functions.

About ThislInstrument... Opens the Configuration window.

About ThisTest... Opens the test description dialog box.

Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.

This tab selects the application test mode of EasyEXPERT. For details of the
graphical user interfacein this mode, see “ Application Test” on page 4-27.

Thistab selects the classic test mode of the EasyEXPERT. For details of the
graphical user interfacein this mode, see “ Classic Test Definition” on page 5-1.

Thistab selects the quick test mode of the EasyEXPERT. For details of the graphical
user interface in this mode, see “Quick Test” on page 4-29.
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Data Display

Calibration

Configuratio

EYN

Switching Matrix

Standby

Repeat

Run Option

Save Data

=

Using EasyEXPERT
Main Screen

Opens “Data Display (page 4-51)” used to display the test result data. EasyEXPERT
always handles the test setup corresponding to the Data Display window now active
or most recently activated.

Opens “ Calibration (page 4-35)" used to see the self-calibration results, to perform
the self-calibration, or to perform the current offset cancel.

Opens “ Configuration (page 4-41)" used to see the module configuration, to see the
self-test results, to perform self-test, to establish the GPIB connection with Agilent
B2200A/B2201A/E5250A switching matrix, or to see the event log.

Opens “ Switching Matrix Operation Panel (page 4-48)” used to control Agilent
B2200A/B2201A/E5250A switching matrix.

Opens “ Standby Channel Definition (page 4-50)" used to set the standby channel
which isthe channel to keep the specified output when the standby modeis ON and
in the non-measurement state.

Triggers asingle measurement. To abort measurement, click Stop button that
appears instead of the Single button.

Triggers the append measurement. The measurement results will be appended to the

d Data Display window that shows the previous measurement results. The Data

Display window can have maximum 10 layers for displaying measurement results.
To abort measurement, click Stop button that appears instead of the Single button.

This button provides a different function depending on the status of the data record
functions (Auto Record and Auto Export). See “Run Option (page 4-18)” for the
datarecord status.

If Auto Record and Auto Export is OFF, this button starts the repeat measurement
immediately.

If Auto Record or Auto Export is ON, this button opens the “ Repeat M easurement
Setup (page 4-31)” dialog box for setting the repeat measurement condition.

Opensthe “Run Option (page 4-18)" dialog box for setting the data record functions
(Auto Record and Auto Export) and the Multi Display function.

This button will appear to the right side of the Run Option button if a measurement
is performed when the data record functions (Auto Record and Auto Export) are
OFF. Clicking the button will save the last measurement data as a test result record.
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Count

Device ID

Save

Recall

My Favorite Setup

Using EasyEXPERT
Main Screen

Displays the number of single measurements executed for the test setup now
opened. Effective for the measurements triggered by both Single and Repeat.

Thisentry field is used to enter astring in the test record. The string can data D,
device ID, test ID, or anything you want.

Performing measurement and changing setup do not change the value in this field.
Change the value if you want.

The button saves the present test setup into the present preset group as a new test
setup of the group.

The button recalls the selected test setup. This means opening and displaying the
measurement definition of the selected test setup.

The test setups you create or modify MUST be saved to My Favorite group (preset
group) to reuse them.

Click the My Favorite Setup button to display the menu that provides the following
functions. Select the preset group by using the field below the button. The test
setups can be recalled by using the area below the field.

Cancel Closes the menu.
Preset Group Provides the following seven functions.

Add New Preset Group  Opensthe Add Preset Group dialog box. Creates a new
preset group and savesit as the specified name.

Rename This Preset
Group Opens the Rename Preset Group dialog box. You can
change the name of the present preset group.

Duplicate This Preset

Group Opens the Duplicate Preset Group dialog box. Creates
acopy of the present preset group and savesit asthe
specified name.

Delete This Preset Group You can delete the present preset group.

Import Preset Group...  Opensthe Preset Group Import dial og box. Importsthe
specified preset group.

Export This Preset
Group... Opensthe Preset Group Export dialog box. Exportsthe
present preset group as the specified name.
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Setup Name
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Remarks

Auto Record OFF

Auto Export ON
=
SMU Zero ON
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Using EasyEXPERT
Main Screen

Organize Preset Group... Opensthe “Organize Preset Group (page 4-33)” dialog
box used to organize the preset group.

Rename You can change the name of the selected test setup.
Duplicate Creates a copy of the selected test setup.

Delete Deletes the selected test setup.

Delete All Deletes all test setupsin the present preset group.

Shows the flag, Important (1), Valid (#), or Questionable (?) set to the record. The
top button sorts the test records by the flag.

While the “ Show Deleted Data (page 4-15)” function is enabled, the list area can
show the test records in Delete-group. For the records, * is set to the column to the
left of the Flag column. The top button sortsthe list by *.

Shows the test setup name. The top button sorts the test records by name, in
lexicographical order.

Shows the date that the test result is recorded. The top button sorts the test records
by date, in chronological order.

Shows the measurement count shown in the Count field. The top button sorts the
test records by count, in numerical order.

Shows the string set to the record by using the Device ID field. The top button sorts
the test records by device ID, in lexicographical order.

Shows the remarks set to the record. The top button sorts the test records by the
remarksin the lexicographic order.

Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit

| while the Auto Record (automatic data record) function is disabled.

Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
while the Auto Export (automatic data export) function is enabled.

Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
while the SMU current offset cancel function is enabled.
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Multi Display ON

workspace name

Results

Using EasyEXPERT
Main Screen

Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
while the standby function is enabled (standby modeis ON).

Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
E while the Multi Display function is enabled.

Field below the Results button shows the present workspace name.

This button provides the following functions. Thelist area shows the test records.
The up or down arrow button is used to expand or reduce the list area.

Cancel

Select All
Unselect All
Display Data

Recall
Filter
Show Deleted Data

Filter...

Expand Application Test
Results

Closes the menu.
Selects all records.
Unselects al records.

Opensthe “Data Display (page 4-51)” and displaysthe
test result data of the selected record. Up to 15
windows can be opened by this function.

Recalls the test setup of the selected record.
Provides the following four functions.

Check this function to see the test records of both
Save-group and Delete-group. To set the data group,
see “Flag and Remarks’ on page 4-17. See also “ Test
Result Editor (page 4-21)”.

Opensthe* Test Results Data Filter (page 4-22)” dialog
box. You can filter the test records in the list area.

Check thisfunction to see all test records created by the
test setups defined in an application test.

If atest record is exported when this function is not
checked, the exported file will contain al records
created by the test setups defined in an application test.
However, if the test record is exported by the Export
As Text File function, the exported file will contain
only the test record of the application test.
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Show All Append Data

Transport Data

Import...

Export AsTest Result...

Export As Compressed
Test Result...

Export AsCSV...

Export AsXML Spread

Export in My Format...

Export AsText File...

Text File Export Setting...

Folder Export...

Check thisfunction to see all test records created by the
append measurement. In the test record list, Sindicates
the test records obtained by a single measurement, and
A indicates the records obtained by an append
measurement.

Provides the following ten functions.

Opens the Test Result Import dialog box. Imports the
specified test record.

Opens the Test Result Export dialog box. Exports the
selected test record as the specified namein the
EasyEXPERT data format.

Opens the Compressed Test Result Export dialog box.
Exports the selected test record as the specified name
in the compressed EasyEXPERT data format.

Opensthe CSV File Export dialog box. Exports the
selected test record as the specified name in the CSV
format that can be read by a spread sheet software.

Opensthe XML Style Sheet Export dialog box.
Exports the selected test record as the specified name
in the XML spread sheet format that can be read by a
spread sheet software.

Opensthe “Export in My Format (page 4-22)” dialog
box. Exports the selected test record as the specified
name in the style converted by using the specified
XSLT filter.

Opens the Text File Export dialog box. Exports the
selected test record as the specified namein the style
defined on the “ Text File Export settings (page 4-77)”
dialog box.

Opensthe “ Text File Export settings (page 4-77)"
dialog box used to define the style of the test record
exported by the Export As Text File function.

Opensthe “ Test Results Data Folder Export (page
4-23)" dialog box used to export the selected multiple
test records to the specified fol der.
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Auto Export Setting...

Edit

Flag and Remarks

Delete

Properties...

Using EasyEXPERT
Main Screen

Opensthe“ Test Results Data Auto Export (page 4-24)”
dialog box used to set the automatic data export
function and the automatic data save function.

Provides the following two functions.

Opens the “ Test Result Editor (page 4-21)" used to put
the selected test record in Save-group or Delete-group.
Also this dialog box can set aflag and remarksto the
selected record. The available data flags are Important
(), Valid (#), and Questionable (?).

Puts the selected test recordsin Delete-group. The
records can be displayed in the list area while the
“Show Deleted Data (page 4-15)” is checked.

Opensthe “ Test Results Data Properties (page 4-26)"
dialog box used to set the number of test records listed
inthelist areaand the number of recoverablerecordsin
Delete-group.
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Main Screen

Run Option

This dialog box appears by clicking the Run Option button and is used to set the data
record functions (Auto Record and Auto Export) and the Multi Display function.
This dialog box provides the following GUI.

» Record Test Result Data Automatically

This check box changes the status of the data record functions (Auto Record and
Auto Export). The functions provide four status shown in Table 4-1. Removing
the check sets Auto Export=Auto Record=OFF. And putting the check again
returns the status to the previous one.

In the checked status, the data record functions can be set to one of three status
except for Auto Export=Auto Record=OFF. To set the functions, use “ Test
Results Data Auto Export (page 4-24)".

In the unchecked status (Auto Export=Auto Record=0OFF), the test result data
will not be recorded. If a measurement is performed in this status, the Save Data
button will appear to the right side of the Run Option button. Clicking the Save
Data button will save the last measurement data as a test result record.

When the automatic data record function is enabled, one test execution result is
stored in one test record. For the classic test, onetest result is stored in one test
record. For the application test, all test results taken by executing one
application test are stored in one test record. However, the automatic data export
function using the Text File type exports the file for each test result.

Table 4-1 Record Test Result Data Automatically Check Box and Data Record Functions
Checked status Unchecked status
Auto Export Auto Record Auto Export Auto Record
ON OFF OFF OFF
ON ON
OFF ON

e Allocate Data Display for each test

This check box sets the Multi Display function ON (checked) or OFF. This
function controls the operation of the Data Display window.

OFF Test result datawill be always displayed on the singular Data
Display window even if the test setup is changed.
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Using EasyEXPERT
Main Screen

ON Test result data of the same test setup name will be displayed on the
exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display
window.

Data Display M anager

Thisdialog box is opened by selecting the Manage Data Display... function of the
Data Display menu, and is used to control the appearances of the Data Display
windows. This dialog box provides the following three action buttons.

OK Applies the setup changes and closes this dialog box.
Cancel Cancels the setup changes and closes this dialog box.
Apply Just applies the setup changes.

This area lists the Setup Name of the Data Display windows opened. The list items
from top to bottom correspond to the windows from front to back in the screen
image. This area supports the following buttons. To select the item, click onein the
list.

Up Moves the selected item upward.

Down Moves the selected item downward.

Select All Selects all items.

Minimize Minimizes the windows corresponding to the selected items.

The list items move to the Minimized Data Displays area.

Close Closes the windows corresponding to the selected items.

This area lists the Setup Name of the Data Display windows minimized. This area
supports the following buttons. To select the item, click onein thelist.

Select All Selects all items.
Restore Restores the windows corresponding to the selected items.
Close Closes the windows corresponding to the selected items.

This area provides the following radio buttons and a check box to change the
appearances of the Data Display windows. All functions are available for the opened
windows.

Keep Setup K eeps the present configuration of the Data Display windows.
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Main Screen

Tiling Resize and collate the data display windows such that they fill
up the entire screen.

Sacking Resize and collate the data display windows so that they
overlap dlightly with an offset.

Overlaying Resize, overlap, and make transparent the data display windows
so that multiple graphs can be viewed and superimposed on one
another.

This check box must be checked to apply the same graph scale to all graphs.

Data Display Properties

This dialog box is opened by selecting the Default Data Display Properties...
function of the Data Display menu, and is used to set the default setting of the Data
Display window. Click the OK button to apply the setup and close this dialog box.

Thisareais used to select the area effective when the Data Display window is
opened, and provides the following check box.

X-Y Graph Check this button to enable the X-Y Graph area.

Grid ON Check this button to display the grid on the X-Y Graph.
List Display Check this button to enable the List Display area.
Parameters Check this button to enable the Parameters area.

Thisareais used to set the color map for the X-Y Graph Plot area. You can change
the color of the background, text, graph grid, and line/cursor. The color paletteis
opened by clicking the pattern of the item.

Thisareais used to set visibility, color, and thickness of the datatracesY1to Y8
plotted on the graph. The color palette is opened by clicking the pattern of the item.

Thisareais used to set the maximum number of decadesto show the minor ticks for
on the log axis. If the number of graph decadesisless than or equal to the entered
value, the minor ticks are displayed. If it is greater than the entered value, the minor
ticks are not displayed.

Thisareais used to set the font size for the graph. The available settings are Largest,
Large, Medium, Small, Smallest, and Fixed. For settings other than Fixed, the
appropriate size is automatically selected. For Fixed, afont size entry field is
provided, and the specified font sizeis always applied.
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X/Y AxisTitle Font size for the axistitle
Scale Font size for the X and Y coordinate values

Legend Font size for the graph legend

Test Result Editor

The Test Result Editor appears when measurement is completed or by clicking
Results > Edit > Flag & Remarks. Thisis used to set aflag and remarks to the
associated test record and provides the following GUI.

Divides test records into groups, Save and Delete.

Test recordsin Save-group are aways listed in the lower area of the EasyEXPERT
main screen.

Test recordsin Delete-group can be listed while Results > Filter >
Show Deleted Data is checked.

The following buttons are available. You can set one of the following flags.

e Important ! button
Sets the important flag (!) to the test record.
+ Vadid# button
Setsthe valid flag (#) to the test record.
* Questionable ? button
Sets the questionable flag (?) to the test record.

You can enter charactersinto thisfield. The characters will be recorded as the
Remarks value of the test record.

Applies the setup on the Test Result Editor, and closes this dialog box.
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Test Results Data Filter

This dialog box appears by clicking Results > Filter > Filter... and is used to specify
the test records listed in the lower area of the EasyEXPERT main screen.

Check this box to list the test records in Save-group.
Check this box to list the test records in Del ete-group.

Select or enter aflag in thisfield to list the test records with the specified flag.
Select or enter atest namein thisfield to list the test records of the specified name.
Specify the date to list the test records within the specified period.

Specify the count values to list the test records within the specified range.

Select or enter the device ID to list the test records of the specified device ID.
Specify the remarks value to list the test records with the specified value.

Performs filtering, and closes this dialog box.

Cancelsfiltering, and closes this dialog box.

Export in My For mat

This dialog box appears by clicking Results > Transport Data > Export in My
Format..., and is used to export the test record by performing the style conversion
using the XSLT filter.

Specify the full path name of the XSLT filter (XML style sheet) used to convert the
style of thetest record. The Browse... button opens the Select XML Style Sheet File
dialog box used to select thefile.

Opens the Export As dialog box. Specify the file name and the file type, and export
the test record.

Cancels data export, and closes this dialog box.

4-22 Agilent B1500 User’s Guide, Edition 7



Destination for
Export

File Name

File Type

Using EasyEXPERT
Main Screen

Test Results Data Folder Export

This dialog box appears by clicking Results > Transport Data > Folder Export...
after the test result records are selected (highlighted).

This function is used to export the multiple test records. The test records can be
exported by specifying the records, the destination folder name, and the naming rule
and the file type for the exported files.

Selects the folder used to save the exported test records. The Browse... button opens
the Browse For Folder dialog box used to select the folder.
Specifies the style of the file name for the exported test records.

File nameis automatically generated by using Setup Name, Device ID, Count, and
Date values defined in the main screen. If an impermissible character isused in a
value, the character is automatically replaced with _ (underscore).

» Default Format: File name without extension is as follows.
Setup Name] Device ID( Count) ; Date]
Example: 1 d-Vd [cnpos1(1l) ; 1 22 2006 3_44 55 PM
» Custom Format: You can specify the style by the File Name Format dialog box.

The File Name Format dialog box appears by clicking the Settings... button. In
the dialog box, enter the desired style into the Format field, for example, the
next example sets the same style as the Default Format.

Example: {0} [{3}({2}) ; {1}]

{0}: Setup Name

{1}: Date, mm_dd_yyyy hh_mm_ss AM/PM
{2}: Count

{3}: DevicelD

Selects the file type (data format).

Test Result EasyEXPERT data format
Compressed Test Result Compressed EasyEXPERT data format
csv CSV format

XML Spread Sheet XML spread sheet format
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My Format Custom format created by the specified XSLT filter. The
following two entry fields are available.

* My Format

Specifies the file name of the XSLT filter (XML style sheet) used to export test
records. The Browse... button opens the Select XML Style Sheet File dialog box
used to select the file.

» Extension of Output File

Enters the appropriate extension, or selects the extension from xml, txt, csv, or
xls.

Text File Custom format defined in the “ Text File Export settings
(page 4-77)" dialog box. The Settings... button opensthis
dialog box.

Starts the folder export. This dialog box is closed after the folder export is
compl eted.

Cancels the folder export, and closes this dialog box.

Test Results Data Auto Export

This dialog box appears by clicking Results > Transport Data > Auto Export
Setting... and is used to set the data record functions (Auto Record and Auto
Export).

There isthe following check box at the top of this dialog box.

» Enable automatic data export to the specified storage device

Checking this box setsthe Auto Export function (automatic data export) and enables
the following GUI.

Selects the folder used to save the exported test records. The Browse... button opens
the Browse For Folder dialog box used to select the folder.

Specifies the style of the file name for the exported test records.

File nameis automatically generated by using Setup Name, Device ID, Count, and
Date val ues defined in the main screen. If an impermissible character isused in a
value, the character is automatically replaced with _ (underscore).
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» Default Format: File name without extension is as follows.
Setup Name[ Device ID( Count) ; Date]
Example: 1 d-Vd [cnps1(1) ; 1 22 2006 3_44 55 PM
e Custom Format: You can specify the style by the File Name Format dialog box.

The File Name Format dialog box appears by clicking the Settings... button. In
the dialog box, enter the desired style into the Format field, for example, the
next example sets the same style as the Default Format.

Example: {0} [{3}({2}) ; {1}]

{0}: Setup Name

{1}: Date, mm_dd_yyyy hh_mm_ss AM/PM
{2}: Count

{3}: DevicelD

Selects the file type (data format).

Test Result EasyEXPERT data format

Compressed Test Result Compressed EasyEXPERT data format

csv CSV format

XML Spread Sheet XML spread sheet format

My Format Custom format created by the specified XSLT filter. The

following two entry fields are available.

* My Format

Specifies the file name of the XSLT filter (XML style sheet) used to export test
records. The Browse... button opens the Select XML Style Sheet File dialog box
used to select the file.

» Extension of Output File

Enters the appropriate extension, or selects the extension from xml, txt, csv, or
xls.

Text File Custom format defined in the “ Text File Export settings
(page 4-77)" dialog box. The Settings... button opensthis
dialog box.
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Remove a check from the following check box to disable the Auto Record function
(automatic data record).

» Enable automatic data record to the internal storage device
Appliesthe setup, and closes this dialog box.
Cancels the setup, and closes this dialog box.

Automatic Data Record Output

When the automatic data record function is enabled, one test execution result is
stored in one test record. For the classic test, one test result is stored in one test
record. For the application test, all test results taken by executing one application
test are stored in one test record. However, the automatic data export function using
the Text File type exports the file for each test result.

Test Results Data Properties

This dialog box appears by clicking Results > Properties... and is used to set the
maximum number of test records listed in the main screen and saved in the
Delete-group.

Sets the maximum number of test records listed in the main screen.

Sets the maximum number of test records saved in the Delete-group.

Closes this dialog box.
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Application Test

In the application test mode, the EasyEXPERT main screen has the following
additional graphical user interface.

Category  ~| (D] Vth gmMax Setup Name: [vth omiax = ‘

[ BIT *||Device Parameters

] cmos

ST Polarity: [ich H| Lg: [l0rm 8| wa: [0oum

| Exercise =

o GenericTest Temp: [25.0 deg E] IdMax: [10.0 ma E
] Memory
] MixedSigna x|
| Library - |[Test Parameters Extended Setup  ~
B
Trrg Idvd >
i Drain: [FMU4HR =
Ll ]
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; Gate: [SMUZFR = subs: fotre 5] |—

Demo-5-M...

Endurance vgStart: [S00mv B 1 vsubs: [0v B
AP «
= vgstop: ooV B
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Lists the categories of the application test definitions. You can select the categories
by using the check box. The test definitions listed in the Library area depend on the
selection of the categories.

The Category button opens the Categories dialog box used to select the categories.

Thisfield just displays the test definition name of the present application test.
Clicking the left i button displays the help message for the test definition.

Lists the application test definitions that belong to the categories selected by the
Category area.

Clicking anicon displaysits brief introduction message and the Select button.
Clicking the Select button loads the application test definition. Now, the B1500 is
ready to start measurement.

The Library button provides the following six functions.
Close Closes this menu.

Define New Test... Opens the “ Test Definition Window (page 6-3)”
used to create a new application test.
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Open Definition of ThisTest...
Opens the “ Test Definition Window (page 6-3)” to
display the definition of the present (selected)
application test or to modify the definition.

Delete Definition of This Test Deletes the present (selected) application test. The
test will be deleted from the application library.

Import Test Definition... Opens adialog box used to specify the test
definition to import.

Export Test Definition... Opens a dialog box used to export the present
application test definition. The test definition will
be saved to the specified file.

Incremental search. Used to search the application test definitions listed in the
Library area.

Used to set the name of test setup. The name must be the identification for the test
setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameis stored in the test result data and is used to differentiate the recordsin
the test record list area.

This area displays the device parameter entry fields if the device parameters are
defined as the variables in the application test definition.

Enter the appropriate value to the entry fields before starting measurement.

This area displays the device connection diagram if it is specified in the application
test definition.

This area also displays the test parameter entry fieldsif the test parameters are
defined asthe variablesin the application test definition. Enter the appropriate value
to the entry fields before starting measurement. If the entry field needs to enter a
vector data, see “Define vector data’ on page 5-18.

This button opens the Extended Setup dialog box that displays the extended
parameter entry fields. See “ Ext” on page 6-6 for the parameters shown in this
dialog box.

Enter the appropriate value to the entry fields and click Close button.
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Quick Test

In this mode, you can execute the test setups saved in a preset group (My Favorite
Setup) sequentialy.

In the quick test mode, the EasyEXPERT main screen has the following additional
graphical user interface.

The following menu is displayed by clicking this button.

Cancel Closes this menu.

Duplicate This
Preset Group Opensthe Duplicate Preset Group dialog box. Creates a copy of
the present preset group and savesit as the specified name.

Import Preset

Group... Opens the Preset Group Import dialog box. Imports the
specified preset group.

Export Preset

Group... Opens the Preset Group Export dialog box. Exports the present

preset group as the specified name.

Organize Preset
Group Opens the Organize Preset Group dialog box used to organize
the preset group. See “Organize Preset Group” on page 4-33.

Selects the preset group to open.

Lists all test setups saved in the preset group.

To select the test setup for the quick test setup operation, click the line.

When you are doing the quick test setup, the softkeys are available to start the
associated test. The softkey label will show the Setup Name.

The following buttons are available for the quick test setup operation.

Select All Selects al test setups for quick test. This button sets the ¢ mark
to theright cell of the Setup Name.
Unselect All Unselects all test setups for quick test. This button deletes the o

mark from the right cell of the Setup Name.
Up Moves the selected test setup upward
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Down Moves the selected test setup downward.

. Set the e mark to theright cell of the Setup Name to be executed
in the quick test. To do so, select the test setup, then click this
button.

After the quick test is started, the test setup with the ¢ mark will
be executed in order from top to bottom of the setup table.

Recall Recalls the selected test setup. The screen is changed to
Application Test or Classic Test.

Rename You can change the name of the selected test setup.

Duplicate Creates a copy of the selected test setup and placesit at the
bottom of the setup table.

Delete You can delete the selected test setup.
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—
Repeat M easurement Setup
Thisdialog box is opened by clicking the Repeat button, and is used to set the repeat
measurement condition. This dialog box supports the following action buttons.
Run Starts measurement.
Abort Aborts the measurement.
Cancel Cancels performing the repeat measurement and closes this

dialog box.

The repeat measurement is performed as shown in Figure 4-1. The repeat
measurement operation is controlled by the value of Count and status. Where, Count
is the number displayed in the Count field of the main screen, and status must be a
parameter of the response created by Start Procedure and Iteration Procedure. For
the response, see Figure 4-2.

Figure4-1 Repeat M easurement Execution Flow

Count=0

Repeat Measurement Setup

Repeat Procedures

| | Start Procedure | |

Start Procedure:

E‘ Browse...
Arguments: =
Iteration Procedure:
EJ Browse...
Arguments: E
Final Procedure: | .
Test Execution |
ﬂ Browse... I
Al its: )
A H | Count=Count+1 |
v Automatically fill in Device ID I
Repeat Stop Condition | » | | Iteration Procedure | |
n
Stop repeating by:

oG T

Yes [&———

[17 Counter reaching to: {5 E] | Abort I

[W Procedure return condition ] Cincet
A

| | Final Procedure | |

If Abort is clicked |

>/«

Thisareais used to specify the procedure to be called while the repeat measurement
is performed. The procedure must be the execution file (.exefile). If no procedureis
needed, empty the field. The Browse button opens a file browser.

status limit
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Sart Procedure  Specifies the procedure executed before starting measurement.

Iteration
Procedure Specifies the procedure executed every single measurement.

Final Procedure Specifiesthe procedure executed after the repeat measurement.
If the procedure requires arguments, enter the values to the Argumentsfield.

If the procedure specified by Start Procedure or Iteration Procedure creates the
response as shown in Figure 4-2, EasyEXPERT performs the operation following
the response. See Figure 4-1. The parameter status value must be the string True or
False, and the parameter device _id value should be any string. EasyEXPERT
ignores the response of the different format.

This check box is available when the Procedure return condition box has been
checked, and is used to enable the device ID automatic input function. Thisfunction
enters the Device ID of the test record automatically. The value is given by
device_id which is a parameter of the response created by Start Procedure and
Iteration Procedure.

Thisareais used to set the repeat measurement stop condition. The following stop
conditions are available.

» Counter Reaching to: limit
The repeat measurement will be stopped if Count > limit.
*  Procedure return condition

The repeat measurement will be stopped if the response shows status = True.

Procedure Response Expected by EasyEXPERT

» Response (input to EasyEXPERT):
XML format data
<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response>
status: True (break) or False
device_id: Device ID
* Example: <Response>

<Break>False</Break>
<Target>waf1a:3 1</Target>
</Response>
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Organize Preset Group

This dialog box is opened by selecting the Organize Preset Group function of the
main screen, the Quick Test setup screen, or the Switching Matrix Operation Panel,
and is used to organize the preset group.

Lists the preset group saved in the workspace. The following buttons are available.

Add Opens the Add Preset Group dialog box. Creates a new preset
group and saves it as the specified name.

Rename Opens the Rename Preset Group dialog box. You can change
the name of the selected preset group.

Duplicate Opensthe Duplicate Preset Group dialog box. Creates a copy of
the selected preset group and savesit as the specified name.

Delete You can delete the selected preset group.

Import Only for the quick test setup. Opens the Preset Group Import
dialog box. Imports the specified preset group.

Export Only for the quick test setup. Opens the Preset Group Export
dialog box. Exports the selected preset group as the specified
name.

Sets the operation of the >> button and the << button. They work as Copy when this
box is checked, and as Move when this box is unchecked.

Copies or moves the preset setup selected in the left Preset Group box to the right
Preset Group box.

Copies or moves the preset setup selected in the right Preset Group box to the left
Preset Group box.

Closes the Organize Preset Group dialog box.
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Preset Group Lists the preset setup saved in the preset group. The following buttons are available.
Preset Group Selects the preset group to open.

Setup Name Lists all preset setup saved in the preset group.

Select All Selects all preset setup.

Unselect All Unselects all preset setup.

Rename You can change the name of the selected preset setup.

Duplicate Creates a copy of the selected preset setup and placesit at the
bottom of the setup list.

Delete You can delete the selected preset setup.
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Calibration

The Calibration window is opened by clicking the Calibration button, and is used to
perform the self-calibration, SMU current offset cancel, CMU data correction, and
SO on.

* “Module Self Calibration”
e “SMU Zero Cancel”
« “CMU Cdlibration”

M odule Self Calibration

The Module Self Calibration tab screen is used to perform the self-calibration of
modules. Check the left check box of Name to select the module for self-calibration.
Open the measurement terminals at the cable end before performing the
self-calibration.

Displays the following values.

Name Name of module.

Full Range Full range calibration On or Off. Only for the HRSMU/ASU.
Satus Calibration status. Pass or fail.

Notes Error information when calibration failed.

Selects all modules for calibration. This checks the check box for all modules.
Unselects all modules. This unchecks the check box for all modules.

Starts calibration for the selected modules.

Aborts calibration.

Check this box to enable the 1 pA range calibration of the HRSMU/ASU.

If you do not use the 1 pA range, uncheck this box. The B1500A does not perform
the 1 pA range offset data measurement and calibration.
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Enables or disables the auto-calibration capability. If this box has been checked
(function ON), and the B1500 automatically starts calibration for all modules every
30 minutes if the output switches of all modules are off for 30 minutes. If
auto-calibration is enabled, do not forget to open the measurement terminals or
disconnect the device under test from the terminal's after measurement.

SMU Zero Cancel

The SMU Zero Cancel tab screen is used to perform the SMU path offset current
measurement, and set the offset cancel function. Check the left check box of Name
to select the effective module. Open the measurement terminals at the cable end
before performing the offset measurement.

See also “Current Offset Cancel” on page 7-42.

Displays the following values.

Name Name of module

Full Range Full range measurement On or Off. Only for the HRSMU/ASU.
InA Offset current measurement datain the 1 nA range.

100pA Offset current measurement data in the 100 pA range. Not

availablefor MPSMU and HPSMU.

10pA Offset current measurement data in the 10 pA range. Not
available for MPSMU and HPSMU.

1pA Offset current measurement datain the 1 pA range. Not
available for MPSMU, HPSMU, and HRSMU.

Enables (On) or disables (Off) the 1 pA range of the HRSMU/ASU.

Sets the integration time for the SMU path offset current measurement. 1 PLC
(power line cycle) to 100 PLC, initial setting 16 PLC.

Selects al modules. This checks the check box for all modules.
Unselects all modules. This unchecks the check box for all modules.

Performs the SMU path offset current measurement for the effective modules.
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CMU Calibration

The CMU calibration tab screen is used to perform the measurement data correction
of the multi frequency capacitance measurement unit (MFCMU). For the easy way,
perform the phase compensation and the open correction at least.

See also “Error Correction” on page 7-24.

For a more accurate measurement, perform correction data measurement at the
measurement frequency before starting the capacitance measurement.

If the measurement frequency isnot included in thelist of default frequencies below,
click the Advanced Options... button and set the measurement frequency on the
Frequency area of the Advanced Options for CMU Calibration window.

Default frequencies:

1k, 2k, 5k, 10k, 20k, 50k, 100k, 200k, 500k, 1 M, 1.2 M, 1.5M,2 M, 25 M,
27M,3M,32M,35M,3.7M,4M,42M,45M, 5MHz

Opens adialog box used to perform correction/compensation data measurement. To
perform the measurement, follow the dialog box.

The correction/compensation measurement data is saved and managed by the
workspace. And the last measured correction/compensation data will be loaded
when the workspace will be opened next time.

Opensthe “ Advanced Optionsfor CMU Calibration (page 4-39)” dialog box used to
set the frequencies for the correction data measurement and the reference values of
the working standard.

This check box is effective after the phase compensation data is measured, and is
used to enable or disable the phase compensation. Uncheck this box to disable the
phase compensation.

To measure the compensation data, open the measurement terminals at the end of
the device side and click the Measure... button.

If you extend the measurement cables to the device end by using the four terminal
pairs method, do not forget to connect following terminal s together at the device
end.

» thehigh potentia (Hp) terminal and the high current (Hc) terminal

» thelow potential (Lp) terminal and the low current (Lc) terminal
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This check box is effective after the open correction datais measured, and is used to
enable or disable the open correction. Uncheck this box to disable the correction.

To measure the correction data, connect the open standard that has the calibration
value or reference value, or open the measurement terminals at the end of the device
side. Then, click the Measure... button.

If you extend the measurement cables to the device end by using the four terminal
pairs method, do not forget to connect following terminal s together at the device
end.

» thehigh potential (Hp) terminal and the high current (Hc) terminal
» thelow potential (Lp) terminal and the low current (Lc) terminal

If the standard is used, click the Advanced Options... button and enter the reference
value to the OPEN Reference entry fields. If you do not use the standard, enter O to
thefields.

This check box is effective after the short correction datais measured, and is used to
enable or disable the short correction. Uncheck this box to disable the correction.

To measure the correction data, connect the short standard that has the calibration
value or reference value, or directly connect the measurement terminals at the end of
the device side. Then, click the Measure... button.

If the standard is used, click the Advanced Options... button and enter the reference
value to the SHORT Reference entry fields. If you do not use the standard, enter 0 to
thefields.

This check box is effective after the load correction datais measured, and is used to
enable or disable the load correction. Uncheck this box to disable the correction.

To measure the correction data, connect the load standard that has the calibration
value or reference value. Then, click the Measure... button.

Before performing the load correction data measurement, click the Advanced
Options... button and enter the reference value to the LOAD Reference entry fields.
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Advanced Optionsfor CMU Calibration

Thisdialog box is opened by clicking the Advanced Options... button, and is used to
set the information required to measure the open/short/load correction data and the
phase compensation data. This dialog box provides the following action button.

OK Applies the setup changes and closes this dialog box.
Cancel Cancel the setup changes and closes this dialog box.

You can select one of the following radio buttons to select the measurement
frequency setup mode.

» Usefactory specified frequencies (Default)

Usually, select this mode. 23 points are automatically set. They are 1k, 2k, 5k,
10k, 20k, 50k, 100k, 200k, 500k, 1 M, 1.2M,1.5M,2M,25M,2.7M, 3 M,
32M,35M,37M,4M,42M,45M, and5 MHz.

» Specify list of calibration frequencies

Select this mode when you want to set the frequencies independently. The
frequency must be 1 kHz to 5 MHz. The number of frequencies must be 1 to
101.

Click Add to open adialog box, and enter the value.
For the unnecessary value, select the value and click Delete.
» Specify frequencies by range
Select this mode when you want to set the frequencies sequentially and
automatically.

Specify the start frequency, the stop frequency, the number of steps, and the
scale LINEAR/LOG. The start frequency must be less than the Stop value and at
least 1 kHz. The stop frequency must be more than the Start value and no more
than 5 MHz. The number of steps must be 2 to 1001.

If the device measurement frequency is not equal to the correction data
measurement frequency, calculation will be performed automatically to get the
correction data for the device measurement frequency, and the cal culated correction
datawill be used for the data correction of the measurement data.
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Integration Time This area defines the integration time used for measuring phase compensation data
or open/short/load correction data. The number of averaging samples
(Mode=AUTO) or the averaging time (Mode=PLC) is set.

Mode A/D converter operation mode, AUTO or PLC
Factor Factor for the initial value. See “Mode, Factor” on page 7-20.
Reference The following entry fields are available to set the calibration values or the reference

Standard Values  values of the open/short/load standard. If you use the standard, enter the values to
the following entry fields.

» OPEN Reference: Capacitance and Conductance

If you do not use the reference, enter O in the both fields.
* SHORT Reference: Inductance and Resi stance

If you do not use the reference, enter O in the both fields.

* LOAD Reference: Inductance and Resistance
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Configuration

The Configuration window is opened by clicking the Configuration button, and is
used to display the system information and event log, as well asto perform
diagnostics and self-test.

* “Main Frame’

e “Modules’

e “ASU”

*  “Switching Matrix”
e “SMU/PG Selector”
* “Event Log”

Main Frame

The Main Frame tab screen is used to display the system information and perform
diagnostics.

Displaysthe instrument ID. B1500A.

Sets the power line frequency, 50 Hz or 60 Hz.
Displays the revision number of the EasyEXPERT.
Displays the revision number of the B1500 firmware.
Displaysthe host id of the B1500 internal computer.

This arealists Item and Status.
Item Name of diagnostics item. To select, check the left check box.

Satus Diagnostics status. Pass or fail.
Selects all items for diagnostics. This checks the box for all items.

Unselects all items. This unchecks the box for al items.
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Starts diagnostics for the selected items. To perform diagnostics, specify theitemsto
perform and click this button. A dialog box appears. Follow the dialog box to
perform the diagnostics. Some items need your judgement, pass or fail. Also you
will need to connect an adapter, press keys, check LEDs, and so on.

Modules
The Modules tab screen is used to perform self-test of modules.

This arealists Slot, Module Type, Name, and Status.

Slot Slot number where the module isinstalled. To select, check the
|eft check box.

Module Type Module model number

Name Module name

Satus Self-test status, Passed, Failed, Recovered, or - - - - (self-test
has not been performed)

SCuuU Specifiesif the module is connected to the SCUU.

Notes Error information when the modul e self-test failed.

Selects al modules for self-test. This checks the check box for all modules.
Unselects all modules. This unchecks the box for all modules.
Starts self-test for the selected modules.

This button isfor service use only. Makes the failed modules respond again. This
button does not solve the problem that causes the Failed status.

Aborts self-test.

Enables (ON) or disables (OFF) the status indicator (LED) of the ASU (Atto Sense
and Switch Unit) and the SCUU (SMU CMU Unify Unit).
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ASU

The ASU tab screen is available if the B1500A installs the HRSMU calibrated with
the ASU (Atto Sense/Switch Unit) regardless of the ASU connection status, and
shows the ASU information.

Slot number

Type of module

Name of module

Seria number of the usable ASU. This cell showsthe serial number even if the ASU

is disconnected.

If anincorrect ASU is connected to the HRSMU, this cell displays an error message
instead of the serial number. Error message is also displayed if an ASU is connected
to the HRSMU which is not available for using ASU.

ASU input to output connection, SMU or AUX

If thisfield is set to SMU, the ASU makes the path from the ASU Forceinput to the
ASU output.

If thisfield is set to AUX, the ASU performs automatic switching in every test. The
ASU normally makes the path from the AUX In input to the ASU output and makes
the path from the ASU Force input to the ASU output for the test with the HRSMU.

Switching Matrix

The Switching Matrix tab screen is used to confirm the GPIB connection with
Agilent B2200A/B2201A/E5250A switching matrix, and defines the connections
between the measurement units and the switching matrix input ports.

Displays the type of the switching matrix. One of the following.
» B2200A Femto Leakage Switch Mainframe (standard)

» B2201A 14ch Low Leakage Switch Mainframe (standard)

» EB5250A Low Leakage Switch Mainframe (option)

» No Switching Matrix (if switching matrix isnot connected)

Specifies the GPIB address of the switching matrix. 1 to 30.
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Confirmsif the switching matrix with the specified GPIB Addressis connected to
the B1500A.

This button starts the selftest of the switching matrix.
SWM INn means the switching matrix input port n. where, nisan integer 1 to 10 for

the E5250A or an integer 1 to 14 for the B2200A/B2201A.

Enter the label used to specify the input port to the right entry field. The port name
and the connected module name can be the Iabel. Or select one from the pull-down
menu. There must be no colon (:) in the label.

If the Kelvin check box is checked, the coupled even number port is grayed out.
If the CMU check box is checked, the SWM IN10 for the E5250A or the SWM
IN14 for the B2200A/B2201A is grayed out.

Check this box if this port is used for the Kelvin connection. Connect the switching
matrix inputs to the SMU as follows.

» for the E5250A (m: integer 1to 3)
SMU INPUT 2m- 1 to the SMU Force terminal
SMU INPUT 2mto the SMU Sense terminal
» for B2200A/B2201A (m: integer 1 to 6)
Input 2m- 1 to the SMU Force terminal
Input 2mto the SMU Sense terminal

Check this check box if this port is connected to the CMU. Connect the switching
matrix inputs to the CMU as follows.

+ for the E5250A
AUX INPUT CV1 to the CMU Hpot/Hcur terminals
AUX INPUT CV2to the CMU Lpot/Lcur terminals
+ for B2200A/B2201A
Input 13 to the CMU Hpot/Hcur terminals
Input 14 to the CMU Lpot/Lcur terminals

To obtain accurate capacitance measurement result, perform capacitance
compensation. See “ Capacitance Compensation When Using Switching Matrix” on
page 3-47. Also see “ Extended Configuration” on page 4-46.
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This button opens the “ Extended Configuration” on page 4-46 dialog box.

SMU/PG Selector

The SMU/PG Selector tab screen is used to specify the input connection and the
channel connection status of the Agilent 16440A SMU/PG selector. The selector can
be controlled by the B1500A viathe Digital 1/0O connector and the Agilent 16445A
selector adapter.

Two selectors can be used. The first selector must be connected to the Digital 1/0
connector viathe 16445A. And if the second selector is used, it must be connected
to the first selector’s Control Output connector. See “SMU/PG Selector” on page
7-48.

To use the selector, connect the selector to the B1500A, and check this check box.

CH1 and CH2 indicates the channels 1 and 2 of the first selector respectively.
CH3 and CH4 indicates the channels 1 and 2 of the second selector respectively.

Specifies the SMU connected to the SMU input of the selector channel CH1, CH2,
CH3, or CHA4.
Specifies the connection status of the selector channel CH1, CH2, CH3, or CH4.

If thisfield is set to Always SMU, the selector makes the path from Input SMU to
Output.

If thisfield is set to Normally PGU (AUX), the selector performs automatic
switching in every test. The selector normally makes the path from Input PGU to
Output and makes the path from Input SMU to Output only for the test which uses
the SMU connected to the Input SMU terminal.

The CH1 and CH3 also provides the PGU Open status which is set by using the
Advanced window of the Measurement Setup.

Event Log

The event log tab screen displays the event log.
Displays date and time of the event.

Event message
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ID Process ID of the event
Process Process name
User User name. Windows login name.
Host Host name of the B1500
Refresh Refreshes the event log.

Extended Configuration

This dialog box opens by clicking the Extended Configuration button in the
Configuration window’s Switching Matrix screen.

Save as Hardware Switching matrix hardware configuration can be saved as the hardware profile.

Profil
rotie Save Saves the present hardware profile.

The hardware profile can be made for each workspace individually.

CmMuU Selects the compensation mode of the capacitance measurement using the switching

Compensation matrix. Click one of the radio buttons, No Compensation, Select, and User
Compensation Data File. For the capacitance compensation, see “ Capacitance
Compensation When Using Switching Matrix” on page 3-47.

* No Compensation

Select thisradio button if you do not need the capacitance compensation. The
raw data without compensation is displayed and saved.

» B2200A/B2201A (standard)
The following setup is available for the B2200A/B2201A hardware profile.

* Select

Select thisradio button to perform the capacitance compensation for the path
from the B2200A/B2201A input portsto Agilent 16495F/G connector plate
or Agilent B2220A probe card interface. The data after compensation is
displayed and saved.

DUT I/F Specifies the model number of the path you use. The
selections are the 16495F/G and B2220A.
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Cable Specifies the model number of the cable from the
B2200A/ B2201A output to the DUT I/F. The selections
are the 16494A/B/C-001 (1.5 m) / 002 (3 m) / 005 (4 m).

This mode cannot perform the capacitance compensation for the cables to
positioner/manipulator or the probe card.

e User Compensation Data File

Select this radio button and specify the compensation datafileto perform the
capacitance compensation for the path from the B2200A/B2201A input
ports to the end of positioner/manipulator/probe card. See “To Create
Compensation Data File” on page 3-50. The data after compensation is
displayed and saved.

» EB250A (option)
The following setup is available for the E5250A hardware profile.
» User Compensation Data File

Select thisradio button and specify the compensation datafileto perform the
capacitance compensation for the path from the E5250A input ports to the
end of positioner/manipulator/probe card. See “To Create Compensation
Data File" on page 3-50. The data after compensation is displayed and

saved.
Clear Clears the User Compensation Data Filefield.
Triaxial Cable Enter the length of the 16494A triaxial cable

connected between the E5250A outputsto the
connector plate.

User Triaxial Cable Enter the length of the triaxial cable between
the connector plate and the DUT. Enter O if
thetriaxial cableisnot used.

User Coaxial Cable Enter the length of the coaxial cable between
the connector plate and the DUT. Enter O if
the coaxial cableis not used.

Close Closes the Extended Configuration dialog box.
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Switching Matrix Operation Panel

The Switching Matrix Operation Panel is opened by clicking the Switching Matrix
button, and is used to create the switch setup for Agilent B2200A/B2201A/E5250A
switching matrix, send the setup to the switching matrix, and so on. The switch
setup can be saved to the switch setup preset group. This group is different from the
preset group for test setups.

This areais used to create the switching matrix switch setup. You can create the
setup by clicking the Input-Output cross point. The switch setup can be sent to the
switching matrix by clicking the Apply Switch Setup button.

Color of cross point Switch setup
green close
gray open
Setup Name Name of switch setup
Clear All Setsdll cross point open.
Input Shows the switching matrix input port and the measurement

resource connected to it. Thisinformation is set in the
“Configuration”.

L abel Shows the label set to the measurement resource. The label is
set in the application test definition or the classic test setup.

ALL Checking this box sets al of thislineto close.
Unchecking this box sets all of thisline to open.

Thisbox isgray and have acheck when acrosspoint in thisline
is set to close.

Output Output channels 1 to 12, 24, 36, or 48. Available numbers
depend on the number of the matrix cardsinstalled in the
switching matrix. Thefield below the channel number isused to
enter the label for the output channel.

This button converts the switch setup to the switching matrix setup dataformat of
the classic test, and savesit to the present My Favorite Setup group.
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This button sends the switch setup to the switching matrix.

This button reads the switch setup from the switching matrix.
This button opens all relays on the switching matrix.

The switch setups you create MUST be saved to the preset group to reuse them.

Click the Preset List button to display the menu that provides the following
functions. Select the preset group by using the field below the button. The switch
setups can be recalled by using the area below the field.

Cancel Closes the menu.
Preset Group Provides the following three functions.

Add New Preset Group  Opensthe Add Preset Group dialog box. Creates anew
preset group and saves it as the specified name.

Rename This Preset
Group Opens the Rename Preset Group dialog box. You can
change the name of the selected preset group.

Duplicate This Preset

Group Opens the Duplicate Preset Group dialog box. Creates
acopy of the present preset group and savesit asthe
specified name.

Delete ThisPreset Group You can delete the selected preset group.

Organize Preset Group... Opensthe Organize Preset Group dialog box used to
organize the preset group. See “Organize Preset
Group” on page 4-33.

Rename You can change the name of the selected switch setup.
Duplicate Creates a copy of the selected switch setup.

Delete Deletes the selected switch setup.

Delete All Deletes al switch setupsin the present preset group.

The button saves the present switch setup into the present preset group as a new
setup of the group.

The button recalls the selected switch setup. This means opening and displaying the
definition of the selected switch setup.
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Sandby Channel Definition

The Standby Channel Definition window is opened by clicking the Standby button,
and is used to define the standby channels and set the standby mode. See “ Standby
Function” on page 7-37.

The standby channel is the channel for maintaining specified output when the
standby mode is ON and in the non-measurement state. The standby channels will
be in the standby state, while the other channelswill bein theidle state whichisOV
output and 100 pA compliance. When the standby mode is OFF and in the
non-measurement state, all channelswill bein theidle state.

This area provides the following button.

Standby ON/OFF

Sets the standby mode ON or OFF.

This area defines the standby channels. The standby channels will start to output in
order, from the top to bottom, aslisted in this area. The order of bias stop is bottom

to top.

Sandby Check the check box to specify the standby channel.
The radio button is used to select the channel setup available for
the Up/Down button.

Unit SMU (Source Monitor Unit) used for the standby output
Standby channel cannot be set for the HRSMU connected to the
ASU (Atto Sense and Switch Unit) which makes the path to the
AUX port.

Mode Output mode, V (voltage) or | (current)

Source Standby channel output value, inV or A

Compliance Compliance value, in A or V. Enter the current limit value for
the voltage source, or the voltage limit value for the current
source.

Up Moves the selected channel setup upward. To select a channel
setup, use the radio button on the left.

Down Moves the selected channel setup downward.
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Data Display

The Data Display window is opened by clicking the Data Display button, and is
used to display measurement data and analyze the data.

» “DataDisplay GUI"”

* “Display Setup”

* “Graph Properties”

» “List Display Properties’
* “Tool Bar”

+ “DataStatus’

» “Miscellaneous Operations’
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About Display Mode

The Data Display window provides two display mode Overwrite and Append.

In Overwrite mode, the “ Display Data (page 4-15)" function opens a new Data
Display window and displays data.

In Append mode, the “ Display Data (page 4-15)” function creates a new display
layer on the present Data Display window and displays data.

Updating Data Calculation

When the classic test result is displayed, you can update the cal culation results of the
user function, analysis function, and auto analysis function. So use the Apply
button. See “Function Setup (page 5-42)".

Append M easurement

After the Append measurement, you will see tabs between the tool bar and the graph
plot area. The tabs are used to select the display layer for data display and analysis
operation. The Data Display window can have maximum 10 display layers.

Multi Display Function

In the Multi Display OFF status, the test result datawill be always displayed on the
singular Data Display window even if the test setup is changed.

In the Multi Display ON status, the test result data of the same test setup name will
be displayed on the exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display window.

The settings on the Display Setup are applied to the X-Y Graph on the Data Display
window. The X-Y Graph can handle one X dataonthe X axisand up to eight Y data
ontheY axis.

Define the X axis carefully when plotting Multi Channel I/V Sweep measurement
results that may contain data measured by multiple VAR1 channels, as the result
may contain multiple X datathat can be selected for the X axis.

The Display Setup must be set properly to match the X axis data and the X data of
the plot to be displayed.
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Data Display GUI
Thisfield just displays the name of the test setup used to get this test record.

This area displays the measurement result graph, traces, marker, cursor, and lines.
The Properties button opens “ Graph Properties (page 4-63)".

This area lists the user-defined output parameters if the output parameters are set.

This area displays the measurement result data list. The Properties button opens
“List Display Properties (page 4-64)”.

The Data Display window can keep up to 10 display layers. And the earliest layer
over 10 will be automatically deleted. This button is available when the window
keeps at least two layers. If this button shows the standing pin, the layer will be kept.
If this button shows the laid pin, the layer can be deleted.

Double clicking the tab gives the same result as this button.
This button closes the selected display layer.

Provides the following functions.

Switch to Append Mode/
Switch to Overwrite Mode  Used to switch the display mode.

Update Test Result Stores the information of the scale and the analysis
toals.

Delete Test Result Deletes the present display data or the selected
display layer.

Close This Display Closes the selected display layer.

Close All Displays Closes all display layers.

Save Image As... Opens the Save Image As... dialog box used to

specify the file name of the graph image to save.
See Figure 4-3. Available data formats are the
BMP, EMF, GIF, and PNG

Page Setup... Opens the Page Setup dialog box used to set the
print page.
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Print Preview

Opens the Print Preview dialog box used to specify
Print Range/Data to print/Scaling of the graph
image to display. Clicking the Preview button
opens the Print preview window. See Figure 4-4.

» Print Range sets Whole Data Display window
or Graph Only.

» Datato print sets Current Data Display window
only or All Data Display windows now opened.

» Scaling sets Adjust To the specified percent of
the normal size or Fit To Page (automatic
adjustment).

Print... Opens the Print dialog box used to specify Print
Range/Data to print/Scaling (see Print Preview) of
the graph image to print. See Figure 4-3. Clicking
the Next button opens another Print dialog box used
to select the printer, print range, and number of
copies, and start print.

Close Closes the Data Display window.

Figure4-3 Save Image As... and Print...
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Figure4-4 Print Preview Example
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Edit menu Provides the following functions.

Copy When the X-Y Graph Plot areais active, this
function copies the graph image as BMP and EMF
into the clipboard.

When the line cursor in the List Display areais
active, this function copies the datalist as CSV.
When the Parameters areais active, this function
copies the parameter data as CSV.

Copy Graph Copies the graph image as BMP and EMF into the
clipboard.

Copy List Copiesthelist dataas CSV.

Copy Parameters Copies the parameter data as CSV.

Graph Properties... Opens “ Graph Properties (page 4-63)”.

List Display Properties... Opens “List Display Properties (page 4-64)".
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Figure 4-5 shows the graph copy and paste example. Click the X-Y Graph Plot area
on the Data Display window, select Edit > Copy menu, and paste it to WordPad. You
will see the result as shown in this example.

Figure 4-5 Graph Copy and Paste
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Figure 4-6 shows the list copy and paste example. Click aline of the List Display
area on the Data Display window, select Edit > Copy menu, and paste it to Notepad.
You will seethe result as shown in this example. The datain Notepad isa CSV data
(separated by acomma). Save it as atext file and open it by using a spreadsheet
software. Each data (comma separated value) will be entered to a separate cell.

Figure 4-6 List Copy and Paste
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Provides the following functions.

X-Y Graph

List Displays
Parameters

Graph Legend ON/OFF

Line Information ON/OFF

Open Preview Window

Auto Scale

Run Time Auto Scale

Zoom In

Zoom Out

Cancel Scaling

Choose ActiveY Axis

Display Setup...

Displays or hides the X-Y Graph Plot area.
Displays or hidesthe List Display area.
Displays or hides the Parameters area.

Displays or hides the graph legend below the plot
area.

Displays or hides the line information (X-intercept,
Y-intercept, gradient) in the plot area.

Opens “Preview (page 4-74)" and “Preview
Settings (page 4-76)”.

Changes graph scale to fit the trace in the graph
automatically.

Enables or disables the run time auto scaling. This
function is set to independently for the X and Y
axes.

If this function is enabled, the graph scale will be
changed automatically to fit the trace in the graph
during the measurement.

Zooms the data graph in the cursor. If the cursor is
not displayed, zooms the data graph in the last
cursor position or the graph center. This enlarges
the trace in the graph.

Zoomsthe data graph out the cursor. If the cursor is
not displayed, zooms the data graph out the last
cursor position or the graph center. Thisreducesthe
trace in the graph.

Returnsto the initial graph scale. This Display
works only for the selected layer. All Displays
works for the all display layers.

Selects the Y-axis that is effective for the marker
control and the auto scale.

Opens “Display Setup (page 4-62)".

If multiple layers are opened on the Data Display window, the scale change is
applied to all layers. This means that the X-Y graph scale will be shared by all
display layers. The auto scaling is performed as follows.
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1. Graph scaleis optimized for the data on the selected layer (top layer).

2. The graph scaleis applied to the graph in al layers.

Note that auto scaling is performed independently for the left and right Y axes.
Marker can move on the measurement data curve. The Marker menu provides the
following six functions.

Marker ON/OFF Enables or disables the marker.

I nter polation ON/OFF Enables or disables the interpolation function of
measurement data. You can read the interpolation
data between two actual measurement points.

Skip Moves the marker to the next measurement curve
that is added by the VAR2 variable.

Go ToMaximum Moves the marker to the maximum value point.

Go ToMinimum Moves the marker to the minimum value point.

GoTo.. Opensthe Direct Marker/Cursor dialog box used to

specify the coordinate values to move the marker.

Cursor can move anywhere on the graph. The Cursor menu provides the following
three functions.

Cursor ON/OFF Enables or disablesthe cursor.
GotoMarker Moves the cursor to the marker position.
Goto... Opensthe Direct Marker/Cursor dialog box used to

specify the coordinate values to move the cursor.

Provides the following five functions. When aline is enabled, gradient, X-intercept,
and Y-intercept are displayed in the graph. See Figure 4-7.

Line 1 ON/OFF Enables or disablesline 1.
Line 2 ON/OFF Enables or disablesline 2.
Line Mode Selects the line mode: normal, gradient, tangent,

regression, or fix.

Adjust Gradient Available when agradient line is active. Checking
this function enables the rotary knob and the mouse
wheel to increase/decrease the gradient of the line.
Unchecking this function, clicking the rotary knob,
or clicking the mouse wheel disables this function.
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Opens the Gradient Value dialog box used to
specify the gradient value of the gradient line.

You can draw aline as shown below:

1. SetLinelorLine?2on.
2. Select aLine Mode.

Normal

Gradient

Tangent

Regression

Fix
Figure4-7 Line Mode

Normal line

A line and two cursors appear. Move cursors to the points
where the line passes through.

A line and a cursor appear. Move cursor to the point where
the line passes through. Enable Adjust Gradient function,
then increase/decrease the gradient of the line by using the
rotary knob or the mouse wheel.

A line appears. Set the marker on. The tangent line appears
on the marker point.

A line and two cursors appear. Move cursors for specifying
the measurement data used for the regression calculation.
The calculation is executed by using the dataincluded in the
square drawn by the extended cross cursor lines. For the
subordinate sweep measurement data, specify the datacurve
by using the marker.

Fixesthe line on the graph.

Gradient line Tangent line Regression line

1 cursor marker 2 cursors
qradient data curve measured data

e
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Up to 20 texts can be added to a graph. The following functions are provided.

New Opens the text editor for adding a new text.
Hide All/ Show Al Hides or shows all texts.
Delete All Deletes dl texts.

Clicking on atext will select the text. To select multiple texts, click the texts while
holding down the Shift key on the keyboard.

The following functions are available for the selected text(s) via the Text menu, the
Text icons, or the right-click menu.

Edit Mode Edits the selected text.

Size Sets the font size of the selected text(s). The
available setting values are Largest, Large,
Medium, Small, Smallest, and Fixed Point (6, 7, 8,
9, 10, 11, 12, 14, 16, 18, or 20). For settings other
than Fixed Point, an appropriate size will
automatically be applied. For Fixed Point, the
specified font size will always be applied.

Font Sets the font of the selected text(s).

Text Color Sets the text color of the selected text(s). Click
Customize to open the color palette.

Background Color Sets the background color of the selected text(s).
Click Customize to open the color palette.

Hide Frame/Show Frame Hides or shows the frame for the selected text(s).
Delete Deletes the selected text(s).

4-60 Agilent B1500 User’s Guide, Edition 7



Pointer menu

Window menu
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Up to 30 pointers can be added to a graph. The following functions are provided.

New This function is enabled when the marker is ON.
Adds anew pointer at the position of the active
marker.

Hide All/ Show Al Hides or shows all pointers.

Show All Descriptions Shows all descriptions (pointer ID and X-Y
coordinate values) of the pointers.

Hide All Descriptions Hides all descriptions of the pointers.

Delete All Deletes al pointers.

Clicking on apointer will select the pointer. To select multiple pointers, click the
pointers while holding down the Shift key on the keyboard.

The following functions are available for the selected pointer(s) via the Pointer
menu, the Pointer icons, or the right-click menu.

Shape Sets the shape of the selected pointer(s).

Hide Description/Show

Description Hides or shows the description of the selected
pointer(s).

Delete Deletes the selected pointer(s).

Provides the three functions bel ow. The functions work for opened windows.

Tiling Tilesall Data Display windows on the screen.
Sacking Stacks all Data Display windows on the screen.
Overlaying Overlays all Data Display windows on the screen.

Then the position, window size, and visibility of the
most front window are applied to all windows on
the screen. The background of the X-Y Graph area
is cleared except for the most back window.

Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.

Agilent B1500 User’s Guide, Edition 7 4-61
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List Display,
Parameters
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Display Setup

This setup screen is displayed by selecting View > Display Setup..., and is used to
select the data displayed in the Data Display window.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8

axes can be set.
Name

Sharing

Scale
Min
Max
Add
Delete
Up

Down

Specifies the parameter for the axis.

Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (no grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale of the axis, Linear or Log

Minimum value of the axis

Maximum value of the axis

Adds a parameter (or axis).

Deletes the parameter selected with the radio button on the lft.
Moves the selected parameter upward.

Moves the selected parameter downward.

Selects the data displayed in the List Display area or the Parameters area. Up to 20
parameters can be set for each area.

parameter Specifies the parameter for the data output.

Add Adds arow for the parameter.

Delete Deletes the parameter selected by the left radio button.

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.
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Graph Color

Graph Trace Color

Log Scale

Text Size
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Graph Properties

This dialog box is opened by clicking the Properties... button in the X-Y Graph Plot
areaor by selecting Edit > Graph Properties..., and is used to set the graph plot area.
Click the OK button to apply the setup and close this dialog box.

This area provides the following check box.
Grid ON Check this button to display the grid on the X-Y Graph.
Thisareais used to set the color map for the graph plot area. You can change the

color of the background, text, graph grid, and line/cursor. The color paletteis
opened by clicking the pattern of the item.

Thisareais used to set visibility, color, and thickness of the datatracesY1to Y8
plotted on the graph. The color palette is opened by clicking the pattern of the item.

This areais used to set the maximum number of decades to show the minor ticks on
thelog axis. If the number of graph decadesis lessthan or equal to the entered
value, the minor ticks are displayed. If it is greater than the entered value, the minor
ticks are not displayed.

Thisareais used to set the font size for the graph. The available settings are Largest,
Large, Medium, Small, Smallest, and Fixed. For settings other than Fixed, the
appropriate size is automatically selected. For Fixed, afont size entry field is
provided, and the specified font sizeis always applied.

X/Y AxisTitle Font size for the axistitle
Scale Font size for the X and Y coordinate values

Legend Font size for the graph legend
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Display

Number Format

Switch Display
Mode

Close All Displays
Show X-Y Graph
Show List Display

Show Parameters
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List Display Properties

Thisdialog box is opened by clicking the Properties... button in the List Display
area or by selecting Edit > List Display Properties..., and is used to set the data
display format in the List Display area. Click the OK button to apply the setup and
close this dialog box.

Check the following check box to add the data status or the physical unit to data.
Unchecking the box removesit.
Data Satus Adds or removes the status code before data.

Physical Unit Adds or removes the physical unit after data.

Selects the data display format from the following formats.
» Engineering Format (Example: - 1. 2345 mA)
Data display with arithmetic point, SI prefix, and unit.
» Scientific Notation (Example: - 1. 23456789012345E- 003 A)

Data display with arithmetic point, exponential part (E, +/- sign, and three-digit
number), and unit.

Tool Bar

The Data Display window provides the 22 icons on the tool bar. You will see the
following icons from left to right in the Data Display window.

Thisicon switches the display mode.

In Overwrite mode, the “ Display Data (page 4-15)" function opens a new Data
Display window and displays data.

In Append mode, the “Display Data (page 4-15)” function creates a new display
layer on the present Data Display window and displays data.

Thisicon closes al display layers.
Thisicon displays or hides the X-Y Graph Plot area.
Thisicon displays or hides the List Display area.

Thisicon displays or hides the Parameters area.
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Auto Scale

Zoom In

Zoom Out

Display Setup...

Choose Active
Y-axis

Marker ON/OFF

Interpolation
ON/OFF

Marker Skip

Marker Maximum

Using EasyEXPERT
Data Display

Thisicon will change the graph scale automatically to fit the trace in the graph.

Theright arrow button opens the menu for enabling or disabling the run time auto
scaling. Thisfunction is set independently for the X and Y axes. If thisfunction is
enabled, the graph scale will be changed automatically to fit the trace in the graph
during the measurement.

If multiple layers are opened on the Data Display window, the scale change is
applied to all layers. This means that the X-Y graph scale will be shared by all
display layers. The auto scaling is performed as follows.

1. Graph scaleis optimized for the data on the selected layer (top layer).
2. Thegraph scaleis applied to the graph in al layers.

Note that the auto scaling is performed independently for the left and right Y axes
individually.

Thereisalso afunction for resetting the graph scale. Click View > Cancel Scaling >
This Display or All Displays. This Display will reset the selected layer only. All
Displayswill reset for the all display layers.

Thisicon zooms the data graph in the cursor. If the cursor is not displayed, zooms
the data graph in the last cursor position or the graph center. This enlarges the trace
in the graph.

Thisicon zooms the data graph out the cursor. If the cursor is not displayed, zooms
the data graph out the last cursor position or the graph center. This reduces the trace
in the graph.

Thisicon opens “Display Setup (page 4-62)".

Thisicon selects the Y-axis that is effective for the marker control and the auto
scale.

Thisicon enables or disables the marker.

Thisicon enables or disables the interpolation function of measurement data. You
can read the interpolation data between two actual measurement points.

This icon moves the marker to the next measurement curve that is added by the
VAR2 variable.

This icon moves the marker to the maximum measurement point.
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Marker Search...

Line 1 State

Line 2 State

Cursor to Marker

Adjust Gradient

Show Graph
Legend

Show Line
Information
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Data Display
This icon moves the marker to the minimum measurement point.

Thisicon opens the Direct Marker/Cursor dialog box used to specify the coordinate
values to move the marker.

Thisicon enables or disablesline 1 and its function: disabled, normal, gradient,
tangent, regression, or fix.

Thisicon enables or disablesline 2 and its function: disabled, normal, gradient,
tangent, regression, or fix.

This icon moves the cursor to the marker position.

Thisiconisavailable when aregression lineis active. Clicking thisicon enables the
rotary knob and the mouse wheel to increase/decrease the gradient of the line.
Clicking thisicon again, pressing the rotary knob, or pressing the mouse wheel
disables this function.

Thisicon displays or hides the graph legend below the plot area.

Thisicon displays or hides the line information (X-intercept, Y-intercept, gradient)
in the plot area.
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Data Satus

If measurement unit detects any status while measurement, the status code is
recorded with the measurement data. And the status code will be displayed in the
Data Display window as shown in the following example.
Example e X-Y Graph Plot area
MARKER( 5.9000000 C 1.82520000 XV 3.33249E-3 )

Thislinewill be displayed at the top of the plot area when marker is ON. The
marker is used to read data of the marker point.

e ListDisplay area

| ndex Vi V2 12
123 5.9 V C 1.8252 V XV 3.33249 mA
Status Code SMU status code:

e C: Compliance

e T: Other channel compliance
* X: Oscillation

* V:Overflow

MFCMU status code:

e U: Unbalance
e D: I/V amp saturation

* V: Overflow

Agilent B1500 User’s Guide, Edition 7 4-67



Using EasyEXPERT
Data Display

Miscellaneous Oper ations

The following user interfaces provide several miscellaneous functions when you
operate the Data Display window.

*  “Mouse/Touch Panel”
* “Rotary Knob”

o “Softkeys’

»  “Keyboard’

M ouse/Touch Panel

While the Data Display window is focused, the mouse/touch panel operations
shown in Table 4-7 (p. 4-72) are available.

Rotary Knob

The following miscellaneous functions are available by using the rotary knab.

e Marker movement in the VARL1 direction

While the Data Display window is focused and the marker is displayed on the
graph, the rotary knob can be used to move the marker. Rotating the knob fast
increases the marker speed.

* Marker movement in the VAR2 direction
Clicking the knob moves the marker in the VAR2 direction.
e Slope adjustment of the gradient line

In the slope adjustment mode (Line > Adjust Gradient) for the gradient line, the
rotary knob can be used to adjust the slope. Clicking the knob quits this mode.

e Pointer movement in the VARL direction
Therotary knob can be used to move the selected pointer. The pointer can not be
moved in the VAR2 direction.

Softkeys

The softkeys can be used for setting the following fields on the Display Setup (p.
4-62) window.

» Name (parameter name)

» Scae(Linear or Log)
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While the Data Display window is focused, the key operations shown in Table 4-2

are available.

Miscellaneous K ey Operations on Data Display Window

Key Description
F1 Displaysthe online help
F2 Shortcut to View > X-Y Graph
F3 Shortcut to View > List Display
F4 Shortcut to View > Parameters
F12 Changes the display mode, Append — Overwrite — Append
Ctrl+W Shortcut to File > Close This Display
Ctrl+Shift+W | Shortcut to File > Close All Displays
Ctrl+S Shortcut to File > Save Image As...
Ctrl+P Shortcut to File > Print...
Ctrl+C Shortcut to Edit > Copy

While the X-Y Graph (graph display area) is focused, the key operations shown in
the following tables are available.

» Table4-3, “Controlling X-Y Graph.”
o Table4-4, “Controlling Marker.”

» Table4-5, “Controlling Cursor.”

» Table4-6, “Controlling Line.”
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Table 4-4
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Controlling X-Y Graph

Key Description
S Shortcut to View > Auto Scale
z Shortcut to View > Zoom In
Shift+z Shortcut to View > Zoom Out
Ctrl+z Shortcut to View > Cancel Scaling
Y Changesthe activedata, Y1 > Y2 —> ... > Y8 > Y1
R Activatestheright Y axis and changes the data set to the axis,
Y2-5Y3—>5..5Y8>Y2
W Shortcut to View > Graph Legend ON/OFF
K Shortcut to View > Line Information ON/OFF

Controlling Marker

Key Description

M Shortcut to Marker > Marker ON/OFF

I Shortcut to Marker > Interpol ation ON/OFF

F Moves the marker +1 2in the VAR1 direction
Shift+F Moves the marker +10 2in the VAR1 direction

B Moves the marker - 1 2in the VAR1 direction
Shift+B Moves the marker - 10 2in the VAR1 direction

P Moves the marker +1 2in the VAR direction
Shift+p Moves the marker - 1 2in the VAR2 direction

J Shortcut to Marker > Go To...

X Shortcut to Marker > Go To Maximum

N Shortcut to Marker > Go To Minimum

a. Multiply 1/10if the interpolation is ON.
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Table 4-6

Using EasyEXPERT

Data Display
Controlling Cursor
Key Description
C Shortcut to Cursor > Cursor ON/OFF
T Shortcut to Cursor > Go To Marker
) Movesthe cursor +1/1000 in the Y axis direction
Shift+ T Moves the cursor +1/100 in the Y axis direction
- Moves the cursor +1/1000 in the X axis direction
Shift+ — Movesthe cursor +1/100 in the X axis direction
d Moves the cursor - 1/1000 in the Y axis direction
Shift+ 4 Movesthe cursor - /100 in the Y axis direction
“— Movesthe cursor - 1/1000 in the X axis direction
Shift+ « Moves the cursor - 1/100 in the X axis direction
Controlling Line
Key Description
12 Shortcut to Line > Line 1 ON/OFF
oa Shortcut to Line > Line 2 ON/OFF
\% Changesthe activeling, Linel — Line2 — Line 1
(availableif both line 1 and line 2 are ON)
L Changes the line mode of the active line,
Normal — Gradient — Tangent — Regression — Normal
G Shortcut to Line > Adjust Gradient

a. 1 and 2 on the numeric pad cannot be used.
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Table 4-7 Mouse/Touch Panel Operationson Data Display Window
Location Operation Description
X-Y Graph clickingontheleft | Activatesthe Y1 data

Y axis

clicking on the
right Y axis

Activatesthe data of theright Y axis, or changesthe active data
if itisaready active.

clicking on a plot

Moves the marker to the position of the mouse pointer if the
marker is displayed on the graph.

clicking on a cursor

Specifies the active cursor if multiple cursors are displayed.

dragging a cursor

Moves the cursor.

clicking on aline

Specifies the active line if multiple lines are displayed.

clicking on atext

Selects the text.

Clicking with pressing the Shift key on the keyboard selects
multiple texts.

dragging a text

Moves the text.

clickingon a Selects the pointer.

pointer Clicking with pressing the Shift key on the keyboard selects
multiple pointers.

clickingon a Selects the description of pointer.

description of Clicking with pressing the Shift key on the key board selects

pointer ) i .
multiple descriptions of pointers.

dragging a Moves the description of pointer.

description of

pointer

rotating the mouse
wheel

Moves the marker if the marker is displayed on the graph,
moves the pointer if the pointer is selected, or adjusts the slope
of the gradient lineif it isin the slope adjustment mode (Line >
Adjust Gradient).
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L ocation Operation Description

X-Y Graph clicking the mouse | Same as clicking the rotary knob.

wheel Thisiseffective if the mouse properties assign the center button
functions to the wheel button.

List Display dragging acolumn | Moves the column.
heading
dragging boundary | Changes the width of the column.
of the column
clickingonarowin | Movesthe marker to the corresponding position.
the table
moving the scroll Changes the data displayed in the List Display area.
bar Scroll is effective for both portrait and landscape.
rotating the mouse | Changes the data displayed in the List Display area.
wheel

Others Specifies the display layer for the data display and analysis.

clicking on atab?
under the tool bar

double clicking on

Changes the status of the pin marked to the display layer.

ata}bs under the Standing pin must be marked to the display layer to be kept.
tool bar
Laid pin is marked to the display layer under the automatic
delete.
dragging boundary | Adjuststhe size of the display area (X-Y Graph, List Display,
of the display area | Parameters) without changing the window size.

dragging the frame
of the Data Display
window

Changes the window size with adjusting the size of the display
area (X-Y Graph, List Display, Parameters).

a. Tabisdisplayed if the display mode is Append and the test result record contains the append
measurement data.
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Parameters
List Display

File menu
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Preview

The Preview window and the Preview Settings dialog box are opened by selecting
View > Open Preview Window in the Data Display window. The Preview Settings
dialog box is used to set the graph title, X axistitle, Y axistitle, and line style. And
the Preview window displays a new plot, and is used to output it to the specified
printer.

The Data Display window cannot do the above settings and display the new plot.
*  “Preview Window GUI”
*  “Preview Settings’

Preview Window GUI

The Preview window provides the following GUI.

Thisfield just displays the name of the test setup used to get this test record.

This area displays the measurement result graph, traces, marker, cursor, and lines.
This area lists the user-defined output parameters if the output parameters are set.
This area displays the measurement result data list.

Provides the following functions. See also Figure 4-3 and Figure 4-4.
Page Setup... Opens adialog box used to set the print page.

Print Preview Opens a dialog box used to specify the data graphs
to make previews. After selecting the graphs,
previews appear on the Print preview window.

Print... Opens adialog box used to specify the print target.
After selecting the target, the Print dialog box is
opened. The dialog box is used to start print.

Close Preview Window Closes the Preview window.
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View menu

Help menu
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Preview

Provides the following functions. See also Figure 4-5 and Figure 4-6.

Copy While the X-Y Graph Plot areais active, this
function copies the graph image as BMP and EMF
into the clipboard.

While theline cursor inthe List Display areais
active, this function copies the datalist as CSV.

While the Parameters areais active, this function
copies the parameter data as CSV.

Copy Graph Copies the graph image as BMP and EMF into the
clipboard.

Copy List Copiesthelist dataas CSV.

Copy Parameters Copies the parameter data as CSV.

Provides the following functions.

X-Y Graph Displays or hidesthe X-Y Graph Plot area.
List Displays Displays or hidesthe List Display area.
Parameters Displays or hides the Parameters area.
Preview Settings... Opens “ Preview Settings (page 4-76)".

Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.
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X/Y Axis Title

Line Style

Color and
Thickness...

OK
Cancel
Apply

Reset

Using EasyEXPERT
Preview

Preview Settings
The Preview Settings dialog box provides the following GUI.

Defines the graph title in the Graph Title field. Thetitle will appear at the bottom of
the plot area.

Definesthe X axistitleinthe X field and the Y axistitleintheY field, Y1to Y8.
Thetitle will appear near the axis.

Selectsthe line style for theline 1, line 2, and trace Y1to Y 8.

Opens the Color and Thickness dialog box that provides the same GUI as “ Graph
Properties (page 4-63)”.

Applies the setup to the Preview window, and closes this dialog box.
Cancels the setup, and closes this dialog box.
Applies the setup to the Preview window.

Clears the setup and returns to the default setting.
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Reset
OK
Cancel

Miscellaneous,
Save As

Miscellaneous,
Quotation

Identification
section

Table 4-8

Using EasyEXPERT
Text File Export settings

Text File Export settings

This dialog box is opened by clicking Results > Transport Data > Text File Export
Settings... or the Settings button on the Test Results Data Folder Export dialog box
or the Test Results Data Auto Export dialog box. This dialog box is used to define
the style of the test record exported by the Export As Text File function.

Appliesthe default value to the all setup items.
Defines and memorizes the present setting, and closes this dialog box.
Cancels and clears the setting changes, and closes this dialog box.

Specifies the delimiter (data separator) and file extension. CSV (comma separated,
.csv, default), Text (tab separated, .txt), or Formatted Text (space separated, .prn).

Specifies the quotation for the string values. Single (single quotes), Double (double
guotes), or None (no quote, default). Even if None is specified, the string which
contains delimiter and/or new line character will be double quoted.

Record items which are used to identify and characterize the test record. They area
sub set of the meta data, test type, and test name. See Table 4-9 for the definition of
the record items. Check the box for the items you want to record, and uncheck the
box for the items you do not want to record. In the default, al items are checked.

The pull-down menu specifies the action for recording the itemsin the I dentification
section. See Table 4-8 to specify the action.

Actionsfor Identification and Setup Data Items

Action Description

Save with measurement data | The checked items are recorded in the test record
with the measurement data. Default.

Do not save No item isrecorded even if any box is checked.

Save as separate file The checked items are recorded in a separatefile.
The name will be the test record’s file name plus
- s before the extension.
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Table 4-9 Identification Section Record Items

Item Description

Setup title | Test setup name

Classictest | Classic test name. I/V Sweep, Multi Channel I/V Sweep, 1/V-t
name Sampling, C-V Sweep, SPGU Control, Switching Matrix Control,
or Direct Control. This record item is exclusive against the
“Application test name” record item.

Application | Application test name. Thisrecord item is exclusive against the
test name “Classic test name” record item.

Test date Test execution date corresponding to the date part of the
RecordTime meta data.

Test time Test execution time corresponding to the time part of the
RecordTime meta data.

DevicelD Device ID corresponding to the TestTarget meta data.

Count Test count corresponding to the Iterationlndex meta data.
Flags Flags set to the test result data, corresponding to the Flag meta
data.

Remarks Remarks set to the test result data, corresponding to the Remarks
meta data.

Setup data section Record itemswhich describesthe test conditions. They are the test parameters, DUT
parameters, and analysis setup. See Table 4-12 for the definition of the record items.
Check the box for the items you want to record, and uncheck the box for the items
you do not want to record.

Tag information for the setup datais string value; TestParameter, DutParameter, or
AnalysisSetup, which means the type of data put in the same row in the exported
test record. If Tag information box is unchecked (default), the tag information is not
recorded. Then, the setup parameter names, such as Channel.Unit, are recorded in
the first column in the test record and the parameter values are recorded in the
following columns. If the Tag information box is checked, the tag information is
recorded in the first column and the parameter names and values are shifted to the
next columns.

The pull-down menu specifies the action for recording the items in the Setup data
section. See Table 4-8 to specify the action.
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Measurement data Record items of the measurement data. It may contain the measurement parameter

section

Table 4-10

Table 4-11

names, data units, and data size. See Table 4-13 for the definition of the record
items. Check the box for the items you want to record, and uncheck the box for the
items you do not want to record.

Tag information for the measurement data s string value; Dimensionl, Dimension2,
Data Name, Data Unit, or Data Value, which means the type of data put in the same
row (in case of By Row orientation) or column (in case of By Column orientation)
in the exported test record. The tag information will be recorded in the test record if
the Tag information box is checked.

See Table 4-10 for the By Row orientation. All data relative to a measurement
parameter will be put in the same column. The first column (ex. column A) contains
the tag information. For the By Column orientation, see Table 4-11. All datarelative
to a measurement parameter will be put in the same row. And the first row (ex. row
1) contains the tag information. If the Tag information box is unchecked (default),
the tag information is not recorded and the measurement data is shifted.

By Row Orientation Export Example

A B C D E F
1 Dimensionl | 101 101 101 1
2 Dimension2 | 1 1 1 1
3 Data Name Vg Id Gm Vth
4 Data Unit \% A S \%
5 Data Value 0 4.55E-09 1.24E-10 1.23
6 | DataVaue 0.02 8.59E-09 5.25E-10

By Column Orientation Export Example

A B C D E F
Dimensionl | Dimension2 | DataName Data Unit Data Value Data Vaue
101 1 Vg \% 0 0.02
101 1 Id A 4.55E-09 8.59E-09
101 1 Gm S 1.24E-10 5.25E-10
1 1 Vth \% 1.23
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Setup Data Section Record Items (ON: checked, OFF: unchecked)

Item Description Default
Test parameters | Test parameters defined by the classic test or the ON
application test.
DUT parameters | DUT parameters defined by the application test. ON
Analysis setup Data Display setup status at and after the OFF
measurement, such as Graph configuration, Graph
format, Graph text, Marker configuration, Cursor
configuration, Line configurations, Pointer
configuration, List configuration, and Scalar list
configuration.
Measurement Data Section Record Items (ON: checked, OFF: unchecked)
Item Description Default
Data names | Measurement parameter name. ON
Dataunits | Unit of measurement data. OFF
Size Dimensionl (VARL size) and Dimension2 (VAR2 size) OFF
of the measurement data.
Datavalues | Record items can be specified by the following segments.
Segment Default
Data assigned to X-Y Graph ON
Data assigned to List Display ON
Data assigned to Parameter Display ON
User function defined but not displayed OFF
Analysis function defined but not displayed OFF
Any datareferred to by the user function but not OFF
directly displayed
Any datareferred to by the analysis function but not OFF
directly displayed
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Classic Test Definition

This chapter provides the reference information of the graphical user interfacein the
classic test mode of Agilent EasyEXPERT software.

“IIV Sweep”

“Multi Channel I/V Sweep”

“I/V List Sweep”

“1/V-t Sampling”

“C-V Sweep”

“Direct Control”

“Function Setup”

“Auto Analysis Setup”

“Display Setup”

“SMU Range Setup Window”

“ADC and Integration Time Setup Window”
“Advanced Setup Window”

“CMU Range Setup Window”
“Advanced Setup Window for C-V Sweep”
“Switching Matrix Control”

“SPGU Control”

“SPGU Pulse Setup Window”

“Load Z Setup Window”

“Pulse Switch Setup Window”
“SPGU ALWG Setup Window”
“Define ALWG Waveform Window”

To perform measurement, see “Main Screen” on page 4-10.

To display measurement data and perform data analysis, see“ Data Display” on page
4-51.

To perform self-test or diagnostics, see “Configuration” on page 4-41.

To perform self-calibration, see “ Calibration” on page 4-35.
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NOTE

If You Use GNDU (Ground Unit)
Keep to the following rule to use the ground unit.

1. Set Modeto COMMON.
2. Set Function to CONST.

3. Do not use the | Name assigned to the ground unit.

Missing any one will cause an execution error.

Classic Test Definition

Agilent B1500 User’s Guide, Edition 7
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
I/V Sweep

1/V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V
Sweep icon. The main screen displaysthe I/V sweep test setup screen. For the
measurement mode, see “1/V Sweep Measurement” on page 7-3.

Used to set the name of test setup. The name must be the identification for the test

setup saved to a My Favorite group (preset group). Enter a unique namethat is
distinct from other definitions.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “Channel Setup” on page 5-5.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
5-6.

This tab displays the Function Setup screen. See “Function Setup” on page 5-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 5-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 5-46.
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Channel Definition

Miscellaneous
Variables

Classic Test Definition
I/V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data
Mode Output mode. For SMU, V (voltage), | (current), VPULSE

(voltage pulse), IPUL SE (current pulse), or COMMON
(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), VARL' (synchronous sweep), or CONST (constant)

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
left radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the dataindex. Integer above O is returned.
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VAR1

Classic Test Definition

I/V Sweep

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Unit Source monitor unit (SMU) used for the VAR1 output

Name Variable name for the VAR output data

Direction Sweep direction, single (start to stop) or double (start to stop to
start)

Linear/Log Sweep output, LINEAR, LOG10, LOG25, or LOG50. where
the number following LOG means the number of sweep points
in one decade.

Sart Sweep start value

Sop Sweep stop value

Sep Incremental step value of the sweep output

No of Step Number of steps. The value is automatically calculated by using
the start, stop, and step values.

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF
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VAR2

VARY’

Timing

Classic Test Definition
I/V Sweep

This area defines the secondary sweep source output.

Unit
Name
Sart
Sop

Step
No of Step

Compliance

Pwr Comp

Source monitor unit (SMU) used for the VAR2 output
Variable name for the VAR2 output data
Sweep start value

Sweep stop value. The value is automatically calculated by
using the start, step, and number of step values.

Incremental step value of the sweep output
Number of sweep steps

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the synchronous sweep source output. The VAR’ output is given
by the following formula.

VARY' output = Offset + Ratio x VARL output

Unit

Name
Offset
Ratio

Compliance

Pwr Comp

Source monitor unit (SMU) used for the VAR1' output
Variable name for the VARL' output data

Offset value

Ratio value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 7-59.

Hold

Delay

Hold time. Thisisthe time from beginning of channel output to
beginning of delay time. 0to 655.35 s, 10 ms resolution.

Delay time. Thisisthe time from end of hold time to beginning
of measurement. The measurement channels start measurement
as soon as the wait time elapses. 0t0 65.535 s, 0.1 ms
resolution.
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Constant

SMU Pulse

Sweep status

Range

ADCl/Integ

Advanced

SPGU Pulse/
ALWG Setup

Classic Test Definition
I/V Sweep

This area defines the constant output source.

Unit Source monitor unit (SMU) used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data

Mode Output mode, V (voltage), | (current), VPUL SE (voltage pulse),
or IPULSE (current pulse)

Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

This area defines the SMU pulse timing parameters. See “SMU Pulse” on page
7-56.

Unit Source monitor unit (SMU) used for the pulsed output
Period Pulse period. 5msto 5's, 0.1 ms resolution.

Width Pulse width. 0.5 msto 2 s, 0.1 ms resolution.

Base Pulse base value

Period and Width must satisfy the following conditions:

* Period > Width + 2 ms (for pulse width < 100 ms)
» Period > Width + 10 ms (for pulse width > 100 ms)

This field specifies the sweep abort condition, continue at any status, or stop at any
abnormal status.

This button opens awindow used to set the measurement ranging operation. See
“SMU Range Setup Window” on page 5-48.

This button opens awindow used to set the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 5-50.

This button opens awindow used to set the other functions of the measurement
channel. See “ Advanced Setup Window” on page 5-51.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 5-59 or “SPGU ALWG Setup Window” on page 5-63.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
Multi Channel I/V Sweep

Multi Channel I/V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the Multi
Channel 1/V Sweep icon. The main screen displays the Multi Channel 1/ Sweep
test setup screen. For the measurement mode, see “Multi Channel 1/V Sweep
Measurement” on page 7-12.

Sets the name of the test setup. The nameis used to identify the test setup savedto a
My Favorite group (preset group). Enter a unique name that is distinct from other
definitions.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “Channel Setup” on page 5-10.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
5-11.

This tab displays the Function Setup screen. See “ Function Setup” on page 5-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 5-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 5-46.

Setting of the Display Setup is applied to the X-Y Graph on the Data Display
window. And the X-Y Graph can handle one X datafor the X axisand the maximum
eight Y datafor the Y axis.

Definethe X axis carefully to plot the Multi Channel 1/V Sweep measurement result
which may have the data measured by the multiple VAR channels. Because the
result may also contain the multiple X data which can be the selections of the X
axis.

The Display Setup must be set properly to match the X axis data and the X data of
the plot you look at.
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Channel Definition

Miscellaneous
Variables

Classic Test Definition
Multi Channel I/V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode Output mode. For SMU, V (voltage), | (current), or COMMON

(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), or CONST (constant)

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes selected channel setup. To select achannel, use the
radio button on the left.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Index Name Variable name of the dataindex. Integer above O is returned.
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VAR1

Constant

Classic Test Definition
Multi Channel I/V Sweep

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Direction

Linear/Log

No of Step
Unit
Name
Sart

Sop

Compliance

Pwr Comp

Sweep direction, single (start to stop) or double (start to stop to
start)

Sweep output, LINEAR, LOG10, LOG25, or LOG50 where the
number following LOG indicates the number of sweep pointsin
one decade.

Number of sweep steps

Source monitor unit (SMU) used for the VAR output
Variable name for the VAR output data

Sweep start value

Sweep stop value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the constant output source.

Unit

V Name

| Name

Mode
Sour ce

Compliance

Source monitor unit (SMU) used for the constant source

Variable name for the constant voltage output or measurement
data

Variable name for the constant current output or measurement
data

Output mode, V (voltage) or | (current)
Output value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.
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VAR2

Timing

Sweep status

Range

ADCl/Integ

Advanced

SPGU Pulse/
ALWG Setup

Classic Test Definition
Multi Channel I/V Sweep

This area defines the secondary sweep source output.

Unit Source monitor unit (SMU) used for the VAR2 output

Name Variable name for the VAR2 output data

Sart Sweep start value

Sop Sweep stop value. The value is automatically calculated from
the start, step, and number of step values.

Sep Incremental step value for the sweep output

No of Step Number of sweep steps

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 7-59.

Hold Hold time. Thisis the time between the beginning of channel
output and the beginning of delay time. 0 to 655.35 s, 10 ms
resolution.

Delay Delay time. Thisis the time between the end of the hold time

and the beginning of measurement. The measurement channels
start measurement as soon as the wait time elapses. 0 to 65.535
s, 0.1 msresolution.

This field specifies the sweep abort condition to continue at any status or to stop at
any abnormal status.

This button opens a window for setting measurement ranging operation. See “SMU
Range Setup Window” on page 5-48.

This button opens awindow for setting the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 5-50.

This button opens awindow for setting other functions of the measurement channel.
See “ Advanced Setup Window” on page 5-51.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 5-59 or “ SPGU ALWG Setup Window” on page 5-63.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
I/V List Sweep

I/V List Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V
Sweep icon. The main screen displaysthe I/V List sweep test setup screen.

I/V List Sweep measurement issimilar to 1/V Sweep measurement described in“1/V
Sweep Measurement” on page 7-3.

Changes from the I/V Sweep are listed bel ow.

*  VARLV/VAR?2 step output values are set by using a vector data. Vector data from
aspreadsheet software, either tab separated or comma separated can be copied to
the Define vector data dialog box via the Windows clipboard. See “Define
vector data’ on page 5-18.

* All SMU instaled in the B1500A can be set to VARL.
* VARZY’ isnot supported.
Sets the name of the test setup. The nameis used to identify the test setup savedto a

My Favorite group (preset group). Enter a unique name that is distinct from other
definitions.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “Channel Setup” on page 5-5.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
5-6.

This tab displays the Function Setup screen. See “ Function Setup” on page 5-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 5-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 5-46.
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Channel Definition

Classic Test Definition
I/V List Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, the measurement data, the time stamp data, and the index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data
Mode Output mode. For SMU, V (voltage), | (current), VPULSE

(voltage pulse), IPUL SE (current pulse), or COMMON
(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), or CONST (constant).

If aSMU is set to Mode=VPUL SE or IPULSE:

¢ Number of VAR1 channels must be one or two.

* |f aVAR1 channel is set to Mode=VPULSE, the other
VAR1 channel must be Mode=V.

¢ |f aVAR1 channd is set to Mode=IPUL SE, the other VAR1
channel must be Mode=I.

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the selected channel setup. To select a channel setup,
use the radio button on the | eft.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order.
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Miscellaneous
Variables

VAR1

NOTE

Classic Test Definition
I/V List Sweep

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Index Name Variable name of the data index. Integer above O is returned.

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Unit Source monitor unit (SMU) used for the VAR output

Source Click the grid button to open the Define vector data dialog box.
See “Define vector data’ on page 5-18.

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF

To define VARL/VAR2 step outputs

To define these parameters, create a vector data by using the Define vector data
dialog box which is opened by clicking the grid button in the vector data entry field.
See Figure 5-1.

Available array size for the vector datais as follows (column x row).

*  VARL1 step output value: Nq = 1 x 1001 maximum (initial setting: 1 x 1)
* VAR step output value: N5 = 1 x 1001 maximum (initial setting: 1 x 1)
» Deélay time: N3 =1 x 1001 maximum (initial setting: 1 x 1)

Then, the following formula must be satisfied.

1<NjxN,<128128
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VAR2

Timing

SMU Pulse

Classic Test Definition
I/V List Sweep

This area defines the secondary sweep source output.

Unit Source monitor unit (SMU) used for the VAR2 output
Name Variable name for the VAR2 output data
Source Click the grid button to open the Define vector data dialog box.

See “Define vector data’ on page 5-18.

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 7-59.

Hold Hold time. Thisis the time from the beginning of channel
output to the beginning of delay time. 0to 655.35 s, 10 ms
resolution.

Delay Delay time. Thisis the time between end of step changing and

the beginning of measurement. For thefirst step, thisisthetime
between the end of hold time and the beginning of
measurement. The measurement channels start measurement as
soon as the wait time elapses. 0to 65.535 s, 0.1 ms
resolution.Click the grid button to open the Define vector data
dialog box. See “ Define vector data” on page 5-18.

This area defines the SMU pulse timing parameters. See “SMU Pulse” on page
7-56.

Unit Shows the source monitor unit (SMU) used for the pulsed
output. The setting cannot be changed.

Period Pulse period is not specified. SMU forces the next pulse after a
specified Delay time (Hold time + Delay time for the first
pulse).

Width Pulse width. 0.5 msto 2 s, 0.1 ms resolution.

Base Pulse base value

5-16 Agilent B1500 User’s Guide, Edition 7



Constant

Sweep status

Range

ADCl/Integ

Advanced

SPGU Pulse/
ALWG Setup

Classic Test Definition
I/V List Sweep

This area defines the constant output source.

Unit Source monitor unit (SMU) used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data

Mode Output mode, V (voltage), | (current), VPUL SE (voltage pulse),
or IPULSE (current pulse)

Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

This field specifies the sweep abort condition to continue at any status or to stop at
any abnormal status.

This button opens awindow for setting the measurement ranging operation. See
“SMU Range Setup Window” on page 5-48.

This button opens awindow for setting the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 5-50.

This button opens awindow for setting other functions of the measurement channel.
See “ Advanced Setup Window” on page 5-51.

This button opens awindow used to set the SPGU output. See “SPGU Pulse Setup
Window” on page 5-59 or “SPGU ALWG Setup Window” on page 5-63.
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Figure5-1

NOTE

Classic Test Definition
I/V List Sweep

Define vector data

This dialog box is opened by clicking the grid button in the vector data entry field.
See Figure 5-1. The vector data entry field can be displayed on the followings.

» Application test setup screen which contains the entry field for avector type test
parameter, on the EasyEXPERT main screen or the Test Definition window

» Test Specification setup screen which contains the definition of avector type test
parameter, on the Test Definition window

» Define symbols dialog box for avector type test parameter

The Define vector data dialog box displays the array defined by using the Define
dimensions dialog box opened from the Test Specification setup screen. Figure 5-1
shows the array created by setting Dim1Min=1, Dim1Max=11, Dim2Min=1, and
Dim2Max=3, where Dim1 is the vertical direction (row) and Dim2 is the horizontal
direction (columns). The array index always starts from 1.

Vector Data Entry Field

B 15004 Semiconductor Device Anslgred
o ! Tiain Oy Hek

g e gﬂmlemwmwmv Bt Name: - [samle test parametar setup
i:&"&‘? | Vector data entry field
Elowesos | Grid button
g CtanoTech x| \
5 Ubrary | [Test Paranleters /
A / i
E Tmg vth o
Parami: Ii il I
@
st paramz: 0 &)

f.'? Param3: W LH -l

Define vector data

o] _ow |

Rotary knob and mouse wheel can be used to change the numeric valuein the
highlighted cell.

To delete column/row, highlight the line and press the Delete key.
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OK button

Cancel button

File menu

Edit menu

Mouse menu 1

Mouse menu 2

Classic Test Definition
I/V List Sweep

The Define vector data dialog box provides the following GUI.
Saves the vector data displayed on the dialog box and closes the dialog box.
Displays a confirmation message and closes the dial og box. Vector datais not saved.

Provides the following function.

Exit Displays a confirmation message and closes the dialog box.
Vector datais not saved.

Provides the following four functions.

Copy Copies the highlighted item to the clipboard.

Paste Pastes the data in the clipboard to the specified | ocation.
Delete Deletes the highlighted item.

Select All Selects and highlights all cellsin the array.

The following menus are displayed when the right mouse button is clicked on a cell.

Cut Moves the highlighted characters to the clipboard.
Copy Copies the highlighted characters to the clipboard.
Paste Pastes the data in the clipboard to the specified | ocation.

The following menus are displayed when the right mouse button is clicked on the
array display area.

Copy Copies the highlighted item to the clipboard.

Paste Pastes the data in the clipboard to the specified | ocation.

Insert Inserts arow before the selected row. Available when the row
header providesthe * button and arow header is selected.

Delete Deletes the highlighted item.

Select All Selects and highlights all cellsin the array.
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To import vector
data

To export vector
data

Classic Test Definition
I/V List Sweep

The Define vector datadialog box can import comma separated data (each data must
be separated by acomma, and have a CR/LF or LF at the end of each line) and tab
separated data (each data must be separated by atab, and have aCR/LF or LF at the
end of each line). The procedure for importing vector datais as follows.

1
2.
3.

Open avector datawith Notepad.
Copy the datain Notepad.

On the Define vector data dialog box, click acell to be used asthe top left corner
of the imported vector data.

Right click on the corner box between the column header and the row header,
and select Paste.

Thus, the Define vector data dialog box can read vector data created on a
spreadsheet software.

The Define vector data dialog box can export vector datain tab separated format.
The procedure for exporting vector datais as follows.

1.
2.
3.
4.

Highlight a vector data on the Define vector data dialog box.
Select Copy from the Edit menu or the mouse menu 2.
Create anew file in Notepad, and paste the vector data.
Savethe dataas afile.

The data can then be read by opening the file with a spreadsheet software.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
I/V-t Sampling

|/V-t Sampling

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V-t
Sampling icon. The main screen displays the I/V-t sampling test setup screen. For
details of the measurement mode, see “1/V-t Sampling Measurement” on page 7-13.

Used to set the name of test setup. The name must be the identification for the test
setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other definitions.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “Channel Setup” on page 5-22.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
5-23.

This tab displays the Function Setup screen. See “ Function Setup” on page 5-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 5-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 5-46.

If you set Interval < 0.002 s

Sampling mode must be linear. This setting is not permitted for the log sampling.

All measurement channels must use the high speed A/D converter (ADC). This
setting is not permitted if a measurement channel uses the high resolution ADC.

If the multiple measurement channels are used, all channels perform measurement
inparallel.

If the measurement ranging mode is not the fixed mode, the measurement channels
automatically select the minimum range that covers compliance value set to the
channel.

If the measurement time is expected to be longer than Interval, the measurement
channels automatically adjust the number of averaging samples (ADC settings) to
keep the sampling interval.
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Channel Definition

Miscellaneous
Variables

Classic Test Definition
I/V-t Sampling

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode Output mode. For SMU, V (voltage), | (current), or COMMON

(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
left radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order. However, if the Output Sequenceis SIMULTANEOUS, the channels
start and stop output simultaneously.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the dataindex. Integer above O is returned.
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Sampling
Parameter

Classic Test Definition
I/V-t Sampling

M easurement Setup

This setup screen is used to set the sampling timing parameters, constant
voltage/current outputs, and so on.

This area defines the sampling timing parameters.

Linear/Log

Interval

No of Samples

Total Sampling
Time

Output Sequence

Hold Time

Sampling mode. LINEAR for linear sampling. LOG10,
LOG25, LOG50, LOG100, LOG250, or LOG500 for
logarithmic sampling.

For the logarithmic sampling, the number after LOG indicates
the number of measurement datain a decade. For example,
LOG10 mode is used to get 10 data/decade.

Interval of the sampling, in seconds. 0.002 to 65.535 s, 0.001 s
resolution.

Interval < 0.002 sin 0.00001 s resolution is aso available for
the linear sampling. It must satisfy the following formula. See
NOTE on page 5-21.

Interval > 0.0001 + 0.00002 x (number of measurement
channels- 1)

Number of samples. Integer. 1 to the following value.
For linear: 100001 / (number of measurement channels)

For logarithmic: 1 + (number of datafor 11 decades)

Thisfield just displays the total sampling time that isthe time
from the measurement start time for the first point to the end of
sampling measurement. It does not include the hold time.

Total Sampling Time = Interval x No of Samples

Source output sequence. SIMULTANEOUS or SEQUENTIAL.
See “ Source Output Sequence and Time Origin” on page 7-18.

Time since the Source value output until the first sampling
point, in seconds. 0o 655.35 s, resolution 0.01 s.

The following values are also available for Interval < 0.002 s.
[Hold Time] will be the time since the sampling start until the
Source value output.

- 0.09 to - 0.0001 s, resolution 0.0001 s.
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Stop Condition

Constants

Classic Test Definition

I/V-t Sampling

Base Hold Time

Hold time of the Base value output until the Source value
output, in seconds. 0 to 655.35 s, resolution 0.01 s.

This area defines the sampling measurement stop condition. See “ Stop Condition”
on page 7-18 for this function.

Enable/Disable
Enable Delay

Name

Threshold

Event

No. of Events

Enables or disables the stop condition.

Delay time. in second. Thisis the time from starting sampling
measurement to enabling this function.

Name of measurement data or user function to monitor for stop
condition. Val of Event.

Threshold value at which to stop sampling measurement.
Th of Event.

Event for stop condition.

Val >Th True if Name parameter valueis greater
than Threshold value.

Val <Th True if Name parameter valueisless than
Threshold value.

[Val| > [Th| Trueif absolute Name parameter valueis

greater than absolute Threshold value.

[Val| < [Th] True if absolute Name parameter valueis
less than absolute Threshold value.

Target value of the count the event occurs (true). When the
count of true is this value, sampling isimmediately stopped.

This area defines the constant voltage/current source.

Unit Source monitor unit (SMU) used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data

Mode Output mode, V (voltage), or | (current)

Base, Source Base or Sourcevalue, inV or A.
0to+100V (HRSMU/MPSMU) or +200 V (HPSMU)
0to+0.1 A (HRSMU/MPSMU) or +1 A (HPSMU)
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Range

ADC/Integ

Advanced

SPGU Pulse/
ALWG Setup

Classic Test Definition
I/V-t Sampling

Base valueis available for al output channels for the
SIMULTANEOUS mode and the last source channel for the
SEQUENTIAL mode.

Compliance Compliance value, in A or V.
0to+0.1 A (HRSMU/MPSMU) or £1 A (HPSMU)
0to£100V (HRSMU/MPSMU) or 200 V (HPSMU)

This button opens awindow used to set the measurement ranging operation. See
“SMU Range Setup Window” on page 5-48.

This button opens awindow used to set the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 5-50.

This button opens awindow used to set the other functions of the measurement
channel. See “ Advanced Setup Window” on page 5-51.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 5-59 or “SPGU ALWG Setup Window” on page 5-63.

SPGU cannot be used for the sampling measurement of Interval < 0.002 s.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
C-V Sweep

C-V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the C-V
Sweep icon. The main screen displays the C-V sweep test setup screen.

For details of the measurement mode, see “C-V Sweep Measurement” on page 7-19.
Used to set the name of test setup. The name must be the identification for the test

setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other definitions.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “ Channel Setup” on page 5-27.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
5-28.

This tab displays the Function Setup screen. See “Function Setup” on page 5-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 5-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 5-46.

Error Correction

Error correction must be performed before starting measurements. See “CMU
Calibration” on page 4-37 that explains the error correction GUI. There are four
techniques. For the easy way, perform the phase compensation and the open
correction.
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Channel Definition

Miscellaneous
Variables

Classic Test Definition
C-V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data.

Unit Module used for the source output or measurement

V Name Available for the MFCMU and the SMU used for voltage
output. Variable name of voltage output data

| Name Available for the SMU used for current output. Variable name
of current output data.

Mode SMU output mode, V (voltage), | (current), or COMMON
(ground)

Add Adds arow for the channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
left radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. However the last output
channel is aways the MFCMU. The output stops in the opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the dataindex. Integer above O is returned.
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Signal Source

Classic Test Definition

C-V Sweep

M easurement Setup

This setup screen is used to set the MFCMU measurement mode, source channel
outputs, the sweep abort condition, and the measurement time.

This area defines the MFCM U measurement mode and DC bias output.

V Name
M odel

paral Name

para2 Name

Direction

Sart
Sop
Sep
No of Step

Variable name of the DC bias output data

MFCMU measurement mode. Primary and secondary
measurement parameters. Select one from the following four
models.

Cp-G: Parallel capacitance (F) and Conductance (S)

Cp-D: Pardllel capacitance (F) and Dissipation factor

Cs-Rs:. Series capacitance (F) and Series resistance (Q2)

Z-Th: Impedance (2) and Phase (degree)

Variable name of the primary measurement parameter, C or Z

Variable name of the secondary measurement parameter, G, D,
R, or Th

Sweep direction, single (start to stop) or double (start to stop to
start)

Sweep start value
Sweep stop value
Incremental step value of the sweep output

Number of steps. The value is automatically calculated by using
the start, stop, and step values.

This area defines the measurement signal.

Frequency List  Fregquency of the measurement signal

F Name Variable name of the frequency data

AC Leve Oscillator level of the measurement signal, 10 mV to 250 mV, 1
mV resolution

Add Adds a measurement frequency.

Delete Deletes the selected frequency. To select the frequency, use the
left radio button.
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Integration Time

Timing

Constant

Sweep status

Range

Advanced

Classic Test Definition

C-V Sweep
Up Moves the selected frequency upward.
Down Moves the selected frequency downward.
This area setsthe A/D converter of MFCMU.
Mode A/D converter operation mode, AUTO or PLC
Factor Factor for the initial value. See “Mode, Factor” on page 7-20.

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 7-59.

Hold Hold time. Thisisthe time from beginning of channel output to
beginning of delay time. 0to 655.35 s, 10 ms resolution.

Delay Hold time. Thisisthe time from end of hold time to beginning
of measurement. The MFCMU starts measurement as soon as
the wait time elapses. 0 to 655.35 s, 0.1 ms resol ution.

This area defines the constant voltage/current source.

Unit Source monitor unit (SMU) used for the constant source

V Name Variable name for the constant voltage output data

| Name Variable name for the constant current output data

Mode Output mode, V (voltage), | (current), or COMMON (ground).
Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

This field specifies the sweep abort condition, continue at any status or stop at any
abnormal status.

This button opens awindow used to set the measurement ranging operation. See
“CMU Range Setup Window” on page 5-53.

This button opens awindow used to set the other functions of the MFCMU (multi
frequency capacitance measurement unit). See “ Advanced Setup Window for C-V
Sweep” on page 5-54.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
Direct Control

Direct Control

On the EasyEXPERT main screen, click the Classic Test tab and select the Direct
Control icon. The main screen displays the Direct Control test setup screen.

Direct Control test mode performs measurement by controlling measurement
resources, SMU, CMU, and SPGU directly. The instrument can be controlled by
using GPIB commands. For the B1500A GPIB commands, see “Agilent B1500A
Programming Guide”.

Available GPIB commands are listed in the Command pull-down menu on the
Measurement Setup screen. Other commands are not supported by the Direct
Control test.

Sets the name of the test setup. The nameis used to identify the test setup saved to a
My Favorite group (preset group). Enter a unique name that is distinct from other
definitions.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “ Channel Setup” on page 5-31.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
5-33.

This tab displays the Function Setup screen. See “Function Setup” on page 5-42.

If Agilent B2200A/B2201A/E5250A switching matrix is used, the CMU
measurement data should be compensated. To perform the compensation, define a
user function by using the “compenReZ” and “compenimZ” functions or the
“compenReY” and “compenimY” functions.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 5-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 5-46.
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Channel Definition

Additional Data
Variables

Miscellaneous
Variables

Classic Test Definition
Direct Control

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of DC voltage output or measurement data

| Name Variable name of DC current output or measurement data

Add SMU Adds arow for the SMU channel setup.

Add CMU Adds arow for the CMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the selected channel setup. To select a channel setup,
use the radio button on the | ft.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

This area defines the variables for the measurement data other than DC voltage and
DC current which can be defined in Channel Definition.

Unit Unit (SMU or CMU) used for the measurement

Type Type of measurement data. See Table 5-1.

Name Variable name of the measurement data

Add Adds arow for the measurement variable.

Delete Del etes the selected measurement variable. To select avariable,

use the radio button on the | eft.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Index Name Variable name of the dataindex. Integer above O is returned.
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Classic Test Definition
Direct Control

Table5-1 Available Type Valuesfor M easurement Data Variables
Type Description

SMU Quasi-Static C SMU capacitance measurement data (F)
CMU Re(2) CMU resistance measurement data (Q2)
CMU Im(2) CMU reactance measurement data (Q2)
CMU Re(Y) CMU conductance measurement data (S)
CMU IM(Y) CMU susceptance measurement data (S)
CMU Frequency CMU output signal frequency data (Hz)
CMU AC Level Output Data | CMU oscillator level output data (Vac)
CMU DC Bias Monitor Data | CMU DC bias monitor data (Vdc)
CMU AC Level Monitor Data | CMU oscillator level monitor data (Vac)
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Advanced

Command Setup

Classic Test Definition
Direct Control

M easurement Setup

This setup screen is used to define GPIB commands for controlling the SMU and
CMU directly, and is used to set the SMU seriesresistor, the SMU filter, and the bias
hold function.

This button opens awindow for setting the SMU series resistor, the SMU filter, and
the bias hold function. See “Advanced Setup” on page 5-34.

This area defines GPIB commands for controlling the SMU and CMU directly.

Command Select the command or function from the pull-down menu. See
“Command Setup” on page 5-36.

Arguments Enter the command parameter. To enter multiple parameters,
insert acomma (,) between parameters. Multiple spaces can be
inserted before and after the comma.

All parameters should be entered. If an optional parameter is
abbreviated, theinitial value may be set, the last used value may
be reused, or no value may be set. The result is unique and
depends on the command. For a description of each command,
see “Agilent B1500A Programming Guide’.

The parameter can be anumeric variable or a numeric
expression with fundamental arithmetic operations.

In an application test definition, the parameter can be anumeric
type test parameters, device parameters, or Symbol.

If theinternal variable is used, it must be used as a string
variable. For example, the variables must be entered as follows.

“%I1", “%R1", “%R2”

Ignore Check this box to comment out this command line.

Add Adds arow for the command setup.

Delete Deletes the selected command setup. To select acommand
setup, use the radio button on the left.

Up Moves the selected command setup upward.

Down Moves the selected command setup downward.
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Options

Channel Settings

After Measurement
Setting

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Direct Control

Advanced Setup

Thiswindow is opened by clicking the Advanced button on the Direct Control
Measurement Setup screen, and is used to set the SMU series resistor, the SMU
filter, and the bias hold function.

The following setup is available.

Primary Setup Primary setup ON or OFF.

If Primary Setup=ON, the primary setup is applied to the instrument when the
Direct Control test is started. For the setup condition, see “Primary Setup” on page
5-35.

If Primary Setup=OFF, the primary setup is not applied. Set the Primary Setup to
OFF if asetup exists and is proven to problem-free for running atest with. The test
execution time can be reduced by this setting.

This area sets the series resistor and the filter.

Unit Source monitor unit (SMU) used for the measurement

VName Variable name of voltage output or measurement data

IName Variable name of current output or measurement data

SeriesR Seriesresistor NONE or IMOHM. See“SMU Series Resistor”
on page 7-63.

SMU Filter SMU filter ON or OFF. See“SMU Filter” on page 7-62.

This area sets the bias hold function for maintaining the source output after
measurement. The source module applies the specified bias between two
consecutive measurements of arepeated measurement or quick test. See“BiasHold
Function” on page 7-40.

BiasHold after Measurement Bias hold function ON or OFF
This area sets the Agilent 16440A selector CH1/CH3 status (DEFAULT or PGU
OPEN). To use this function, set the DEFAULT setting to Always SMU or Normally

PGU (AUX) by using the SMU/PG Selector tab screen on the Configuration window
before starting the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CH3 status, DEFAULT or PGU OPEN.
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Classic Test Definition
Direct Control

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 7-48 for details on the selector.

Agilent 16445A selector adapter is needed for connecting the 16440A.

Primary Setup

Primary setup istheinitial setting set for when the Direct Control test is started. This
setting is different from the initial setting set by the device clear or the *RST
command. The differences are listed below.

« Dataoutput format

FMT 13, 0 is set.
* Program memory

Setup is hot changed. The last used setting is retained.
* Internal variables

Setup is hot changed. The last used setting is retained.
» Measurement condition setup commands

Setup is not changed for the following commands. The last used setting is
retained.

MM
WV, WI, WSV, WSI, WNX

PV, PI, PWV, PWI

BDV

QSV, QSO

LGI,LGV, LS, LSV, LSSI, LSSV
BGI, BGV, BSI, BSV, BSSI, BSSV
FC, WDCV

PDCV, PWDCV

WFC

WACV

MDCV
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Table5-2

Classic Test Definition

Direct Control

Command Setup

To define the Command Setup, set acommand or a function to the Command field,
and enter the command parameters to the Argument field. Also, be aware of the

following note.

FMT command'sfirst parameter must be 13.

» Usethe Unit value of Channel Setup to specify the channel.
» Usethe ReadDataBuffer function to read measurement data.

» Program memory number must be within the range of 1 to 1000.

» SCR command parameter cannot be abbreviated.

* VAR command's second parameter must be within the range of 1 to 40. Hence,
internal variables %l 1 to %140 and %R1 to %R40 are available.

A setup exampleis shown in Table 5-2. This example uses SMU1 to performs
voltage output and current spot measurement.

Command Setup Example

Command Arguments Description
FMT 13,0 Sets the data output format.
MM 1, SMUL:HP Sets the measurement mode.
TSC 1 Enables the time data output.
AV 10,1 Sets the number of averaging.
DV SMUZL:HR 0, 1.5, Forcesthe DC voltage.
0.1
CMM SMUZL:HP 0 Sets the SMU operation mode.
RI SMUL:HP, 0 Sets the current measurement range.
TSR Resets the timer.
XE Starts the measurement.
ReadDataBuffer | 1 Reads the measurement data.
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Syntax

Parameters

Example

Classic Test Definition
Direct Control

ReadDataBuffer

This function reads the measurement data. The number of data blocksto beread is
specified by the count parameter. If count is abbreviated, this function reads one
data block.

ReadDat aBuf f er [count]

count Number of data blocks or the number of terminators to be read.

A datablock is agroup of datathat ends with aterminator. For
the data output format, see “ Agilent B1500A Programming
Guide’.

The following example performs three high speed spot measurements and then
reads three measurement data blocks.

Command Arguments Description

TI 1,0 Measurement channel 1 performsthe high
speed spot measurement.

TI 2,0 Measurement channel 2 performs the high
speed spot measurement.

TI 3,0 Measurement channel 3 performs the high
speed spot measurement.

ReadDataBuffer | 3 Reads three measurement data bl ocks.

NOTE

NOTE

The data output buffer is cleared when the Direct Control test is started.

If aSMU performs the force side measurement operation and the source data output
isenabled (by the FMT command), the SMU’s source datais deleted and the SMU’s
measurement datais stored instead of the source data. The force side measurement
operation is the SMU operation which performs the voltage force and voltage
measurement or the current force and current measurement.
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Classic Test Definition
Direct Control

compenReZ

This built-in function performs compensation on the specified impedance data and
returns the real data for the compensation resullts.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReZ and compenimZ functions as the user functions on the
Function Setup screen, so that the compensation is performed while the Direct
Controal test is being executed. Also enter the formula to calculate the measurement
parameters. An example definition is shown in Figure 5-2. For the equations, see

“ About Impedance Measurements” on page 7-21.

Syntax conpenReZ(frequency, Real , | magi nary)

Parameters frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Z) measurement result data. Q2. Numeric vector data.

Real should be a vector variable that stores the impedance real
data before compensation.

Imaginary CMU Im(Z) measurement result data. Q2. Numeric vector data.
Imaginary should be avector variable that stores the impedance
imaginary data before compensation.
Example Name Rconpen
Definition compenReZ( Freq, ReZ, | n¥)

Rcompen returns the impedance real data for the compensation results.
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Syntax

Parameters

Example

Classic Test Definition
Direct Control

compenimZ

This built-in function performs compensation on the specified impedance data and
returns the imaginary data for the compensation results.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReZ and compenimZ functions as the user functions on the
Function Setup screen, so that the compensation is performed while the Direct
Controal test is being executed. Also enter the formula to calculate the measurement
parameters. An example definition is shown in Figure 5-2. For the equations, see

“ About Impedance Measurements” on page 7-21.

conpenl nZ(frequency, Real , | magi nary)

frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Z) measurement result data. Q2. Numeric vector data.

Real should be a vector variable that stores the impedance real
data before compensation.

Imaginary CMU Im(Z) measurement result data. Q2. Numeric vector data.
Imaginary should be avector variable that stores the impedance
imaginary data before compensation.

Name Xcompen

Definition compenl nZ( Freq, ReZ, | n¥)

Xcompen returns the impedance imaginary data for the compensation results.
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Syntax

Parameters

Example

Figure5-2

Classic Test Definition
Direct Control

compenReY

This built-in function performs compensation on the specified admittance data and
returns the real data for the compensation resullts.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReY and compenimY functions as the user functions on the
Function Setup screen as shown in Figure 5-2, so that the compensation is
performed while the Direct Control test is being executed. Also enter the formulato
calculate the measurement parameters. For the equations, see “ About Impedance
Measurements” on page 7-21. Figure 5-2 defines the following formulato calculate
capacitance.

C=ImY/(2xPlIxFreq)

conpenReY(frequency, Real , | magi nary)

frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Y) measurement result data. S. Numeric vector data.

Real should be a vector variable that stores the admittance real
data before compensation.

Imaginary CMU Im(Y) measurement result data. S. Numeric vector data.
Imaginary should be avector variable that stores the admittance
imaginary data before compensation.

Name Gconpen

Definition compenReY( Freq, ReY, | nY)

Gcompen returns the admittance real data for the compensation results.

Function Setup Example

R [
Name: Unit: Definition:

ol [T = x|[3.1415 ]

‘& iIm‘r‘ glohm j |compenIm‘r’[Fl'eq,G,B} E]

r IRe‘r‘ §|0hm _vJ|CD|11|JEI1RE‘T'I:FI'EE|,G,B] E

& I = |F _x|[tmivf(2*PI*Freq) E]
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Syntax

Parameters

Example

Classic Test Definition
Direct Control

compenlmY

This built-in function performs compensation on the specified admittance data and
returns the imaginary data for the compensation results.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReY and compenimY functions as the user functions on the
Function Setup screen as shown in Figure 5-2, so that the compensation is
performed while the Direct Control test is being executed. Also enter the formulato
calculate the measurement parameters. For the equations, see “ About Impedance
Measurements” on page 7-21. Figure 5-2 defines the following formulato calculate
capacitance.

C=ImY/(2xPlIxFreq)

conpenl nY(frequency, Real , | magi nary)

frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Y) measurement result data. S. Numeric vector data.

Real should be a vector variable that stores the admittance real
data before compensation.

Imaginary CMU Im(Y) measurement result data. S. Numeric vector data.
Imaginary should be avector variable that stores the admittance
imaginary data before compensation.

Name Bconpen

Definition compenl mY( Fr eq, ReY, | nY)

Bcompen returns the admittance imaginary data for the compensation results.
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Apply

User Function,
Analysis Function

Classic Test Definition
Function Setup

Function Setup

This setup screen is displayed by clicking the Function Setup tab of the 1/V Sweep /
Multi Channel 1/V Sweep / 1/V List Sweep / I/V-t Sampling / C-V Sweep / Direct
Control test setup screen, and is used to set the user function and the analysis
function.

Calculation of the function is automatically performed after measurement. And the
functions defined in the Display Setup screen will be displayed on the Data Display
window. The user functions are available for the X-Y Graph Plot, List Display, and
Parameters area. The analysis functions are available for the Parameters area.

This button performs calculation of the definition in this screen. If this button is
clicked when the Data Display window associated with this test has been opened,
the display is also updated.

The associated Data Display window will be the Data Display window that displays
the last measurement data or that isrecalled at last.

The User/Analysis Function area sets the user/analysis functions effective for the
test. Up to 20 functions can be set. The user function result is referable from the
other user function defined in the following lines. The analysis function result is
referable from the other analysis function defined in the following lines.

Name Function name
Unit Unit of the function
Definition Definition of the function. The following identifiers can be used.

» Variables for the measurement/output data used in this test
» Functions defined in the above lines

» Local variables passed from the application test that calls this
test as a component

» Built-in functions and global variables
» Read out functions (hot available for the user functions)
Also see Chapter 8, “Built-in Programming Tool.”

Add, Delete  Addsafunction, or deletes the selected function. To select the
function, use the left radio button.

Up, Down Moves the selected function upward or downward.
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Apply

Interpolation Mode

Line 1, Line 2

Classic Test Definition
Auto Analysis Setup

Auto Analysis Setup

This setup screen is displayed by clicking the Auto Analysis Setup tab of the I/V
Sweep / Multi Channel 1/ Sweep / I/V List Sweep / 1/V-t Sampling / C-V Sweep /
Direct Control test setup screen, and is used to set the automatic analysis function.
When a measurement finishes, the function automatically draws lines, a marker, or
both on the X-Y Graph of the Data Display window.

You can set up two lines and one marker for the automatic analysis function.
IntheLine 1 and Line 2 areas, you can set up the lines to be drawn.

In the Marker area, you can set up the marker.

This button performs calculation of the definition in this screen. If this button is

clicked when the Data Display window associated with this test has been opened,
the display is also updated.

The associated Data Display window will be the Data Display window that displays
the last measurement data or that isrecalled at last.

Check this box to enable the interpolation mode. You can position marker between
measurement points.

Thisareasetstheline 1 or line 2 automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the line.

Fix Check this box to fix the line on the graph after the auto
analysis is performed. Remove the check to make the line free.

Type Select one of the available line types listed below.

Axis Axis effective for the line. Specify onefromY1to Y8.

First Point See the following description for the line you selected.

Second Point See the following description for the line you selected.
Available line types:

*  “Normal line": For drawing a line between any two points.

» “Gradient line": For drawing aline through any point with a specified gradient.

» “Tangent line”: For drawing atangent line to a measurement point.

Agilent B1500 User’s Guide, Edition 7 5-43



Marker

Normal line

Gradient line

Classic Test Definition
Auto Analysis Setup

» “Regressionling’: For drawing aregression line by using the measurement data
included in the area specified by any two points.

This area sets the marker automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the marker.

Condition Enter a variable name and a condition expression to specify
where you want the marker to appear.

After Check this box to enable the additional condition.

Enter a second variable and condition expression. Thissetsup a
search start condition for finding specified point.

For example, you can specify the following expressionsto search for a measurement
point that satisfies the first condition after the second condition is satisfied.

Condition:] DGM]=[MAX(DGM)*0.01] [x] After [DGM]=[MAX(DGM)]

The First Point area and the Second Point area are used to specify the pointsthe line
passes through. The following two ways are available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition
Enter a variable name and condition expression to specify the point. Thisis the

same method as specifying the Marker point.

The First Point areais used to specify the point the line passes through. The
following two ways are available to specify the point.

» X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisisthe
same method as specifying the Marker point.

In the Gradient field, enter agradient value or expression.
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Tangent line The First Point areais used to specify the measurement point the tangent line passes
through.

Enter avariable name and condition expression to specify the point. Thisisthe same
method as specifying the Marker point.

Regression line The First Point area and the Second Point area are used to specify the range of the
measurement data used for the regression calculation. The following two ways are
available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisis the
same method as specifying the Marker point.
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X-Y Graph

List Display,
Parameters

Classic Test Definition
Display Setup

Display Setup

This setup screen is displayed by clicking the Display Setup tab of the I/V Sweep /
Multi Channel 1/V Sweep / 1/V List Sweep / I/V-t Sampling / C-V Sweep / Direct
Control test setup screen or by checking the Define own Output Parameters box on
the Test Definition window, and is used to set the test result output.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8
axes can be set.

Name Specifies the parameter for the axis.

Sharing Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (no grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale Scale of the axis, Linear or Log

Min Minimum value of the axis

Max Maximum value of the axis

Add Adds a parameter (or axis).

Delete Deletes the parameter selected with the radio button on the left.
Up Moves the selected parameter upward.

Down Moves the selected parameter downward.

Selectsthe datadisplayed in the List Display areaor the Parameters area of the Data
Display window. Up to 20 parameters can be set for each area.

parameter Specifies the parameter for the data output.
Add Adds arow for the parameter.
Delete Deletes the selected parameter. To select the parameter, use the

|eft radio button.
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Display Setup

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.
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Classic Test Definition
SMU Range Setup Window

SMU Range Setup Window

Thiswindow is opened by clicking the Range button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling M easurement Setup screen,
and is used to set the measurement ranging operation.

For the measurement ranging function, see “SMU Ranging Mode” on page 7-49.

Unit Source monitor unit (SMU) used for the measurement
Name Variable name for the measurement data

Mode Ranging mode, auto, limited, or fixed

Range Range value. For auto ranging, ignore this field. For limited

auto ranging, the measurement channel never uses ranges less
than the specified range.

Range Change

Ruleand Rate Not available for voltage measurement or fixed ranging. See
also “Enhanced Auto Ranging for Current Measurement” on
page 7-52.

Available Range Change Rule valuesare BY FULL RANGE,
GO UP AHEAD, and UP AND DOWN AHEAD.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules,
specify the Rate value, 11 to 100, which fixes the boundary of
the ranging. The ranging occurs when the measurement data
goes across the boundary values shown below.

go up boundary = present measurement range x Rate/ 100
go down boundary = present measurement range x Rate/ 1000

The go down boundary is available only for the UP AND
DOWN AHEAD rule.

Up Moves the selected measurement channel setup upward.
Down Moves the selected measurement channel setup downward.

If multiple measurement channels are defined, the channels perform measurement
sequentially. The order istop to bottom of the channels defined in this screen. For
exceptions and details, see “ Multiple Measurement Channels’ on page 7-61.
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SMU Range Setup Window

NOTE To use 1 pA range

The measurement channel connected to the ASU (Atto Sense and Switch Unit)
supportsthe 1 pA range. To usethe 1 pA range, set the 1 pA fixed range or the 1 pA
limited auto ranging.

The B1500A automatically performs the compensation of the data measured by the
1 pA range and returns the compensated data. You can use either the pre-stored
offset data or the pre-measured offset data.

To measure the offset data, perform the self-calibration before starting the
measurement for a DUT. This offset data is temporarily memorized until the
B1500A is turned off.
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A/D Converter

Integration Time

Classic Test Definition
ADC and Integration Time Setup Window

ADC and Integration Time Setup Window

Thiswindow is opened by clicking the ADC/Integ button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling M easurement Setup screen,
and is used to set the A/D converter of the measurement channels.

This area selects the ADC type and enables/disabl es the auto zero function. See
“Integration Time” on page 7-57.

Unit Source monitor unit (SMU) used for the measurement
Name Variable name for the measurement data
ADC ADC type, high resolution ADC or high speed ADC

This area sets the ADC mode and its factor for each ADC type.

Mode ADC operation mode, auto, manual, or PLC
Factor Factor value. Thisisthe N value shown in Table 7-8.
Auto Zero For the high resolution ADC. Auto zero function ON or OFF.

See “ADC Zero Function” on page 7-57.

5-50 Agilent B1500 User’s Guide, Edition 7



Channel Settings

Wait Time Control

After Measurement
Settings

Classic Test Definition
Advanced Setup Window

Advanced Setup Window

Thiswindow is opened by clicking the Advanced button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling Measurement Setup screen,
and is used to set the following functions of the measurement channel.

This area sets the series resistor and the filter.

Unit Source monitor unit (SMU) used for the measurement

VName Variable name of voltage output or measurement data

IName Variable name of current output or measurement data

SeriesR Seriesresistor NONE or IMOHM. See*SMU Series Resistor”
on page 7-63.

SMU Filter SMU filter ON or OFF. See“SMU Filter” on page 7-62.

This area setsthe source output wait time and the measurement wait time. See “ Wait
Time” on page 7-60. The Output Wait sets the source output wait time. The
Measurement Wait sets the measurement wait time.

Factor Factor value. 0 to 10, 0.1 resolution. Thisis the N value shown
in “Wait Time” on page 7-60.

This area sets the bias hold function used to keep the source output after
measurement. The source module applies the specified bias between a measurement
and the next measurement performed in the repeat measurement or quick test. See
“Bias Hold Function” on page 7-40.

BiasHold after

M easurement Bias hold function ON or OFF
Output Valueafter

M easurement Source output value after measurement

START (sweep start value), STOP (sweep stop vaue),
SOURCE (sampling output source value), or BASE (sampling
output base value)

Agilent B1500 User’s Guide, Edition 7 5-51



Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Advanced Setup Window

This area sets the Agilent 16440A selector CH1/CH3 status (DEFAULT or PGU
OPEN). To use this function, set the DEFAULT setting to Always SMU or Normally
PGU (AUX) by using the SMU/PG Selector tab screen on the Configuration window
before starting the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CH3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 7-48 for details on the selector.

Agilent 16445A selector adapter is needed for connecting the 16440A.
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Table5-3

Classic Test Definition
CMU Range Setup Window

CMU Range Setup Window

Thiswindow is opened by clicking the Range button on the C-V Sweep
Measurement Setup screen, and is used to set the measurement ranging operation.

Unit
Mode

Range

Module (MFCMU) used for the measurement

Ranging mode, AUTO (auto ranging) or FIXED (fixed range).
If Mode=AUTO, the MFCMU automatically searches for and
measures at the range that provides the best resolution.

If Mode=FIXED, the MFCMU measures at the range specified
by the Range field.

Measurement range. Thisfieldis effective when Mode=FIXED.
Available measurement ranges depend on the measurement
frequency setting. See Table 5-3.

Available M easurement Ranges

Frequency Available measurement ranges

< 200kHz | 50, 100 2, 300 Q, 1 kQ, 3kQ, 10 kQ, 30 k2, 100 k2, 300 kQ
< 2MHz | 500,100 Q, 300 Q, 1 kQ, 3k, 10 kQ, 30 kQ

< 5MHz | 509, 100 Q, 300 Q, 1 kQ, 3k
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AC Level/DC Bias
Monitor Settings

After Measurement
Settings

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Advanced Setup Window for C-V Sweep

Advanced Setup Window for C-V Sweep

Thiswindow is opened by clicking the Advanced button on the C-V Sweep
Measurement Setup screen, and is used to set the following functions of the
MFCMU.

This area defines the variables for the AC level dataand the DC bias data monitored
by the MFCMU while the capacitance measurement is performed.

Unit Module (MFCMU) used for the measurement
AC Level Monitor

Name Variable name of the AC level monitor data
DC Bias Monitor

Name Variable name of the DC bias monitor data

This area sets the bias hold function used to keep the source output after
measurement. The source module applies the specified bias between a measurement
and the next measurement performed in the repeat measurement or quick test. See
“Bias Hold Function” on page 7-40.

BiasHold after

M easurement Bias hold function ON or OFF
Output Valueafter

M easurement Source output value after measurement

START (sweep start value) or STOP (sweep stop value)

This area sets the Agilent 16440A selector CH1/CH3 status (DEFAULT or PGU
OPEN). To use this function, set the DEFAULT setting to Always SMU or Normally
PGU (AUX) by using the SMU/PG Selector tab screen on the Configuration window
before starting the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CHS3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 7-48 for details on the selector.

Agilent 16445A selector adapter is needed for connecting the 16440A.
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Setup Name

Connection

Classic Test Definition
Switching Matrix Control

Switching Matrix Control

On the EasyEXPERT main screen, click the Classic Test tab and select the
Switching Matrix Control icon. The main screen displays the Switching Matrix
Control setup screen. This setup screen is used to create the relay control setup for
Agilent B2200A/B2201A/E5250A Switching Matrix.

To apply the relay control setup, click the Single button. Before doing this, you have
to establish the GPIB connection to the switching matrix by using the Switching
Matrix tab screen of the Configuration window. See “ Switching Matrix” on page
4-43.

Used to set the name of the relay control setup. The name must be the identification
for the setup saved to a My Favorite group (preset group). Enter a unique name that
is distinct from other definitions.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

Thisareais used to create the relay control setup for the switching matrix.

Add Adds arow for the relay connection setup.

Delete Deletes the setup row. To select the setup row, use the left radio
button.

Up Moves the selected setup row upward.

Down Moves the selected setup row downward.

The setup row provides the following entry fields.
Operation Relay control operation

Open All, Switch Setup, Close Range, Open Output,
Open Range, or Open Input. See Table 5-4.

Input Switching matrix input port number or label

Available for the Switch Setup, Close Range, and Open Input
operations.
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Classic Test Definition
Switching Matrix Control

Outputs

Rule

Switching matrix output channel number or label

Four entry fields are available for the Switch Setup and
Open Output operations to specify the output channels.

Two entry fields are available for the Close Range and
Open Range operations to specify the range of output channels.

Relay connection rule

BBM: Breaks the previous connection and then makes the new
connection for the specified outputs.

MBBR: Makes the new connection and then breaks the
previous connection for the specified outputs.

Table 5-4 Relay Control Operations

Operation

Description

Open All

Opens all relays.

Switch Setup

Makes the connection from the specified input port to the
specified output channels. Up to four output channels can be
specified at once.

Close Range

Makes the connection from the specified input port to the
specified output channels. They are between two channels given
by the Outputs fields.

Open Output

Opens the relays connected to the specified output channels. Up
to four output channels can be specified at once.

Open Range

Opens the relays connected to the specified output channels.
They are between two channels given by the Outputs fields.

Open Input

Opens the relays connected to the specified input port.
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Setup Name

Channel Definition

SPGU Setup

Classic Test Definition
SPGU Control

SPGU Control

On the EasyEXPERT main screen, click the Classic Test tab and select the SPGU
Control icon. The main screen displays the SPGU control screen. See “ SPGU
Module” on page 7-26 for the function of the SPGU.

Used to set the name of the SPGU control setup. The name must be able to identify
a setup saved in a My Favorite group (preset group). Enter a unique name that is
distinct from other definitions.

The nameis recorded in the execution result data and is used to differentiate the data
in the test record list area.

Defines the SPGU channel setups.

Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output or the arbitrary linear waveform voltage
output

VName Name of voltage output data

Mode Output mode VPUL SE (voltage pul se output) or ALWG

(arbitrary linear waveform voltage output).

All SPGU channels must have the same output mode.

Add Adds arow for the channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
left radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

Provides the following buttons used to open the following setup window.

Pulse/ ALWG Opens “SPGU Pulse Setup Window” if Mode=VPULSE.
Opens “SPGU ALWG Setup Window” if Mode=ALWG.

Advanced Opens “Advanced Setup Window for SPGU Control”.

Agilent B1500 User’s Guide, Edition 7 5-57



Progress Monitor

After Measurement
Setting

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
SPGU Control

Provides the following check boxes used to set the Data Display window displayed
while the SPGU channel output is applied.

Graph: % of
Progress Check this box to display the Percent of Progress vs. Time plot.

List: TimeData Check thisbox to display the Time datalist.

No data may be displayed on the Data Display window if the SPGU output time is
too short. The progress monitor will be used for long duration outputs, for example
when the duration is longer than 30 seconds.

Advanced Setup Window for SPGU Control

Thiswindow is opened by clicking the Advanced button on the SPGU Control
screen, and is used to set the following functions of the SPGU channel.

Sets the bias hold function used to decide the channel output after the SPGU output
operation.

Bias Hold after
M easurement Bias hold function ON or OFF

If the bias hold function is OFF, the channel stops the output immediately after the
SPGU output operation.

If the function is ON, the channel maintains the base voltage output (in the VPUL SE
mode) or theinitial voltage output (in the ALWG mode) between a SPGU output
operation and the next operation performed in the repeat execution or quick test.
Channel initialization occurs at the beginning of the next operation.

Setsthe Agilent 16440A selector CH1/CH3 status (DEFAULT or PGU OPEN). To
use thisfunction, set the DEFAULT setting to Always SMU or Normally PGU (AUX)
by using the SMU/PG Selector tab screen on the Configuration window before
starting the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CHS3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 7-48 for details on the selector.

Agilent 16445A selector adapter is needed for connecting the 16440A.
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Global Settings

Operation

Pulse Settings

Classic Test Definition
SPGU Pulse Setup Window

SPGU Pulse Setup Window

Thiswindow is opened by clicking the Pulse/ALWG button on the SPGU Control
screen when Mode=VPUL SE, or by clicking the SPGU Pulse Setup button on the
I/V Sweep / Multi Channel I/V Sweep / 1/V List Sweep / 1/V-t Sampling
Measurement Setup screen. It is used to set the SPGU pulse output. See Figure 5-3
for the pulse setup parameters.

Provides the following entry field. The setting is effective for al channels.
Period Pulse period. 20 nsto 10 s, 10 nsresolution.
Provides the following radio buttons used to set the SPGU channel output operation

mode, free run, pulse count, or duration. Select one of the following buttons to set
the operation mode. The setting is effective for all channels.

FREE RUN In this mode, the SPGU continues the pulse output until the
measurement is completed or stopped.

This mode is not available for the SPGU Control classic test.

PULSE COUNT Inthis mode, the SPGU outputs the specified number of pulses.
Specify a number within the range of 1 to 12000000.

DURATION In this mode, the SPGU continues the output until the specified
time elapses. Specify atime within the range of 1 usto
31556926 s (1 year).

Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output

VName Name of voltage output data

Type 2-Level Pulse or 3-Level Pulse. If you choose 3-Level Pulse,
the Additional Pulse fields become effective.

Base, Peak Pulse base and peak voltage. 0to + 40 V, 1 mV resolution.

Delay Delay time. 0 sto Period- 20 ns, resolution 2.5 nsor 10 ns
(pulse transition time > 8 ps).

Width Pulse width. 10 nsto Period- 10 ns, resolution 2.5 nsor 10 ns

(pulse transition time > 8 us).

Leading, Trailing Pulsetransition time. 8 nsto 400 ms, resolution 2 nsor 8 ns
(pulse transition time > 8 us).
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SPGU setup view
order

Load Z

Pulse Switch

Figure5-3

Classic Test Definition
SPGU Pulse Setup Window

Up Moves the selected channel setup upward.
Down Moves the selected channel setup downward.

Changes are effective only for the display on the SPGU Pulse Setup window and not
memorized. They are not applied to the Channel Setup.

This button opensthe“Load Z Setup Window” used to set the load impedance of the
DUT (device under test) connected to the SPGU channel. The SPGU wiill
automatically adjust the output voltage by using this value, and output the voltage
close to the specified pulse base and peak values.

This button opens the “ Pulse Switch Setup Window” used to set the pulse switch
operation. The pulse switch is used to set the open condition of the SPGU output
channel. The pulse switch is more durable than mechanical relays, and is better
suited for frequent switching applications.

SPGU Pulse Setup Parameters

V/10 4

Normally open  Close _Open
Pulse switch 1 ; ! ‘ !
Delay-sw Width-sw Delay-sw
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Load Z Setup Window

Load Z Setup Window

Thiswindow is opened by clicking the Load Z button on the SPGU Pulse Setup
window or the SPGU ALWG Setup window, and is used to set the load impedance
of the DUT (device under test) connected to the specified SPGU channel.

Set the correct impedance value. The SPGU will automatically adjust the output
voltage by using this value, and output the voltage close to the specified pulse base

and peak values.

Load Z Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output or the arbitrary linear waveform voltage
output

VName Name of voltage output data
Load Z Load impedance of the DUT (device under test) connected to

this channél in Q.
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Pulse Switch

Classic Test Definition
Pulse Switch Setup Window

Pulse Switch Setup Window

Thiswindow is opened by clicking the Pulse Switch button on the SPGU Pulse
Setup window, and is used to set the pulse switch operation. The pulse switch is
used to set the open condition of the SPGU output channel. The pulse switch ismore
durable than mechanical relays, and is better suited for frequent switching

applications.

Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output

VName Name of voltage output data

SW Sync ENABLE (enables the pulse switch) or DISABLE (disables the
pulse switch).

Switching of the pulse switch status (open and close) will be
controlled automatically and synchronized with the output
pulse, as shown in Figure 5-3.

Delay Delay time from start of pulse output to changeover of pulse
switch. 0 sto Period- 100 ns, 10 nsresolution.

Width Duration to hold the switched state of the pulse switch. 100 ns
to Period- Delay ns, 10 ns resolution.

Normal CLOSE (normally closes the pulse switch) or OPEN (normally
opensthe pulse switch). The pulse switch will change the status
after the Delay-sw time and keep the status until the Width-sw
time elapses as shown in Figure 5-3. This operation is repeated
every pulse period.
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ALWG Setting

Load Z

Figure5-4

Classic Test Definition
SPGU ALWG Setup Window

SPGU ALWG Setup Window

Thiswindow is opened by clicking the Pulse/ALWG button on the SPGU Control
screen when Mode=ALWG, or by clicking the SPGU ALWG Setup button on the
I/V Sweep / Multi Channel I/V Sweep / 1/V List Sweep / 1/V-t Sampling
Measurement Setup screen. It is used to set the arbitrary linear waveform output.

Provides the following radio buttons used to set the SPGU channel output operation
mode, free run, sequence count, or duration. Select one of the following buttonsto
set the operation mode. The setting is effective for all channels.

FREE RUN In this mode, the SPGU continues the ALWG sequence output
until the measurement is completed or stopped.

This mode is not available for the SPGU Control classic test.

SEQUENCE

COUNT In this mode, the SPGU outputs the specified number of
sequences. Specify a number within the range of 1 to 1000000.

DURATION In this mode, the SPGU continues the output until the specified
time elapses. Specify atime within the range of 1 usto
31556926 s (1 year).

Provides the following field.

ALWG Source  Click the start button in this field to open the Define ALWG
Waveform window which is used to define the arbitrary linear
waveform and its output sequence. See “Define ALWG
Waveform Window” on page 5-64.

Thisbutton opensthe“Load Z Setup Window” used to set the load impedance of the
DUT (device under test) connected to the SPGU channel. The SPGU will
automatically adjust the output voltage by using this value, and output the voltage
close to the specified pulse base and peak values.

SPGU ALWG Setup Window

[Operation |

* FREERUN *° PULSE COUNT 10000 2]

" DURATION ]

[ALWG Setting \

ALWG Source: (] ]

start button %= |
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File menu

Pattern menu

Column menu

Classic Test Definition
Define ALWG Waveform Window

Define ALWG Waveform Window

Thiswindow is opened by clicking the start button in the waveform data entry field
or the ALWG Source field on the SPGU ALWG Setup window, and is used to create
the arbitrary linear waveform data which is defined by the pattern data and the
sequence data.

Provides the following five functions.

Export ALWaveform... Exportsthe waveform data.

Import ALWaveform... Imports the specified waveform data.

Export Pattern... Exports the pattern highlighted in the Patterns display
area.

Import Patterns... Imports the specified pattern data.

Close Closes the Define ALWG Waveform window.

Provides the following six functions.

New Thisisfor creating anew pattern. Opens the New Pattern
dialog box. Entering a new name opens Waveform
Pattern Editor (p. 5-67).

Edit Opens the Waveform Pattern Editor with the pattern
highlighted in the Pattern display area.

Cut Cuts the pattern highlighted in the Pattern display area
and storesit on the Clipboard.

Copy Copies the pattern highlighted in the Pattern display area
to the Clipboard.

Paste Pastes the pattern stored on the Clipboard.

Rename Renames the pattern highlighted in the Pattern display
area.

Provides the following five functions.

Edit Opensthe Waveform Pattern Editor with the column data
highlighted in the Sequence Editor area.

Insert Adds a column.
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Sequence Editor

Delete

Move

Repeat Count

Classic Test Definition
Define ALWG Waveform Window

Deletes the column data highlighted in the Sequence
Editor area.

Moves the highlighted column to the left or the right.

Opens the Repeat Count dialog box used to set the repeat
count.

Specifies the output channel, the output pattern, the repeat count of the pattern, and
the output sequence of patterns. These setup information create the arbitrary linear

waveform data

Column No.

Repeat Count

channel
(e.g SPGU1:HV)

Number for specifying the output sequence. The pattern will be
output in the order of this number.

Output repeat count for the pattern specified by the channel
field (e.gright field of the label “SPGU1:HV"). The repeat
count must be entered in thisfield.

Output channel and its output pattern. The channel is specified
by the header (e.g SPGU1:HV) of this row. The pattern data
must be specified by this entry field. A pre-defined pattern can
be selected from the drop down menu in thisfield. The right
button opens the Waveform Pattern Editor.

This area provides the following buttons.

Insert Column
Delete Column
To L eft

To Right

Adds a column.

Deletes the highlighted column.

Move the highlighted column to the left.
Move the highlighted column to the right.

This area also provides the following functions in the menu displayed by
right-clicking this area.

Cancel

Insert Column
Delete Column
Move Column
Repeat Count

Edit

Closes the menu.

Adds a column.

Deletes the highlighted column.

Moves the highlighted column to the left or the right.

Opens the Repeat Count dialog box used to set the repeat count.

Opens the Waveform Pattern Editor with the specified pattern
data (Pattern) or the specified column data (Column).
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Classic Test Definition
Define ALWG Waveform Window

The Repeat Count field provides the following functionsin the menu displayed by
right-clicking the field.

Cut Cuts the highlighted value and stores it on the Clipboard.
Copy Copies the highlighted value to the Clipboard.
Paste Pastes the value stored on the Clipboard.

When acolumn is highlighted (light blue), the highlighted area provides the
following functionsin the menu displayed by right-clicking the field.

Cancel Closes the menu.

Edit Column Opens the Waveform Pattern Editor with the specified column
data.

When achannel field is highlighted (light blue), the highlighted field provides the
following functions in the menu displayed by right-clicking the field.

Cancel Closes the menu.
Edit Pattern Opens the Waveform Pattern Editor with the specified pattern
data.

Displaysiconsfor all pre-defined waveform patterns and provides the following
functionsin the menu displayed by right-clicking this area.

Cancel Closes the menu.

New Pattern Thisisfor creating anew pattern. Opensthe New Pattern dialog
box. Entering a new name opens Waveform Pattern Editor (p.
5-67).

Edit Opens the Waveform Pattern Editor with the highlighted
pattern.

Cut Cuts the highlighted pattern and stores it on the Clipboard.

Copy Copies the highlighted pattern to the Clipboard.

Paste Pastes the pattern stored on the Clipboard.

Rename Renames the highlighted pattern.

Export Pattern... Exportsthe highlighted pattern data.
Import Pattern... Importsthe specified pattern data.

Double-clicking a pattern icon will open the Waveform Pattern Editor with the
clicked pattern.
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File menu

Edit menu

Display menu

Classic Test Definition
Define ALWG Waveform Window

Waveform Pattern Editor

Thiswindow is opened by several actions, for example by selecting New from the
Pattern menu, and is used to create or edit the pattern data.

Provides the following three functions.

Save Saves the pattern data.

SaveAs... Opens adialog box used to specify a pattern name
and save the pattern data.

Close Closes the Waveform Pattern Editor without saving
the data.

Provides the following seven functions.

Undo Undoes the last action.

Redo Cancels the Undo operation.

Add a New Point Adds apoint.

Delete a Point Deletes the highlighted point.

Same Level AsLeft Point Sets the highlighted point to the same level asthe
left point.

Copy Pattern to Clipboard  Copiesthe highlighted pattern data to the Clipboard
in the tab-separated spreadsheet format.

Paste Pattern from Clipboar d Pastes the tab-separated spreadsheet format data
stored on the Clipboard.

Provides the following function.

Channe Opens the Display Channels dialog box used to
select the SPGU channels displayed on the
Waveform Pattern Editor. Thisfunctionisavailable
if the Waveform Pattern Editor was opened with the
column data.
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Classic Test Definition
Define ALWG Waveform Window

Defines the pattern data. The Pattern Editor provides two methods, graphic mode
and tabular mode, for defining the pattern data.

In the graphic mode, you can define the pattern data by using the mouse pointer and
GUIs on the graph (on the left side of the Pattern Editor).

In the tabular mode, you can define the pattern data by entering Time in seconds,
Level inV, and Switch O (pulse switch open) or 1 (pulse switch close) into the table
(on the right side of the Pattern Editor).

The Delta Time check box and the Delta L evel check box are used to switch the data
expression in thetable. If the box isnot checked, the value will be an absolute value;
if the box is checked, the value will be the difference from the previous point.

The Pattern Editor provides the following buttons.
Undo Undoes the last action.

Redo Cancels the Undo operation.
Add a New Point Addsa point.

Delete a Point Deletes the highlighted point.

The Pattern Editor also provides the following functions in the menu displayed by
right-clicking the area.

Cancel Closes the menu.

Save Saves the pattern data.

Edit Displays the Edit menu.
Display Displays the Display menu.

If the Pattern Editor is opened with the column data, the following GUI will be
available.

Ref Ch. Specifies the channel or the pattern which contains the
reference point.

Ref Pt. Specifies the reference point by the index number (No. column
of table).

DeltaT Displays the difference from the reference point. For time data.

DeltaV Displays the difference from the reference point. For level data.
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Application Test Definition

This chapter provides the reference information of the Test Definition window used
to create the application test definitions.

* “Test Definition Window”
» “Test Specification”

«  “Test Output”

* “Test Contents’

* “Loca Variable Definition”
*  “Program Component”

* “Auto Anaysis’

» “DataDisplay Control”

» “Display Data Setup”

e« “GPIBI/O"

s “Message’

» “Data Store Control”

e “Command Execution”

» “Using Command Execution”

6-2
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Figure 6-1

Application Test Definition
Test Definition Window

Test Definition Window

The Test Definition window is opened by selecting the Define New Test... function
or the Open Definition of This Test... function of the Library menu, and is used to
create atest definition used in the application test mode.

The test definition consists of the elements shown in Figure 6-1. And the Test
Definition window provides the following three tabs for creating atest definition.

» “Test Specification”

The test specification contains test name, description, device parameters, and
test parameters. The parameters will be the variables used to pass the test
conditions to the test execution flow or test setup defined in the test contents.

 “Test Contents’

The test contents are the core of the test definition, and defines the local
variables, test execution flow, and test setup. You can define the test setup by
selecting application tests, classic tests, or My Favorite setup, and entering the
test conditions.

«  “Test Output”

The test output setup is optional. If you need the test result output (test result
display and record) of the test definition, declare the variables (analysis
parameters) and define the display setup.

Test Definition

Test Specification

*Test name *Variables
*Test description *Analysis parameters
+Variables *Test result display
*Device parameters *X-Y graph
*Test parameters *Data list

«Entry fields Tesl ne'inilinn +Parameter display

Local variables
*Test execution flow
*Test setup

+Classic test
*Application test
My Favorite setup
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Application Test Definition
Test Definition Window

The Test Definition window provides the following menus.

File menu Provides the following two functions.

Save Saves the test definition. The sample application
tests furnished with the EasyEXPERT and the
application tests created by other users cannot be
saved without changing the Test Name value. The
Test Name must be your original.

Close Opens adialog box that asksif you want to save
before closing the window. Selecting Yes saves the
test definition and closes the Test Definition
window. Selecting No closes the Test Definition
window without saving the test definition.

Help menu Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.
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Test Information

Device Parameters
Definition

Application Test Definition
Test Specification

Test Specification

This setup screen is used to define the test definition information and the input
parameters for the test definition.

The test information is defined in this area.

Category

Test Name

lcon

Description

Displays the category of the test definition.

The button opens a dialog box used to set the category. It must
be 1 to 30 characters. Multiple categories can be set to atest
definition.

Specifies the test definition name. It must be 1 to 30 characters.

Specifies a bitmap file used for the test definition icon listed in
the Library area of the main screen.

Browse...: Opens adialog box used to select a bitmap file.
Cancel: Returnsto the default setting.
Enters the description of the test definition.

The device parameters are defined in this area. Type of the device parameter is

Numeric.
Name
Default
Description
Add

Delete

Up

Down

Device parameter name

Default value of the parameter
Description of the parameter

Adds arow for the device parameter.

Deletes the selected device parameter. To select the parameter,
use the left radio button.

Moves the selected device parameter upward.

Moves the selected device parameter downward.
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Test Parameters
Definition

Application Test Definition

Test Specification

The test parameters are defined in this area.

Background

Name

Type

Default

Description

Align

X, Y

Width
Ext

Layout...

Specifies a bitmap file used for the background in the Test
Parameters area of the main screen.

Browse...: Opens adialog box used to select a bitmap file.
Cancel: Returnsto the default setting.
Test parameter name

Type of the test parameter, Numeric, Module, String, Vector, or
ALWaveform (SPGU ALWG output data)

Default value of the parameter

For the Numeric, Vector, or ALWaveform type parameter, this
field provides the button to open Numeric KeyPad at the right
side.

For the Vector type parameter, this field provides the button to
open the “Define vector data (page 5-18)” dialog box at the left
side.

For the ALWaveform type parameter, this field provides the

button to open the “ Define ALWG Waveform Window (page
5-64)" at the left side.

Description of the parameter

Specifiesthe X origin of the entry field in the main screen Test
Parameters area. Check this box to set it to the |eft edge of the
entry field. Uncheck this box to set it to the left edge of the
parameter name placed to the left of the entry field.

Specifies the entry field position. (X, Y)=(0, 0) specifiesthe
upper left corner of the main screen Test Parameters area.
Downward and rightward are positive. See “Layout...”.
Specifies the width of the entry field.

Do not check usually. The entry field for the parameter is put on
the main screen.

If the parameter is minor and do not need changes frequently,
check the Ext check box. The entry field will be put on the
dialog box displayed by clicking the “ Extended Setup (page
4-28)" button.

Opens the “ Define Layout (page 6-10)” dialog box.
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Properties

Add
Delete

Up

Down

Application Test Definition
Test Specification

Adds arow for the test parameter.

Deletes the selected test parameter. To select the parameter, use
the left radio button.

Moves the selected test parameter upward.

Moves the selected test parameter downward.

The Properties areais used to define the following values for the specified device
parameter or test parameter. See “ Device Parameters Definition” on page 6-5 and
“Test Parameters Definition” on page 6-6.

To specify the parameter, select the radio button to the left of the parameter name.

Min

Max
Digits
Resolution

Unit

Typical Values...

Resource Type

For Numeric or Vector parameters. Allowable minimum value.
For Numeric or Vector parameters. Allowable maximum value.
For Numeric or Vector parameters. Number of effective digits.

For Numeric or Vector parameters. Allowable setup resolution.
For Numeric or Vector parameters. Unit of the parameter.

For Numeric or String parameters.

Opens the Define typical values dialog box used to define the
selections (typical values) for the specified parameter.

The values defined here are the selections for the parameter
entry field displayed on the main screen in the application test
mode. The selections for the active entry field are displayed on
the softkey. And one of the selections can be set by using the
softkey. Also, it can be set by using the Select sub menu
displayed by right-clicking the entry field.

The selections are effective for the specified parameter only.
For Module parameters.

Opens the Define Resource Types dialog box used to specify
the type of measurement resource. Multiple resouces can be set.

SMU, HPSMU, HRSMU, MPSMU, HRSMU/ASU, GNDU,
SPGU, HVSPGU, WGFMU, RSWGFMU, MFCMU,
MFCMU/SCUU, SWM IN, SWM AUX IN, or SWM SMU IN
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Application Test Definition

Test Specification

Dimension...

Assign Output
Channels...

For Vector parameters.

Opens the Define dimensions dialog box for defining the
dimension of vector data.

Use Dim1Min and Dim1Max to specify the primary dimension
of vector data. This direction can be for the primary sweep data.

Use Dim2Min and Dim2Max to specify the secondary
dimension of vector data. This direction can be for the
secondary sweep data.

The following conditions must be satisfied.
¢ 1 < DimlMin < DimlMax (ex. Dim1Min=1,
Dim1lMax=11)

e 1 < Dim2Min < Dim2Max (ex. Dim2Min=1,
Dim2Max=3)

For ALWaveform parameters.

This button opens the Assign ALWaveform Output Channels
dialog box which specifies the variables if they are used to
identify the SPGU channels. The variables must be the Module
type test parameter.

For example, when the parameters are defined as shown bel ow,
PG1 should be set to the Assign ALWaveform Output Channels
dialog box for the WAV E1 parameter.

PG1: Module parameter to identify the SPGU channel
WAVEL: ALWaveform parameter for the PG1 setup data

Use “Define ALWG Waveform Window (page 5-64)” to create
the SPGU ALWG setup data. For the above example, the PGlis
the SPGU channel identifier when creating the WAV E1 data.
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NOTE

Symbols...

Application Test Definition
Test Specification

For Numeric or Vector parameters.

Opensthe Define dimensions dialog box for assigning a symbol
(string value) to a numeric value for the specified numeric
parameter.

By defining the numeric-symbol assignment, the symbol value,
instead of the numeric value, is set to the parameter entry field
displayed on the main screen in the application test mode.

In the test definition, the parameter works as a numeric value.
However, the numeric-to-string trandation result will not be the
string value simply trandated from the numeric value but the
symbol assigned to the numeric value.

For example, if Symbol=ON is assigned to Value=1 of the
Param1 parameter, the string ON will be set to the Param1 entry
field when numeric value 1 is entered into the Param1 field.
Also, while the Param1 field shows ON, the Param1 value will
be 1 in the test definition. And when the numeric value of
Paraml is 1, the numeric-to-string translation result will not be
the string 1 but the string ON.

The numeric-symbol assignment is effective for the specified
parameter only.

Value and symbol must be in a one-to-one relationship.

The value must satisfy the Min, Max, Digits, and Resolution
settings. The symbol must be between 1 and 30 characters.

Symbols... numeric-symbol assignment

For parameters defined with a numeric-string assignment, the numeric-to-string
translation result will be the symbol assigned to the numeric value. Be careful when
using the string built-in function that is used to translate a numeric expression to a

string value.

For the following example setup of a numeric-symbol assignment,
st ri ng( Mode) execution result at Mode=0 is the string OFF, not the string O.

Name=Mode, Value=0, Symbol=0FF
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Figure 6-2

Application Test Definition
Test Specification

Define L ayout

This dialog box is opened by clicking the Layout... button on the Test Specification
screen of the Test Definition window, and is used to define the layout of the test
parameter entry fields displayed on the application test setup screen. See Figure 6-2.

To define the layout of the entry field, follow the procedures bel ow.
1. Select the entry fields to move. See“To Select Entry Fields’ on page 6-13.
2. Move the selected entry fields. See “To Move Entry Fields’ on page 6-13.

Define Layout dialog box

———— e S— _ -
File Edit View Align Distribute Centralize Tab Order

Cancel

Define Layout GUI
This section describes the Graphical User Interface of the Define Layout dialog box.
The Define Layout dialog box provides the following buttons.

OK Saves the layout definitions and closes the Define Layout
dialog box.

Cancel Closes the Define Layout dialog box without saving the layout
definitions.
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File menu

Edit menu

View menu

Aligh menu

Distribute menu

Centralize menu

Application Test Definition
Test Specification

The Define Layout dialog box provides the following menus.

Exit

Undo
Redo
Select All

Property...

L eft

Center

Right

Top

Middle

Bottom

To Grid

Horizontally

Vertically

Horizontally

Vertically

Closes the Define Layout dialog box without saving the layout
definitions.

Cancels an operation. Up to ten operations can be cancelled.
Performs the canceled operation again.

Selects all entry fields.

Opens the “ Properties (page 6-12)” window.

Alignsthe left ends of other selected entry fieldsto the left end
of the primary entry field.

Alignsthehorizontal centers of other selected entry fieldsto the
horizontal center of the primary entry field.

Alignsthe right ends of other selected entry fields to the right
end of the primary entry field.

Alignsthe upper ends of other entry fields to the upper end of
the primary entry field.

Alignsthe vertical centers of other selected entry fields to the
vertical center of the primary entry field.

Alignsthe lower ends of other selected entry fieldsto the lower
end of the primary entry field.

Alignsthe upper left corner of the entry field to the nearest grid.

Distributes the selected entry fields (3 or more) with even
horizontal intervals. The leftmost entry field is used as the base
point.

Distributes the selected entry fields (3 or more) with even
vertical intervals. The leftmost entry field is used as the base
point.

Moves the horizontal center of all selected entry fields to the
horizontal center of the entry field area.

Moves the vertical center of all selected entry fieldsto the
vertical center of the entry field area.

Agilent B1500 User’s Guide, Edition 7 6-11



Tab Order menu

Design

Layout

Behavior

Layout

Application Test Definition

Test Specification

Top to Bottom

L eft to Right

Properties

Sets the Tablndex in ascending order of the X of the entry
fields, starting at the upper l€eft entry field. If the X of the entry
fields are equal, the Tablndex is set in ascending order of the Y
of the entry fields. For more information on X/Y, see
“Properties’ on page 6-12.

Sets the Tablndex in ascending order of the Y of the entry
fields, starting at the upper left entry field. If the Y of the entry
fields are equal, the Tablndex is set in ascending order of the X
of entry fields.For more information on X/Y, see “Properties’
on page 6-12.

Thiswindow is opened by clicking the Property... button in the View menu of the
Define Layout dialog box, and specifies characteristics of the entry field area or the

entry fields.

When the entry field areais selected, the following characteristics can be specified.

DrawGrid
GridSize
SnapToGrid

Size

Sets whether to display the grid.
Sets the width and the height of the grid.
Sets whether to snap to the grid.

Sets the width and the height of the entry field area.

When entry fields are selected, following characteristics can be specified.

Tablndex

Align

Width
X, Y

Setsthe tab traversing order for the test parameter entry fields
of the application test.

Specifies the X origin of the entry field.

True: Left edge of the entry field

False: Left edge of the parameter name placed to the left of the
entry field

Specifies the width of the entry field.

Specifiesthe entry field position. The Y origin isthe upper edge

of theentry field.(X, Y)=(0, 0) specifiesthe upper |eft corner of
the entry field area. Values increase downward and rightward.
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Application Test Definition
Test Specification

To Select Entry Fields
The following methods are available for selecting the entry fields.

» Click ontheentry field. Multiple entry fields can be selected by clicking on the
entry field while holding down the Ctrl key on the keyboard.

» Drag the mouse to draw arectangle around multiple entry fields.
e Select Select All from the EDIT menu to select all entry fields.

The selected entry fields are outlined by the blue rectangles. The primary entry field,
which is the base for layout operations, is surrounded by a highlighted blue
rectangle, as shown in Figure 5-5. Only one primary entry field can be selected. To
change the primary entry field, click on a selected entry field. The selected entry
field that was most recently clicked will be the primary entry field.

The following methods are available for releasing (unselecting) the selected entry
fields.

e Click the selected entry field while holding down the Shift key on the keyboard.
» Click outside of the selected entry fieldsto release all selected entry fields.

ToMove Entry Fields

The following methods are available for defining the layout of the selected entry
fields.

» Drag & drop with the mouse to move the selected entry field(s).

» Changethe X/Y valuesin the property window to move the sel ected entry
field(s).
» Pressthe arrow keys on the keyboard to move the selected entry field(s).

» Using the functions in the Align menu, the selected single or multiple entry
fields can be aligned to the primary entry field.

» Usethe functions in the Distribute menu to evenly distribute the selected entry
horizontally or vertically.

» Usethe functions in the Centralize menu to move the horizontal or vertical
center of all selected entry fields to the horizontal or vertical center of the entry
field area
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Define Own Output
Parameters

Allocate Data
Display for each
test

Define Analysis
Parameters...

X-Y Graph,
List Display,
Parameters

Application Test Definition
Test Output

Test Output

This setup screen is used to set the test result output (test result display and record)
that is the output of the test definition.

The test output setup is optional. If you have the following requirements, define the
analysis parameters and set the display parameters.

» To send thetest result data to the subsequent tests in an application test
» To make the program branching depends on the test result

» To make the calculation using the test datain the Test Contents

» Todisplay/record the test result of this application test

To read the analysis parameters defined in the application test used in atest
definition, use the “External Variable Setup (page 6-23)” dialog box.

Check this check box to set the test result outputs of the test definition. While this
box is checked, the X-Y Graph, List Display, and Parameters areas are available.
The test result output will be obtained every execution of the test definition.

Thisfield setsthe Multi Display function to Enable, Disable, or Comply with above
level.

If Enable is selected, the test result data of the same test setup name will be
displayed on the exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display window.

If Disable is selected, the test result data will be always displayed on the singular
Data Display window even if it isthe test result data of the different test setup name.

Select Comply with above level for complying with the Multi Display ON/OFF
status or the setting of the application test which uses this application test internally.

This button opens the window. This “ Analysis Parameter Definition (page 6-15)”
window is used to define the vector data and the scalar data used in the test result
output. The defined variable is called as the analysis parameter.

The areas are used to set the test result output (test result display and record) that is
the output of the test definition. See “Display Setup” on page 5-46.
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NOTE

Vector Parameters

Scalar Parameters

Application Test Definition
Test Output

Analysis Parameter Definition

Thiswindow is opened by clicking the Define Analysis Parameters button, and is
used to define the vector variables and the scalar variables used in the test result
output. The variables are called as the analysis parameters. Thiswindow is closed
by the Close button.

Analysis parameters can be referred from atest definition which uses this
application test. To read the value, make a mapping table between the analysis
parameters and the local variables, device parameters, test parameters, or analysis
parameters defined in the test definition by using the “ External Variable Setup (page
6-23)” dialog box.

This area sets the analysis parametersfor the vector data. The vector dataisan array
datathat contains numeric data more than one.

Name Name of the analysis parameter

Unit Unit of the analysis parameter

Description Description of the analysis parameter

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the
|eft radio button.

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.

This area sets the analysis parameters for the scalar data. The scalar dataisa
numeric data.

Name Name of the analysis parameter

Unit Unit of the analysis parameter

Description Description of the analysis parameter

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the
|eft radio button.

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.

Agilent B1500 User’s Guide, Edition 7 6-15



Figure 6-3

Application Test Definition
Test Contents

Test Contents

Test contents are the core of the test definition, and consists of the local variables,
test setups, and test execution flow. In the test contents, the following elements can
be defined. See Figure 6-3.

Local variables

Program components

Application tests

Classic tests

My Favorite setup

Analysis components

Miscellaneous components

Device parameters defined in Test Specification
Test parameters defined in Test Specification
Analysis parameters defined in Test Output

The device parameters, test parameters, and analysis parameters can be used in the
Test Contents without defining as the local variables.

For the available components, see Figure 6-4.

Test Contents
Test Specification Test Output
Variables Variables

Local variables

*Device parameters
Test parameters

Test Contents

Miscellaneous

*Analysis parameters

Program Component

Application Test My Favorite setup
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Figure 6-4

Defining/Editing Test Contents

Application Test Definition

Test Contents

The Test Contents setup screen is used to define the test execution flow that is the
core of the test definition. To define the test execution flow, use the test flow list
area at the lower left of the window, and do following. Also see Figure 6-5.

1. Definelocal variables by using the Local Variables Definition statement.

2. Select acomponent from the component selection area. See Figure 6-4 for the

available components.

Insert it between the BLOCK and END BLOCK statements.

4. Repeat thisuntil your test execution flow is completed.

Available Components

Program Component
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Application Test
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- | \ ¢ o
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Analysis
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Auto Display Data Data Display
Analysis Setup Control
[
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IV Sweep Multi vt C-V Sweep SPGU Switching Direct
Channel L.. Sampling Control Matrix ... Control =
Miscellaneous
= = ~
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GFIB /O Message Command Data Store
Execution Control
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move Preset
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Program
Component

Application Test

Analysis

Classic Test

My Favorite Setup

Application Test Definition
Test Contents

This component selection menu lists the program components available for the test
flow. See “Program Component” on page 6-26.

This menu lists the application test setups available for the user. Inserting an
application test setup to the test flow displays the test setup screen almost same as
the “Application Test” on page 4-27. You set the test condition on this screen.

Variables can be used for setting the test condition. To use a Numeric or Module
variable, enter the variable name to the entry field. To use a String variable, type an
equal sign (=) and enter the variable name (for example, =VAR).

Clicking the Assign to external variables... button opens the External Variable Setup
dialog box. See “External Variable Setup” on page 6-23.

This component selection menu lists the analysis functions available for the test
flow, and provides the following components.

» “Auto Anaysis’ on page 6-27
» “Display Data Setup” on page 6-31
» “DataDisplay Control” on page 6-30

This component selection menu lists the classic test objects, 1/V Sweep, Multi
Channel 1/V Sweep, I/V List Sweep, I/V-t Sampling, C-V Sweep, SPGU Control
Switching Matrix Control, and Direct Control.

Inserting a classic test component to the test flow displays the test setup screen
almost same asthe “1/V Sweep” on page 5-4, “Multi Channel 1/ Sweep” on page
5-9, “I/V List Sweep” on page 5-13, “1/V-t Sampling” on page 5-21, “C-V Sweep”
on page 5-26, “ SPGU Control” on page 5-57, “ Switching Matrix Control” on page
5-55, or “Direct Control” on page 5-30. You set the test condition on the screen.

Clicking the Assign to external variables... button opens the External Variable Setup
dialog box. See “External Variable Setup” on page 6-23.

This component selection menu is used to select the My Favorite setup inserted to
the test flow. Specify the preset group, then select the setup.
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Miscellaneous

Edit / Debug

Block Selection /
Line Selection

Application Test Definition
Test Contents

This component selection menu lists the miscellaneous functions available for the
test flow, and provides the following components.

e “GPIB I/O" on page 6-33

* “Message’ on page 6-38

» “Command Execution” on page 6-40
» “Data Store Control” on page 6-39

To add a component to the test flow, select the destination line for the component
and drag the component from the component selection areato the test flow list area.
Instead, you can select aline and a component, then click the Insert button. The
component will be put on the line after the selected line, and the following lineswill
shift downward.

After adding a component to the test flow, selecting the new line might display an
editor at the center to lower right of the window. The editor is used to define the
setup. Some components provide the editor, and some components do not. For
example, the Local Variables Definition provides the editor used to define the local
variables. See “Local Variable Definition” on page 6-24.

You can edit the test flow by using the Block Selection/Line Selection, Insert,
Delete, Copy, Cut, and Paste buttons. Also you can debug the test flow by using the
Run/Pause, Abort, Step, Break, and Inspect buttons. See “ Debugging Test Contents’
on page 6-21.

The Edit tab displays the buttons Block Selection/Line Selection, Insert, Delete,
Copy, Cut, and Paste.

The Debug tab displays the buttons Run, Abort, Step, Break, and Inspect.

Only the buttons effective for the selected linein the list area are active.

The Line Selection button changes the list area sel ection mode to the line selection

mode. The Block Selection button changes the sel ection mode to the block
selection.

In the line selection mode, the line cursor selects every line.

In the block selection mode, the line cursor selects every block. For example, the
lines from the |F statement to END | F statement can be a block.
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Application Test Definition
Test Contents

Insert This button puts the selected component on the next line of the selected line. The
following lines will shift downward.

Delete This button deletes the selected line. The following lines will shift upward.

Copy This button copies the selected line to the clipboard.

Cut This button moves the selected line to the clipboard. The following lines will shift
upward.

Paste This button puts the components in the clipboard on the next line of the selected

line. The following lines will shift downward.

Figure 6-5 Test Contents Screen
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Figure 6-6

Run/Pause

Abort

Step

Break

Inspect

Application Test Definition
Test Contents

Debugging Test Contents

On the Test Contents tab screen, click the Debug tab. The following buttons will
appear. They are useful for debug of your test contents.

Set the break point, and click the Run button. And check the operation of the test
contents, the value of variables by using the Variable Inspector, and so on.

Debugging Test Contents
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This button starts the debug (executes the test flow). During execution, the label
changesto Pause. Clicking Pause pauses the execution, and changes the label to Run
that is used to continue the debug (execution).

This button aborts the debug (execution).

This button executes the selected line of thetest flow. Clicking the button repeatedly
continues the execution by aline.

This button sets/rel eases the break point. For the break point, this button releases the
break point from the selected line. Program execution will break at the break point
automatically.

Thisbutton is avail able when the debug (execution) is paused or broken. This button
opens the Variable Inspector used to monitor value of device parameters, test
parameters, analysis parameters, local variables, or system variables. See “Variable
Inspector” on page 6-22.
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Numeric Variable

Vector Variable

String Variable

Module Variable

Application Test Definition
Test Contents

Variable I nspector

This Variable Inspector is displayed by clicking the “Inspect (page 6-21)" button on
the Test Contents screen, and is used to monitor or change the value of the local
variables, device parameters, test parameters, and analysis parameters. For the
vector variables, only datamonitor is available. The Variable Inspector provides the
following buttons to add the variable monitor area.

Add Numeric Variable Adds the numeric variable monitor area.
Add Vector Variable Adds the vector variable monitor area.
Add String Variable Adds the string variable monitor area.
Add ModuleVariable  Addsthe module variable monitor area.

The following functions are available for the menu displayed by clicking the banner
of the variable monitor area.

Up This button shifts the variable monitor area upward.
Down This button shifts the variable monitor area downward.

Remove This button del etes the variable monitor area

You can monitor or change the following information.
Variable Numeric variable name

Value Value of the variable

You can monitor the following information.

Name Vector variable name. Two dimensional array.
Index1/2 Index for the primary/secondary plane of the two-dimensional array
Value Value of the variable

You can monitor or change the following information.
Variable String variable name

Value Value of the variable

You can monitor or change the following information.
Variable Module variable name

Value Value of the variable
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External variable

Measurement data

Example

Application Test Definition
Test Contents

External Variable Setup

Thisdialog box is displayed by clicking the Assign to external variable... button on
an Application Test setup screen or a Classic Test setup screen, and is used to make
amapping table between the test setup internal variables and the local variables,
device parameters, test parameters, or analysis parameters defined in the test
definition which uses this test setup. After making the mapping table, you can read
the value by using the external variables.

This dialog box provides the following buttons.

Add Adds the variable entry fields.

Delete Deletes the variable entry fields selected by the radio button.
Up Shifts the selected variable entry fields upward.

Down Shifts the selected variable entry fields downward.

This dialog box provides the following entry fields.

Name of local variable, device parameter, test parameter, or analysis parameter
connected with the variable set to the Measurement data field

Name of internal variable used in atest setup and to be read. For the Application
Test, only the analysis parameters are available.

The following example connects the internal vector variable Vdata with the local
variable VDATA.

1. Define VDATA asalocal variable by using the Local Variables Definition
statement.

Click the Assign to external variable... button on atest setup screen.
Click the Add button on the External Variable Setup dialog box.
Set VDATA to the External variable field.

Set Vdata to the Measurement data field.

o g~ WD

Click the Close button.
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Application Test Definition
Local Variable Definition

L ocal Variable Definition

This setup editor is displayed while the Local Variable Definition is selected in the
test execution flow list area, and is used to define the variables used in the test
definition. The setup editor provides the following buttons to add the variables.

Add Numeric Variable Addsthe numeric variable.
Add Vector Variable Adds the vector variable.
Add String Variable Adds the string variable.
Add Module Variable  Addsthe module variable.

The following functions are avail able for the menu appeared by clicking the banner
of the variable area.

Up This button shifts the variable area upward.
Down This button shifts the variable area downward.

Remove This button deletes the variable.

Numeric Variable  This area providesthe following entry fields.
Name Numeric variable name
Value Initial value of the variable

Description Additional information for the variable
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Vector Variable

String Variable

Module Variable

Application Test Definition
Local Variable Definition

This area provides the following entry fields.

Name Vector variable name. Two dimensional array.
Count Number of elements, or array size
Description Additional information for the variable

This area also provides the following radio button used to specify how to set the
initial value of the array data automatically.

* Assign Linear Values FROM [value of first element] TO [value of last element]

If Count > 1, this setsfirst value + (N- 1) x (last value- first value)/(Count- 1) to
the N-th element. If Count = 1, this setsfirst value (=last value) to the element.

* Assign Linear Values FROM [value of first element] STEP [step value]
This setsfirst value + (N- 1) x step to the N-th element.

This area provides the following entry fields.
Name String variable name
Value Initial value of the variable

Description Additional information for the variable

This area provides the following entry fields.
Name Module variable name

Description Additional information for the variable
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ASSIGN

COMMENT

IF

ELSE IF

FOR

Application Test Definition
Program Component

Program Component

The Program Component selection menu provides the components described in
“Script Program Statements’ on page 8-19. Especially, the following components
provide the setup editor.

. “ASSIGN”
« “COMMENT’
. P

. “ELSEIF

.+ “FOR’

This component provides the setup editor that contains the following entry fields
used to define the value of the variable.

Variable Variable name
Expression Definition of the variable

This component provides the setup editor used to enter the comment for the line.

This component provides the setup editor used to enter the condition for the IF
Statement.

This component provides the setup editor used to enter the condition for the
EL SE IF statement.

This component provides the setup editor that contains the following entry fields
used to define the FOR NEXT loop condition.

Variable Variable name

Initial Value Count to start the FOR NEXT loop

Terminate Value Count to terminate the FOR NEXT loop

Sep Value Loop count incremental step value
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Interpolation Mode

Line 1, Line 2

Application Test Definition
Auto Analysis

Auto Analysis

This component provides the setup editor used to set up the automatic analysis
function. When a measurement finishes, the function automatically drawslines, a
marker, or both on the X-Y Graph of the Data Display window.

You can set up two lines and one marker for the automatic analysis function by
using the setup editor.

IntheLine 1 and Line 2 areas, you can set up the lines to be drawn.
In the Marker area, you can set up the marker.

Check this box to enable the interpolation mode. You can position marker between
measurement points.

Thisareasetstheline 1 or line 2 automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the line.

Fix Check this box to fix the line on the graph after the auto
analysis is performed. Remove the check to make the line free.

Type Select one of the available line types listed below.

Axis Axis effective for the line. Specify onefromY1to Y8.

First Point See the following description for the line you selected.

Second Point See the following description for the line you selected.
Available line types:

*  “Normal ling": For drawing a line between any two points.
» “Gradient line": For drawing aline through any point with a specified gradient.
» “Tangent line”: For drawing atangent line to a measurement point.

» “Regressionline’: For drawing aregression line by using the measurement data
included in the area specified by any two points.
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Marker

Normal line

Gradient line

Application Test Definition
Auto Analysis

This area sets the marker automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the marker.

Condition Enter a variable name and a condition expression to specify
where you want the marker to appear.

After Check this box to enable the additional condition.

Enter a second variable and condition expression. Thissetsup a
search start condition for finding specified point.

For example, you can specify the following expressionsto search for a measurement
point that satisfies the first condition after the second condition is satisfied.

Condition:[ DGM]=[MAX(DGM)*0.01] [x] After [DGM]=[MAX(DGM)]
The First Point area and the Second Point area are used to specify the pointsthe line
passes through. The following two ways are available to specify the point.
* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition
Enter a variable name and condition expression to specify the point. Thisisthe

same method as specifying the Marker point.

The First Point areais used to specify the point the line passes through. The
following two ways are available to specify the point.

» X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisisthe
same method as specifying the Marker point.

In the Gradient field, enter agradient value or expression.
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Application Test Definition
Auto Analysis

Tangent line The First Point areais used to specify the measurement point the tangent line passes
through.

Enter avariable name and condition expression to specify the point. Thisisthe same
method as specifying the Marker point.

Regression line The First Point area and the Second Point area are used to specify the range of the
measurement data used for the regression calculation. The following two ways are
available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisis the
same method as specifying the Marker point.
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Application Test Definition
Data Display Control

Data Display Control

This component enables or disables the test result display of the application test or
the classic test used in the test definition.

Enable Data Display = Checking this box enables the test result display.

If you do not use this component, the test result display is enabled.

This component cannot control the test result display of the test definition. The test
result display is always enabled for the test definition. For the test result output of
the test definition, see “ Test Output” on page 6-14.
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X-Y Graph

Application Test Definition
Display Data Setup

Display Data Setup

This component is used to set the data output of the local variables defined in the
test execution flow. The values can be displayed on the Data Display window.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8

axes can be set.
Name

Sharing

Scale
Min
Max
Add
Delete
Up

Down

Specifies the parameter for the axis.

Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (ho grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale of the axis, Linear or Log

Minimum value of the axis

Maximum value of the axis

Adds a parameter (or axis).

Deletes the parameter selected with the radio button on the left.
Moves the selected parameter upward.

Moves the selected parameter downward.
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Application Test Definition
Display Data Setup

List Display, The List Display area sets the output for the List Display area of the Data Display
Parameters window. The Parameters area sets the output for the Parameters area of the Data

Display window. Up to 20 parameters can be set for each area.

parameter Specifies the parameter for the data output.

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the

left radio button.
Up Moves the selected parameter upward.
Down Moves the selected parameter downward.
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CAUTION

Write String

Write Value

Application Test Definition
GPIB I/O

GPIB I/O

This component provides the setup editor that contains the following entry fields.
This component is used to control the GPIB interface. For the fieldsto enter a
variable name, only the variable name defined in the test definition can be entered.

Do not set the GPIB address of the B1500A to the Address parameter of this
component even if thisis on the Desktop EasyEXPERT software. Operation of the
B1500A is not guaranteed.

Sends the specified string data to the specified GPIB device.

Address
Sring

Terminator

GPIB address of the target device
String value to send

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified)

Translates the specified numeric data to the string data, and sends it to the specified

GPIB device.
Address
Format

ValueO
Valuel
Value2
Value3

Terminator

GPIB address of the target device

Format of Write Value. Follow Agilent T& M Programmers
Toolkit.

Numeric value or string value to send
Numeric value or string value to send
Numeric value or string value to send
Numeric value or string value to send

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified).
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Read String

Read Value

Application Test Definition

GPIB 1/O

Reads a string value from the specified GPIB device.

Address
Sring
Length To Read

Length Actually
Read

Ter minator

Terminated

Timeout

GPIB address of the target device
String variable name. Used to store the returned value.
Byte length of the string value to read

Numeric variable name. Used to store the byte length of the
returned value. If the Length To Read is large enough and the
terminator is sent with the returned string value, the value of
this numeric variable is smaller than the specified Length To
Read.

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified)

Numeric variable name. Used to store the execution result. If
reading is completed by the terminator, 1 is entered. Otherwise,

0 is entered.
Timeout. The value must be less than 231
0 does not set timeout.

s, 1 msresolution.

Reads a numeric value from the specified GPIB device.

Address GPIB address of the target device

Value Numeric variable name. Used to store the returned value.

Preamble String variable name. Used to store preamble of the returned
value. The preamble is a part considered as non-numeric value.
If thisfield is not set, the preambleis del eted.

Postamble String variable name. Used to store postamble of the returned
value. The postambleisapart considered as non-numeric value.
If thisfield is not set, the postamble is del eted.

Success Numeric variable name. Used to store the execution result. For
the successful result, 1 is entered. Otherwise, O is entered.

Terminator Terminator, DEFAULT, EOI, CR/LF+EOI, LF+EOQOI, CR/LF,
LF, or NONE (not specified)

Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.
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Read List

Read STB

GP-IB Control

Application Test Definition

GPIB I/O
Reads a vector data from the specified GPIB device.
Address GPIB address of the target device
Values Vector variable name. Used to store the returned value.
Delimiter Delimiter. 1 character. 0t0 9, E, g, +, - , and . (comma) cannot
be specified.
Length Actually
Read Numeric variable name. Used to store the number of data stored
in the vector variable.
Ter minator Terminator, DEFAULT, EOI, CR/LF+EOI, LF+EOQOI, CR/LF,
LF, or NONE (not specified)
Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.
Reads the status byte of the specified GPIB device.
Address GPIB address of the target device
Satus Byte Numeric variable name. Used to store the status byte to read.
Timeout Timeout. The value must be less than 231 s, 1 msresolution.

0 does not set timeout.

This area selects one from the following GPIB statements to execute.

» Group Execution Trigger
Sends atrigger to the specified GPIB device.
Address GPIB address of the target device

231

Timeout Timeout. The value must be less than s, 1 msresolution.

0 does not set timeout.
» DeviceClear
Sends a device clear to the specified GPIB device.
Address GPIB address of the target device

Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.
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Example 1

Application Test Definition
GPIB I/O

» GoTolLoca
Returns the specified GPIB device to the local state.
Address GPIB address of the target device

Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.

* Local LockOut
Locks the specified GPIB device.
Address GPIB address of the target device

Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.

To send the following command to Agilent B2200A switching matrix (GPIB
address 22), use Write Value function and enter the parameters as shown bel ow.

‘ROUT:SYMB:CHAN 0, 1, “Gate”

This command assigns the string Gate to the output 1 of the B2200A in the auto
configuration mode.

*  Write Vaue
Address 22
For mat :ROUT:SYMB:CHAN {0}, {1}, “{2}"
ValueO 0
Valuel 1
Value2 Gate
Value3 (blank)
Terminator LF+EOI

where, {0}, {1}, {2}, and { 3} are the variablesthat can be used in the Format field,
and corresponds to the Value0, Valuel, Value?, and Value3 respectively.
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Application Test Definition
GPIB I/O

Example 2 After performing Example 1, enter the following query command and read the
response by using Write String and Read String functions as shown below. Use
Write String to send the command, after that use Read String to read the response.

‘ROUT:SYMB:CHAN?O, 1

This command returns the string assigned to the output 1 of the B2200A in the auto
configuration mode.

»  Write String:
Address 22
Sring :ROUT:SYMB:CHAN?0, 1
Terminator LF+EOI

* Read String:
Address 22
Sring ReturnedVvalue
Length To Read 10
Length Actually Read Lengthl
Terminator LF+EOI
Terminated Term
Timeout 1.00s

where, ReturnedValue is a string variable to store the response of the
‘ROUT:SYMB:CHAN? 0, 1 command, Lengthl is a numeric variable to store the
byte length of the ReturnedValue value, and Term is a numeric variable to store the
execution result. They must be defined in the Local Variables Definition statement.
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Message
User Response

Button 1

Button 2

Button 3

Button 4

Application Test Definition
Message

M essage

This component provides the setup editor that contains the following entry fields.
These are used to set up the message box that pauses program execution, appears on
the screen, and waits for the response of the user.

Enter the message displayed on the message box.
This area provides the Button 1, Button 2, Button 3, and Button 4 areas.

This area provides the following entry fields.
Label Label or name of the button placed at the left side

Selected Variable name used in the test definition. The variable is used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

Label Label or name of the button placed at the second from the left

Selected Variable name used in the test definition. The variable is used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

Label Label or name of the button placed at the second from the right

Selected Variable name used in the test definition. The variable is used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

L abel Label or name of the button placed at the right side

Selected Variable name used in the test definition. The variable is used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.
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Application Test Definition
Data Store Control

Data Sore Control

This component enables or disables the test record of the application test or the
classic test used in the test definition.

Enable Creating Test Result Record
Checking this box enables the test record.

If you do not use this component, the test record is enabled.

This component cannot control the test record of the test definition. The test record
is always enabled for the test definition. For the test result output of the test
definition, see “ Test Output” on page 6-14.
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Application Test Definition
Command Execution

Command Execution

This component provides the setup editor that contains the following entry fields.
This component is used to execute the specified execution file (EXE file) and obtain
the execution results. For the fields to enter a variable name, only the variable name
defined in the test definition can be entered. See “Using Command Execution” on

page 6-42.
Command File name of the Windows execution file (EXE file) to execute.
Filename
Argument Argument or parameter to passto the EXE file.
Write Type Type of datato write. String (string data) or List (vector data).
e String

Displays the Write String area used to specify the string data to write. Up to 20
string data can be defined.

+ List
Displays the Write List areathat provides the following entry fields.
Values Variable name of the List data to be passed to the EXE file.

Format
If you do not specify Format, this function passesthe List datato
the EXE file. To pass adatain the List data, enter the keyword to
specify the element. See “Defining Format Field” on page 6-45.
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Application Test Definition
Command Execution

Read Type Type of datato read. String (string data), Value (numeric data), List (vector data), or
None (no response).
String
Displays the Read String area that provides the following entry fields.
Result Numeric variable name. Used to store the execution result.
Sring String variable name. Used to store the returned value.
Length
Actually Read Numeric variable name. Used to store the byte length of the
returned value.
Value

Displays the Read Value area that provides the following entry fields.

Result Numeric variable name. Used to store the execution result.
Value Numeric variable name. Used to store the returned value.
List

Displaysthe Read List areathat provides the following entry fields.

Result Numeric variable name. Used to store the execution result.
Values Vector variable name. Used to store the returned value.
None

Thistypeisfor the EXE file without response or datato read.
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NOTE

Application Test Definition
Using Command Execution

Using Command Execution

Windows execution file (.exe file) can be executed by using the Command
Execution component. Most execution files will need parameters to be sent or
returned. The parameters will be variables that can be defined on the Test
Specification tab screen or the Local Variable Definition component on the Test
Contents tab screen.

This section describes how to enter the windows execution file.

* “Command Parameters’

» “Defining Numeric/Vector Input Parameter”
» “Defining String/Numeric Input Parameters”
» “Defining Numeric Output Parameter”

» “Defining Vector Output Parameter”

» “Defining String Output Parameter”

» “Defining Format Field”

Command Parameters

The Windows Command Execution component supports one input variable and one
output variable. To use multiple string input parameters or multiple numeric input
parameters, set the variable as shown below. Multiple vector input parameters and
multiple output parameters are not supported.

» If the command requires multiple string input parameters, use string variables.
In the Windows Command Execution component, set the Write Type to String.
Up to 20 string data can be defined.

» If the command requires multiple numeric input parameters, use numeric
variables and set the Write Type to String. To enter the numeric variable name,
use the string built-in function. For example, enter st ri ng( Rz) to set the Rz
numeric variable.

» If the command requires both numeric and string input parameters, use numeric
and string variables respectively, and set the Write Type to String.

Before calling the command, enter the value to the input variable by using the
ASSIGN statement.
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NOTE

Application Test Definition
Using Command Execution

string built-in function

The string built-in function is used to translate a numeric expression to a string
value. Be careful about the argument for this function. If it isanumeric variable
defined with the numeric-symbol assignment, the string function execution result
will be the symbol assigned to the numeric value, not the string value just trandl ated
from the numeric value. The numeric-symbol assignment is defined in the “ Test
Specification” on page 6-5.

For the following example setup of the numeric-symbol assignment,
st ri ng( Mode) execution result at Mode=0 is the string OFF, not the string O.

Parameter Mode, Value=0, Symbol=0OFF

Defining Numeric/Vector Input Parameter

1. Define avector variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Write Type to List in the Windows Command Execution component.
3. Enter the variable name in the Values field of the Write List area.

For the numeric parameter, a data element of vector variableis used to store the
data for the parameter. Specify the data by using the Format field. For example,
enter { 0} to specify the datain the first element of the vector variable. For the

Format field, see “Defining Format Field” on page 6-45.

For the vector parameter, ignore the Format field.

Defining Sring/Numeric I nput Parameters

1. Define string or numeric variables in the Test Specification tab screen or the
Local Variable Definition component in the Test Contents tab screen.

2. Set the Write Type to String in the Windows Command Execution component.
3. Add alinein the Write String area.
4. Enter the variable name for the first input parameter in the first line.

If the command needs multiple input parameters, add a line and enter the
variable name for the variable in the added line. Then observe the order of
parameters.

To enter anumeric variable name, use the string built-in function. For example,
enter st ri ng( Rz) to set the Rz numeric variable.
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Defining Numeric Output Parameter

1. Define anumeric variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Read Type to Vaue in the Windows Command Execution component.
3. Enter the variable namein the Value field of the Read Value area.

The Result field can be blank or the name of another numeric variable defined in the
Test Specification or Local Variable Definition. The variable will be used to receive
the command execution result.

Defining Vector Output Parameter

1. Define avector variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Read Typeto List in the Windows Command Execution component.

3. Enter the variable name in the Values field of the Read List area.

The Result field can be blank or the name of a numeric variable defined in the Test
Specification or Local Variable Definition. The variable will be used to receive the
command execution result.

Defining Sring Output Parameter

1. Defineastring variablein the Test Specification tab screen or the Local Variable
Definition component of the Test Contents tab screen.

2. Set the Read Type to String in the Windows Command Execution component.

3. Enter the variable name in the String field of the Read String area.

The Result field and the Length Actually Read field can be blank or the name of a
numeric variable defined in the Test Specification or Local Variable Definition. The
variable will be used to receive the command execution result or the length of the
returned string data.
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Application Test Definition
Using Command Execution

Defining Format Field

The Format field requires a keyword to specify adatain vector variable. The
keyword must have the style such as {I,A:F}. where,

I Index used to specify the element. Integer, O or positive number.
Mandatory. 0 specifies the first element.

A Character length of the specified data element. Positive integer for
right-aligned, or negative integer for left-aligned. If thisvalueisnot set,
the length is not specified (no limit).

F Style of the data. See Table 6-1. If thisvalueisnot set, G is selected..

Following are the example formats. For more information, see online help or
manual of Agilent T& M Programmers ToolKkit.

» {0,5:E} First element, five characters, exponential notation

» {1,10} Second element, 10 characters, general

o {2:x} Third element, no limit for length, hexadecimal numeric
» {3} Fourth element, no limit for length, genera

Available F values

F M eaning F M eaning
Corc | Circulation Norn | Numeric
Dord | Decima numeric Porp | Percent
Eore | Exponentia notation Rorr | Roundtrip
Forf Fixed point X orx | Hexadecimal numeric
Gorg | Genera
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Figure 6-7

Application Test Definition
Using Command Execution

Setup Example

The following example setup is used to execute a PlsdivM easureld command that
has two numeric inputs and four numeric outputs.

ranging and id_range are numeric variables used for the input parameters,

read data isavector variable used for the output parameters, and PassFail isa
numeric variable used to store the command execution result. They must be defined
in the Test Specification tab screen or the Local Variable Definition component on
the Test Contents tab screen. Input parameter values must be set to the variables
before executing the command. Four datawill be assigned to read_data in sequence.

Windows Command Execution Setup Example

Windows Command Exzecution |

Ccommand Filename: IEPngram Files¥a,gilent¥PLSDIVEPLSDIVEe¥ TISExe¥PlsdiviMeasurald. exe g Browse. .. |

Argument: I _@

Write Type: & String  List

Read Type: " String " Yalue & List  MNone

Write String |

Add Delete | Up | D |

© [string(ranging) =

o |string(id_range) =

Read List

Result: IPassFaiI - I Yalues: Iread_data - I
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Function Details

This chapter explains the following measurement functions of
Agilent B1500A/EasyEXPERT, and the efficient functions of the EasyEXPERT
software.

* “1/V Sweep Measurement”

o “Multi Channel I/V Sweep Measurement”
o “1/V-t Sampling Measurement”
* “C-V Sweep Measurement”

* “SPGU Module’

* “Sweep Abort Function”

e “Standby Function”

» “BiasHold Function”

* “Current Offset Cancel”

e “SMU CMU Unify Unit”

» "Atto Sense and Switch Unit”
* “SMU/PG Selector”

* “SMU Ranging Mode”

* “SMU Compliance”

e “SMU Pulse’

* “"SMU Measurement Time”

e “SMU Filter”

* “SMU Series Resistor”

* “Interlock Function”

» “Auto Power Off Function”

e “Initial Settings”
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Figure 7-1

Function Details
I/V Sweep Measurement

|/V Sweep M easurement

For the 1/V sweep measurements, sweep source channels (SMU) perform staircase
sweep output of voltage or current, while monitor channels (SMU) measure voltage
or current for each sweep step. According to the output function, the following
measurements are available. See Figure 7-1 for the SMU output function.

» “Basic Sweep Measurement” by using VAR function
» “Subordinate Sweep Measurement” by using VAR1 and VAR1' functions

» “Synchronous Sweep Measurement” by using VAR and VAR2 functions,
VARY' function isalso available

» “Pulsed Sweep Measurement”

Thisisthe basic, subordinate, or synchronous sweep measurement using a pulse
output SMU. Only one pulse output SMU is available.

SMU Output Function and Sweep Output

VAR1

VAR2 j—,—,i

VART’

Available M odules

SMUs and SPGUs can be used. SMU can be constant voltage/current source or
pulse voltage/current source and perform voltage/current measurement. SPGU can
be pulse voltage source. See “ SPGU Modul€e” on page 7-26 for using the SPGU.

If multiple measurement channels are used, the channels perform measurement in
order. See “Multiple Measurement Channels’ on page 7-61.
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Function Details
I/V Sweep Measurement

Output Range

Output range of the sweep source channel is automatically set to the following
range.

e minimum range covers all sweep output valuesin Linear sweep.
e minimum range covers al sweep output valuesin Log voltage sweep.

» optimum range for output value every sweep step in Log current sweep.

Basic Sweep M easurement

Basic sweep measurement uses the primary sweep source (VARL). You can select
any combination of Direction and Linear/Log as shown in Figure 7-2.

» Direction

» Single source channel sweeps the output from user specified start value to
stop value.

« Double source channel sweeps the output from user specified start value to
stop value, then from stop value to start value.

* Linear/Log

¢ Linear staircase

* Logarithmic staircase

Saircase Sweep Outputs

Single Sweep Double Sweep

Linear Sweep JJI ﬁ
Log Sweep J J_H_HL

See “1/V Sweep” on page 5-4 for the GUI.
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The following setup is required to perform the basic sweep measurements.

1. Select the following on the Channel Setup tab screen.

* Seect VARL for the Function of the SMU used for VARL.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPUL SE for voltage monitor SMU. Pulseis available only for one SMU.

2. Specify the following parameters for VAR on the Measurement Setup tab

screen.
Direction

Linear/Log

Sart

Sop

Sep, No of Sep

Compliance

Pwr Comp

Hold

Delay

Single or double sweep.

Linear or logarithmic sweep. For logarithmic sweep, the
number steps in one decade is 10, 25, or 50.

Start value of sweep. Allowable range of start depends on
output range of sweep source. For logarithmic sweep, start
must not be zero.

Stop value of single sweep or turning back value of double
sweep. Allowable range of stop depends on output range of
sweep source. For logarithmic sweep, stop must have same
polarity as start, and must not be zero.

For linear sweep, step is step increment of sweep. No of Sep
is calculated from start, stop, and step.

For logarithmic sweep, step isinvalid. Number of sweep
stepsis calculated from start, stop, and number of stepsin
one decade.

Calculated number of steps must bein range: 1 to 1001.

Compliance value of sweep source. Allowable range of
compliance depends on the compliance range of sweep
source.

(Optional) Power compliance value of sweep source.
Allowable range depends on power compliance range of
Sweep source.

Time required for DUT to settle after forcing start value.
0 to 655.35 swith 10 msresolution.

Time required for DUT to settle after stepping the output.
0 to 65.535 swith 100 usresolution.
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Figure 7-3 Basic Sweep M easurement
Qutput Voltage Th : hold time
or Current Td : defay time
N : #umber of steps
Stop Value T N
Th+Td . . Td

Single Sweep e 3

8]

Start Value + ¢

Time

} X

Trigger Completion
Th: hold time
Output Voltage Td : delay time
or Current Nt number of steps
Td
Stop N > N4
Value T
Double Sweep s % Td
LTt o T4
0 1 2N
Start T
Yalue
Time
X f
Trigger Completion

Subordinate Sweep M easurement

For subordinate sweep measurement, you set up a secondary sweep source (VAR?2)
in addition to aprimary sweep source (VARL). After VAR1 sweep is completed, the
output of VAR2 sweep source isincreased or decreased by the specified step value,
then the VAR1 sweep sourceis swept again.

Only the linear single sweep is available for the VAR2.

The following setup is required to perform the subordinate sweep measurements.
See “1/V Sweep” on page 5-4 for the GUI.

1. Select the following on the Channel Setup tab screen.
* Seect VARL for the Function of the SMU used for VARL.
* Seect VAR2 for the Function of the SMU used for VAR2.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPUL SE for voltage monitor SMU. Pulseis available only for one SMU.
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2. Set the VAR1 channel as shownin “Basic Sweep Measurement”.

3. Specify the following parameters for VAR2 on the Measurement Setup tab

screen.

Sart Start value of secondary sweep. Allowable range of start
depends on the output range of secondary sweep source.

Sop Stop value of secondary sweep iscalculated from start, step,
and number of steps. Allowable range of stop depends on
the output range of secondary sweep source.

Sep Step increment of secondary sweep.

No of Step Number of secondary sweep steps (N,). 1 to 1001.

Then, the following formula must be satisfied.
1 <Nj x N, <128128 (N4: number of primary sweep steps)

Compliance Compliance value of secondary sweep source. Allowable
range of compliance depends on the compliance range of
secondary sweep source.

Pwr Comp (Optional) Power compliance value of secondary sweep
source. Allowable range of power compliance depends on
the power compliance range of sweep source.

Figure7-4 Subordinate Sweep M easurement
Stop value |...
Primary

Sweep Source 0 (———
Start value |-
Stop value |---

Secondary

Sweep Source 0

Start value |... Step value
f

Sweep Start

Time

T

Completion
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Synchronous Sweep M easurement

For synchronous sweep measurement, you set up a synchronous sweep source
(VARLY") in addition to a primary sweep source (VARL).

The relationship between the output of primary and synchronous sweep sourcesis
determined by the following equation:

synchronous output = primary output x ratio + offset

The synchronous output determined by above equation must not exceed the output
range of synchronous sweep source.

The following parameter settings are effective for the VARL' sweep source.

» Direction (Single or Doubl€)
» Linear/Log

The following setup is required to perform the synchronous sweep measurements.
See “1/V Sweep” on page 5-4 for the GUI.

1. Select the following on the Channel Setup tab screen.

* Seect VARL for the Function of the SMU used for VARL.
* Seect VAR for the Function of the SMU used for VARY'.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPUL SE for voltage monitor SMU. Pulseis available only for one SMU.

Mode of VAR1 and VAR must be the same, voltage or current.
2. Set the VAR1 channel as shownin “Basic Sweep Measurement”.

3. Specify the following parameters for VAR1' on the Measurement Setup tab
screen.

Offset Offset between outputs of primary and synchronous sweep
sources.

Ratio Ratio between outputs of primary and synchronous sweep
sources.

Compliance Compliance value of synchronous sweep source. Allowable

range of compliance depends on the compliance range of
synchronous sweep source.

Pwr Comp (Optional) Power compliance value of synchronous sweep
source. Allowable range of power compliance depends on
the power compliance range of synchronous sweep source.
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Figure 7-5 Synchronous Sweep M easurement

Output Voltage
ar Cyrrent

Synchronous Source
Stop Value i

Primary Source
Stop Value

Synchronous Source
Start Value h

Primary Source
Start Value

(S —

Time

Pulsed Sweep M easurement

For a sweep measurement, a sweep or constant source SMU can be a pulse source.
But only one SMU can be a pulse source.

Figure 7-6 shows the rel ationship between pul se source and other sources. Each step
of the primary sweep source is synchronized with output of the SMU pulse source.
M easurements are made during the pulse output. For the pulsed sweep
measurement, the delay time setting isignored.

The following setup is required to perform the pulsed sweep measurements. See
“1/V Sweep” on page 5-4 for the GUI.

1. Select the following on the Channel Setup tab screen.

* Sdect VARL for the Function of the SMU used for VARL.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPUL SE for voltage monitor SMU. Pulseis available only for one SMU.

2. Set the VAR1 channel as shownin “Basic Sweep Measurement”.

3. Specify the following parameters for the SMU Pulse on the Measurement Setup
tab screen.
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Period SMU forces the next pulse after specified pulse period.
5 msto 5 swith 100 us resolution.

Width Time from when SMU output starts to change from base
value to time when SMU starts to return from peak value.
M easurements are made while the peak value is output.
0.5 msto 2 swith 100 us resolution.

Base The base output value of the SMU pulse.

Pulse peak value  Pulse peak value depends on the Function setting of the pulse source SMU. See

Table 7-1.
Table 7-1 Pulse Peak and Function
Function Pulse peak
CONST Source value in the Constants area
VAR1 Calculated from the Start, Stop, Step values of the VAR1.
VAR2 Calculated from the Start, Stop, No of Step values of the
VAR2.
VARY Calculated from the Start, Stop, Step values of the VARL
and the Offset and Ratio values of the VARY'.
Measurement Only one SMU can be used for the measurement channel.

channel . .
The measurement channel always uses the compliance range which coversthe

setting compliance value. The Range button in the Measurement Setup is not
available.

The measurement integration time cannot be changed. The ADC/Integ button in the
Measurement Setup is not available.
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Figure 7-6 Pulse Source and Other Sources

Pulsed on Primary Source Unit (VART) Pulsed on Synchronous Source Unit (VART)
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Function Details
Multi Channel I/V Sweep Measurement

Multi Channel I/V Sweep M easurement

Multi Channel 1/V Sweep measurement is similar to I/V Sweep measurement.
Changes from I/V Sweep are listed bel ow.

* All SMU can be set to the VAR1 sweep source (up to 10 channels)

» Both voltage mode and current mode are available for the VAR1 sweep output
*  VARYI sweep output is not available

» SMU pulse output is not available

The timing of the sweep output and measurements are shown in Figure 7-8. The
output channels start to output in the order in which they are listed on the Channel
Setup screen. If multiple measurement channels are used, the channels perform the
measurements in order. See “Multiple Measurement Channels’ on page 7-61.

Multi Channel I/V Sweep M easurements using High-Resolution A/D Converter

Voltage or current =: Measurement

Start measurement L_J

04— Primary sweep source
Start value Delay time

Stop value

Hold time
Voltage or current

Stop value - Delay time

Second sweep source

U

Start value =

Voltage or current

Stop value -

0 H —\ Tenth sweep source

Start value

Time
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Figure 7-9

Function Details
I/V-t Sampling Measurement

|/V-t Sampling M easurement

For the 1/V-t sampling measurements, source channels (SMU) force constant current
or voltage, and monitor channels (SMU) measure current or voltage changes at a
device under test (DUT) with a specified sampling interval.

Available M odules

SMUs and SPGUs can be used. SMU can be constant voltage source or constant
current source and perform voltage measurement or current measurement. SPGU
can be pulse voltage source. See “ SPGU Module” on page 7-26 for using the SPGU.

To use the SPGU, the sampling interval must be > 2 ms.

Operation Summary

[/V-t sampling measurement is executed as explained below. See Figure 7-9. In this
example, the Output Sequenceis set to SEQUENTIAL. And the bias hold function
sets the bias to the Base value.

Operation Summary

Voltage or current

Source value

Voltage or current

Source value

Base value

Starts sampling ) ) ] ]
Time=Hold time + a Time=Hold time + Interval + b

L

= |Vleasurement

l Channel 1 output il P»l

|

~

-

. A

Interval
Time=0 (origin)

Hold time

Measurement time

Base hold time ‘—'| )

(R
, Channel 2 output \

Time
In thisfigure, a and b in the formula of Time indicate the time from the start of one
point measurement to the start of integration by the A/D converter.
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. When the Output Sequenceis SEQUENTIAL, source channels start the Source

value output in order, and the last source channel starts the Base value output
(Starts sampling). See “Source Output Sequence and Time Origin” on page
7-18.

When the Output Sequenceis SIMULTANEOQUS, source channels start the Base
value output simultaneously (Starts sampling).

Base valueis available for al output channels for the SIMULTANEOUS mode
and the last source channel for the SEQUENTIAL mode.

Base Hold Timelater, the source channel s change the output to the Source value.
The channels keep the value until the end of the sampling measurement.

. Another Hold Time later, the measurement channel starts measurement for the

first sampling point. If multiple channels are used, the channels perform
measurement in order. See “Multiple Measurement Channels’ on page 7-61.

. After that, the following operation is repeated with the specified time Interval.

This operation is repeated until the number of measurement result data reaches
the specified No of Samples of measurement data.

» Measurement channels start measurement if they are ready to measure.
* Measurement channels keep the condition if they are busy.

For the log sampling, the B1500A holds only the data that can be plotted on the
log scale in the same distance as close as possible. Only the held dataiis counted
in the number of measurement result data.

For the linear sampling with Interval < 2 ms, if the total measurement time runs
over the specified time Interval x No of Samples, the sampling measurement will
be stopped even if the number of measurement result dataisless than the
specified No of Samples.

. The source channels stop the output, and the 1/V-t sampling measurement is

completed.

If the bias hold function is enabled, the source channels force the Base or Source
value.

Time data and index

For the log sampling, the recorded datawill be only the data that can be plotted on
the log scale in the same distance as close as possible. Theindex of the first datais
1. And the index of the following data will increase by 1. For the linear sampling,
see “Time Dataand Index” on page 7-17.
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Setup Parameters

The following setup is required to perform the 1/V-t sampling measurements. See
“1/V-t Sampling” on page 5-21 for the GUI.

If you set Interval < 0.002 s

Sampling mode must be linear. This setting is not permitted for the log sampling.
Also SPGU is not available.

All measurement channels must use the high speed A/D converter (ADC). This
setting is not permitted if a measurement channel uses the high resolution ADC.

If the multiple measurement channels are used, all channels perform measurement
inparallel.

If the measurement ranging mode is not the fixed mode, the measurement channels
automatically select the minimum range that covers compliance value set to the
channel.

If the measurement time is expected to be longer than Interval, the measurement
channels automatically adjust the number of averaging samples (ADC settings) to
keep the sampling interval.

1. Select the following on the Channel Setup screen.

«  Select SMUs used for constant voltage sources or constant current sources.

e Select V. or COMMON for Mode of current monitor SMU, or | for voltage
monitor SMU.

2. Specify the following parameters for the SMU in the Sampling Parameter area
on the Measurement Setup screen.

Linear/Log Sampling mode. LINEAR for linear sampling. LOG10,
LOG25, LOG50, LOG100, LOG250, or LOG500 for
logarithmic sampling.

For the logarithmic sampling, the number after LOG
indicates the number of measurement datain a decade. For
example, LOG10 mode is used to get 10 data/decade.

I nterval Interval of the sampling, in seconds. 0.002 to 65.535 s,
0.001 sresolution.

Interval < 0.002 sin 0.00001 sresolution is also available
for the linear sampling. It must satisfy the following
formula. See NOTE above.
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No of Samples

Total Sampling
Time

Output
Sequence

Hold Time

Base Hold
Time

Interval > 0.0001 + 0.00002 x (number of measurement
channels- 1)

Number of samples. Integer. 1 to the following value.
For linear; 100001 / (number of measurement channels)

For logarithmic: 1 + (number of datafor 11 decades)

Thisfield just displays the total sampling time that is the

time from the measurement start time for the first point to
the end of sampling measurement. It does not include the
hold time.

Total Sampling Time = Interval x No of Samples

Source output sequence. SIMULTANEOUS or
SEQUENTIAL. See* Source Output Sequence and Time
Origin” on page 7-18.

Time since the Source value output until the first sampling
point, in seconds. 0 to 655.35 s, resolution 0.01 s.

The following values are also available for Interval < 0.002
s. |Hold Time| will be the time since the sampling start until
the Source value output.

- 0.09 to - 0.0001 s, resolution 0.0001 s.

Hold time of the Base value output until the Source value
output, in seconds. 0 to 655.35 s, resolution 0.01 s.

3. Specify the following parameters for the SMU in the Constants area on the
M easurement Setup screen.

Base, Source

Compliance

Base or Sourcevalue, inV or A.

Base value is available for all output channels for the
SIMULTANEOUS mode and thelast source channel for the
SEQUENTIAL mode.

Compliance value, in A or V.

Value effective for Base, Source, and Compliance:
0to+0.1 A (HRSMU/MPSMU) or +1 A (HPSMU)
0to+100 V (HRSMU/MPSMU) or +200 V (HPSMU)
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Figure 7-10

Function Details
I/V-t Sampling Measurement

Time Data and I ndex

To obtain the time data, enter avariable name (e.g. Time) into the Time Stamp
Name field of the Channel Setup screen. The time data can be obtained after the
linear sampling measurement is executed, and can be expressed by the following
formula

Time=Hold Time + Interval x [(Index — 1) + N] +

Time: Variable name set to the Time Stamp Name field of the Measurement
Setup screen. Time datais returned.

Index : Variable name set to the Index Name field of the Measurement Setup
screen. Dataindex is returned. Maximum value is 2147483647.

Interval : Sampling interval. Defined in the Measurement Setup screen.
Hold Time: Hold time. Defined in the Measurement Setup screen.

N : Number of samplings performed while one point measurement was
executed. Thisvalueis 0 if the sampling interval islonger than the
measurement time.

o Time from the start of one point measurement to the start of
integration by the A/D converter.

If the sampling interval islonger than the actual measurement time, measurement
channels repeat measurement with the specified sampling interval. However, if the
sampling interval is shorter than the measurement time, the measurement interval
will beintegral multiples of the specified sampling interval. Example for Hold Time
=10 ms, Interval=5 ms, and the following Time values is shown in Figure 7-10. In
this case, N=3.

e Time (for Index=1) =10ms=10+5x [(1 - 1) + O] ms
» Time (for Index=2) =30ms=10+5x [(2—- 1) + 3] ms

Sampling and M easurement Timing

Interval

pasehoimet 4 4 4 b b4

and Hold time Measurement time

>

d d

Time (at Index=1) Time (at Index=2)

Time

a, b: Time from the start of measurement to the start of integration
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Source Output Sequence and Time Origin

When the Output Sequence is SEQUENTIAL, source channels start output in order.
The order istop to bottom of the channels defined in the Channel Setup screen. The
order of bias stop is bottom to top.

When the Output Sequenceis SIMULTANEOQUS, source channels start output
simultaneously. And the source channels stop output at the same time.

The time origin is when the source output value is changed from Base to Source.

Sampling Completion

The sampling measurement compl etes when one of the following conditionsis
satisfied:

» Theevent of the stop condition occurs. See “ Stop Condition” on page 7-18.

» The measurement channels obtain the specified number (No of Samples) of
measurement data

» Thetotal measurement time runs over the time Interval x No of Samples for the
linear sampling with Interval <2 ms.

» The Stop button is clicked.
* Anemergency condition occurs on Agilent B1500A.

» Interlock terminal is opened when a channel isin the high voltage output status.

Sop Condition

The stop condition is defined by using the Stop Condition fields on the
Measurement Setup screen. This function stops the measurement as shown below.

1. Comparesthe value of parameter set to the Name field and the value defined in
the Threshold field.

2. Counts how many times the selected Event occurs.

3. When the count reaches the value defined in the No. of Eventsfield, samplingis
stopped immediately.

For the setup parameters of the stop condition, see “1/V-t Sampling” on page 5-21.
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C-V Sweep M easurement

For the C-V sweep measurements, the multi frequency capacitance measurement
unit (MFCMU) forces AC signal, performs staircase sweep output of DC bias
voltage, and measures impedance for each sweep step.

Available Module

MFCMU can be used for the C-V sweep measurements. For the DC bias output over
+ 25V, usethe SMU CMU Unify Unit (SCUU) and SMUs. This expands the
voltage range up to + 100 V.

Setup Parameters

The following setup is required to perform the C-V sweep measurements.See “ C-V
Sweep” on page 5-26 for the GUI.

1. Set thefollowing on the Channel Setup tab screen.
e SetV Name of the CMU.

« If you use a constant current or voltage source, set Mode (1, V, or
COMMON) and V Name or | Name of the SMU.

2. Specify the following parameters for the CMU on the M easurement Setup tab
screen.

Model, x Name  Measurement parameters, Cp-G, Cp-D, Cs-Rs, or Z-6. See

Table 7-2.
Direction Single or double sweep.
Sart, Stop Sart isthe DC bias sweep start value. Sop is the stop value

of single sweep or turning back value of double sweep. The
CMU can force up to £ 25 V. Setting resolutionis1 mV.

If the SCUU (SMU CMU Unify Unit) is used, up to + 100
V output is available. For the output over + 25V, setting
resolution is5 mV.

Sep,No of Step
Sep is step increment of sweep. No of Sep valueis
calculated from start, stop, and step. Cal culated number of
steps must be in range: 2 to 1001.
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FrequencyList
AC signal frequency. 1 kHz to 5 MHz. Resolution: 6 digits.

F Name Variable name of frequency list.
AC Leve AC signal level. 10 mV to 250 mV, 1 mV resolution.

Mode, Factor One of the following is used for setting the measurement
time.

For Mode=AUTO, you set the number of samples used for
averaging of the measurement data. The initial valueisthe
predefined constant, and you set the multiple number to
Factor. Available Factor values are 1 to 1023, integer.

For Mode=PL C, you set the integration time of the A/D
converter. Theinitial valueis 1 power line cycle (20 msfor
50 Hz, 16.7 msfor 60 Hz), and you set the multiple number
to Factor. Available Factor values are 1 to 100, integer.

Hold Hold time. Thetimerequired for DUT to settle after forcing
start value. 0 to 655.35 swith 10 ms resolution.

Delay Time required for DUT to settle after stepping the DC bias
output value. 0 to 65.535 swith 100 us resolution.

NOTE For a more accurate measurement, perform correction data measurement at the
measurement frequency before starting the capacitance measurement.

If the measurement frequency isnot included in thelist of default frequencies below,
click the Advanced Options... button and set the measurement frequency on the
Frequency area of the Advanced Options for CMU Calibration window.

Default frequencies:

1k, 2k, 5k, 10k, 20k, 50k, 100k, 200k, 500k, 1 M, 1.2 M, 1.5M,2 M, 25 M,
27M,3M,32M,35M,3.7M,4M,42M,45M, 5MHz
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Table 7-2

NOTE
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M easurement Parameters

MFCMU performs impedance measurement, cal cul ates parameters shown in Table
7-2, and returns the calculated data. A combination can be selected for the return
data. For your reference, select the parallel measurement mode (Cp-G or Cp-D) for
the low capacitance measurements (100 2 or more of impedance), and select the
series measurement mode (Cs-Rs) for the high capacitance measurements (100 Q or
less of impedance). Because the low capacitance yields high reactance, which
impliesthat the effect of the parallel resistance has relatively more significance than
that of series resistance.

Measurement Parameters

Primary Parameter Secondary Parameter
Cp (parallel capacitance, F) G (conductance, S)
Cp (parallel capacitance, F) D (dissipation factor)

Cs (series capacitance, F) Rs (series resistance, Q)
Z (impedance, Q) 0 (phase, degree)

GPIB remote mode

In the remote mode, the MFCMU can cal culate and return the other measurement
parameters. See Table 2-13 and Programming Guide. In Agilent EasyEXPERT
operation environment, only the parameters shown in Table 7-2 are available.

About | mpedance M easurements

All circuit components, resistors, capacitors, or inductors, have parasitic
components, for example unwanted resistance in capacitors, unwanted resistance in
inductors, and unwanted inductance in resistors. Thus simple components should be
modeled as complex impedances.

Impedance definitions and vector representation of impedance are shown in Figure
7-11. Impedance Z isthe total opposition that acircuit or device offersto the flow of
alternating current at a given frequency. Z containsareal and an imaginary part, and
it isexpressed in rectangular form as resistance R and reactance X, or in polar form
as magnitude of impedance |Z| and phase 6.

In addition to these parameters, the quality factor Q and dissipation factor D are
used to describe the quality of components.
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Figure 7-12
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Impedance and Parameter Calculation
I Imaginary part

— 7} . =t
N— ( I current (A) 7
v V: voltage (V) iX 12|
Z=R+jX= 12|46
Z: impedance (Q) 0
|Z]=/(R*+X") R: resistance (Q) R Real part
IX| X: reactance (Q)
6=tan' (&) 0. phase (degree or radian)
ReR Rs: series resistance (Q)
=ns f.  frequency (Hz)
X=2mfL L: inductance (H)
I Q: quality factor
=5 =% D: dissipation factor

In the GPIB remote mode, you can get the inductance data. For your reference,
select the parallel measurement mode (Lp-G, Lp-D, or anything) for the high
inductance measurements (100 Q or more of impedance), and select the series
measurement mode (Ls-Rs, or anything) for the low inductance measurements
(100 © or less of impedance). Because the reactance of high inductance at a given
frequency isrelatively high (compared with that of alow inductance), so the parallel
resistance becomes more significant than the series component.

Admittance and Parameter Calculation

Y= ;—=G+jB =|Y|Lg

IY|=/(G7+B7) Real part
Y: admitance (S) ¢
d=tan” (ﬂ) =_g | G: conductance (S) .
G B: susceptance (S) iB
B= 2 fC ¢: phase (degree or radian) [Y]
f.  frequency (Hz)
0=1_=@ C: capacitance (F)
D G Q: quality factor Imaginary part
1 D: dissipation factor
GzR_p Rp: parallel resistance (Q)

In some case, the reciprocal of impedance (admittance) Y isused. Figure 7-12
shows the vector representation of admittance. Asimpedance Z, Y containsareal
and an imaginary part, and is expressed in rectangular form as conductance G and
susceptance B, or in polar form as magnitude of admittance |Y | and phase ¢.
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Four-Terminal Pair Configuration

Generally, any mutual inductance, interference of the measurement signals, and
unwanted residual factorsin the connection method incidental to ordinary
termination methods will have significant effects on the measurements, especially at
a high frequency. The MFCMU employs the four-terminal pair (4TP) measurement
configuration which permits easy, stable, and accurate measurements and avoids the
measurement limitations inherent to such factors.

Figure 7-13 shows the four-terminal pair measurement principle. The measurement
terminals consist of the following four coaxial connectors.

* Hcur: High current

» Hpot: High potential

* Lpot: Low potential

* Lcur: Low current

Four-Terminal Pair M easurement Principle
Multi frequency CMU

[ { Outer shield or Guard
Hecur

»ﬁ @ O X— =
Hpot /H( o

System ground | Ve W J

[ouT]

Auto balance bridge< LPOtW

Y A Lcur . Ix Virtual ground
MW@

% Ix---->=

The four-terminal pair measurement method has the advantage in both low and high
impedance measurements. The outer shield conductors work as the return path for
the measurement signal current (they are not grounded). The same current flows
through both the center conductors and outer shield conductors (in opposite
directions), but no external magnetic fields are generated around the conductors (the
magnetic fields produced by the inner and outer current completely cancel each
other). Because the measurement signal current does not develop an inductive
magnetic field, test leads do not contribute additional errors due to self or mutual
inductance between the individual leads.
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To realize accurate measurements using the four-terminal pair measurement
method, the following connection tips are important. See Figure 7-13 and Figure
7-14.

The signal path from MFCMU to DUT must be as short as possible.

Thefour-terminal pair configuration must be extended as close as possible to the
DUT.

The outer shield conductors must be connected together at the extended cable
ends. Then take care of contacts. They must be electrically isolated.

Thisisthe same as connecting the CMU return terminal s of the atto sense/switch
unit (ASU) or the guard switch unit (GSWU).

The signal path from the shield endsto the DUT must be as short as possible.

If it is possible, make protective guard (plate, shield, or anything) around the
DUT, and connect it to the outer shield conductor of the four-terminal pair
configuration. This minimizes the effects of stray capacitance and electrical
noise. Then take care of contacts. The guard must be electrically isolated.

The Low (Lcur, Lpot) terminal must be prevented from stray capacitance and
guard capacitance. If the measurement terminal has to be connected to the wafer
chuck, use the High (Hcur, Hpot) terminal to connect to the wafer chuck.

Error Correction

The MFCMU is equipped with the error correction function used to realize accurate
impedance measurements. The correction function minimizesthe effects of the error
elementsin the extension cables and the DUT interface such as manipulator and
probe card.

Phase compensation

Corrects phase error caused by extending measurement cables.

Open correction

Corrects for stray admittance. Effective for high impedance measurements.
Short correction

Corrects for residual impedance. Effective for low impedance measurements.
Load correction

Corrects any error by using the working standard.
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The MFCMU will internally perform the error correction for the CMU cables and
CMU accessories that keep the four-terminal pair configuration.

For the measurements for evaluating DUT against a working standard, perform the

open/short/load correction.

However, you have to consider that some parasitic remain in measurement path
even after performing corrections. To minimize the influence of parasitic, make the
signal path from the shield ends to the DUT as short as possible.

To perform the phase compensation and error correction, see“CMU Calibration” on

A

page 4-37.
Figure 7-14 Error Correction
Multi frequency CMU Outer shield L
[ Hour \ {___>:Error elements
O
- Wl WH:L%\/\
System ground on < b 2 i
w7 | - high
CMU return Euj
Auto balance bridge t Lpot /\ | |
T T |
. Virtual ground \N\/‘—I 1
L e w—— ' T U

\./

€7 Connection

4-terminal pairs

2-terminal

Error correction

internal

external (Open/Short/Load)
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Figure 7-15
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NOTE

SPGU Module

High voltage SPGU is a pul se generator module designed for semiconductor
parametric test applications and provides the following key functions. The SPGU
can be controlled by using the SPGU Control classic test or the SPGU setup
function in the 1/V Sweep, Multi Channel 1/V Sweep, I/V List Sweep, and I/V-t
Sampling classic tests.

Number of output channels: 2 channels per module

Output impedance: 50 O

Output level: 0to + 40 V (open load), + 20 V (50 Q load)

SPGU operation mode (effective for al channelsinstalled in B1500A):

PG (pulse generator) or ALWG (arbitrary linear waveform generator)
Channel output operation mode:

Free run, duration, or pulse count (PG mode)/sequence count (ALWG mode)
Free run mode is not available for the SPGU Control classic test.

PG output mode:

2-level pulse or 3-level pulse, for each channel

Pulse switch, which is more durable than mechanical relays, and better suited for
frequent switching applications.

Automatic voltage level adjustment by specifying load impedance of DUT

SPGU Simplified Circuit Diagram

50 O Pulse switch 50 O Pulse switch

\o—> Output 1 \O—> Output 2
PG 2-level PG 2-level
or 3-level or 3-level
or or
/\/\ ALWG /\/\ ALWG

To use the SPGU for 1/V-t Sampling tests, the sampling interval must be > 2 ms.
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Figure 7-16

PG Operation Mode
In the PG mode (pul se generator operation mode), the SPGU outputs 2-level or

3-level pulse voltage as shown in Figure 7-16.

The SPGU channels simultaneously start the pulse output and repeat the output

Function Details
SPGU Module

every pulse period. The channels continue the pulse output until the specified time
elapses or the repeat count reaches the specified number of pulses.

For the SPGU pulse setup, see “ SPGU Pulse Setup Parameters’ on page 7-28.

For asummary of source output operation in sweep or sampling measurement mode,
see “Pulse Output Operation Summary” on page 7-30.

3-Level Pulse Output Examples
1V Output of
Primary Pulse
Pulse period
0V/  width
Delay1 _l
Pulse period —— @——
Delay2 J
0V Width2
3-Level pulse output
Output of
Additional Pulse RRY
Output of
Primary Pulse
3V
Pulse period
2V
Delayl Width1 _l av
~—— Pulseperiod —— @" 3V
Output of J
Additional Pulse 2V
1V
0V 3-Level pulse output
Delay? Width2
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SPGU Pulse Setup Parameters
The following setup is required to apply the SPGU pulse. See “SPGU Control” on

page 5-57 for the GUI.

1. Set thefollowing for the SPGU channel on the Channel Setup tab screen.

¢ Set theV Name of the SPGU.
¢ Set the Modeto VPULSE. This sets the PG mode. Do not set to ALWG.

2. Onthe SPGU Pulse Setup window, specify the following parameters for the
SPGU. See Figure 7-17 for the pul se setup parameters.

Period

Operation

Type

Base, Peak

Delay

Width

Leading,
Trailing

Pulse period. 20 nsto 10 s, 10 nsresolution.
FREE RUN, PULSE COUNT, or DURATION.

In the FREE RUN mode, the SPGU continues the pulse
output until the measurement is completed or stopped. Not
available for the SPGU Control classic test.

For the PULSE COUNT mode, specify the number of
pulses, within the range of 1 to 1000000. The SPGU will
output the specified number of pulses.

For the DURATION mode, specify the total time to output,
within the range of 1 usto 31556926 s (1 year). The SPGU
will continue to output until the specified time elapses.

2-Level Pulse or 3-Level Pulse. If you choose 3-Level
Pulse, the Additional Pulse fields become effective.

Pulse base and peak voltage. 0to + 40 V (open load), + 20
V (50 Q load), 1 mV resolution.

Delay time. 0 sto Period- 20 ns, 2.5 nsresolution.
Resolution will be set at 10 nsif the pulse transitiontimeis
>8us.

Pulse width. 10 nsto Period- 10 ns, 2.5 nsresolution.
Resolution will be set at 10 nsif the pulse transitiontimeis
>8us.

Pulse transition time. 8 ns to 400 ms, 2 ns resolution.
Resolution will be set at 8 nsif the pulse transition timeis >
8 us.
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3. (Optional) Set the Additional Pulse fields for the 3-Level Pulse. 3-level pulses
can be achieved by the Primary Pulse and the Additional Pulse. See Figure 7-16
for examples.

4. OntheLoad Z Setup window, specify the load impedance of the DUT (device
under test). The value is used to adjust the SPGU output voltage automatically.
The SPGU will output the voltage close to the specified Base or Peak value.

5. (Optional) On the Pulse Switch Setup window, enable the pulse switch, whichis
the semiconductor relay mounted in the SPGU output and is used to open the
SPGU channel output. Thisrelay is more durable than mechanical relays, andis
better suited for frequent switching applications.

SW Sync ENABLE (enablesthe pulse switch) or DISABLE (disables
the pulse switch).

Switching of the pulse switch status (open and close) will be
controlled automatically and synchronized with the output
pulse, as shown in Figure 7-17.

Delay, Width, and Normal fields will be active when SW Sync=ENABLE.

Delay Delay timefrom start of pulse output to changeover of pulse
switch. 0 sto Period- 100 ns, 10 nsresolution.

Width Duration to hold the switched state of the pulse switch.
100 nsto Period- Delay ns, 10 ns resolution.

Normal Switch status in the pul se switch normal condition. CLOSE
(normally closes the pulse switch) or OPEN (normally
opens the pulse switch). The pulse switch will change the
status after the Delay-sw time and keep the status until the
Width-sw time elapses, as shown in Figure 7-17. This
operation is repeated every pulse period.

Figure7-17 Pulse Setup Parameters

Start

‘ ,:::V/m ‘ v/10::::
3 Delay | Width i Delay |
! Period !
Normally open  Close ‘Openi Close
Pulse switch | | ! 1 ;
Delay-sw Width-sw Delay-sw
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Figure 7-18
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Pulse Output Operation Summary

The SPGU can be used for I/V Sweep, Multi Channel I/V Sweep, 1/V List Sweep,
and 1/V-t Sampling classic tests. The SPGU pulse output operation will differ as
shown in the following cases. Pulse output example of the sampling measurement is

shown in Figure 7-18.

»  Sampling measurement, simultaneous output mode. See Table 7-3.
e Sampling measurement, sequential output mode. See Table 7-4

e Sweep measurement mode. See Table 7-5.

SPGU Pulse Output Example for Sampling M easurement in Free Run M ode

Simultaneous output:

Start measurement End of measurement
| base hold time 1‘
1: SMU1 ~—————————=| source |
ov ! b 14 ov
— base | |
I [
| | !
2: SPGU1 } L
oV 1.3 oV
- 1
| base ‘ '
|
! |
3: SPGU2
‘ JU U U U U
| base | H
ESMU2 | !

0V i1 oV
base source

Sequencial output:

Start measurement End of measurement
| |
1- SMUT source :
ov | V14 ov
|
| H
2: SPGU1 | |
oV 3 oV
| base ‘ | |
3: SPGU2 \ ‘ |
ov | L L L L L 2 oV
D
base | i
] | I
4: SMU2
oy plase | 1 Qv
source —

base hold time
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Table 7-3 Output Timing for 1/V-t Sampling, Simultaneous
Pulse output Source Channel Operation
conditions Sarting During measurement After measurement Ending
Duration > SMUsand After the base hold SMUs continue the source | If the bias
Measurement | SPGUs start time, SMUs start the value output and SPGUs hold
time thebasevalue | sourcevalueoutputand | continue pulse output until | functionis
output SPGUs start pulse the specified time elapses ON, dl
simultaneoudly. | output smultaneously. | or the repeat count reaches | source
SMUs start the specified number. 222:23 2
sampling After that, SMUs output the outout
measurement the base or source value set put.
operation. by the Output Value after Else, al
Measurement, and SPGUs | source
output the base value. output
goestoOV
Free run SMUs output the base or inthe
source value set by the reverse
Output Value after order of
Measurement, and SPGUS | ihe
continue pulse output. Channel
If the bias hold functionis | Setup
OFF, SPGUs output the definition.
base value.
Duration < After the base hold SMUs output the base or
M easurement time, SMUs start the source value set by the
time sourcevalueoutput and | Output Value after
SPGUs start pulse Measurement, and SPGUs
output simultaneously. output the base value.
After the specified time
elapses or the repeat
count reaches the
specified number,
SPGUs output the base
value.
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Table 7-4 Output Timing for 1/V-t Sampling, Sequential
Pulse output Source Channel Operation
conditions Sarting During measurement After measurement Ending
Duration > Except for the | After the base hold SMUs continue the source | If the bias
Measurement | last SMU, time, thelast SMU start | value output and SPGUs hold
time SMUs start the | the source value output | continue pulse output until | function is
source value and SPGUs start pulse | the specified time elapses ON, all
output. And output simultaneously. | or the repeat count reaches | source
SPGUs and the the specified number. channels
last SMU start After that, the last SMU continue
the base value the output.
output, The outputs the base or source
value set by the Output Else, al
source output
sequence s the Value after Measurement, source
o and SPGUs output thebase | output
definition order alue 06sto 0V
on the Channel vaue. ign the
Freerun Setup screen Thelast SMU outputsthe | (oyerse
(top to bottom). base or source value setby | order of
SMUSs start the Output Value after the
sampling M ea.surement, and SPGUs | channel
measurement continue pul se output. Setup
operation. If the bias hold functionis | definition.
OFF, SPGUs output the
base value.
Duration < After the base hold The last SMU outputs the
M easurement time, thelast SMU start | base or source value set by
time the source value output | the Output Value after
and SPGUs start pulse | Measurement, and SPGUs
output simultaneously. | output the base value.
After the specified time
elapses or the repeat
count reaches the
specified number,
SPGUs output the base
value.
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Table 7-5 Output Timing for 1/V Sweep, Multi Channel |/V Sweep, I/V List Sweep
Pulse output Source Channel Operation
conditions Sarting During measurement After measurement Ending
Duration > SMUs and SPGUs start and continue Sweep sources output If the bias
Measurement | SPGUsstart | the pulse outpuit. thestart or stop valueset | hold
time output. The SMUs start and perform by the Output Value functionis
source after Measurement. ON, dll
output sween measurement : source
. operation. SPGUs continue the
sequenceis . channels
pulse output until the .
the S continue the
I specified time elapses or
definition output.
the repeat count reaches
order on the o
Channel the specified number. Else, all
After that, SPGUs source
Setup screen
output the base value. output goes
(topto ;
bottom) toOV inthe
Freerun . Sweep sources output reverseorder
Then, sweep thestart or stopvalueset | ot the
SOUFCES by the Output Value Channél
output the after Measurement. Setup
start value, SPGUSs continue pu|se definition.
constant output.
sources . .
output the _If the bias hold function
source is OFF, SPGUs output
value, and the base value.
Duration < SPGUs SPGUs start the pulse Sweep sources output
Measurement gutputatlhe output. the start or stop value set
: ase value.
time SMUs start and perform by the Output Value
The constant Sweep measurement after Measurement.
SOurces operation. SPGUs output the base
continue the value
output until SPGUs continue the pulse '
Ending. output until the specified
time elapses or the repeat
count reaches the specified
number. After that, SPGUs
output the base value.
Agilent B1500 User’s Guide, Edition 7 7-33



Pattern data

Sequence data

Figure 7-19
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ALWG Operation Mode

In the ALWG mode (arbitrary linear waveform generator operation mode), SPGU
can output an arbitrary linear waveform voltage as shown in Figure 7-19. The
waveform is the voltage pattern sequence specified by the pattern data and the
sequence data, which can be created by using the Define ALWG Waveform Window

(p. 5-64).

For asummary of source output operation in sweep or sampling measurement mode,
see “Pulse Output Operation Summary” on page 7-30. One sequence output will be

handled as same as one pulse output.

Specifies al of the voltage patterns set to achannel. A pattern consists of some
vector data. A vector datais defined by the output level and the time data.

*  Number of patterns: maximum 512 for a channel

*  Number of vector data: maximum 1024- N (N: number of patterns) for defining

all patternsto a channel

*  Output level: 0to + 40 V (open load, 1 mV resolution)

e Time data (incremental time): 10 ns to 671.088630 ms (10 ns resolution)

Specifies the output channel, the output pattern, the repeat count of the pattern, and
the output sequence of patterns applied in a single sequence.

* Repeat count of a pattern: 1,048,576

» Number of patternsin a sequence: maximum 512

ALWG Output Example

Start
1 sequence

! setup change (50 ns) !

! I I I !

: | o | | :

SPGU1 i ) P ! ) i
|n|t|alvalue: Pattern2 : Pattern2 : : Pattern1 : Pattern1 : Pattern1 :lnltlalvalue

I I I I |

I I

SPGU2 ! ' L ' ' !
initial val ! 1 * + initial value

INHAtVale oo ttern2 ' Pattem2 ' ! Pattern] ! Patternl ! Pattern1 |
SPGU2 pulse switch 0: Open

(normally open)011 1111 011 1111 0

0N 11 MO 11 MO MM 10 1: Close
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In the example in Figure 7-19, SPGU1 and SPGU2 are used. The channels output
Pattern2 twice and Patternl three times in one sequence, although the two patterns
for SPGUL1 are the same.

The SPGU channels simultaneously start the sequence output. The sequence will be
repeated in the same way as for the pulse period. The channels continue the
seguence output until the specified time elapses or the repeat count reaches the
specified number of sequences.

NOTE Setup delay time between the different patterns

When the pattern is changed to a pattern of adiffering index, a 50 ns setup delay will
always be inserted.

There is no delay between patterns of the same index.
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Sweep Abort Function

The automatic sweep abort function is used to stop sweep measurement (increasing
or decreasing source output value) when one of the following conditions occurs.
This function is useful to reduce sweep time and to prevent damage to the device
during measurement.

The output reaches voltage compliance or current compliance
A measurement value exceeds the specified measurement range
An SMU oscillates

An error is caused in the MFCMU

The automatic abort function is enabled by using the Sweep [xxxx] status field on
the Measurement Setup screen of the Classic Test definition.

Sweep [CONTINUE AT ANY] status: Sets the abort function OFF.
Sweep [STOP AT ANY ABNORMAL] status: Sets the abort function ON.

Thisfunction is available for the following measurement modes:

“1/V Sweep Measurement”
“C-V Sweep Measurement”

When abort occurs

After measurement is aborted, the source forces the following value.

Sweep source: Start value

Pulsed source or Pulsed sweep source: Pulse base value

7-36 Agilent B1500 User’s Guide, Edition 7



Function Details
Standby Function

Sandby Function

This function forces the specified DC bias outputs (standby outputs) before starting
or after stopping a measurement.

Sandby Channels

Standby channels are source monitor units (SMU) that force the standby output.
Standby channels maintain the specified DC bias output when the standby mode is
ON and in the non-measurement state.

Standby channel cannot be set for CMU, GNDU, and HRSMU connected to the atto
sense and switch unit (ASU) which makes the path to the AUX port.

See “ Standby Channel Definition” on page 4-50 to define the standby channels and
set the standby mode.

Sandby Sate

Standby state is the state before starting or after stopping a measurement, in which
only the standby channels perform DC bias outputs. The other channels will bein
theidle state, which is 0 V output, 100 uA compliance, SMU filter OFF, and series
resistor OFF. When the standby mode is OFF and in the non-measurement state, all
channels will bein theidle state.

When B1500A isin the standby state, the measurement trigger stops the standby
state, so the standby channels stop the standby output and the measurement channels
perform a measurement (measurement state). After the measurement, the standby
channels start the standby output (standby state). During this series of operations,
the state is never changed to the idle state. See Figure 7-20 for an example
operation.

If the bias hold function is enabled for the standby channel, after the measurement,
the channel forces the bias output set by the bias hold function. After the bias hold
period, the channel starts the standby output. During this series of operations, the
state is never changed to the idle state.
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Output Sequence of Sandby Channels

The standby channels will start to output in order, from the top to bottom, aslisted in
the Standby Channel Definition on the Standby Channel Definition window. The
order of bias stop is bottom to top.

Figure 7-20 shows the standby and measurement operations for the following
exampl e setup. This example assumes that the channel setup is defined in the
Standby Channel Definition as follows in the order show, and that the output value
in the standby state is the same as the output value in the measurement state.

» SMU1: Voltage source, non-standby channel
» SMUZ2: Voltage source, standby channel
» SMU3: Voltage source, standby channel

Figure 7-20 Sandby Function
V1-_
Idle state force V Idle state
SMU1
1 1
1 1
1 1
1 1
1 1
Voo | |
1 1
SMU2 Standbyon ! forceVo
1 1 1 1
:x : : I
1 1 1 1
1 1 1 1
1 1 1 1
V3__i | | l
: : force V : i
SMU3  ——4 i i Standby OFF b
1
Idle state | Standby state : : Standby state Idle state

1
! Measurement state
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To Use Sandby Function

To start the standby output, click the Standby ON button on the Standby Channel
Definition window. However, if no channel has been defined as the standby channel,
the standby mode cannot be turned ON. In the standby state, the Standby ON
indicator appears at the bottom of the EasyEXPERT main screen. The Standby
Channel Definition window is opened by clicking the Standby button on the main
screen.

To stop the standby output, click the Standby OFF button on the Standby Channel
Definition window.

In the standby state, you can change the setting parameters for non-standby channels
without changing the operation state. However, if you modify the settings for the
standby channels, the operation state is changed from the standby state to theidle
state.

In the standby state, the following functions are set to OFF.

e SMU filter

» Seriesresistor

In the standby state, the following functions cannot be performed.
» Diagnostics

o Sdf-test

» Self-calibration (SMU calibration and CMU calibration)

*  SMU zero offset measurement

» ASU connection path change

In the standby state, self-calibration isnot performed even if auto calibration is set to
ON. Also the state cannot be changed to the standby state while self-calibration is
being performed.

When the workspace is opened, it will bein theidle state.

If the workspace or EasyEXPERT is closed while the standby modeis ON, the mode
isautomatically changed to OFF in the closing process.

If Windows session is stopped while the standby mode is ON, the mode is not
changed to OFF in the closing process.
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Output channels
and output value

Period of bias hold

Reset of source
output

Function Details
Bias Hold Function

Bias Hold Function

This function is used to keep source output after measurement. Source modules
apply the specified bias between measurementsin a quick test or application test
that defines some classic test setups, or a repeat measurement. And the source
modul es change the output val ue and the unused modules are disconnected when the
next measurement is started.

If the bias hold function is OFF, the channel stops the output immediately after
measurement.
If the function is ON, the channel continues the output as shown below.

[/V Sweep measurement:.

* VARl and VARY output channels: Sweep start or stop value
* VAR2 output channel: Sweep stop value

» CONST output channels: Output value

» SMU pulse output channels: Base value

C-V Sweep measurement:

» Bias sweep output channel: Sweep start or stop value

e CONST output channels: Output value

[/V-t Sampling measurement:

» Constant source output channels: Base or source value

SPGU output:
»  SPGU keeps the output as shown in Table 7-6.

» From the end of a measurement to the end of a single measurement

» From the end of a measurement to the start of the next measurement during a
quick test, application test, or repeat measurement

The source output isreset after aquick test, application test, repeat measurement, or
single measurement. The SMU isset to O V output and 0.1 mA compliance. The
MFCMU issetto OV DC biasand 0 V oscillator level.
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Bias Hold Function

Setup method This function can be set by using the Advanced Setup window.

» Biashold after measurement
Set the function ON (enable) or OFF (disable, default setting).
* Output value after measurement

Select the bias output value START (default) or STOP for the I/V or C-V sweep
measurement, or BASE or SOURCE (default) for the sampling measurement.
Thisisinvalid for the VAR2, CONST, and constant source for C-V Sweep.

Table 7-6 SPGU Channel Output after Execution when BiasHold is ON

SPGU output

oper ation mode SPGU output

FREE RUN Continues the pulse output in the VPUL SE mode or the
seguence output in the ALWG mode.

SPGU trigger reset is performed at the beginning of the
simultaneous sampling measurement.

COUNT Continues the base voltage output in the VPUL SE mode
or theinitial voltage output in the ALWG mode.

DURATION
SPGU channel initialization is performed at the beginning

of the next measurement.
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NOTE

Function Details
Current Offset Cancel

Current Offset Cancel

This function subtracts the offset current from the current measurement raw data,
and returns the result as the measurement data. This function is used to compensate
the error factor (offset current) caused by the measurement path such asthe
measurement cables, manipulators, or probe card.

The offset cancel is not available for measurement over 100 nA range. For 10 nA
range measurement, the offset cancel is performed by using the 1 nA range offset
value. For measurement by arange less than 10 nA, the offset value measured by
each rangeis used. See Table 7-7 for the effective measurement range, the allowable
offset value, and the module type of the measurement channel.

You can perform the offset current measurement and enable the offset cancel
function as shown bel ow.

1. Click the Calibration button on the main screen to open the Calibration window.
See “Calibration” on page 4-35.

2. Specify the channelsto perform the offset current measurement on the SMU
Zero Cancel tab screen of the Calibration window. To specify the channel, check
the check box to the left of the Name field.

3. Toenablethe 1 pA range offset current measurement of the HR/ASU channel,
check the Full Range check box.

4. Settheintegration time for the offset measurement to the Integration Timefield.
Available value: 1 PLC (power line cycle) to 100 PLC, initial setting 16 PLC.

Set the value longer than the integration time for the measurement of the device
under test. Otherwise, the offset cancel will not be performed.

5. Click the Measure... button. A dialog box is opened.

Follow the instruction of the dialog box, and perform the offset measurement.
After the measurement, the offset cancel function is automatically enabled.

Open the measurement terminals at the cable end of the device side during the
offset current measurement.

The high resolution A/D converter is used for the offset current measurement.

To disable the offset cancel function, remove the check from the check box to the
|eft of the Name field.
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Current Offset Cancel

Table 7-7 M easurement range, allowable offset value, and module type
Measurement Allowable offset value Moduletype
range
1nA +10 pA HR/ASU, HR, MP, HP
100 pA +1 pA HR/ASU, HR
10 pA +400 fA HR/ASU, HR
1pA +100 fA HR/ASU

If the offset value for a measurement range of a channel exceeds the allowable
value, the offset datais not effective in this range and lower for this channel. Then,
if the ranging mode setting of this channel covers this range or lower, the offset
cancel is not performed for any data measured by this channel.
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SMU CMU Unify Unit

The SMU CMU Unify Unit (SCUU) is available for Agilent B1500A installed with
the multi frequency capacitance measurement unit (MFCMU). The MFCMU must
beinstalled inthe dot N (integer, 3 to 10) and the SMUs must beinstalled in the slot
N- 1 and N- 2. See“To Connect SCUU/GSWU"” on page 3-21 to install the SCUU
properly. The SCUU cannot be connected to the high power SMU (HPSMU).

The Guard Switch Unit (GSWU) controlsthe connection of the CMU High and Low
guard lines (CMU return). The connection will be broken when using the SMU and
made when using the MFCMU.

The SCUU can switch the measurement resources, MFCMU or SMU, and can
configure four setups shown in Figure 7-21. When the B1500A is turned on, no
measurement resource is connected to the output. The SCUU has input connectors,
four coaxial and four triaxial, connected to the MFCMU and SMU directly or by
using the dedicated SCUU cable.

The SCUU front panel LEDs indicate the following conditions of the SCUU.

SMU SMU in the slot N- 1/N- 2 can be used.

CMU Internal Bias MFCMU can be used. CMU interna DC bias source is used.
CMU SMU Bias MFCMU can be used. SMU is used as DC bias source.

The SCUU has output connectors, four triaxial, that must be connected to the DUT
interface such as manipulators and probe card. When the measurement resource is
the SMU, they are the Forcel/Sensel and Force2/Sense? connectors for the Kelvin
connection. And when the resource isthe MFCMU, the CMU High/Low are
connected to the Forcel/Force2 respectively, and the Sensel/Sense? are not used.

To realize accurate impedance measurements, connect the CMU return terminals
together. The CMU return terminal means the shield end of the outer shield
conductor extended to the DUT interface. The shield end must be opened as close as
possible to the DUT. See Figure 7-14 on page 7-25.

The GSWU has one connector and two terminals. The connector must be connected
to the SCUU by using the SCUU cable. And the terminals must be connected to the
CMU High/Low guard lines at the shield ends of the DUT interface by using awire.
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Figure 7-21

Setup 1: CMH/Force1/Sensel: SMU (slot N-1)
CML/Force2/Sense2: Open

Force Forcel
SMU in slot N-1
Sense Sensel

Setup 2: CMH/Force1/Sensel: Open
CML/Force2/Sense2: SMU (slot N-2)

Force Force2
SMU in slot N-2
Sense Sense2

Setup 3: CMH/Force1/Sensel: SMU (slot N-1)
CML/Force2/Sense2: SMU (slot N-2)

Force Forcel
SMU in slot N-1
Sense Sensel
Force Force2
SMU in slot N-2
Sense Sense2
NOTE Before using SCUU

Function Details
SMU CMU Unify Unit

SCUU Input/Output Connections

Setup 4: CMH/Forcel: CMUH (slot N)
CML/Force2: CMUL (slot N)
Sense1/Sense2: Open

Heur @—4 CMUH
CMU Return
Hpot ( » }

MFCMU in slot N

Leur g 9—4 CMUL
€ }

to GSWU through
DUT interface

CMU Return

Lpot to GSWU through

DUT interface

Instrument connection must be done before Agilent B1500A is turned on.
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Atto Sense and Switch Unit

The Atto Sense and Switch Unit (ASU) can be used with the high resolution SMU
(HRSMU). Using the ASU permits use of the 1 pA range. Also the ASU can switch
the measurement resources, HRSMU or an instrument connected to the AUX input
connectors. The ASU can configure two setups shown in Figure 7-22. When the
B1500A isturned on, the ASU will be the Setup 1 condition. See “ To Connect
ASU” on page 3-17 to install the ASU properly.

The ASU has input connectors, one triaxial and two coaxial. The triaxial connector
must be connected to the HRSMU Force, and the coaxial connectors must be
connected to an instrument. Also the ASU has the control connector to be connected
to the HRSMU by using the ASU cable.

Figure 7-22 ASU Input/Output Connections

Setup 1: AUX Off ( SMU input to ASU output )

Force

(@)

@

From SMU

L >

D-sub

Setup 2: AUX On ( CMU/AUX input to ASU output )

CMU-cur/AUX In

@

CMU-pot

©

O CMU Return

The ASU has the following status indicators (LED).
SMU The HRSMU can be used (Setup 1).
AUX The AUX instrument can be used (Setup 2).
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NOTE

Function Details
Atto Sense and Switch Unit

The ASU has output connectors, two triaxial, that must be connected to the DUT
interface such as manipulators and probe card. When the measurement resourceis
the HRSMU, they are the Force/Sense connectors for the Kelvin connection. And
when the resourceisnot HRSM U, the CMU/AUX is connected to the Force, and the
Senseis not used.

If you connect the MFCMU or the LCR meter with the four-terminal pair
configuration, two ASUs are required. Then the CMU-pot/CM U-cur connectors of a
ASU must be connected to the Hpot/Hcur of the instrument. And the other one must
be connected to the L pot/L cur in like manner.

To realize accurate impedance measurements using the four-terminal pair
measurement method, connect the CMU Return terminals of ASUs together. See
“Four-Terminal Pair Configuration” on page 7-23 and Figure 7-14 on page 7-25.

To use 1 pA range

The measurement channel connected to the ASU (Atto Sense and Switch Unit)
supportsthe 1 pA range. To usethe 1 pA range, set the 1 pA fixed range or the 1 pA
limited auto ranging.

The B1500A automatically performs the compensation of the data measured by the
1 pA range and returns the compensated data. You can use either the pre-stored
offset data or the pre-measured offset data.

To measure the offset data, perform the self-calibration before starting the
measurement for a DUT. This offset data is temporarily memorized until the
B1500A is turned off.

Before using ASU
ASU connection must be done before Agilent B1500A isturned on.

The combination of ASU and HRSMU isimportant. The B1500A can work with
wrong combination, but it cannot satisfy its specifications. The specifications are
guaranteed for the correct combination which the performance verification was
performed. See “ASU” on page 4-43 and check if the combination is correct.

The CMU-pot connector is for the MFCMU or the LCR meter that uses the
four-terminal pair. For the other instrument, connect a BNC open connector or
nothing to there. The line will beinternally connected to the CMU-cur/AUX-in line.

It is unavailable to use the series resistor in the HRSMU connected to the ASU.
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Figure 7-23

Function Details
SMU/PG Selector

SMU/PG Selector

Adgilent 16440A SMU/PG Selector provides the built-in switching capability to
select a measurement path connected to the Output port. See Figure 7-23 for the
simplified circuit diagram of the selector. The selector has the channels CH 1 and
CH 2 which provide the following conditions. It can be controlled by using the
SMU/PG Selector tab screen of the Configuration window.

CH1 Open (no connection), SMU connect, PGU connect, and PGU open
CH2 Open (no connection), SMU connect, and PGU connect

The PGU open isavailable only for the CH 1, and is made by keeping the PGU side
mechanical relay close and opening the semiconductor relay. Thisis effective for
frequent switching applications because the semiconductor relay is more durable
than mechanical relays. The PGU open can be set by using the Advanced witndow
of the Measurement Setup.

SMU/PG Selector Circuit Diagram and Connections

16440A Selector 16440A Selector #2 for DUT terminals 3 and 4
CONTROL
SMU Input — O put_ 0w () () (O
l @ CH'IC> O o — CH2
Qutput P DUT terminal 1
> Output lnput gy, SMU #1 Force
CH1 1/ @ Input P PGU #1 or others
- \ % DUT terminal 2
PGU Input @ I—:":‘:bSMU #2 Force
npu —=—> PGU #2 or others
SMU Input— ONONO) g 'ONO) d)
3 @ CH 1 L8 thy
16440A Selector #1
CH2 —» OQutput
f @ 16445A Selector Adapter
PGU Input — IUMDCU?NTROLIE%I (]
@ Mechanical relay P AC power
@ Semiconductor relay P B1500A Digital /0

The selector must be connected to the B1500A through the Digital 1/0 connector
and the Agilent 16445A Selector Adapter. Up to two selectors can be used by
connecting the selector control cable between the CONTROL Output connector of
the first selector and the CONTROL |nput connector of the second selector.
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For measurement
channels

For output
channels

Function Details
SMU Ranging Mode

SMU Ranging Mode

Agilent B1500 provides the following operation modes for the measurement range
and the output range. The ranging mode must be set for each channel.

“Auto Ranging”
“Limited Auto Ranging”
“Fixed Range”
“Compliance Range”

“Enhanced Auto Ranging for Current Measurement”

To Set Ranging M ode

The following points must be noted when setting the ranging mode.

If you do not specify the ranging mode, the auto ranging mode is set
automatically.

For the channels that perform Vf/Vm (voltage force and voltage measurement)
or If/Im (current force and current measurement), the measurement range is
always the same as the output range.

For measurement with pulse output, the measurement channel uses the
compliance range or the specified fixed range. The channel cannot perform the
auto ranging operation or the limited auto ranging operation.

For the HRSMU connected to the atto sense/switch unit (ASU), the 10 pA range
isthe minimum for the auto ranging operation. To use the 1 pA range, select the
1 pA limited auto ranging mode or the 1 pA fixed range mode.

The auto ranging mode and the limited auto ranging mode are available for the
output channels.

When the voltage output range or the voltage compliance range is changed, the
channel forces 0V at that moment.
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Function Details
SMU Ranging Mode

Auto Ranging
Range changing is performed as below.

The measurement channel automatically searches for and measures at the range that
provides the best resolution as follows:

» For current measurement, the measurement channel uses the present range if the
following formulais satisfied; otherwise, the channel changes the range.

Range x 0.1 < Measurement value < Range x X/100
where X=115, or 100 at the maximum range.
See also “Enhanced Auto Ranging for Current Measurement” on page 7-52.

» For voltage measurement, the measurement channel uses the present range if the
following formulais satisfied; otherwise, the channel changes the range.

Next lower range value < Measurement value < Range x X/100
where X=110, or 100 at the maximum range.

The output channel automatically searches for and forces at the lowest range that
covers the output value as follows:

» For staircase sweep output, the output channel uses the lowest range that covers
the start and stop values. However, it uses the lowest range that covers the step
output value for the logarithmic current sweep. For the voltage sweep that sets
the power compliance, the channel uses the lowest range (20 V range or more)
that covers the step output value.

» For pulsed bias output, the output channel uses the lowest range that coversthe
base and peak values.

» For pulsed sweep output, the output channel uses the lowest range that covers
the base, start, and stop values.

» For quasi-pulsed output and search source output, the output channel uses the
lowest range that covers the start and stop values.

The maximum output value is as follows:
e Maximum current output value = Range x X/100
where X=115, or 100 at the maximum range.

e Maximum voltage output value = Range value
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Function Details
SMU Ranging Mode

Limited Auto Ranging

Limited auto ranging is similar to auto ranging. However, limited auto ranging does
not use the range(s) less than what you specified. For example, if you select 10 mA
limited auto ranging, the measurement unit does not use the 1 mA range or less.
Consequently, the measurement time for limited auto ranging is less than for auto
ranging.

Fixed Range

The channel uses the specified range only.

For the current measurement channel, if you specify a range higher than the
minimum range that covers the compliance value, the measurement channel uses
this range (compliance range).

Compliance Range

The compliance range is effective for the Vf/Im (voltage output and current
measurement) or If/Vm (current output and voltage measurement) channel. The
measurement channel automatically selects and usesthelowest range that coversthe
specified compliance value.

For the measurement channel that performs constant voltage or current output, you
can set the compliance range.

For the measurement channel that performs sweep output, you can set the power
compliance value. If you set the power compliance value, the channel usesthe
lowest range that covers the lower value of either the specified compliance value or
the compliance value given by the following formula

Current compliance = Specified power compliance value / Step voltage
Voltage compliance = Specified power compliance value / Step current
For details about setting compliance, refer to “SMU Compliance” on page 7-53.

Range change is performed when the compliance value is set, not when the
measurement is performed.
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Enhanced Auto Ranging for Current M easurement

Expanded functions are available for the auto ranging operation of the current
measurement channel. To use the functions, set Range Change Rule. See “SMU
Range Setup Window” on page 5-48. Rate value defines the boundary of ranging.

» Range Change Rule=BY FULL RANGE:

Performs normal auto ranging operation. If a condition shown below is satisfied,
the range changes immediately, even during measurement.

Measurement value > Range x X/100
Measurement value < Range x 0.1
where X=115, or 100 at the maximum range.
* Range Change Rule=GO UP AHEAD:
If the following condition is satisfied, the range changes up after measurement.
Measurement value > currentl
» Range Change Rule=UP AND DOWN AHEAD:

If the following condition is satisfied, the range changes down immediately,
even during measurement.

Measurement value < current2
If the following condition is satisfied, the range changes up after measurement.
Measurement value > currentl

where current1 and current2 are given by the following formula. Then rate must be
an integer, 11 to 100.

currentl = Range x rate/100

current?2 = Range x rate/1000

For example, if therange valueis 10 mA and rate is 90, they are:
currentl = 9 mA

current2 = 0.9 mA
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SMU Compliance

Compliance is the output limiter to prevent damage to the test device from
overcurrent, overvoltage, or overpower. Voltage complianceisfor the current output
channels, and current complianceis for the voltage output channels.

When a channel reaches compliance, the channel acts as aconstant voltage source or
aconstant current source. The channel keeps the output value when reaching

compliance.

Compliance can be set with the same resolution and accuracy as output current or
output voltage. For the values, refer to “ Specifications’ on page 2-33.

Polarity and Output Area

» Polarity of current compliance

Agilent B1500 automatically sets current compliance for both positive and
negative polarity. For opposite polarity as the output voltage, the compliance
valueisincreased by an amount that is 2.5 % to 12 % of the range value in the
lowest range that covers the specified compliance value. See Figure 7-24.

» Polarity of voltage compliance

Agilent B1500 automatically sets voltage compliance to the same polarity asthe
output current. There is no compliance for opposite polarity.

Figure 7-24 Relation of Compliance and Output
Current Voltage

7

+| Compliance | +| Compliance |

V<0 V>=0 <0 | >=0
; Output Voltage ’ Output Current
—| Compliance | —| Compliance |
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Figure 7-25

For voltage sweep:

Current

\ <— Specified current compliance value

Function Details
SMU Compliance

Power Compliance

In addition to V compliance or | compliance, you can set power compliance for the
staircase sweep source.

If you specify power compliance, the source/monitor unit (SMU) changes the
current or voltage compliance value every sweep step. The valueis the lower value
of either the specified compliance value or the compliance value given by the
following formula. See Figure 7-25.

Current compliance = Specified power compliance value/ Step voltage

Voltage compliance = Specified power compliance value / Step current

Power Compliance Output Area

For current sweep:

Voltage

<— Specified power compliance <— Specified power compliance

{<—— Specified voltage compliance value

Actual current compliance Actual voltage compliance

Available values

Conditions after
compliance

Voltage Current

The following values are available for the power compliance:

MPSMU/HRSMU ImWto2W

HPSMU 1mwWto20 W

When a channel reaches compliance, the staircase sweep source automatically stops

the sweep and forces the start value. After reaching the compliance, the
measurement datawill be “NaN".
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SMU Compliance

SMU output values If you specify power compliance, the SMU changes the current or voltage
compliance every sweep step. Hence, the SMU can apply voltage or current with the
maximum power. Figure 7-26 shows the differences between the output with power
compliance and the output without power compliance, for MPSMU.

Figure 7-26 Allowable Current in Voltage Sweep (0 V to 100 V, MPSM U)
When power compliance is set: When power compliance is not set:
Current (mA) Current (mA)
100 100
<—For the sweep 0 Vto 20 V
For the sweep 0 Vto 40V
50 L B0} +-ss+es-eieeeeneee-; For the sweep 0V to 100 V
20 20 f l
1 | H
20 40 100 Voltage (V) 20 40 100 Voltage (V)
NOTE If you specify power compliance, the measurement time increases slightly because

the B1500 adjusts the compliance for every sweep step.

To Set Compliance
The following points must be noted when setting the compliance.

 If the current compliance valueistoo low, the SMU will take along settling
time.

e The SMU will reach voltage compliance if the SMU cannot force the specified
current for the following reasons:

e Over current for test device.
« Another channel has reached compliance.

* Current measurement data of another channel has reached the limit for the
present measurement range.
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SMU Pulse

The source/monitor unit (SMU) can apply voltage or current pulse. The pulse width
and pulse period must be the following values.

Pulsewidth 0.5msto 2 s, 0.1 msresolution
Pulse period 5msto5s, 0.1 msresolution

The setup values must satisfy the following conditions.

» period > width + 2 ms (for pulse width < 100 ms)

» period > width + 10 ms (for pulse width > 100 ms)

To Set Pulse Output
The following points must be noted when setting the pulse output.
» Cannot use the 1 nA output range and lower ranges.

» Cannot use multiple measurement channels.

» The measurement channel uses the compliance range. The channel cannot
perform the auto ranging operation or the limited auto ranging operation.
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SMU Measurement Time

M easurement time depends on integration time, measurement range, and other
measurement conditions, and can be expressed by the following formula:

Measurement time = Integration time + Overhead time

Integration time is the time required for measurement, and does not include such
factors as range changing or data compensation, which would be the overhead time.

Integration Time

Integration time is the time required to get measurement data. For accurate and
reliable measurement, integration time should be increased. I ntegration time can be
set for each type of A/D converter (ADC) used by the measurement channel.

e High-speed ADC

You can adjust the number of averaging samplesinstead of the integration time.
For high speed measurement. Installed in each measurement module.

e High-resolution ADC

You can adjust the integration time directly. For high accuracy and high
resolution measurement. This ADC is mounted on the mainframe, and used by
the multiple modules alternately.

To set the integration time or the number of averaging samples, select the mode and
set the value as shown in Table 7-8.

The ADC zero function is available for the high-resolution A/D converter (ADC)
and not available for the high-speed ADC. Thisfunction measurestheinternal offset
of the high-resolution ADC and compensates it automatically. The measurement
data displayed on the LCD will be the data after compensation.

Thisfunction is especialy effective for the low voltage measurement. Disable the
function in cases where measurement speed is more important than measurement
accuracy. This approximately halves integration time.
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Table 7-8 Integration Time and Number of Samples

ADC

Mode

Description

High Speed
ADC

AUTO

Number of averaging samples= N x reference

where reference is the number of averaging samples
automatically set by Agilent B1500; this cannot be
changed.

Specify the N value shown above. Available values are
1t01023. Initial valueis 1.

MANUAL

Specify the number of averaging samples (N).
Available values are 1 to 1023. Initial valueis 1.

PLC

Number of averaging samples= N x 128

Specify the N value shown above. Available values are
1to 100. Initial valueis1.

Agilent B1500 gets 128 samplesin a power line cycle.
Hence, the N valueis equal to the number of power line
cycles.

High
Resolution
ADC

AUTO

Integration time = N x reference

where reference is the integration time automatically
set by Agilent B1500A; it cannot be changed.

Specify the N value shown above. Available values are
1to 127. Initia valueis6.

MANUAL

Integration time = N x 80 psec

Specify the N value shown above. Available values are
1to 127. Initial valueis 3.

PLC

Integration time = N / power line frequency

Specify the N value shown above. Available values are
1to 100. Initial valueis1.

The N value means the number of power line cycles.
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Overhead Time

The overhead time is the time required for range changing and so on. Thistime
depends on the measurement condition, and cannot be specified. Major elements of
the overhead time are:

» Range changing time during measurement (when measurement ranging mode is
set to auto or limited auto)

» Range changing time at measurement start (when the measurement rangeis less
than the compliance value)

To Specify Source Output Time

You cannot specify the measurement time. However, in sweep measurement mode,
you can specify a source output time that includes the measurement time. To specify
the source output time, set the delay time and the step delay time. The step delay
time is defined as the time from the measurement trigger up to the trigger for
changing the source output value. See the figure below. The step delay time must
cover the measurement time to keep the source output time constant.

The EasyEXPERT does not support the step delay time. It is available only for the
GPIB remote mode.

Source output time ,Td . Tsd
Step delay time (Tsd)
only for Remote mode [

Td | Tsd
Delay time (Td)
—
[ |
Vstart— I ‘ Measurement time
1
Hold time
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Wait Time

Wait time is the time after starting source output until changing the source output
value or until starting measurement. You can set the source wait time and the
measurement wait time individually.

The source wait time isthe time the source channel alwayswaits after it starts output
until it changes the output value. The measurement wait timeis the time the
measurement channel always waits after the source channel starts output until the
measurement channel starts measurement. Refer to Figure 7-27. Thewait timeis
given by the following formula:

wait time = N x reference

where reference is the wait time Agilent B1500 automatically sets according to the
present settings; this wait time cannot change. Available N valuesare 0 to 10, 0.1
step. Initial valueis 1.

It is not easy to determine the best wait time. If you specify it too short, the
measurement may start before device characteristics stable. If too long, time will be
wasted. For measurements of low capacitance or fast response devices, if
measurement speed has top priority or is more important than reliability and
accuracy, set the wait time shorter. Theinitial wait time may be too short for
measurements of high capacitance or slow response devices. Then set the wait time
longer.

Source/M easurement Wait Time

Measurement wait time

Source wait time

= leasurement

Delay time
[

Hold time Step delay time )
Time

In the GPIB remote mode, if the delay time is longer than the wait time, the wait
time can be ignored.

The EasyEXPERT does not support the step delay time.
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Multiple M easurement Channels

To use multiple measurement channels, define multiple measurement parametersin
the Display Setup screen or the Function Setup screen. Then, measurement
sequence, time data, and measurement time for each measurement point are as
follows.

*  Sequence of measurement execution

Measurement channels perform measurement in the order shown below.

1. Measurement channels which use the high speed AD converter and the
FIXED measurement range start measurement simultaneoudly (parallel
measurement).

2. After the parallel measurement, the other measurement channels perform
measurement sequentially. The order istop to bottom of the channels defined
in the SMU Range Setup screen.

Asaspecial casg, for the linear sampling measurement with Interval <2 ms, al
channels start measurement simultaneously.

 Timedata

Only the measurement start time of the channel which starts measurement at
first isrecorded.

* Measurement time

Measurement time is the sum of the measurement time by all channels.
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SMU Filter

Thefilter is mounted on each source/monitor unit (SMU) module. It assures clean
source output with no spikes or overshooting. However, using afilter may increase
the SMU settling time.

To set thefilter, refer to “ Advanced Setup Window” on page 5-51.

NOTE The SMU filter is set to OFF for the standby channelsin the standby state.
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SMU Series Resistor

The series resistor (approx. 1 MQ) is mounted on each source/monitor unit (SMU)
module. The series resistor may be used for the device protection, negative
resistance measurement, and so on. It depends on the characteristics of test device
and measurement environment.

If you use a seriesresistor, the voltage you set is applied to the near side of the series
resistor. Thus, the voltage will be divided by the series resistor and the device under
test. Then, the measurement data is not compensated.

To set the series resistor, refer to “ Advanced Setup Window” on page 5-51.

Restrictions

The series resistor cannot be used for the measurements that use the high resolution
SMU (HRSMU) connected to the Atto Sense and Switch Unit (ASU) or the
measurements that use 1 A range of the high power SMU (HPSMU).

The series resistor is set to OFF for the standby channelsin the standby state.
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Interlock Function

Theinterlock function is designed to prevent electrical shock when a user touches
the measurement terminals. If the Interlock terminal is open, maximum output is
limitedto + 42 V.

To perform high voltage measurement more than + 42 V, connect the Interlock
terminal to an interlock circuit of test fixture or connector plate. Theinterlock circuit
must have one LED and two mechanical switches placed near the shielding box
opening doors. And they must be connected together. For details on how to install
the interlock circuit, see “To Make an Interlock Circuit” on page 3-29.

The interlock function works as shown below.

*  When theinterlock circuit is open, maximum output islimited to + 42 V.

*  Whentheinterlock circuit is close, source channel can forceits maximum output
value.

* When theinterlock circuit is opened in the high voltage condition more than
* 42V, output voltage is set to 0 V immediately.

If the actual output valueis not set to 0 V within 120 msec, Agilent B1500
automatically performs the initialization. Then perform self-test. Any module may
be defective.

Danger ous voltage of up to the maximum voltage of SM Us may be present at
force, guard, and senseterminalsif the Interlock terminal is closed.
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Auto Power Off Function

If an abnormal voltage or current is detected in Agilent B1500, Agilent B1500
automatically turns off to prevent damage.

If thisfunction is activated, Agilent B1500 is turned off, but the Standby switch is
left ON. Perform the following steps to turn Agilent B1500 on again.

1. If Windowsis running, end all tasks, and shutdown Windows.
Open the measurement terminals.

Press the Standby switch to set it to the OFF position.
Remove the power cable from the B1500 rear panel.

Wiait for 10 seconds or more.

o g~ WD

Connect the power cable from the B1500 rear panel.
7. Pressthe Standby switch to set it to the ON position.

Abnormal voltage or current can be caused by incorrect connections of Agilent
B1500 to the test device, excess voltage or current input, momentary power 10ss,
defects of the instrument, and so on.

If no cableis connected to the measurement terminals of Agilent B1500, and theline
voltageis correct, Agilent B1500 may have a defect. Contact the nearest Agilent
Technol ogies Service Center for assistance.
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Initial Settings

Agilent B1500 isinitialized by turning the B1500 on, the * RST command, or the
device clear. Initial settings of the B1500 are shown in the following tables.

Table 7-9 Initial Settings
Setup Item Initial Setting
Mainframe | Auto calibration off
SMU Output switch close

Filter on

Series resistor off

ASU path/indicator SMU side/enable

ASU 1 pA auto range disable

Current measurement range with pulse compliance range
without pulse auto

Voltage measurement range with pulse compliance range
without pulse auto

A/D converter

high resolution A/D converter

ADC integration time

high speed ADC: auto

high resolution ADC: auto

ADC zero function off
Sweep automatic abort function off
Hold time Os
Delay time O0s
Pulse width 0.001s
Pulse period 0.01s
7-66 Agilent B1500 User’s Guide, Edition 7




Function Details
Initial Settings

Setup Item Initial Setting
CMU SCUU path/indicator open/enable

M easurement parameter Cp-G

M easurement range auto

Measurement time auto

Open/short/load correction off

Phase compensation mode auto

Measurement signal frequency 1k, 2k, 5k, 10k, 20k, 50k, 100 k, 200 k, 500 k,
1M,2M,5MHz

Automatic abort function off

Hold time 0s

Delay time O0s

SPGU Operation mode VPUL SE (PG mode)

Pulse period 10us

Channel output mode Primary Pulse, 2-level pulse output

Pul se source setup Delay: 0s
Width 100 ns
Leading: 20 ns
Trailing: 20 ns

ALWG setup Cleared

Pulse switch Disable

DUT load impedance 500

SPGU trigger output Disable
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Built-in Programming Tool

This chapter explains the programming tool built into Agilent
B1500A/EasyEXPERT. The programming tool is used to define user functions and
analysisfunctionsin the Classic Test definitions and to define the test contentsin the
Application Test definitions.

This chapter contains the following sections.
»  “Variables and Expressions’
e “Built-in Functions’

* “Read Out Functions’

“Script Program Statements’
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Variables and Expressions

Variables can be used in Agilent EasyEXPERT setup editor for the following
applications. User functions and analysis functions can also be used for variables.

» To store the value of the measurement condition input parameter

» To store the value of the measurement result data or analysis data

» Variable used in the test execution flow of the Application Test definition
»  User function of the Classic Test definition

» Analysisfunction of the Classic Test definition

The following characters can be used for the variable name.

e Alphabetic characters A to Z and ato z, case sensitive

e (underscore)

*  Numeric characters0to 9

e @ (at mark)

Numeric characters and at mark cannot be used for the first character of variable

name.

About variable names

The variable name must be unique. If avariable is defined as alocal variablein an
application test definition and its name i s the same as one of the following variables,
the local variable is effective and the following variable is not effective.

» variablethat defines abuilt-in function in atest setup
» variablethat defines aread out function in atest setup
» variable defined as atest parameter

» variable defined as a device parameter

» variable defined as an analysis parameter

Thelocal variables are defined by using the Local Variable Definition statement in
the Test Contents setup displayed on the Test Definition window. The test
parameters and the device parameters are defined in the Test Specification setup,
and the analysis parameters are defined in the Test Output setup.
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Expressions
Figure 8-1 shows the expression effective for variable definition. The elements are
explained bel ow.

Figure 8-1 Syntax of Expression

y { Expression '—“—>

Monomial
Operator

Xxpression Operator
—' Litetral }

—‘ Constant }

—' Variable E
Built-in -
® ©

Function

Read Out
Function

User
Function

Analysis
Function

Constants

The following scientific constants are available.
e electric charge. 1.602177x10™19

«  k: Boltsmann's constant. 1.380658x10°%3

« e space permittivity. 8.854188x10712
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Literals

Numeric type and string type are available.

Numeric type

To enter anumeric value, type as follows, where[ ] isoptional.
Dd[ . d] [ E[ S] d] [s]

D: Numeric character 0to 9

d: This means repeating D 0 times or more.

E: Exponent symbol, E or e

S: Sign, + or -

s: Prefix symbol. The subsequent symbols (y, z, a, f, p, h, u, m, k, M, G)
separated by the comma mean the value following the colon.

y: 1024, 2102, & 10718, f: 1015, p: 102, n: 1072, u: 106, m: 1073,
k: 103, M: 105, G: 10°

String type

Enclose the string by using the double quotes. To contain the double quotes into
the string, type as shown below. The example string is ABC"DEF.

" ABC' " DEF"

Monomial Operatorsand Binomial Operators

Table 8-1 shows monomial operators and binomial operators available for an
expression. The table also shows the priority of operators and the type of operand.
For the expression that contains the same priority operators, the operations are
performed from |eft to right. Module type variable is one of SMU, HPSMU,
MPSMU, HRSMU, HRSMU/ASU, CMH, or CML.

Operation between arrays

Operation is performed between data at the same index.
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Monomial Operator and Binomial Operator

o Type of operand
Q Operator
Z Numeric Vector? Sring Module
T O Yes Yes Yes Yes
S NOT Yes Yes No No
A Yes Yes No No
*or/ Yes Yes No No
+ or -, monomia Yes Yes +:Yes, - : No No
+ or -, binomial Yes Yes +:Yes, - : No No
> >= < <= Yes Yes Yes No
= <> Yes Yes Yes No
AND Yes Yes No No
- XOR Yes Yes No No
%’ OR Yes Yes No No

a. Two-dimensiona array. The primary planeisfor the primary sweep index, and the
secondary planeis for the secondary sweep index.

Built-in Functions

Agilent EasyEXPERT built-in function can be used. See “Built-in Functions’ on
page 8-7.

Read Out Functions

Agilent EasyEXPERT built-in read out function can be used. Available only for the
Analysis Functions. See “Read Out Functions’ on page 8-15.

User Functionsand Analysis Functions

User functions and analysis functions are the user-defined functions that consist of
the variable name, unit, and expression. The functions are effective for numeric or
vector type data. To define the functions, see “Function Setup” on page 5-42.

Numeric literal, scientific constants (g, k, €), variableto store the test result data, and
abuilt-in function that returns the numeric or vector type data can be used in the
expression.

For an analysis function, the read-out function can also be used.
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abs(A)

acos(A)

asin(A)

at(A,B)

at(A,B,C)

Built-in Programming Tool
Built-in Functions

Built-in Functions

This section describes Agilent EasyEXPERT built-in functions. The functions
appear in alphabetical order. In the function name, the character in parenthesesis a
variable.

Returns the absolute value of the expression A.
Example B=abs(A)
Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Returns the arccosine value of the expression A. The A value must be between - 1
and 1.

Example B=acos(A)
Datatype A:numeric, B: numeric. Or A: vector, B: vector.

Returns the arcsine value of the expression A. The A value must be between -1 and
1

Example B=asin(A)
Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Finds a data el ement in the expression A, and returns the value. The dataelement is
specified by index B. The index number startsfrom 1. If B isnot an integer, alinear
interpolated A value will be returned.

Example C=at (A B)
Datatype A: vector or numeric, B: numeric, C: vector.

Finds a data e ement in the expression A, and returns the value. The data element is
specified by the indices B and C. B isthe index for the primary plane of a
two-dimensional array and C istheindex for the secondary plane. Theindex number
starts from 1.

If B isnot an integer, alinear interpolated A value will be returned. The linear
interpolation will be executed between A[n,C] and A[n+1,C], wheren < B < n+1.

If Cisnot aninteger, C will ben, wheren < C < n+1.
Example D=at (A B, Q)
Datatype A: vector or numeric, B: numeric, C: numeric, D: numeric.

Agilent B1500 User’s Guide, Edition 7 8-7



atan(A)

atan2(A,B)

avg(A)

ceil(A)

cond(A,B,C,D)

cos(A)

Built-in Programming Tool
Built-in Functions

Returns the arctangent value of the expression A.

Example B=atan(A)

Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Returns the radian value of the angle made by the X-axis and the line that passes
through the coordinates (0, 0) and (A, B).

Example C=atan2(A, B)
Datatype A:numeric, B: numeric, C: numeric. If A and/or B is vector, C: vector.

Returns the average value of datain the expression A. For subordinate sweep
measurement, this function returns the average values for each primary sweep.
Example B=avg(A)

Datatype A: vector or numeric, B: vector.

Returns the minimum integer value more than or equal to the expression A.
Example B=ceil (A)
Datatype A:numeric, B: numeric. Or A: vector, B: vector.

This function does the following.

« If A<B,returnsC.
 If A>B,returnsD.

If the A or B valueisinvalid, the value for the previous measurement index number
is used for the comparison.

Example E=cond(A, B, C, D)
Datatype A, B, C, D: numeric, E: numeric. If A, B, C, and/or D is vector,

E: vector.
Returns the cosine value of the expression A.
Example B=cos(A)
Datatype A: numeric, B: numeric. Or A: vector, B: vector.
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Returns the difference of the expression A. Calculation is performed as follows.

D,=(A>-Ay) whenn=1
Dh=An1-An/2 whenl<n<N

Dp = (AN~ An-1) whenn=N

where,

D, difference for the index number n

Aq A value for the index number n

N number of sweep steps or number of samples

For subordinate sweep, the first index number of each primary sweep is always 1.

If A isadatavariable for a secondary sweep source, this function returns the sweep
step value of the secondary sweep.

For frequency data of C-V sweep, the calculation is performed for all frequencies.

Example B=del t a( A)
Datatype A: vector or numeric, B: vector.

Returnsthe differential coefficient of the expression A by B. Calculationis
performed as follows.

A= (A A)DI(By- By) whenn=1

A= (Apir- An)/(Brag- Brog) whenl<n<N
A= (An- An.)/(By- B.g) whenn=N

where,

Ay differential coefficient for the index number n
Ap: A value for the index number n

By B value for the index number n

N: number of sweep steps or number of samples

For subordinate sweep, the first index number of each primary sweep is always 1.
Example C=diff (A B)
Datatype A, B: vector or numeric, C: vector.
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dim2Size(A)

exp(A)

floor(A)

getNumericData(A
)

getVectorData(A)

index(A,B)

Built-in Programming Tool
Built-in Functions

Returns the number of elementsin the primary plane of the vector variable A.
Example B=di niSi ze(A)
Datatype A: vector, B: numeric.

Returns the number of elementsin the secondary plane of the vector variable A.
Example B=di n2Si ze(A)
Datatype A: vector, B: numeric.

Raises e (exponential) to the power of the expression A. The following example
enters € calculation result to the variable B.

Example B=exp(A)

Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Returns the maximum integer value less than or equal to the expression A.

Example B=fl oor (A)
Datatype A:numeric, B: numeric. Or A: vector, B: vector.

Returns data of the numeric variable specified by A. Thisfunction is effective for
the variables defined in the Function Setup or Display Setup of the last Classic Test
or the analysis parameters of the last Application Test. The variables are validin a
test definition.

Example B=get NumericData("A")

Datatype A: string (name of numeric variable), B: numeric.

Returns data of the vector variable specified by A. This function is effective for the
variables defined in the Function Setup or Display Setup of the last Classic Test or
the analysis parameters of the last Application Test. The variables are valid in atest
definition.

Example B=get VectorDat a("A")

Datatype A: string (name of vector variable), B: vector.

Findsthe string B in the string A, and returns the index number wherethe string B is
first found. Theindex O indicates the first character. The following example returns
3.

Example C=index("AG LENT","L")

Datatype C: numeric.
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Built-in Programming Tool
Built-in Functions

Performs numerical integration of the expression A by B. Calculation is performed
asfollows.

Whenn=1,a,=0

Whenn > 1, o, isdefined asfollows:

1 n
o, =220 0 )0 )
i=2

where,

Op: integral of A for the index number n
Yi: A value for theindex number i

X;: B value for the index number i

If A or B contain some invalid values, theinvalid values are ignored for the
calculation.

For subordinate sweep, the first index number of each primary sweep is always 1.
Example C=integ(A B)
Datatype A, B: vector or numeric, C: vector.

Returns 1 if the expression A isvalid and is not double.NaN, or else returns 0.
Example B=isValid(A)
Datatype A:numeric, B: numeric.

Returns the logarithm (base 10) of the expression A.
If A=0, - Over f | owisreturned with the status “ Arithmetic error”.

If A isanegative value, the logarithm of the absolute value is returned with the
status “ Arithmetic error”.

Example B=lgt(A)
Datatype A:numeric, B: numeric. Or A: vector, B: vector.
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Returns the logarithm (base €) of the expression A.
If A=0, - Over f | owisreturned with the status “ Arithmetic error”.

If A isanegative value, the logarithm of the absolute value is returned with the
status “ Arithmetic error”.

Example B=l og(A)
Datatype A: numeric, B: numeric. Or A: vector, B: vector.
Returns the moving average value of datain the expression A. B specifies how

many data to use for the average. The moving average at the index number nis
defined as follows.

Whenn< r
_ 1 n+r
X, = X;
r+n i=1
Whenr<n< N-r
l n+r
= _ .
2r+1 2 l
When N-r <n
iy
X =— X,
" r+N-ntl i rl
where,
Xp - moving average of A for the index number n
X A value for theindex number i
r: B value
N : number of sweep steps or number of samples

If A contains someinvalid values, theinvalid values are ignored for the calculation.
For subordinate sweep, the first index number of each primary sweep is always 1.
Example C=mavg(A, B)

Datatype A: vector or numeric, B: numeric, C: vector.
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min(A)

setDeviceld(A)

sin(A)

sqrt(A)

storeAt(A,B,C,D)

Built-in Programming Tool
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Returns the maximum value of datain the expression A. For subordinate sweep
measurement, this function returns the maximum value of the primary sweep for
each secondary sweep step.

If thereareinvalid valuesin A, invalid values are ignored.
Example B=max(A)
Datatype A: vector or numeric, B: vector.

Returns the minimum value of data in the expression A. For subordinate sweep
measurement, this function returns the minimum value of the primary sweep for
each secondary sweep step.

If A containsinvalid values, the invalid values are ignored.
Example B=ni n(A)
Datatype A: vector or numeric, B: vector.

Setsthe value of the string variable A to the Device ID parameter of the test result
record. Thisvalueis effective for the test result records created after this function
call. If the A value is an empty string, this function does nothing.

Example B=set Devi cel d(A)

Datatype A: string, B: numeric. B (returned value) is always 0.

Returns the sine value of the expression A.
Example B=sin(A)
Datatype A:numeric, B: numeric. Or A: vector, B: vector.

Returns the square root of the expression A.
Example B=sqrt (A)
Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Finds a data element in the expression A, and replaces it with the D value, and
returns the result vector data. The data element is specified by theindices B and C.
B istheindex for the primary plane of atwo-dimensional array and C is the index
for the secondary plane. The index number starts from 1. The following example
replaces the A[5, 5] value with the D value and enters the result vector datato the
variable E.

Example E=storeAt(A 5,5, D)
Datatype A: vector or numeric, B, C, D: numeric, E: vector.
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substring(A,B,C)

swmToModule(A)

tan(A)

value(A)

Built-in Programming Tool
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Translates the expression A to a string data, and returnsiit.
Example B=string(A)
Datatype A: numeric or module, B: string.

Translating the variabl e defined with the numeric-symbol assignment

If the argument of the string function is a numeric variable defined with the
numeric-symbol assignment, the string function execution result will be the symbol
assigned to the numeric value, not the string value just trandated from the numeric
value. The numeric-symbol assignment is defined in the “ Test Specification” on

page 6-5.

For the following example setup of the numeric-symbol assignment,
st ri ng( Mode) execution result at Mode=0 is the string OFF, not the string 0.

Parameter Mode, Value=0, Symbol=OFF

Extracts astring from the string A, and returnsit. B is the index used to specify the
first character to extract, and C is the number of characters to extract. The index
number startsfrom 0. If B or C isnot an integer, digits over the decimal point are
used as the integer. The following example returns G.

Example D=substring("AG LENT", 1, 1)
Datatype A:string, B, C: numeric, D: string.

Searches the measurement module connected to Agilent B2200 input port number
A. And returns the module name.

Example B=swnifoMbdul e( A)
Datatype A: string (Input port number 1 to 14), B: module.

Returns the tangent value of the expression A.

Example B=tan(A)

Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Translates the string A to a numeric data, and returnsit. If the A valueisinvalid as
numeric literal, O isreturned.

Example B=val ue(A)
Datatype A: string, B: numeric.
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@Ml

@MX

@My

@MYn

@CX

@CY
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Read Out Functions

The read out functions are built-in functions for reading various values rel ated to the
marker, cursor, or line. You can use these functions to perform complex analysis of
the measurement results. They are available only for the Analysis Functions.

To read the value of the read out function, use a numeric variable. The following
example reads the X intercept of the line 1 and entersit to the variable A.

Example A=@1X

In this section, n of the function nameis an integer (1 to 8), and mis1or 2.

You cannot assign adata variable that includes a read out function to an axis of a
graphics plot.

If the marker, cursor, or linethat are referred to by the read out function are not
displayed, the read out function uses the position at which it was most recently
displayed. If the marker, cursor, and line have not been displayed, the read out
function returnsinvalid data.

Functionsfor Marker

Returns the index number of measurement data at the marker location.

If interpolation mode is enabled and the marker is located between the measurement
data, this function returns a non-integer value.

Returns the value of the X coordinate at the marker location.

Returns the value of the Y coordinate at the marker location.

If therearetwo Y axes, this function returns the value for the selected axis.

Returns the value of the Y n coordinate at the marker location (n: 1 to 8, integer).

Functionsfor Cursor

Returns the value of the X coordinate at the active cursor position.

Returnsthevalue of the Y coordinate at the active cursor position. If therearetwo Y
axes, this function returns the value for the selected axis.
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@CYn Returns the value of the Y n coordinate at the active cursor position (n: 1 to 8,
integer).

Functionsfor Line

@LmCO Returns the correl ation coefficient of the regression for Linem (m: 1 or 2).

Line m must be in regression mode. If not, this function returnsinvalid data.

@LmG Returnsthe slope of Linem (m: 1 or 2).
If therearetwo Y axes, this function returns the value for the selected axis.

This function cal cul ates the slope by using the following formula:
o IftheX and Y axesare both linear scale;
a = (Y1~ Yo) / (X1- Xo)
» If the X axisislog scale, and the Y axisislinear scale:
a = (y1- Yo) / (log x4~ 10g Xq)
» If the X axisislinear scale, and the Y axisislog scale:
a = (logy;- 109 yo) / (X1- Xq)
» IftheX and Y axes are both log scale:
a = (logy;- log yg) / (Iog x1- 10g Xo)
where,
o Slope of Linem
Xg,Yo,X1,Y1:  XandY coordinate values at the two points where Linem
intercepts the perimeter of the plotting area.
@LmGn Returnsthe slope of Linem (m: 1 or 2) for the Yn axis (n: 1 to 8, integer).

This function cal culates the slope by using the following formula:
» [f the X and Y n axes are both linear scale:

a = (Y1~ Yo) / (X1~ Xo)
» If the X axisislog scale, and the Yn axisislinear scale:

a = (Y1~ Yo) / (log x4~ log Xq)
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e If the X axisislinear scale, and the Yn axisislog scale:
a = (logy;- 109 yo) / (X1- Xo)
e If the X and Yn axes are both log scale:

a = (log ys- log yp) / (log x4~ log Xp)

where,
a: Slope of Linem
Xo0,Y0,%X1,Y1:  XandY coordinate values at the two points where Linem

intercepts the perimeter of the plotting area.

Returns the X intercept value (Y=0) of Linem (m: 1 or 2).

If Line mis horizontal, this function returnsinvalid data.

Returnsthe Y intercept value (X=0) of Linem (m: 1 or 2).
If therearetwo Y axes, this function returns the value for the selected axis.

If Line misvertical, this function returns invalid data.
Returnsthe Yn (n: 1 to 8) intercept value (X=0) of Linem (m: 1 or 2).

If Line misvertical, this function returns invalid data.

Functionsfor Two Line Display

Returns the value of the X coordinate at the intersection of Line 1 and Line 2.

This function cal cul ates the intersection by using the following formula.
X=(yzy1) / (ag-ay)

where,

X: Value of the X coordinate at the intersection. If the X axisislog scale,
this function returns 10%.

Ym Y intercept value of Linem (m: 1 or 2). If theY axisislog scale, y,, is
thelog value of the Y intercept of Linem.

O - Slope of Linem

If Line 1isparalel to Line 2, this function returnsinvalid data with the status
“Arithmetic error”.
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Returns the value of the Y coordinate at the intersection of Line 1 and Line 2.
If therearetwo Y axes, this function returns the value for the selected axis.

This function calculates the intersection by using the following formula:

Y =yitog x( Y- y1) / (ag- ap)

where,

Y: Value of the Y coordinate at the intersection. If the Y axisislog scale,
this function returns 10" .

Ym - Y intercept value of Linem (m: 1 or 2). If theY axisislog scale, y, is
thelog value of the Y intercept of Linem.

O : Slopeof Linem

If Line 1isparalel to Line 2, this function returnsinvalid data with the status
“Arithmetic error”.

Returnsthe value of the Yn (n: 1 to 8, integer) coordinate at the intersection of Line
landLine2.

This function calcul ates the intersection by using the following formula:

Yn =yj+aq x(Yo- Y1) / (og- ap)

where,

Yn: Value of the Y n coordinate at the intersection. If the Yn axisislog
scale, this function returns 107",

Y - Ynintercept of Linem(m: 1 or 2). If theYn axisislog scale, y, isthe
log value of the Yn intercept of Line m.

O : Slopeof Linem

If Line 1isparalel to Line 2, this function returnsinvalid data with the status
“Arithmetic error”.
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Script Program Satements

The program statements are used to define the test execution flow on the Test
Contents tab screen of the Test Definition window. On the screen, click the Program
Component tab. The program statements are listed in the component selection area.
See also “Program Component” on page 6-26.

This statement defines the local variables used in the test definition. For the setup
editor, see “Local Variable Definition” on page 6-24. For the available names and
variable types, see “Variables and Expressions’ on page 8-3.

Thelocal variables are effective only for this test definition.

This statement enters a value or expression to the variable as follows:
<variable> = <definition>

where, <variable> is the variable to define, and <definition> is the value or
expression.

Beginning of the BLOCK/END BLOCK block. The statements are added to the
program list as a pair. The test execution flow (program) must be defined between
the statements. Optionally, the following statements can be used in this block.

*»  ON ERROR

This statement enables an event-initiated branch performed when an error
occurs. The routine to be performed when error occurs must be defined between
ON ERROR and END BLOCK or between ON ERROR and FINALLY.

*  FINALLY

This statement enables an event-initiated branch performed just before
terminating the block. The routine to be performed before terminating the block
must be defined between FINALLY and END BLOCK.

The statements or components between the BLOCK and END BLOCK statements
are performed from top-down. If no error occurs during program execution, the
routine below FINALLY is executed and the block is terminated.

If an error occurs, the error code is stored in the @ERROR system variable, the
routine below ON ERROR is executed, and the block is terminated. If FINALLY is
used, the routine below FINALLY is executed before the block is terminated.
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ERROR
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This statement enters acomment in the program line.

This statement terminates program execution. After the END statement, the routines
defined by the FINALLY statement are performed.

This statement causes an error. However, no error code is stored in the @ERROR
system variable because of the fictious error.

Beginning of the FOR/NEXT loop block. FOR and NEXT are added to the program
list as a pair. The statements repeatedly performed when looping must be defined
between the statements. The FOR/NEXT statements are entered as follows:

FOR <variable> = <initial value> TO <terminate value> STEP <step value>
NEXT <variable>

where, <variable> is avariable used for the loop counter. <initial value>,
<terminate value>, and <step value> are values for the loop counter start value, stop
value, and step value respectively.

The EXIT FOR statement is available to exit from the loop before the loop count
reaches <terminate value>. After looping, the next line of NEXT is performed.

Beginning of the IF/END IF block. The statements are added to the program list asa
pair. The IF statement specifies the primary branching condition. The routines
performed when the condition is satisfied are defined between the statements. The
statements are entered as follows:

IF <expression>
END IF

where, <expression> is the condition of branching. Optionally the following
statements can be used in this block.

» ELSE IF <expression>

This statement specifies the additional branching condition used when the
previous condition is not satisfied, and defines the routines performed when this
branching condition is satisfied.

« ELSE

This statement defines the routines performed when no branching condition is
satisfied.
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Beginning of the LOOP/END L OOP block. LOOP and END LOOP are added to the
program list as a pair. The statements repeatedly performed during looping should
be defined between the statements.

The EXIT LOOP statement isavailable to exit from the loop. After looping, the next
line of END LOORP is performed.

Test definition name: Vth_gmMax

Local Variables Definition
BLOCK
I****x | ntegration Time Setting *****
I F I ntegTi me=" SHORT"
I nt egMode = " MANUAL"
AdcFactor = 8
ELSE | F | ntegTi me="MEDI UM'
I nt egvbde = "PLC'
AdcFactor =1
ELSE | F | ntegTi me="LONG'
I nteghvbde = "PLC"
AdcFactor = 16
END I F
Lxxxxx | L\ Speep **rr*
Vt h_gmmax
Lxxxx% Analysis *rExx
Aut o Anal ysi s
END BLOCK
Line 1: Defineslocal variables.

Line 2: Beginning of program. Program ends by the END BLOCK statement.

Line 3: Comment line. The COMMENT statement is used.

Lines 4 to 13: Changes the integration time setting by the variable IntegTime value.
Line 14: Comment line. The COMMENT statement is used.

Line 15: Executes Vth_gmmax of the Application Test component to perform Id-Vg
measurement.

Line 16: Comment line. The COMMENT statement is used.

Line 17; Executes Auto Analysis of the Analysis component.
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Test definition name: NandFlash [V-Write-1V

Local Variables Definition
BLOCK
I****x | ntegration Time Setting *****
I F I ntegTi me=" SHORT"
I nt egvbde = " MANUAL"
AdcFactor = 8
ELSE | F | ntegTi me="MEDI UM'
I ntegvbde = "PLC'
AdcFactor =1
ELSE | F | ntegTi me="LONG'
I nteghvbde = "PLC"
AdcFactor = 16
END I F
I**xx%x | [V Sweep & Analysis Initial Characteristics *****
For ceP&
Id-Vg_lnitial
Reset PG
Aut o Anal ysi s

(continues to the next page)

Line 1: Defineslocal variables.

Line 2: Beginning of program. Program ends by the END BLOCK statement.

Line 3: Comment line. The COMMENT statement is used.

Lines 4 to 13: Changes the integration time setting by the variable IntegTime value.
Line 14: Comment line. The COMMENT statement is used.

Line 15: Executes ForcePG2 of the Application Test component to apply pulse from
the Output 2 terminal of Agilent 81110A pulse generator connected to Agilent
B1500A.

Line 16: Executes |d-Vg_lnitia of the Application Test component to perform
|d-V g measurement.

Line 17; Executes ResetPG of the Application Test component to reset Agilent
81110A.

Line 18; Executes Auto Analysis of the Analysis component.
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(continues from the previous page)

Vthlnitial = getNunericData("VthBefore")

Vgat eLi st = get Vect orDat a("Vgate")

IdlnitialList = getVectorData("ldrain")

I ***xx Force Pul se *****

For cePGL

Reset PG

P xxxx | [V Sweep & Analysis after Wite ***x*

For ceP&

ld-Vg_Witten

Reset PG

Aut o Anal ysi s

VthWitten = getNumericData("VthAfter")

IdWittenList = getVectorData("ldrain")
END BLOCK

Lines 19 to 21: Entersthe value of the variables (VthBefore, V gate, Idrain) defined
in the Function Setup or Display Setup of the Id-Vg_Initial test into the local
variables (Vthinitial, VgatelList, IdInitialList). The ASSIGN statements are used.

Line 22;: Comment line. The COMMENT statement is used.

Line 23: Executes ForcePG1 of the Application Test component to perform the
NAND-type flash memory write operation.

Line 24: Executes ResetPG of the Application Test component.
Line 25: Comment line. The COMMENT statement is used.
Line 26: Executes ForcePG2 of the Application Test component.

Line 27: Executes |d-V g_Written of the Application Test component to perform
|d-V g measurement.

Line 28: Executes ResetPG of the Application Test component.
Line 29: Executes Auto Analysis of the Analysis component.

Lines 30 to 31: Entersthe value of the variables (VthAfter, Idrain) defined in the
Function Setup or Display Setup of the Id-Vg_Written test into the local variables
(VthWritten, IdWrittenList). The ASSIGN statements are used.

Line 32: End of program
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If You Have a Problem

This chapter explains how to solve problems or how to read error codes, if you
encounter some problems. This chapter consists of the following sections.

“When You Operate B1500A”
“When You Perform Measurement”
“Before Shipping to Service Center”
“Data Backup and Recovery”
“B1500A System Recovery”
“Updating EasyEXPERT”

“Error Codes’

If error occurs, find solutionsin the following sections and solve problems.
However, if problems still remain, perform self-test.

If Agilent B1500A fails self-test, contact Agilent Technologies.

To get the latest firmware/software/el ectronic manual §/support information, visit
Agilent Technol ogies support site (http://www.home.agilent.com), and click Test &
M easurement Equipment > Parametric Test, click Semiconductor Parameter/Device
Analyzer Series, and click B1500A Semiconductor Device Analyzer. You can reach
Agilent B1500A support site.
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When You Operate B1500A

This section covers the following basic problems that you may encounter when you
install or operate Agilent B1500A, and the solutions. See also “Error Codes’ on
page 9-23.

*  “Power On Trouble’

¢ “SCUU isnot Detected”

*  “ASU isnot Detected”

» “External GPIB Devices are not Detected”

» “To Simplify the Connections”

To set up the Windows, see “Inspection and Installation” on page 3-6

If you need to reinstall Agilent EasyEXPERT software, see “B1500A System
Recovery” on page 9-19

Power On Trouble

» Connect the power cable to the B1500A firmly.

» Connect the power cable to power outlet firmly.

»  Open the measurement terminals, and set the Standby switch to the ON position.
Open the measurement terminals at the device side when turning the B1500A on.
Also disconnect the device from the measurement terminals and open the
measurement terminals after the measurement. If you leave the connection with the

device, the device may be damaged by unexpected operations or charge-up of
measurement cables.

SCUU is not Detected

If Agilent B1500A/EasyEXPERT cannot detect SCUU (SMU CMU unify unit), turn
B1500A off, check the cable connection, and reboot B1500A/EasyEX PERT.

For the install ation and connection of SCUU, see “To Connect SCUU/GSWU” on
page 3-21.
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ASU isnot Detected

If Agilent B1500A/EasyEXPERT cannot detect ASU (atto sense/switch unit), turn
B1500A off, check the cable connection, and reboot B1500A/EasyEX PERT.

For the installation and connection of ASU, see “To Connect ASU” on page 3-17.

NOTE Connect ASU to dedicated HRSM U

The specifications are satisfied and guaranteed for the exclusive combination of the
ASU and the HRSMU. So confirm the serial number of the ASU and connect it to
the dedicated HRSMU properly.

External GPIB Devices are not Detected

If Agilent B1500A/EasyEXPERT cannot detect external GPIB devices, do the
following troubleshooting.

1. Turn B1500A and external GPIB devices off, check the GPIB cable connection,
and reboot the devices and B1500A/EasyEXPERT.

2. If the problem still remains, confirm if B1500A is set to the system controller.
See “To Enable System Controller” on page 3-10.

3. If the problem still remains, confirm if B1500A is connected to USBO. Open
Agilent Connection Expert, check Instrument I/O on this PC. The USBO in this
area must show the information as shown below.

USBO
+ B1500A( USBO: : xxxX: : X: : XXXX: :X:: | NSTR)

+ agb1500a
+ UsbDevi cel

If the problem still remains, perform Agilent B1500 system recovery. To perform
recovery, see “B1500A System Recovery” on page 9-19.
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To Simplify the Connections

If you want to simplify the measurement connections, use thetriaxial cablesinstead
of the kelvin triaxial cables, and connect the triaxial cables between the Force
terminals and the test fixture or the connector plate. Then the Sense terminals must

be opened.

The B1500A has the Force and Sense terminals to make the kelvin connection. And
the kelvin triaxial cables are effective to extend the measurement terminals near by
the device under test. Connecting the Force and Sense lines together at the device
terminals can minimize the measurement error caused by the residual resistance of
the connection cables. The kelvin connection is effective for the low resistance
measurement and the high current measurement. Also it is one of the conditionsto
satisfy the measurement specifications of the B1500A.
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When You Perform M easurement

This section covers the following basic problems that you may encounter when you
making a measurement, and the solutions.

» “Measurement Takes More Time than Specified”
* “Noise Affects the Measured Values’

» “Voltage Measurement Error is Large”
* “SMU Oscillates for High-Frequency Device Measurements’
» “SMU Oscillates for Negative Resistance M easurements’

e “Large Current Causes High Temperature (Thermal Drift)”

e “Measurement Damages the Device under Test”

» “Leaving Connections Damages Devices after Measurement”
» “Unexpected Sampling Measurement Data is Returned”

+ “MFCMU Causes Unbalance Condition”

M easurement Takes More Time than Specified

If you set many measurement channels, auto ranging mode, or too long integration
time, measurement takes a longer time.

To solve this problem:

Depending on your measurement requirements, perform following:
* Decreases measurement channels.

» Useslimited auto ranging mode.

* Usesfixed range.

» Decreases averaging samples of the high-speed A/D converter.

» Decreasesintegration time of the high-resolution A/D converter.

* Disablesthe ADC zero function.
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Noise Affectsthe Measured Values

When you measure low current of a DUT, the measured values may not be stable.

To solve this problem:

Set the power line frequency correctly. The value affects the integration time. So
the wrong val ue causes the measurement error by the power line noise. You can
set the power line frequency by using the Configuration window of the
EasyEXPERT.

Use guarding to reduce the leakage current between your prober and the
B1500A. Note that long wires cause oscillation because of their large
inductance.

If some high-power electric machines are operating around the B1500A, turn off
the machines, then perform the measurements. The machines affect the power
line waveform.

Shut the lid of test fixture or shield box to prevent effects of light.

If these are vibrations due to nearby machines or due to air flow, put cushioning
material under prober, cable, and the B1500A; install stabilizer on the prober;
and make the cabl es stable by taping.

Wait several minutes after connecting cables or moving probe needles. Because
these operations cause el ectromotive force.

If you use only Force terminal and triaxial cables, connect an open cap to Sense
terminal.

Keep constant temperature in the room when you use the B1500A. Shift of 1 °C
may shift the measurement values. Temperature change causes the following.

¢ Offset current in the B1500A.
¢ Thermoelectromotive force in DUT, which causes low current.

« Expansion and contraction of cables, which causes noise.
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Voltage Measurement Error isLarge

Voltage measurement error may be large because of the effects of the cable
resistance when forcing alarge current.

To solve this problem:

» Usekelvin connections between SMUs and DUT. To cancel the effects of cable
resistance, connect the sense line as close as possible to the terminal of the DUT.

SMU Oscillates for High-Frequency Device
M easur ements

When measuring parameters of high-frequency devices, such as GaAs MESFETs or
high-frequency bipolar transistors, oscillation may cause measurement problems.
Normal measurement cannot be performed because of oscillation.

To solve this problem:

» For FETS, add resigtive ferrite beads as close as possible to the gate.

» For bipolar transistors, add resistive ferrite beads as close as possible to the base
or emitter.

» Make connection cables as short as possible. Long wires cause oscillation
because of their large inductance.

N

Test device

Ferrite beads To unit
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SMU Oscillates for Negative Resistance M easurements

If the DUT has negative resistance characteristics, SMUs may oscillate. Because the

positive feedback may be configured by the DUT and the SMUs.

To solve this problem:

» For voltage controlled negative resistance device

e Connect G in parallel with your DUT to cancel negative resistance. To
obtain an output 1-V curve, use the following equation.

lY=1- GxV

<]

V

» For current controlled negative resistance device

UGTO6C03, 110x50

e Connect R in series with your DUT to cancel negative resistance. To obtain
an output I-V curve, use the following equation.

VZ=V- RxlI

« If theresistance of the DUT islessthan 1 MQ, you can use a series resistor

built into the SMU.

99 °

vV

I
i
\V4

R

-

Vz

UGTO6004, 1050
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L arge Current Causes High Temperature (Thermal
Drift)

If alarge current isforced to a DUT, the temperature of the DUT may increase,
which may cause characteristics to drift.

To solve this problem:

e Usethe pulse output mode of the SMU.

For large currents, the SMU should be set to pulse output mode. This decreases
the average power output to prevent temperature rise of DUT.

M easurement Damages the Device under Test
When performing breakdown measurements, DUTs may be damaged.

When voltage is forced from an SMU, the current is limited by the compliance
setting, which prevents the DUT from being damaged by alarge current. But when
the current rapidly increases, the current limiter in the SMU cannot follow the rapid
current increase, so alarge amount of current may flow through the DUT for a
moment, which may damage the DUT.

To solve this problem:

» Insert aprotecting resistor as close as possible to DUT. You can also use aseries
resistor built into the SMU.

L eaving Connections Damages Devices after
M easur ement

After the measurements, open the measurement terminals or disconnect the device
under test from the measurement terminals. If you leave the connection with the
device, the device may be damaged by unexpected operations.

Do not |eave the connection over 30 minutes after the measurement if the auto
calibration is set to ON. Then, the B1500A performs the self-calibration
automatically every 30 minutes after the measurement. The calibration requiresto
open the measurement terminals.

Open the measurement terminals and never connect anything when the calibration is
performed.
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Unexpected Sampling M easurement Data is Retur ned

If sampling interval is set to ashort time and if FILTER ON is set, you may get
unwanted data. FILTER ON causes a slower risetime, so short initia interval will
sample during thisrise time.

To solve this problem:

* SetFILTER field to OFF if you set initial interval to a short time.

Some data may be skipped because measurement takes a long time. M easurement
takes along time if measurement is performed in alow current range, if many
measurement channels are set up, or if analysis, such as moving a marker, is
performed during measurements.

To solve this problem:

» Measure current using afixed range that is more than 10 uA. For measurement
ranges 10 pA or less, measurement takes longer than the specified integration
time.

» Do not perform analysis operation during measurement state.

MFCMU Causes Unbalance Condition

Extending measurement cables may cause the unbalance condition of the MFCMU.
To solve this problem:

» Perform the phase compensation. See “CMU Calibration” on page 4-37.

» Thesigna path from MFCMU to DUT must be as short as possible.

» Reduce stray capacitance and guard capacitance on the signal line.

Do not connect the Low (Lcur, Lpot) terminal to the wafer chuck. If the
MFCMU must be connected to the wafer chuck, use the High (Hcur, Hpot)
terminal to connect to the wafer chuck.
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Before Shipping to Service Center

Before shipping Agilent B1500 to the Service Center, you have to do following:

* “ToMake Backup”
* “To Check Module Slots’
*  “To Check ASU/HRSMU Combination”

» “To Collect Equipment and Accessories’

To Make Backup

If theinternal hard disk drive (HDD) isfailed, you will lose al data stored in the
HDD. So it isimportant to make backup constantly.

Before shipping the B1500 to the service center, make backup of datain the HDD.
And keep the backup mediain trust. You may need to perform datarecovery of the
B1500 returned from the service center.

If the HDD isreplaced, the B1500 will be returned with the latest revision of the
software, Windows X P, EasyEXPERT, and so on.

To Check Module Slots

Do not remove the plug-in module from the mainframe. The B1500 must be shipped
with all modules. The module cannot be repaired without the mainframe. If a
module is removed and installed by anyone who is not a service personnel of
Adgilent Technol ogies, the specifications are not guaranteed.

To Check ASU/HRSM U Combination

When you ship the B1500 used with the atto sense/switch unit (ASU), disconnect
the ASU cable set (triaxial and Dsub) between the ASU and the high resolution
source monitor unit (HRSMU), and ship the mainframe, the ASU cable set, and the
ASU. The ASU can be used with the exclusive HRSMU. To confirm the
ASU/HRSMU combination, check the serial number. See “ASU” on page 4-43.

9-12 Agilent B1500 User’s Guide, Edition 7



WARNING

If You Have a Problem
Before Shipping to Service Center

To Collect Equipment and Accessories

The following equipment and accessories are required for servicing and must be
shipped to the Service Center.

» B1500A with al plug-in modulesinstalled

*  ASU exclusiveto HRSMU

» Connection cable set between ASU and HRSMU
* RSU

» Connection cable set between RSU and WGFMU

For returning ASU or RSU, do not forget to notify the combination of the unit,
connection cable, and module channel.

The connection cable set between ASU and HRSMU means one of the following.

» E5288A-001 Triaxial and D-sub cables, 1.5 m
» E5288A-002 Triaxial and D-sub cables, 3m
The connection cable set between RSU and WGFMU means one of the following.

* 16493R-003 3 m Cable between WGFMU and RSU

* 16493R-004 5 m Cable between WGFMU and RSU

* 16493R-006 1.5 m Cable between WGFMU and RSU

* 16493R-001 and 002 60 cm Cable and 2.4 m Cable between WGFMU and RSU
* 16493R-001 and 005 60 cm Cable and 4.4 m Cable between WGFMU and RSU

To prevent electrical shock, turn off Agilent B1500A and remove the power
cable before removing the connection cables.
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NOTE

Data Backup and Recovery

Unexpected trouble of HDD (hard disk drive), operation mistake, or malfunction
may cause elimination of valuable data. To avoid this kind of risk, make backup of
datain the HDD as frequently as possible.

* “Foldersto Backup”

* “To Make Database Backup”

* “To Restore Database Backup”

* “To Make Backup of Other Data”

* “To Restore Backup of Other Data”

Drive for making backup

Make backup into the storage device that has large free space and can be accessed
by the B1500A directly. The device may be the D drive, a USB memory, an external
HDD with USB interface and such.

If you make backup into the B1500A internal HDD, C drive or D drive, make a copy
of the backup into an external storage device or backup media, CD-ROM, CD-RW,
USB memory and such.
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Foldersto Backup

Backup should be made for the following data areas.

EasyEXPERT database, below D:\Agilent\EasyEXPERT

D: \ Agi | ent\ EasyEXPERT\ 1

Personal folders, below C:\Documents and Settings

Example: C: \ Docunent s and Setti ngs\ B1500user

Desktop EasyEXPERT user folder

Example: C: \ Program Fi | es\ Agi | ent \ B1500\ EasyEXPERT\ User
Desktop EasyEXPERT database

Example:
C:\ Program Fi | es\ Agi | ent\ B1500\ EasyEXPERT\ User\ 1

Folders that store the data exported by EasyEXPERT or Desktop EasyEXPERT
Other folders that store the data to be saved

To Make Database Backup
EasyEXPERT database backup can be made by the following procedure.

1
2.

Launch Start EasyEX PERT.

Click Option > EasyEXPERT Database > Backup EasyEXPERT Databasein the
Start EasyEXPERT window.

Follow the EasyEXPERT Database Backup Creation wizard, and make backup
into the D drive. The extension of the backup file is xdb.

Make a copy of the xdb file into an external storage device or backup media.
Example: COPY EasyEXPERT backup_ 1. xdb F:\
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To Restore Database Backup
EasyEXPERT database can be restored by the following procedure.

1. Make acopy of the database backup file (xdb file) into the D drive.
2. Launch Start EasyEXPERT.

3. Click Option > EasyEXPERT Database > Restore EasyEXPERT Databasein the
Start EasyEXPERT window.

4. Follow the EasyEXPERT Database Restoration wizard, and restore the backup
of EasyEXPERT database.

If the backup is not the xdb file

The backup for recovery must be “a copy of the folder that contains the
EasyEXPERT database image”. And it must be stored in the location other than the
following folders.

e D:\Agil ent folder
e EasyEXPERT database folder

For the Windows backup (bkf file) or the compressed backup (zip file or other),
uncompress the backup file at the location other than the above folders. And launch
the wizard after the uncompression is completed.

Also, for the Backup Type Selection of the wizard, select “ A Copy of the folder that
contains the EasyEXPERT database image” and follow the wizard.
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To Make Backup of Other Data

There are the following three ways to make backup of data other than the
EasyEXPERT database. Make backup by using one of the following methods.

e To use Windows backup program:

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the Backup or Restore wizard, and make backup into the D drive.
The extension of the backup file is bkf.

3. Make acopy of the bkf fileinto an external storage device or backup media.
Example: COPY Mydat a_backup_1. bkf F:\
» To make and copy a compressed file:

1. Make acompressed file for the whole folder to back up.

2. Make acopy of the compressed file into an external storage device or
backup media.

Example: COPY Mydat a_backup_1.zip F:\

e To copy awhole folder for backup:

1. Connect an external storage device, HDD with USB interface and such, to
the B1500A.

2. Make acopy of the folder into the external storage device.
Example: XCOPY Fol der _user _1 F:\ Backup_user_1
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To Restore Backup of Other Data

Backups can be restored as shown below. The recovery method depends on how the
backup was made.

* Backupisabkf file:
1. Make acopy of the backup file (bkf file) into the D drive.
2. Click Start > All Programs > Accessories > System Tools > Backup.
3. Follow the Backup or Restore wizard, and restore the bkf file.

» Backup isacompressed file:

1. Make acopy of the compressed file into the D drive.
2. Uncompress the file at the place different from the original folder.

3. Copy all of the uncompressed files and folders, and paste them to the
original folder.

* Backup isawhole folder:
1. Make acopy of the whole folder into the D drive.
Example: XCOPY F:\ Backup_user 1 Backup_user_1
2. Deletethe original folder.
Example: RVMDI R / S Fol der _user _1
3. Change the folder name to the original one.

Example: RENAME Backup_user 1 Fol der _user_1
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B1500A System Recovery

If you find problemsin the B1500A system, perform the system recovery.

» “To Perform System Recovery”
* “Tolnitialize Database’
* “To Restore Database’

Before system recovery

After performing B1500A system recovery, the C drive will be returned to the
condition when you received the B1500A or when it left the factory. To avoid
deleting valuable data, Agilent Technologies strongly recommends to make backup
of datain the C drive before starting the system recovery. See “Data Backup and
Recovery” on page 9-14 for making the backup.

To Perform System Recovery
B1500A system recovery can be performed by the following procedure.

1. Set the B1500A Standby switch to the OFF position.

2. Disconnect all USB devices from the B1500A.

3. Connect the USB keyboard to a USB port of the B1500A.
4. Set the B1500A Standby switch to the ON position.
5

. On the boot system selection menu, select Agilent Recovery System, and press
Enter key. To select the system, use arrow keys.

The Command Prompt window is opened. See Figure 9-1.

Where, 2 isnot valid now. 3 should be entered for rebooting the B1500A
without performing system recovery.

6. For the message“Enter aChoice:”, enter 1 and pressthe Enter key. M essage will
be displayed for asking if you allow to overwrite the C drive.

7. For the message, enter 1 and press the Enter key. System recovery starts. After
the recovery compl etes successfully, system boot starts automatically.

8. Perform “To Initialize Database” on page 9-20.
9. Perform “To Restore Database” on page 9-21.
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Agilent System Recovery Screen

Agi | ent Technol ogi es System Utilities
Recovery Options

Choose one of the foll ow ng:

1. Recover Factory Backup | nmage.
2. Update System
3. Exit

Enter a Choi ce:

To Initialize Database

EasyEXPERT database can be initialized by the following procedure. You can use
EasyEXPERT after this procedure is compl eted.

1. Exit Start EasyEXPERT.
2. Rename D:\Agilent\EasyEXPERT\1 folder (EasyEXPERT database).
Example:

CHDI R / D D:\ Agi | ent\ EasyEXPERT
RENAME 1 1-backup

3. Create D:\Agilent\EasyEXPERT\1 folder.
Example:
MKDI R 1

4. Copy all filesand foldersin the D:\Agilent\EasyEXPERT\Copy of 1 folder, and
paste them to the D:\Agilent\EasyEXPERT\1 fol der.

Example:
CHDI R Copy of 1
CoPY * . .\1
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To Restore Database

EasyEXPERT database can be restored by the following procedure.

In the example shown in “To Initialize Database” on page 9-20, the EasyEXPERT
database backup isthe whole D: \ Agi | ent \ EasyEXPERT\ 1- backup folder.
The database can be restored by using the datain this folder.

» For EasyEXPERT revision A.02.10 and earlier

The database reconfiguration tool is required. Obtain it from Agilent
Technologies web site. For the execution procedure, see the readme text file
included in the package.

» For EasyEXPERT revision A.02.11 and later

1. Launch Start EasyEXPERT.

2. Click Option > EasyEXPERT Database > Restore EasyEXPERT Databasein
the Start EasyEXPERT window.

3. Follow the EasyEXPERT Database Restoration Wizard and complete the
restoration of EasyEXPERT database.
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Updating EasyEXPERT

The latest version of the EasyEXPERT update package can be obtained from
Agilent Technologies web site.

The EasyEXPERT revision A.03.20 does not require the administrator privilege
which isrequired by the revision A.03.11 and previous revisions. However, if the
softwareis updated from apreviousrevision to therevision A.03.20, it still requires
the administrator privilege.

EasyEXPERT can be updated by the following procedure.

1. Make abackup of EasyEXPERT database. See “ To Make Database Backup” on
page 9-15.

2. If thisisthe update from the revision A.03.10 or earlier to therevision A.03.11
or later, install the following software. They are included in the update package.

* Microsoft .NET Framework Version 2.0 Redistributable Package
* Microsoft .NET Framework 2.0 Service Pack 1
If they are already installed, go to the step 3.
3. Execute the setup program of the update package.
4. Follow the setup wizard and complete the update of EasyEXPERT.
5. After the update is completed, make a backup of EasyEXPERT database.

Perform the following procedure.

If EasyEXPERT could recover to the revision before starting the update procedure,
skip the following step 1 to 2.

1. Perform system recovery. See “B1500A System Recovery” on page 9-19. This
isnot required for Desktop EasyEXPERT software.

2. Update EasyEXPERT to the revision before starting the update procedure.

3. Restore the backup made by the update procedure step 1. See “To Restore
Database Backup” on page 9-16.

4. Perform the update procedure step 2 to 5.

9-22 Agilent B1500 User’s Guide, Edition 7



If You Have a Problem
Error Codes

Error Codes

This section lists Agilent B1500 error codes and messages.

» “Agilent EasyEXPERT Operation Error”
» “Agilent FLEX Execution Error”
» “Agilent B1500A Self-test/Calibration Error”

» “Setup File Converter Execution Error”

Agilent EasyEXPERT Operation Error

When Agilent B1500 causes errorsin Agilent EasyEXPERT execution
environment, the B1500 returns the following error codes and error messages.

101001
101002
101003
102001
102002
102003

102004

103001
103002
103003
103004
103005
103006

103007
103008

Log repository operation failed.
Log file operation failed.

L og record operation failed.
Service started successfully.
Service stopped successfully.

Service starting process failed. Contact your nearest Agilent
Technol ogies Service Center.

Service stopping process failed. Contact your nearest Agilent
Technol ogies Service Center.

USB488 error occurred. Alias: A, Reason: B

USB488 device was not found. Alias: A, Reason: B

USB488 timeout occurred. Alias: A, Timeout: B [mg]

GPIB error occurred. Interface: A, Address: B, Reason: C

GPIB address must be between 0 and 31. Interface: A, Address: B

Duplicate GPIB address was found. GPIB address must be unique.
Interface: A, Address. B

GPIB device was not found. Interface: A, Address: B, Reason: C

GPIB timeout occurred. Interface: A, Address. B, Timeout: C [ms]
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104001 Module (A) is not available.
105001 Generic setup error occurred. Code: A, Reason: B

105002 Duplicate data name was found. Data name must be unique. Data
name: A

105003 Operation is not supported in offline mode.

105004 Interlock circuit is open. Interlock circuit must be closed for setting
voltage source/compliance absolute value exceeding 42V.

105005 Output series resistor cannot be used for HRSMU with ASU.
105006 Source wait time coefficient must be between A and B.

105008 Monitor wait time coefficient must be between A and B.
105010 Seriesresistor is not available for HPSMU using the 1 A range.
105011 I/V Staircase Sweep needs at |east one monitoring channel.
105012 I/V Pulse Sweep needs exactly one monitoring channel.
105013 I/V Pulse Biased Sweep needs exactly one monitoring channel.
105014 [/V-t Sampling needs at least one monitoring channel.

105015 C-V Sweep needs at least one monitoring channel.

105016 At least one measurement channel is required for Multi Channel I/V
Sweep measurement.

105017 Only one measurement channel can be used for I/V-t linear sampling
measurement of interval <2 ms.

105018 Base hold time is not available for 4155B/C and 4156B/C. The value
must be 0.

105020 Interlock circuit is open. Interlock circuit must be closed to set an
output or compliance value greater than + 40 V.

105021 Current source value of A must be between B A and C A.
105022 Voltage compliance value of A must be between BV and C V.
105023 Voltage source value of A must be between BV and C V.
105024 Current compliance value of A must be between B A and C A.
105025 Power compliance value of A must be between B W and C W.
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105031

105032

105033

105034

105035

105036
105037
105041

105042

105043

105044

105045

105046

105047

105048

If You Have a Problem
Error Codes

The product of voltage source value and current compliance value of A
exceedsits output power range. Please set the current compliance value
between BA and C A.

The product of current source value and voltage compliance value of A
exceedsits output power range. Please set the voltage compliance value
betweenBV and C V.

The polarity of peak value(s) and the base value of SMU current pulse
must be the same.

The start value and stop value of SMU log sweep must be non-zero and
have same polarity for primary sweep source (and synchronous sweep
SOUrce).

Invalid value (A) was specified for SMU |/V Sweep stop condition.
Valid option(s): B

Aisnot available for the setting of the sweep abort condition. Select
one from the available choices B. If you use aformula, the calculation
result must show the available value.

The hold time for SMU I/V Sweep must be between Asand B s.
The delay time for SMU I/V Sweep must be between Asand B s.

Invalid value (B) was specified for current monitor ranging mode of A.
Valid option(s): C

Invalid value (B) was specified for current monitor range of A. Valid
option(s): C

Invalid value (B) was specified for current monitor ranging rule of A.
Valid option(s): C

Invalid value (B) was specified for voltage monitor ranging mode of A.
Valid option(s): C

Invalid value (B) was specified for voltage monitor range of A. Valid
option(s): C

Invalid value (A) was specified for the integral mode of
High-Resolution ADC. Valid option(s): B

The coefficient for High Resolution ADC A integral mode must be
between B and C.

Invalid value (A) was specified for the averaging mode of High-Speed
ADC. Valid option(s): B
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105049 The coefficient for High Speed ADC A averaging mode must be
between B and C.

105050 Invalid value (A) was specified for the integral mode of ADC. Valid
option(s): B

105051 Invalid value (A) was specified for the sweep direction. Valid option(s):
B

105052 Invalid value (A) was specified for the sweep stop condition. Valid
option(s): B

105053 Invalid value (A) was specified for the impedance measurement model.
Valid option(s): B

105054 Hold time value must be between Asand B s.

105055 Delay time value must be between Asand B s.

105056 Voltage source value of A must be between BV and C V.

105057 Frequency value of A must be between B Hz and C Hz.

105058 Coefficient value of A integral mode must be between B and C.

105059 AC Level value of A must be between B mV and C mV.

105060 Invalid value (B) was specified for monitor ranging mode of A. Valid
option(s): C

105061 SMU pulse period must be A slonger than the pulse width.

105062 Primary sweep source step value must be greater than the setup
resolution.

105063 Synchronous sweep source step value must be greater than the setup
resolution. Adjust the offset value and the ratio value, or change the
primary sweep source settings.

105064 Compliance absolute value must be A A or greater if the channel isthe
SMU pulse source and the output valueis B Vpp.

105065 Compliance valuemust be+ 2 V or lessif the channel isthe SMU pulse
source and the output valueis 0 A to 10 pA.

105066 Current compliance must be 100 mA for VSU.

105067 Power compliance must be OFF for V SU.

105071 Sampling interval for I/V-t sampling must be between Asand B s.

105072 Number of samplesfor 1/V-t A sampling must be between B and C.
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105073
105074

105075

105076
105077

105078
105079
105080

105081

105083

105091

105092

105093

105094

105095

105801

105802

105803

If You Have a Problem
Error Codes

Hold time for I/V-t sampling must be between Asand B s.

Multiplying the number of monitor channels by No of Samples must be
between A and B.

Invalid value A specified for I/V-t sampling Lin/Log setting.
Valid option(s): B

Base hold time for 1/V-t sampling must be between Asand B s.

Invalid value A specified for I/V-t sampling output sequence.

Valid option(s): B

Sampling interval for 1/V-t A sampling must be between Bsand C s.
Hold time for I/V-t A sampling must be between Bsand C s.

Hold time for 1/V-t A sampling with interval of B sor longer must be
betweenCsand D s.

Hold time for 1/V-t A sampling with interval shorter than B s must be
betweenCsand D s.

The number of VAR steps multiplied by the number of VAR2 steps
must be between Aand B in I/V Sweep, I/V List Sweep and Multi
Channel 1/ Sweep.

List length of VAR1 sweep must be between A and B for the I/V List
Sweep measurement. Length C is not applicable.

List length of VAR2 sweep must be between A and B for the I/V List
Sweep measurement. Length C is not applicable.

List length of delay time must be between A and B for the I/V List
Sweep measurement. Length C is not applicable.

Time until the first step measurement, (hold time + delay time), must be
between A and B sfor the I/V List Sweep measurement using SMU
pulse.

A does not support current measurement.

Invalid value A specified for Output Value after Measurement in the
Advanced Setup dialog box. Valid option(s): B

Invalid value A specified for Bias Hold after Measurement in the
Advanced Setup dialog box. Valid option(s): B

Bias hold function execution error. All channel outputs or voltage
compliance must be at £42 V or lessto control the output switch or the
seriesresistor.
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105804 Bias hold function execution error. Output voltage or voltage
compliance must be + 40 V or less to control the output switch or the
seriesresistor.

105811 Invalid value A was specified for Semiconductor Relays (B) of
Advanced Setup. Valid option(s): C

105821 Invalid value A was specified for Type of SPGU Pulse Setup. Valid
option(s): B, VName: C

105822 Invalid value A was specified for SW Sync of Pulse Switch Setup. Valid
option(s): B, VName: C

105823 Invalid value A was specified for Normal of Pulse Switch Setup. Valid
option(s): B, VName: C

105824 Width value of Pulse Switch Setup must be between Asand B s.
VName: C

105825 Width for pulse switch must be between A sand B s. VName: C

105826 Sum of Delay and Width of Pulse Switch Setup must be within Period
value. VName: A

105830 Load Z value must be between A ohm and B ohm. VName: C

105831 Period value of SPGU Pulse Setup must be between Asand B s.

105832 PUL SE COUNT value of SPGU Pulse Setup must be between A and B.

105833 DURATION value of SPGU Pulse Setup must be between Asand B s.

105834 Base value of SPGU Pulse Setup must be between AV and B V.
VName: C

105835 Peak value of SPGU Pulse Setup must be between AV and B V.
VName: C

105836 Delay value of SPGU Pulse Setup must be between Asand B s.
VName: C

105837 Width value of SPGU Pulse Setup must be between Asand B s.
VName: C

105838 Leading value of SPGU Pulse Setup must be between Asand B s.
VName: C

105839 Trailing value of SPGU Pulse Setup must be between Asand B s.
VName: C

105840 Leading x 1.25 must be within Width value. VName: A
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105841

105842

105843

105844

105845

105846

105901
105902
105903
105904

105905

105906

105907

105908

105909

105910

105911

If You Have a Problem
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Sum of Delay, Width, and Trailing x 1.25 must be within Period value.
VName: A

Invalid value A was specified for PGU output impedance.
Valid option(s): B, VName: C

SPGU cannot be used for bias source of I/V-t linear sampling
measurement of interval <2 ms.

|Peak- Base| value of PGU pulse must be between AV and B V.
VName: C

Period, Width, and Delay values of PGU pulse must be in the same
setting range. And Leading and trailing values must be in the same
setting range.

SPGU cannot output the specified voltage. Change Load Z value or
output voltage.

Over voltage was applied to SMU measurement terminal.
Over current was applied to SMU measurement terminal.
Cannot use the specified module that failed self-test.

A cannot be set to Additional Data Variables. Only the channel s defined
in Channel Definition can be set.

Entry isaready defined in Additional Data Variables. It is not
necessary to redefine the entry. Unit: A, Type: B

Variable name specified in Additional Data Variablesis used for
another variable. Specify a different name. Variable name: A

FMT command's first argument must be 13.

Invalid Type value was found in the Additional Data Variables area. A
test setup cannot contain both the type Re(Z) or Im(Z) and the type
Re(Y) or Im(Y).

Program memory number is out of range. Valid value: Ato B Entered
value: C

Program memory variable number is out of range. Valid value: Ato B
Entered value: C

Empty Command field was found in the Command Setup. A command
must be entered in the Command field.
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105912 Test execution error was detected. Check the parameter values of the
command, and set the Arguments field again. Setup Name=A, Line
Number=B, Command=C

105913 Incorrect usage of ST and END commands. Use them as a pair to store
a command group into the program memory.

105914 Improper number of Arguments for the A command. Enter the
Arguments correctly.

106001 L ogon request was rejected. The number of Logons already reachesthe
limit of the software regulation. Restart EasyEXPERT. If this does not
solve the problem, restart the B1500.

107001 Workspace management error was occurred.

107002 Workspace was not found. Restart Agilent B1500A. If the problem still
occurs, contact your nearest Agilent Technologies Service Center.

107003 Workspace could not be loaded. Restart Agilent B1500A. If the
problem still occurs, contact your nearest Agilent Technologies Service
Center.

107004 The request to load or create Workspace was rejected. Workspaceis
already active. Close the present Workspace and open the Workspace
again.

107005 The operation cannot be executed because Workspace is in use now.
Close the present Workspace and open the Workspace again.

107006 The workspace name is conflicting. It must be unique in system.
Specify the correct Workspace name.

108001 Function Library management error occurred.

108002 Function Library function has not been configured correctly or is not
running. Restart Agilent B1500A. If the problem still occurs, contact
your nearest Agilent Technologies Service Center.

108003 Invalid Function Module assembly file. Restart Agilent B1500A. If the
problem still occurs, contact your nearest Agilent Technologies Service
Center.

108004 Invalid Function Module. Restart Agilent B1500A. If the problem still
occurs, contact your nearest Agilent Technologies Service Center.

108005 Function Module was not found. Restart Agilent B1500A. If the
problem still occurs, contact your nearest Agilent Technologies Service
Center.
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108006

108007

108008

108009

108010

108011

108020

108021

108022

109001
109002
109011
109012

109021

If You Have a Problem
Error Codes

Function Module is inaccessible because it has been removed. Restart
Agilent B1500A. If the problem still occurs, contact your nearest
Agilent Technologies Service Center.

The same processis running now. Restart Agilent B1500A. If the
problem still occurs, contact your nearest Agilent Technologies Service
Center.

Profile was not found. Restart Agilent B1500A. If the problem still
occurs, contact your nearest Agilent Technologies Service Center.

Profile could not be loaded. Restart Agilent B1500A. If the problem
still occurs, contact your nearest Agilent Technologies Service Center.

The request to load or create Profile was rejected. Profile is already
active. Restart Agilent B1500A. If the problem still occurs, contact
your nearest Agilent Technologies Service Center.

Invalid Function Module for this EasyEXPERT revision. Module ID:
A, Path: B

Restart Agilent B1500A. If the problem still occurs, contact your
nearest Agilent Technologies Service Center.

An /O error occurred during Function Library operation. Path: A

Restart Agilent B1500A. If the problem still occurs, contact your
nearest Agilent Technologies Service Center.

Function Module read error. Path: A

Restart Agilent B1500A. If the problem still occurs, contact your
nearest Agilent Technologies Service Center.

Function Module save error. Path: A

Restart Agilent B1500A. If the problem still occurs, contact your
nearest Agilent Technologies Service Center.

Auto calibration isin progress.
CMU phase compensation failed.
CMU open correction failed.

The value of standard for CMU open correction must be finite as
admittance.

CMU short correction failed.
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109022 The value of standard for CMU short correction must be finite as
impedance.

109031 CMU load correction failed.

109032 The value of standard for CMU load correction must be finitein
impedance (non-zero as admittance).

109041 Cannot define multiple standby settings for a SMU. Channel: A

109051 Direct Control execution status. Sweep measurement was aborted by
the automatic abort function or the power compliance. Test setup: A

109052 Direct Control execution status. Quasi-static CV measurement was
aborted by the automatic abort function. Test setup: A

109053 Direct Control execution status. Search measurement was aborted by
the automatic abort function. Test setup: A

109054 Direct Control execution status. Sampling measurement was aborted by
the automatic abort function. Test setup: A

109061 Duplicate SMU assignment was found. SMU assignment must be
unique. SMU: A

110001 Configuration query completed.

111001 Data name (A) isinvalid.

111002 Function name (A) isinvalid.

111003 Function name (A) duplicates other data/function name.
111004 Definition expression of function (A) isinvalid. expression: B
111005 The data (A) assigned with the data (B) is not defined.

111006 The data (A) assigned to the data (B) is not defined.

111007 The data (A) cannot be assigned to the data (B) for the mismatch of
their types.

111008 Recursive definition is not allowed for function (A). Expression: B
111011 Vector data expression is expected. Expression: A

111012 Numeric expression is expected. Expression: A

111013 String expression is expected. Expression: A

111014 Descriptor expression is expected. Expression: A

111015 M odule descriptor expression is expected. Expression: A
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111016
111021
111022
111031
111032
111033

111034

111035

111036

111037

111038

112001

112002

112003

112004
112005

112006

112007

112008

112009

If You Have a Problem
Error Codes

ALWaveform type expression must be entered. Expression: A
Test setup name cannot be an empty string.

Test setup name must be A characters or less.

Assign module parameter for ALWaveform type parameter.
ALWG Pattern Name must be entered.

Invalid character isincluded in Name of module parameter assigned for
ALWaveform type parameter. Module name: A, Invalid character: B

Invalid character isincluded in ALWG Pattern Name. ALWG pattern
name: A, Invalid character: B

No segquence is defined in the ALWG waveform data. Define one
column or more.

Pattern is not defined in the ALWG waveform data for the output
channel A. Specify a pattern.

ALWG waveform data contains an invalid pattern.
Name of the invalid pattern: A

ALWG waveform data memory overflow. Delete unnecessary columns
or pointsin a pattern, and increase free space.
Output channel: A, Required space: B, Maximum space: C

Output function must be constant for the unit (A) in common mode.
Output function (A) must be assigned to any unit.

Output function (A) cannot be assigned to multiple units (B and C).
Pulse mode cannot be assigned to multiple SMUs (A and B).

I/V mode of the primary sweep source and synchronous sweep source
must be the same.

Duplicate channel data name was found. Channel data name must be
unique. Channel data name: A

Duplicate channel unit assignment was found. Channel unit assignment
must be unique. Channel unit: A

No channel unit was assigned. At least one channel unit must be
assigned.

Function (A) can be used for amaximum of B channel(s) in the C mode.
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112010 All SPGU channels must be set to the same output mode, VPUL SE or
ALWG

112011 SMU descriptor expression is expected. Expression: A

112012 CMU descriptor expression is expected. Expression: A

112013 SPGU descriptor expression must be entered. Expression: A

112014 Mode must be V or COMMON for VSU (A).

112015 VMU (A) must be defined as a constant current source.

112016 Mode must be COMMON for GNDU.

112022 No CMU was assigned. At least one CMU must be assigned.

112023 No SMU was assigned. At least one SMU must be assigned.

112024 At least one SPGU must be used for SPGU Control.

112051 Auto analysis operation failed.

112052 Invalid value A specified for the switching matrix input setting. Specify
astring, string variable, or module variable defined in the test definition
or test setup.

112053 Enter avalue for numeric variable A, used to specify the switching
matrix output channel.

112054 A switch setup named A is aready in the preset group B. The switch
setup name must be unique in a preset group.

112055 A preset group named A already exists. The preset group name must be
unique.

112056 Enter a name for the switching matrix setup.

112057 Maximum length for a switching matrix setup nameis A characters.

112058 Read Switch Setup operation failed. Set the switching matrix
configuration mode to Normal. Could not read the setup for connecting
multiple input ports to a output channel.

112060 Specified connection pattern is not available for the couple port A, B.
112061 Input port A uses a shared path. The path is currently connected to the
other input port. The specified connection is not available.

112071 Invalid Unit value was entered in the Channel Definition area. A test
setup cannot use multiple units connected to the SCUU. Invalid entry:
Unit=SMU A
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112072

112073

112074

112075

112100

112101

113001
113002
113003

113011

113012

113013
113014

113015

113016

113017
113018

113021
113022

If You Have a Problem
Error Codes

Invalid value A was specified for Enable/Disable of 1/V-t Sampling
Stop Condition. Valid option(s): B

Invalid value A was specified for Name of 1/V-t Sampling Stop
Condition. Valid option(s): B

Invalid value A was specified for Event of I/V-t Sampling Stop
Condition. Valid option(s): B

Invalid function was used in the definition of variable specified by
Name of I/V-t Sampling Stop Condition.

ALWG waveform datafor A was not found. Set data of the
ALWaveform type parameter properly.

Multiple ALWG waveform data are specified for A. Set Properties of
the ALWaveform type parameter properly.

Category name length must be in range of A to B characters.
Application test definition name cannot be an empty string.

Application test definition of the same name is already existing. Test
definition: A Test categories: B

Duplicate parameter name was found. Parameter name must be unique.
Parameter name: A

Duplicate typical value A is assigned. Each typical value must be
unique for a numeric parameter.

Symbol must not be an empty string.

Symbol A isduplicated. Symbol must be unique for a numeric
parameter.

Same value A is assigned to symbols B and C. Each symbol must have
unique value for a numeric parameter.

Duplicate typical value A is assigned. Each typical value must be
unique for a string parameter.

Empty string is not alowed for the symbol.

Symbol Aisused for another vector parameter. Specify a different
symbol.

The type of evaluated value does not match the type of parameter A.

Value for numeric parameter is out of range. Value must be in range.
Parameter name: A Parameter value: B Parameter range: from C to D
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If You Have a Problem
Error Codes

113023

113024

113025

113031

114001

114002

114011

114012

114021

114031

114032

114101

114102
114103

Value for string parameter is not contained in the enumeration. Value
must be a member of the enumeration. Parameter name: A, Parameter
value: B, Enumeration: C

Value for module parameter isinvalid or is not compliant to the
resource type of the parameter. Parameter name: A, Parameter value: B

Improper value specified for the vector parameter. The value must be
within the following range.
Restriction: A, Specified value: B, Effective range: C to D

Test setup A depends on an undefined application test B. Please import
the application test B in advance.

A preset group named A already exists. The preset group name must be
unique.

Unnamed preset group cannot be exported. Please name the preset
group in advance.

A test setup named A is already in the preset group B. The test setup
name must be unique in a preset group.

A test setup named A cannot be retrieved in the preset group B.
Probably it had already been modified or deleted.

Following test result record cannot be retrieved. Probably it had already
been deleted. Test result record: A

Change the file name in the File Name Format dialog box. Following
elements can be used in the file name.

A Setup Name

B Date (Time stamp)
C Count

D DevicelD

Change the file name in the File Name Format dial og box. Specified
value contains an invalid character. Specified file name: A,
Invalid character: B

File 1/0 error occurred during automatic data export. Refer to the detail
message, and retry after taking necessary measures.

Specify the folder path in the Test Results Data Auto Export dialog box.

Change thefolder path in the Test Results Data Auto Export dial og box.
Specified value contains an invalid character. Specified folder path: A
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114104

114105

114106

114107

114151

114152

115001

115011

115021

115022

115031
115032
115041
116001

116002

116003

116004

If You Have a Problem
Error Codes

Folder creation failed during automatic data export. Specify the correct
drive letter and folder path in the Test Results Data Auto Export dialog
box.

Change the file extension in the Test Results Data Auto Export dialog
box. Specified value contains an invalid character.
Specified file extension: A

Datafile creation failed during automatic data export. Refer to the
detail message, and retry after taking necessary measures.

Index file creation failed during automatic data export. Refer to the
detail message, and retry after taking necessary measures.

Specify the XML Style Sheet File Path in the Test Results Data Auto
Export dialog box.

Change the XML Style Sheet File Path in the Test Results Data Auto
Export dialog box. Specified value contains an invalid character.
Specified path: A

Thereis no working test setup. First preset the test setup.

The application test A depends on an undefined application test B.
Import the application test B in advance.

Test setup import operation failed. Probably the imported contents are
not a test setup.

Test setup conversion failed. Setup A is not available for the tests that
use the model B.

Failed to invoke A.
Repeat execution was aborted.
Standby state was changed to OFF due to high voltage related error.

Connected model not supported by Desktop EasyEXPERT. Only model
Ais supported. Connected model: B (address: C)

B1500 firmware revision A is not supported by Desktop EasyEXPERT.
Only revisions B and later are supported.

Invalid argument specified for /gpib. Specified argument: /gpib:A
Example argument (valid): /gpib:gpib0::17

Desktop EasyEXPERT does not support 4155/56 firmware revision A.
Update the firmware to the revision B or later.
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If You Have a Problem
Error Codes

117001 Enter another label for the switching matrix input port. A is already
used for another port.

117002 Do not use acolon (:) in the label for a switching matrix input port.

117003 Connect the switching matrix to use this function. To establish the
GPIB connection, set the GPIB address on the Configuration window’s
Switching Matrix tab, and click the Poll button.

117004 Invalid value A for the switching matrix output channel. Value must be
between B and C.

117005 AtoBisnot avalid range for the switching matrix output channels. Use
positive integers, with the first value no greater than the second.

117006 Switching matrix close error. Enter odd numbers to specify output
channels connected to couple input port A.

117007 Switching matrix open error. Enter odd numbers to specify output
channels connected to couple input port A.

117008 Switching matrix input port A is a couple input port. Enter A- 1 to
specify the couple port.

117009 swmToModule(A) execution failed. Specified port number is out of the
valid range (1 to 14). Otherwise, an invalid resource name has been
defined in the switching matrix input port configuration. Enter the port
number for an input that has a valid resource name.

117010 Switching matrix command execution error. B2200 error code: A
B2200 error message: B

117011 Connected model not supported by EasyEXPERT. Only model A is
supported. Connected model: B

117012 Capacitance compensation data file read error. Specified fileis either
corrupt, or is not a compensation datafile.

117014 Cannot control the switching matrix. It is controlled by the other tool.

120000 Script program execution error.

120001 Duplicated variable name used. Change the name of the variable. In a
script program, the local variable name must be unique.

120002 Script program execution is aborted. Program execution paused by
clicking the Pause button. This is the status message in normal
operation.
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120003

120004

120005

120006

120007

120008

121000
121001

121002
122000
122001

122002

122003

If You Have a Problem
Error Codes

Script program execution ended abnormally. Program execution
stopped by anillegal operation or statement. For more information,
click the Detail button.

An error forced by ERROR statement. Program execution stopped by
the ERROR statement. Thisis the status message in normal operation.

Invalid value detected in flow control statement. Correct the IF, FOR,
or other flow control statement. |nappropriate expression used in the
statement.

Pasting program component failed. Specified program components
cannot be pasted to the specified place. Cut or copy the appropriate
program components, and paste them to the appropriate place.

Variable type mismatch detected for assigning. Enter the appropriate
value to the variable. Data type must be the same.

Unknown program component imported. Keyword Prefix: A, Keyword:
B

Dataimport was completed for an application test definition that
contains a statement to call atest definition not in this system. Then the
statement was automatically commented out. Before importing the test
definition, import the test definition to be called.

Plug-in execution error.

Plug-in execution aborted. Plug-in execution paused by clicking the
Pause button. Thisis the status message in normal operation.

Plug-in execution ended abnormally.

Script Error.

Operator located in wrong place. Operator: A

Correct the expression. Put the operator in the correct place.

Invalid expression is specified in user function definition.
User function: A, Expression: B

Correct the expression B defined in the user function or analysis
function A. Click the Detail button for more information.

Bracket Mismatch. Add or delete parenthesis. Parentheses must be
paired.
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If You Have a Problem
Error Codes

122004

122005

122006
122007

122008

122009

122010

122011

122012

122013

122014

122015
123000

Invalid expression is specified for function argument. Function: A,
Argument: B

Correct the expression defined for the argument B of the function A.
Click the Detail button for more information.

Invalid type of datais specified as function argument. Correct the data
type of the variable used for the argument. Or change the variable that
is the same data type as the argument.

Incorrect data is specified as function argument.

Specified argument is out of range. Correct the value of the argument.
The value must be within its allowable range.

Invalid character is used for system symbol. System symbol: A, Invalid
character: B

Invalid character isused for user defined symbol. User defined symbol:
A Invalid character: B

Use the characters available for the user defined symbol.
Missing operator. Index: A

Correct the expression. Put the operator on the correct place.
Missing operand. Index: A

Correct the expression. Number of operands must be one for the
monomia operators, and two for the binomial operators.

Operand Type Mismatch. Operator: A

Correct the expression. The type of operands used in the expression
must be the same.

Undefined Symbol is used. Symbol: A

Correct the expression. Symbols must be defined before using them in
the expression.

Function failed to call. Function: A

Failed to call the function A. For more information, click the Detail
button.

Number of vector data elements must be A or less.

Only literal value can be specified here. Invalid character is entered in
the Variable Inspector. Enter the correct variable name.
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130001
130002

130003

130004

130005
130011
131001
131002

131003

131004

131005
132001
132002

133001
133002

133003

133004

133005

If You Have a Problem
Error Codes

Transport function error occurred.

A target package was not found. Cannot import data because of invalid
file format or corrupted file. Specify correct file.

The package is unusable because it includes incorrect data. Cannot
import data because of invalid file format or corrupted file. Specify
correct file.

Package data is insufficient for this process. Cannot import data
because of invalid file format or corrupted file. Specify correct file.

File 1/O error. Cannot find or access the package file.
Dataimport failed. Data may be incompatible or corrupt. Data: A
Conversion function error occurred.

Invalid style sheet. Cannot export data (to CSV or XMLSS) because of
invalid file format or corrupted file. Specify correct file.

Invalid XML document. Restart Agilent B1500A. If the problem still
occurs, contact your nearest Agilent Technologies Service Center.

Conversion process failed. Cannot export data (to CSV or XMLSS)
because of invalid file format or corrupted file. Specify correct file.

File 1/O error. Cannot access the target file.
Command interface error occurred.

The process failed to execute the specified external command. Confirm
that the fileisin the system path, and specify the correct file name.
Otherwise the file might have a problem.

GPIB interface error occurred.

Internal error occurred during GPIB operation. GPIB interface might be
defective.

The GPIB operation failed to complete within the specified timeout
period. Set the correct timeout value. GPIB interface might be
defective.

The specified expression does not match any device, or the GPIB
resource was not found. Set GPIB address properly. GPIB interface
might be defective.

The specified GPIB resources are invalid. Set GPIB address properly.
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Error Codes

133006 The specified GPIB address value isinvalid. Set the correct GPIB
address of the GPIB device.

133007 The specified GPIB interface number value isinvalid. Set the correct
GPIB interface number of the GPIB device.

133008 The specified timeout valueisinvalid. Set the proper timeout value.

133009 The specified delimiter characters are invalid. Set the proper delimiter
value.

133010 Install Agilent IO Library.

133011 The specified GPIB address A is assigned to the B1500A. Specify the
value assigned to the other equipment. Cannot control the B1500A.

134001 Dialog box interface error occurred.

134002 The processfailed to activate the message-box window. Restart Agilent
B1500A. If the problem still occurs, contact your nearest Agilent
Technol ogies Service Center.

134003 Message-box is already registered in the system. Restart Agilent
B1500A. If the problem still occurs, contact your nearest Agilent
Technol ogies Service Center.

134004 M essage-box function is not available because it is unregistered.
Restart Agilent B1500A. If the problem still occurs, contact your
nearest Agilent Technologies Service Center.

134005 The message-box configuration with no button information isinvalid.
Define the message box properly.

135001 No value is entered in this field. Enter the appropriate valuein this
field.

140001 Specified value range from Ato B of theaxis“C” isnot valid. Specified
value isout of therangefor the “C” axis. Enter the available value.

140002 Specified scaletype “A” of the axis“B” isnot valid. Set the scale type
to LINEAR or LOG.

140003 Datafor Auto Analysisis not found. Cannot find the data that satisfy
the automatic analysis condition. Specify the analysis condition
properly.

140004 Data Display Operation has not completed within specified time (A
seconds). Cannot complete the graph plot, automatic analysis, or data
display properly. Internal error.
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140005
140006

140007
140008
140009
140010
140011
140012
140013
140014
140015

140016

140017

140101

140102

141001

141002
151001

151002
151003
151004
161001

If You Have a Problem
Error Codes

Invalid operation for the stream occurred. Internal error.

Duplicate data name was found. Data name must be unique. data name;
A

No printersinstalled.

Operation for printing failed. Perform printer setup properly.

Failed to evaluate the read out function “A”.

Enable the X-Y Graph to use this read out function.

Define the axis A to use this read out function.

There isno data for this read out function.

Font size must be between A and B.

Number of texts exceeds the limit. Maximum of A texts are allowed.

Number of pointers exceeds the limit. Maximum of A pointers are
allowed.

Invalid value included in data specified by the marker. Pointer could
not be added.

Available number of decades for the log scale must be between A and
B.

Scalar data A is not found. Calculation failed. Scalar data A does not
exist. Change the test definition so that the dataiis set beforeit is called.

Vector data A is not found. Calculation failed. Vector data A does not
exist. Change the test definition so that the datais set beforeit is called.

Maximum A Data Display windows can be opened other than the base
window. Cannot open additional Data Display window because the
number of opened windows reaches the limit. Close an unnecessary
window to open a new window.

Maximum A Base Data Display windows can be opened.

Maximum A Data Display windows can be opened other than the base
window.

Test execution mode cannot be changed during the test.
Up to A datatraces can be displayed in the Data Display window.
Repeat Measurement Setup is not available when Data Record is OFF.

Number of test definition windows must be A or less.
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If You Have a Problem
Error Codes

170001 Archive process failed. Reason: A

171001 Data compression failed. Program error. Contact Agilent Technologies.

171002 Specify acorrect file for theimport. Specified file s either unsupported
or corrupt.

171003 File 1/0O failed during compressed data export. Could not access
destination file. Specified fileis either unsupported or corrupt. Specify
acorrect file for the export.

171004 Compression process or decompression process failed. Specified fileis
either unsupported or corrupt. Specify a correct file for the export or
import. It may also be a program error.

200001 Select from the candidates. Specify the value from the choices for this
field.

200002 Input a numeric value. The value must be numeric. Enter a numeric
value.

200003 Number of grid data elements must be A or less.

200004 Data paste failed. Data format is unsupported or incorrect.

200005 Data paste failed. Data of size AxB cannot be pasted to position C,D. It
must be pasted to arange of ExF.

201001 Failed to load image data. File A may not be an imagefile.

202001 The name A aready exists.

300001 SDA daemon is already running.

300002 SDA daemon configuration file is corrupt. Check the file
C:\Program Files\Agilent\B1500\EasyEX PERT\Daemon\StaDaemon.e
xe.config.

300003 Specify a correct folder for the EasyEXPERT database. Specified
folder not found.

300004 Moving of EasyEXPERT database failed. Refer to the detail message,
and retry after taking necessary measures.

300011 SDA daemon failed to start FLEX command service.
path: A, arguments: B, reason: C

300012 FLEX command service was stopped by SDA daemon. After closing
Agilent Connection Expert, launch Start EasyEXPERT or restart
B1500A.
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300021

300031

300041

300042

300051

300052
300101

300102

300103

300104

300105

300106

300107

300108

If You Have a Problem
Error Codes

SDA daemon failed to start SDA service.
path: A, arguments: B, reason; C

SDA daemon failed to start SDA shell.
path: A, arguments: B, reason; C

SDA daemon failed to start model name inspection process. Path: A,
Arguments:. B, Reason: C

Model nameinspection failed. Set VISA interface ID and GPIB address
correctly, or connect the GPIB cable properly. Reason: A

SDA daemon failed to start database recovery process.
Path: A, Arguments: B, Reason: C

Database recovery failed. Contact Agilent Technologies. Reason: A

Error occurred during inspection for the specified EasyEXPERT
database. Path: A

See the log file C:\Documents and Settings\All Users\ Application
Data\Agilent Technologies, inc\EasyEXPERT\StaDaemon.log if
needed.

The specified EasyEXPERT database is broken. Initialize the database
or restore the normal database backup. Path: A, Reason: B

EasyEXPERT database backup file (.xdb) is broken. Cannot restore this
backup. Path: A

Insufficient free space of HDD. Drive: A Present Free Space: B bytes
Required Free Space: C bytes

Retry the operation after increasing free space. Free space can be
increased by deleting unnecessary files, compressing folders, and so on.

EasyEXPERT database is not in the specified drive A. Specify afolder
on the drive B where the EasyEXPERT database exists.

The specified backup contains the EasyEXPERT database contents for
another revision. Specify the other backup. Contents: A

The specified backup does not contain the file or folder needed to
restore the database. Specify the other backup. Contents: A

The specified backup contains the database that is created by the
EasyEXPERT revision A. It cannot be supported by the present
revision. Specify the other backup.
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Error Codes

300109 EasyEXPERT database backup extraction error. See the log file
C:\Documents and Settings\All Users\Application Data\Agilent
Technologies, inc\EasyEXPERT\StaDaemon.log if needed. Backup
restoration is canceled, and the present EasyEXPERT database remains
the same.

300110 Folder delete error. Delete the folder in the following path manually.
Path: A

300111 EasyEXPERT database backup restoration error. Database could not be
replaced with the backup. See the log file C:\Documents and
Settings\All Users\Application Data\Agilent Technologies,
inc\EasyEX PERT\StaDaemon.log if needed. Source: A, Destination: B
If Source shows the EasyEXPERT database folder name, the database
remains the same.

If Destination shows the EasyEXPERT database folder name, the
database is broken. Restore the previous database by renaming the
temporary database folder named 1.tmp1A and such.

300112 Application Library update error. Information: A

300113 The specified backup is hot complete. Evidence of deletion was
detected. Specify the other backup.

300114 The specified folder is not empty. Specify an empty folder.

300115 Folder deletion was canceled. The folder isleft to the following path.
Path: A

300116 EasyEXPERT database backup extraction was canceled. The extracted
files were deleted.

300117 Folder copy was canceled. The copied files were del eted.

400001 Failed to load inf.dat file. Path: A, Description: B

400002 Cannot access EasyEXPERT database. Path: A, Description: B

400003 The specified EasyEXPERT database contains the contents for another
revision. Path: A, Description: B

400004 The specified EasyEXPERT database has the incorrect structure. Path:
A, Description: B

400005 Failed to load dir file. Path: A, Description: B

400006 Cannot access EasyEXPERT database library directory.

Path: A, Description: B
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500011

500012
500021
500022
500023

500024

500031
500032

If You Have a Problem
Error Codes

License device not found. Connect the license device for EasyEXPERT
properly. Feature: A, Error: B

License device busy. Try again later. Feature; A, Error: B
License for this feature islocked. Try again later. Feature: A, Error: B
Unlicensed feature found. Feature: A

Unknown license information for this feature. The software revision
may be too old. Feature: A

You need the license to use thisfunction. Function: A, Required Option:
B

License authentication error. Feature: A, Reason: B

License authentication failed. Feature: A, Reason: B
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If You Have a Problem
Error Codes

Agilent FLEX Execution Error

When Agilent B1500 causes errorsin Agilent FLEX command execution
environment, the B1500 returns the following error code and error message.

100 Undefined GPIB command.
Send the correct command.

102 Incorrect numeric data syntax.
Correct the data syntax.

103 Incorrect terminator position.
Correct the command syntax. The number of parameters will be
incorrect.

104 Incorrect serial data syntax.

120 Incorrect parameter value.
Correct the parameter value.

121 Channel number must be 1 to 10.
Correct the channel number. The channel number must be 1 to 10 for
Agilent B1500.

122 Number of channels must be corrected.
Check the MM, FL, CN, CL, IN, DZ, or RZ command, and correct the
number of channels.

123 Compliance must be set correctly.
Incorrect compliance value was set. Set the compliance value correctly.

124 Incorrect range value for this channel.
Check the range value available for the channel, and correct the range
value.

125 Search goal value must be less than compliance value.

126 Pulse base and peak must be same polarity.
The polarity of the base and peak values must be the samein the Pl
command. Also the polarity of the base, start, and stop values must be
the samein the PWI command.

130 Start and stop must be same polarity.
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150

151
152

153

160

161

162

170

171

If You Have a Problem
Error Codes

For alog sweep, the polarity of the start and stop values must be the
same in the WV, WI, WSV, WSI, or WNX command. Also, 0 is not
allowed for the start and stop values.

Command input buffer isfull.

Agilent B1500 can receive 256 characters maximum including the
terminator at one time.

This command is not allowed to this channel.
Cannot use failed module.

The channel number specifying the module failed the self-test or
calibration. Specify another module that passed the self-test or
calibration. For the service purpose, execute the RCV command to
enable the module.

No module for the specified channel.
Moduleis not installed in the slot specified by the channel number.
Incorrect ST execution.

Theinternal memory programming can be started by the ST command
and completed by the END command. Do not enter the ST command
between the ST command and the END command.

Incorrect END execution.

Theinternal memory programming can be started by the ST command
and completed by the END command. Do not send the END command
before starting the programming.

Incorrect command for program memory.

Specified command cannot be stored in the program memory. For the
incorrect commands, see Programming Guide.

Incorrect usage of internal variable.

Theinternal variable must be %lIn for integer data, or %Rn for real
data. where nis an integer, 0 to 99. Use %ln for the integer type
command parameters; and use %Rn for the real type command
parameters. For the internal variables, see the VAR command of
Programming Guide.

Internal variableis not allowed.
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Error Codes

The internal variables %ln and %Rn are not available for the ACH,
VAR, and VAR? commands. Do not use the internal variables for the
commands.

200 Channel output switch must be ON.
To enter the specified command, set the channel output switch to ON.
201 Compliance must be set.

To change the source output mode (voltage or current), set the
compliance value.

202 Interlock circuit must be closed.

To set the output voltage or the voltage compliance to more than +42 V
(high voltage state), close theinterlock circuit. If the interlock circuit is
opened in the high voltage state, outputs of all unitswill be set to 0 V.

203 Cannot enable channel.

The channel output switch cannot be set to ON in the high voltage state.
Set the output voltage or the voltage complianceto +42 V or lessto set
the switch to ON.

204 Cannot disable channel.

The channel output switch cannot be set to OFF in the high voltage
state. Set the output voltage or the voltage compliance to £42 V or less
to set the switch to OFF. Or send the CL command with no parameter to
set switches of all channelsto OFF immediately.

205 DZ must be sent before RZ.
The RZ command is effective for the channels set to 0 V output by the
DZ command.

206 Do not specify the channel recovered by RZ.

Specify the channels that have not been recovered yet by the RZ
command after the DZ command. The RZ command cannot be
executed if the specified channelsinclude a channel that has already
been recovered by the RZ command.

210 Ext trigger could not start measurement.
External trigger cannot start measurement because of busy condition.

211 TM1 must be sent to use GET.
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212

213

214

217
220

221

222

223

224

If You Have a Problem
Error Codes

Send the TM 1 command to use the GPIB GET command (TRIGGER
statement in HP BASIC).

Compliance must be set correctly.

Compliance was not set or an incorrect compliance value was set in the
DV, DI, PV, PI, PWV, PWI, TDV, TDI, LSV, LSI, LSSV, LSS, BSV,
BSI, BSSV, or BSSI command. Set the compliance value correctly.

Cannot perform self-test or calibration.

Self-test and calibration cannot be performed in the high voltage state.
Set the output voltage or the voltage complianceto +42 V or lessto
perform the self-test or calibration.

Send MM before measurement trigger.

Before sending the measurement trigger, the MM command must be
sent to set the measurement mode.

Self-test is not defined for this module.
Send WV or WI to set primary sweep source.

Before triggering the staircase sweep measurement, triggering the
staircase sweep with pulsed bias measurement, or sending the WSV,
WSI, or WNX command to set the synchronous sweep source, send the
WV or WI command to set the primary sweep source.

Send PWV or PWI to set pulse sweep source.

Before triggering the pul sed sweep measurement, or sending the WSV
or WSI command to set the synchronous sweep source, send the PWV
or PWI command to set the pul se sweep source.

Send PV or PI to set pulse source.

Before triggering the staircase sweep with pulsed bias measurement,
send the PV or PI command to set the pul se source.

Compliance must be set correctly.

Compliance was not set or an incorrect compliance value was set in the
WV, WI, WSV, WSI, WNX, or BDV command. Set the compliance
value correctly.

Sweep and sync output modes must be the same.

The primary sweep channel and the synchronous sweep channel must
be different, and they must be set to the same output mode (voltage or
current).
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225 Send WSV, WSI, or WNX to get sync sweep data.

If you enable data output of the synchronous sweep source, do not
forget to set the synchronous sweep source by the WSV, WS, or WNX
command. For data output, see the FMT command of Programming
Guide.

226 Set linear sweep for MM4 or MM5.

Only the linear sweep is available for the PWV or PWI command for
the pulsed sweep measurement (MM4) or the WV or WI command for
the staircase sweep with pulsed bias measurement (MM5).

227 Sweep measurement was aborted.

Sweep measurement was aborted by the automatic abort function or the
power compliance.

228 Pulse period is not set for pulse measurements.
230 Pulse source must be set.

To perform the pulsed spot measurement (MM 3), send the PV or PI
command to set the pul se source.

231 Compliance must be set correctly.

Compliance was not set or an incorrect compliance value was set in the
PV, Pl, PWV, or PWI command. Set the correct compliance value
effective for the pulse output.

238 Too large pulse width (max. 2 s).

The maximum value of the pulse width is 2 s. And the available value
depends on the pulse period value. See the PT command of
Programming Guide.

239 Pulse width must be 0.5 ms or more.

Set the pulse width to 0.5 ms or more. See the PT command of
Programming Guide.

240 Enter QSV to set QSCV sweep source.

The QSV command must be entered to set the sweep source of the
quasi-static CV measurement.

241 QSR range value must be - 9to - 14.

The range values available for the QSR command are - 9 to - 14. Set
one of the available values.
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244
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246
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253

254

255

260

If You Have a Problem
Error Codes

QSCV measurement was aborted.

Quasi-static CV measurement was aborted by the automatic abort
function.

Enter MM 13 before QSZ.

Before the QSZ command, the MM 13 command must be entered to set
the measurement mode.

Set alonger integration time to QST.

The integration time is too short to perform the offset measurement. Set
alonger value to the integration time parameter of the QST command.

Specify a higher measurement range to QSR.

Too large offset current was measured. Specify the next higher
measurement range to the QSR command.

QSV mode value must be 1 or 3.

The mode values available for the QSV command are 1 (single linear)
and 3 (double linear). Set one of the available values.

Dedicated channel must be specified by QSO.

Specify the dedicated channel to the QSO command. It must be the
channel other than the measurement channel set by the MM 13
command or the sweep output channel set by the QSV command.

Program memory isfull.

Maximum of 2000 programs or 40000 commands can be stored in the
program memory. See the ST command of Programming Guide.

Invalid input for amemory program.

The GPIB GET command (TRIGGER statement in HP BASIC) and an
external trigger input are not allowed in a memory program (between
the ST and END commands).

Maximum nesting level is eight.

Nesting (one program calling another) of a memory program must be
eight levels or less.

Data output buffer isfull.

Maximum 34034 measurement data items can be stored in the data
output buffer.
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270 Search source channel must be set.

Before triggering the search measurement or sending the LSSV, LSSI,
BSSV, or BSSI command to set the synchronous search source, send
the LSV, LSI, BSV, or BSI command to set the primary search source.

271 Search monitor channel must be set.

Before triggering the search measurement, send the LGV, LGI, BGV, or
BGI command to set the search monitor channel.

273 Search and sync output modes must be the same.

The primary search source channel and the synchronous source channel
must be different, and they must be set to the same output mode
(voltage or current).

274 Search sync source is overflow.

Set the search sources so that the same output range is set to both
primary and synchronous search sources.

275 Search target must be compliance value or less.

The search target value must be less than or equal to the compliance
value of the search monitor channel. Correct the search target value or
the compliance value.

276 Start and stop must be different.
Set different values for the search start and stop values.
277 Step must be output resolution or more.
Set the search step value to the output resolution or more.
278 Search and sync channels must be different.
Set the search source and the synchronous source to different channels.
279 Search monitor mode must be compliance side.

Send the LGI/BGI command to set the voltage source search monitor
channel, or send the LGV/BGV command to set the current source
search monitor channel.

280 Send WDCYV to set CV sweep source.

Before triggering the multi frequency CV measurement, send the
WDCV command to set the DC voltage sweep source.

281 Send PDCYV to set CV pulse source.
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301
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304
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307

310

311

If You Have a Problem
Error Codes

Before triggering the pulsed spot C measurement, send the PDCV
command to set the pulsed voltage source.

Send PWDCYV to set CV pulse sweep source.

Before triggering the pulsed CV measurement, send the PWDCV
command to set the pulsed voltage sweep source.

Set linear sweep for MM 20.

Only the linear sweep is available for the PWDCV command for the
pulsed CV measurement (MM 20).

Improper setting of CMU frequency and pulse width.

Pulse width valueis out of the range for the CMU output frequency. Set
both frequency value and pulse width value properly.

Send WFC to set Cf sweep source.

Before triggering the Cf sweep measurement, send the WFC command
to set the frequency sweep source (oscillator).

Line power failure.
Excess voltagein MPSMU.

Voltage that exceeds maximum voltage at the present current range was
detected by a MPSMU. All output switches were set to OFF.

Ground unit abuse is detected.
Excess current in HPSMU.

Current that exceeds maximum current at the present voltage range was
detected by a HPSMU. All output switches were set to OFF.

Unsupported module.

Thismoduleis not supported by this firmware revision. Until you
update the firmware, use Agilent B1500 with this module removed.

Interlock open operation error. Initialized.

Initialization was automatically performed because the B1500 failed to
set its output to 0 V when the interlock circuit was opened in the high
voltage condition. Any module may be defective. Perform self-test.

ASU control cable was connected/di sconnected.

The B1500 must be turned off when the Atto Sense and Switch Unit
(ASU) is connected/disconnected.
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312 SCUU control cable was connected/disconnected.

The B1500 must be turned off when the SMU CMU Unify Unit
(SCUU) is connected/disconnected.

320 Excess current in CMU.

Current that exceeds maximum current at the present voltage range was
detected by the CMU. The output switch was set to OFF.

321 This command is not available for CMU.

CMU was specified for the SMU dedicated command. Specify SMU.
322 This command is not available for SMU.

SMU was specified for the CMU dedicated command. Specify CMU.
323 Use SSPinstead of CN for SCUU modules.

It is not necessary to specify the modules connected to the SMU CMU
Unify Unit (SCUU) in the CN command. The output switches will be
controlled by the SSP command.

330 Turn on again to detect source channel.

SCUU might be disconnected/connected on the power on condition.
Restart the B1500 to detect and enable the channel.

331 Turn on again to detect synchronous channel.

SCUU might be disconnected/connected on the power on condition.
Restart the B1500 to detect and enable the channel.

332 Turn on again to detect measurement channel.

SCUU might be disconnected/connected on the power on condition.
Restart the B1500 to detect and enable the channel.

333 Turn on again to detect search source.

SCUU might be disconnected/connected on the power on condition.
Restart the B1500 to detect and enable the channel.

334 Turn on again to detect search sync source.

SCUU might be disconnected/connected on the power on condition.
Restart the B1500 to detect and enable the channel.

335 Turn on again to detect search monitor channel.

SCUU might be disconnected/connected on the power on condition.
Restart the B1500 to detect and enable the channel.

9-56 Agilent B1500 User’s Guide, Edition 7



603

610
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630

631

632

640

650

If You Have a Problem
Error Codes

Sweep and pulse channels must be different.

Set the sweep source and the pulse source to different channels for the
staircase sweep with pulsed bias measurement (MM5).

Quasi-pul se source channel must be set.

Before triggering the quasi-pulsed spot measurement, send the BDV
command to set the quasi-pul se source.

TGP specified incorrect 1/O port.

Specify trigger input for the Ext Trig In port, or trigger output for the
Ext Trig Out port by the TGP command. See the TGP command of
Programming Guide.

Specify trigger input port for PAX/WSX.

No trigger input port was specified for the PAX or WSX command.
Specify the trigger input port, or set the port as the trigger input port.
See the TGP command of Programming Guide to set trigger port.

Specify trigger output port for OSX.

No trigger output port was specified for the OSX command. Specify the
trigger output port, or set the port as the trigger output port. See the
TGP command of Programming Guide to set trigger port.

Incorrect polarity of search step value.

For the linear search measurement. The step value must be positive if
start<stop, or negative if start>stop.

Number of search steps must be 1001 or less.

For the linear search measurement. The number of search steps
between start and stop must be 1001 or less. This means the |step| value
must be |stop-start|[/1001 or more.

Search measurement was aborted.
Search measurement was aborted by the automatic abort function.
Search limits must be range/20000 or more.

For the binary search measurement. The limit value for the search
target must be range/20000 or more. where range means the
measurement range actually used for the measurement.

Data format must be ASCII to get time data.
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The time stamp function is not available for the binary data output
format. To use the time stamp function, set the data output format to
ASCII.

655 Cannot connect/disconnect series resistor.

The series resistor status cannot be changed in the high voltage state.
Set the output voltage or the voltage complianceto +42 V or lessto
connect or disconnect the seriesresistor.

656 Series resistor must be OFF for 1 A range.

The seriesresistor cannot be set to ON for the measurement channels or
the output channelsthat use 1 A range.

657 Series resistor cannot be used with ASU.
The seriesresistor isnot available for the channel connected to the Atto
Sense and Switch Unit (ASU).
660 Sampling measurement was aborted.
Sampling measurement was aborted by the automatic abort function.
661 Negative hold timeis only valid for I/V-t linear sampling with interval
<2ms.
662 Sampling interval for 1/V-t log sampling must be 2 ms or longer.
663 Number of samples does not have to exceed 100001.
664 Base and bias must be same polarity for | mode.
The base and bias values of the MI command must be the same
polarity.
670 Specified channel does not have ASU.
Specify the modul e that can be used with the ASU.
671 SSP is not available for this channel.

SSP command is available only for the CMU. Specify the slot number
that the CMU has been installed.

680 CMU correction mode must be manual.

To perform the CMU correction by using the ADJ? command, set the
CMU correction mode to manual by using the ADJ command.

681 CMU correction mode must be off.
682 Invalid standard is specified as CMU correction.

9-58 Agilent B1500 User’s Guide, Edition 7



683
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685

2000

2001

2002

2003

2004

2051

2052

2053

2054

2055

2056

2101

2103

2104

If You Have a Problem
Error Codes

Frequency index is not available for CMU correction.

AC VoltageisO mV.

CMU correction is not compl ete.

SPGU module does not exist.

The SPGU channel number must be specified correctly.

SPGU channel does not exist.

The SPGU channel number must be specified correctly.

SPGU signal source does not exist.

The SPGU signal source number must be specified correctly.
SPGU operation mode must be PG. (SIM 0).

SPGU operation mode must be ALWG (SIM 1).

Over voltage emergency occurred.

All modules stopped their output and opened their output relay.
Over current emergency occurred.

All modules stopped their output and opened their output relay.
High temperature emergency occurred.

All modules stopped their output and opened their output relay.
Over voltage H/'W SRQ detected.

Specified module stopped the output and opened the output relay.
Over current H/W SRQ detected.

Specified module stopped the output and opened the output relay.
High temperature H/W SRQ detected.

Specified module stopped the output and opened the output relay.
Specified load impedance is out of absolute limits.

Set the appropriate impedance value to SER.

Specified period is out of absolute limits.

Set the appropriate pulse period value to SPPER.

Specified trigger count is out of absolute limits.
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Set the appropriate count value to SPRM.

2105 Specified load voltage is out of range.
Set the appropriate voltage to SPV or ALW.
2106 Specified load voltage of added amplitudeis out of range.
Set the appropriate voltage to SPV for setting the 3-level pulse output.
2107 Specified voltage is out of absolute limits (can't achieve amplitude).
Set the appropriate voltage to SPV. It must be the voltage which can be
applied under the present load impedance condition.
2108 Specified transition time is out of absolute limits.
Set the appropriate value of leading time or trailing time to SPT.
2111 L eading/0.8 must be within Width value.
Set the appropriate value to SPT. The pulse width value must be more
than leading time/0.8 value.
2112 Delay + Width + Trail/0.8 must be within Period value.
Set the appropriate value to SPT. The pulse period value must be more
than delay time+pul se width+trailing time/0.8 value.
2113 Specified pulse delay is out of absolute limits.
Set the appropriate delay time value to SPT.
2114 Specified pulse width is out of absolute limits.
Set the appropriate pulse width value to SPT.
2115 Specified duration is out of absolute limits.
Set the appropriate duration value to SPRM.
2121 Delay + Width must be within Period value (ODSW Timing).
Set the appropriate value to ODSW. The period value must be more
than delay+width value.
2122 Specified ODSW delay timing parameter out of absolute limits.
Set the appropriate delay value to ODSW.
2123 Specified ODSW width timing parameter out of absolute limits.
Set the appropriate width value to ODSW.
2131 Delay + Interval * N must be within Period value (ADC Timing).
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2154

2155

2156

2157

2158

If You Have a Problem
Error Codes

Set the appropriate value to CORRSER?. The period value must be
more than delay+interval xcount value.

Specified delay for DUT impedance measurement out of absolute
limits.

Set the appropriate delay time value to CORRSER?.

Specified interval for DUT impedance measurement out of absolute
limits.

Set the appropriate interval value to CORRSER?.

Specified count for DUT impedance measurement out of absolute
limits.

Set the appropriate count value to CORRSER?.

ALWG Sequence Datais not ready.

Sequence data must be set by using AL S before starting the output.
Specified ALWG Sequence Data size is out of absolute limits.

Set the appropriate sequence datato ALS. Too large data was specified.

Specified pattern index of ALWG Seguence Datais out of absolute
limits.

Set the appropriate sequence datato AL S. The pattern index in the
sequence data must be the index of a pattern defined in the pattern data.

Specified repeat count of ALWG Sequence Datais out of absolute
limits.

Set the appropriate sequence datato AL S. The repeat count in the
sequence data must be 1 to 1048576.

ALWG Pattern Datais not ready.

Pattern data must be set by using ALW before starting the output.
Specified ALWG Pattern Data size is out of absolute limits.

Set the appropriate pattern datato ALW. Too large data was specified.
Specified interval time of ALWG Pattern is out of absolute limits.

Set the appropriate pattern datato ALW. The incremental time valuein
the pattern data must be 10 nsto 671.088630 msin 10 ns resolution.

Specified output voltage of ALWG Pattern Datais out of absolute
limits.
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2204

2206

3000

3001

3015

3050

3051

3052

3201

3202

Set the appropriate pattern datato ALW. The output level valuein the
pattern data must be 0to + 40 V in 1 mV resolution.

Load voltage istoo small for DUT impedance measurement.

Failed to perform the terminal voltage measurement and the load
impedance cal culation by the CORRSER? command. Set the SPGU
output voltage more than 1 V. Set high voltage for high impedance.

Auto correction of load impedance failed.

Cannot perform the SPGU automatic level adjustment. Load
impedance exceeds the acceptable range. Change the SPGU output
voltage or the DUT.

WGFMU modul e does not exist.

Check the channel number of the WGFMU module and set the correct
value.

RSU is not connected.

Check the channel number of the WGFMU module connected to the
RSU and set the correct value.

M easurement data corrupted.

Cannot get the measurement data. Correct measurement result is not
stored in the memory.

M easurement data memory overflow error.

ALWG sequencer run time error. WGFMU module memory overflow
occurred. Data exceeds memory size could not be stored.

Measurement data FIFO overflow error.

ALWG seguencer run time error. WGFMU module FIFO overflow
occurred because the averaging count was frequently changed.

M easurement range change request error.

ALWG sequencer run time error. Measurement range cannot be
changed because the range change interval istoo short.

ALWG Sequence Datais not ready.

Sequence data must be set to the specified WGFMU channel.
ALWG Waveform Datais not ready.

Waveform data must be set to the specified WGFMU channel.
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3302

3303

3304

3305

3306

3307

3308

3309

3310

3311

If You Have a Problem
Error Codes

Specified output voltage is out of absolute limits.

Check the output voltage and set the correct value. The value must be
-3Vto+3V forthe3Vrange -5V to+5V forthe5V range, - 10V
toOV for the- 10V range, or OV to +10 V for the + 10 V range.

Specified voltage output range isinvalid.
Check the voltage output range and set the correct value.
Invalid measurement mode for current operation mode.

Operation mode must be Fast 1V or DC to perform current
measurement.

Specified ALWG Vector Datasizeis out of absolute limits.

ALWG data cannot be read because of too large data size.

Specified ALWG Sequence Data size is out of absolute limits.
ALWG data cannot be read because of too large sequence data size.
ALWG Waveform Datais empty.

ALWG data must not be empty.

Specified ALWG Waveform Data sizeis out of absolute limits.
ALWG data cannot be read because of too large waveform data size.

Specified waveform index of ALWG Sequence Datais out of absolute
limits.

Check the index value of the sequence data and set the correct value.

Specified loop number of ALWG Sequence Data is out of absolute
limits.

Check the loop value of the sequence data and set the correct value.

Specified output voltage of ALWG Waveform Datais out of absolute
limits.

Check the output voltage and set the correct value. The value must be
-3Vto+3V forthe3Vrange -5V to+5V forthe5V range, - 10V
to0V for the- 10 V range, or O V to +10 V for the + 10 V range.

Specified interval time of ALWG Waveform is out of absolute limits.

Check the incremental time (interval time) and set the correct value.
The value must be 10 nsto 10995.11627775 s, in 10 ns resolution.
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3312

3313

3314

3315

3316

3317

3318

3319

3320

3321

3322

3323

Specified ALWG measurement interval timeis out of absolute limits.

Check the measurement interval time and set the correct value. The
value must be 10 nsto 1.34217728 s, in 10 ns resolution.

Specified ALWG measurement instruction code isinvalid.
Check the measurement event setting and set the correct values.
Specified ALWG range change instruction codeisinvalid.
Check the range event setting and set the correct values.
Specified ALWG measurement count is out of absolute limits.

Check the measurement averaging time and set the correct value. The
value must be 0, or 10 nsto 0.020971512 s, in 10 nsresolution.

Specified ALWG measurement count is greater than measurement
interval.

Check the measurement averaging time and set the correct value. The
value must less than or equal to the measurement interval time.

Specified slot isinvalid.

Check the slot number and set the correct value. The sot number must
be 1 to 10.

Specified module channel isinvalid.
Check the channel number and set the correct value.
Output delay is out of absolute limits.

Check the output delay and set the correct value. The value must be
- 50 nsto 50 ns, in 625 ps resol ution.

Measurement delay is out of absolute limits.

Check the measurement delay and set the correct value. The value must
be - 50 nsto 50 ns, in 625 ps resolution.

VM/IM measurement mode isinvalid.

Check the measurement mode and set the correct value.
Voltage measurement range isinvalid.

Check the voltage measurement range and set the correct value.

Current measurement range isinvalid.
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3325

3326

3327

If You Have a Problem
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Check the current measurement range and set the correct value.
WGMA?,WGMB? command query size is out of absolute limits.
Check the data size for WGMA? or WGMB? and set the correct value.
Specified count for spot measurement is out of absolute limits.

Check the count value for WGM S? and set the correct value.

Specified interval for spot measurement is out of absolute limits.
Check theinterval value for WGMS? and set the correct value.
Specified operation mode isinvalid for spot measurement.

Operation mode must be DC to perform spot measurement.
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Agilent B1500A Self-test/Calibration Error

When Agilent B1500 fails the self-test or self-calibration, the B1500 returns the
following error code and error message.

Inthe error code, N indicates the slot number. If themoduleisinstalled in slot 1, and
it fails the function test, the error code will be 1760.

700 CPU failed NVRAM read/write test.

701 CPU failed FPGA read/write test.

702 CPU failed H-RESOLN ADC end signal test.
703 CPU failed H-RESOLN ADC start signal test.
704 CPU failed emergency status signal test.

705 CPU failed SRQ status signal test.

706 CPU failed high voltage status signal test.

707 CPU failed low voltage status signal test.

708 CPU failed DAC settling status signal test.
709 CPU failed measure ready status signal test.
710 CPU failed set ready status signal test.

711 CPU failed measure end status signal test.

712 CPU failed measure trigger signal test.

713 CPU failed pulse trigger signal test.

714 CPU failed abort trigger signal test.

715 CPU failed DAC set trigger signal test.

720 H-RESOLN ADC isnot installed.

721 H-RESOLN ADC failed ROM/RAM test.
722 H-RESOLN ADC failed B-COM offset DAC test.
723 H-RESOLN ADC failed sampling ADC test.
724 H-RESOLN ADC failed integrating ADC test.
725 H-RESOLN ADC failed bus function test.
740 GNDU failed calibration.

935 CMU FPGA version mismatch.
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2401
2402
2403
2404
2405
2406
2407
2408
2409
2410
2411
2412
2413
2414
2415
2416
2417
2418
2419
2430
2431
2432
2433
2434
2435
2450
2451

If You Have a Problem
Error Codes

SPGU moduleisin TEST FAIL state.

Digital H/W function test failed.

CPLD access function test failed.

CPLD version check test failed.

CPLD revision check test failed.

FPGA configuration test failed.

FPGA access function test failed.

FPGA version check test failed.

FPGA revision check test failed.

DCM function test failed.

CONVEND interrupt function test failed.

EMG interrupt function test failed.

10 MHz clock test failed.

FPGA SYNC SEL pin control function test failed.

FPGA SYNC FB pin control function test failed.

FPGA SYNC IN pin control function test failed.

IDELAY function test failed.

NVRAM access function test failed.

ADC function test failed.

SDRAM access function test failed.

Module EEPROM CRC dataisinvalid.

Module EEPROM CRC data of module data ID isinvalid.
Module EEPROM CRC data of format revision datais invalid.
Module EEPROM CRC data of analog reference dataisinvalid.
Module EEPROM CRC data of timing calibration dataisinvalid.
Module EEPROM CRC datais skew calibration datainvalid.
Internal ADC function test failed.

0.5 Vref Internal ADC function test failed.
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2452 4.5 Vref Internal ADC function test failed.

2453 Power Amp initial test failed.

2454 Filter & Amp test failed.

2455 Internal temperature test failed.

2456 Internal output resistance test failed.

2481 Invalid frame configuration.

2482 Frame has no modules.

2483 PLL not locked in slave module.

2484 Reference lineis not connected.

2485 Sync lineis not connected.

2486 Interrupt line is not available.

2487 Module service request assertion test failed.

2488 Module service request detection test failed.

2489 Emergency interrupt is not available.

2500 SPGU cdlibration failed.

2501 Power Amp idling calibration failed.

2502 DAC output level calibration failed.

3002 WGFMU initidization failure.

3003 WGFMU FPGA is not configured.

3004 EEPROM CRC data of system timing dataisinvalid.

3005 EEPROM CRC data of DAC DCM PSdataisinvalid.

3006 EEPROM CRC dataof ADC DCM PSdataisinvalid.

3007 EEPROM CRC data of DAC clock edge dataisinvalid.
3008 EEPROM CRC data of ADC clock edge dataisinvalid.
3009 EEPROM CRC data of DAC level calibration datais invalid.
3010 EEPROM CRC dataof ADC level calibration datais invalid.
3011 EEPROM CRC data of DAC skew calibration dataiis invalid.
3012 EEPROM CRC data of ADC skew calibration dataiisinvalid.
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3014
3400
3401
3402
3403
3404
3405
3406
3407
3408
3409
3410
3411
3412
3413
3414
3415
3416
3417
3418
3419
3420
3421
3422
3423
3424
3425

If You Have a Problem
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EEPROM CRC data of RSU calibration dataisinvalid.
Invalid EEPROM type.

WGFMU moduleisin TEST FAIL state.

Digital H/W function test failed.

CPLD access function test failed.

FPGA configuration test failed.

FPGA1 access function test failed.

FPGA?2 access function test failed.

FPGA1 System Clock DCM function test failed.
FPGA1 DAC Clock DCM function test failed.
FPGA1 ADC Clock DCM function test failed.
FPGA1 Memory Clock DCM function test failed.
FPGA2 System Clock DCM function test failed.
FPGA2 DAC Clock DCM function test failed.
FPGA2 ADC Clock DCM function test failed.
FPGA2 Memory Clock DCM function test failed.
FPGA1, 2 communication I/F test failed.
CONVEND interrupt function test failed.

10 MHz clock test failed.

FPGA SYNC SEL pin control function test failed.
FPGA SYNC FB pin control function test failed.
FPGA SYNC IN pin control function test failed.
IDELAY function test failed.

Channel 1 SDRAM access function test failed.
Channel 2 SDRAM access function test failed.
WGFMU EEPROM access function test failed.
Channel 1 RSU EEPROM access function test failed.
Channel 2 RSU EEPROM access function test failed.
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Error Codes

3426 WGFMU EEPROM CRC dataisinvalid.

3427 WGFMU EEPROM CRC data of format revision dataisinvalid.

3428 WGFMU EEPROM CRC data of serial number dataisinvalid.

3429 WGFMU EEPROM CRC data of system timing dataisinvalid.

3430 WGFMU EEPROM CRC data of DAC DCM PS dataisinvalid.

3431 WGFMU EEPROM CRC data of ADC DCM PSdataisinvalid.

3432 WGFMU EEPROM CRC data of DAC clock edge dataisinvalid.
3433 WGFMU EEPROM CRC data of ADC clock edge dataisinvalid.
3434 WGFMU EEPROM CRC data of DAC level calibration dataisinvalid.
3435 WGFMU EEPROM CRC dataof ADC level calibration dataisinvalid.
3436 WGFMU EEPROM CRC data of DAC skew calibration datais invalid.
3437 WGFMU EEPROM CRC data of ADC skew calibration datais invalid.
3438 RSU EEPROM CRC data of format revision dataiis invalid.

3439 RSU EEPROM CRC data of serial number dataisinvalid.

3440 RSU EEPROM CRC data of typeid dataisinvalid.

3441 RSU EEPROM CRC data of calibration dataisinvalid.

3450 WGFMU EEPROM dataisinvalid.

3451 WGFMU EEPROM data of RSU typeisinvalid.

3452 WGFMU EEPROM data of RSU cable typeisinvalid.

3460 Main DAC, Main ADC test failed.

3461 Bias DAC, Main ADC test failed.

3462 Main DAC, Reference ADC test failed.

3463 VM function test failed.

3464 IM offset test failed.

3465 IM short test failed.

3480 Invalid frame configuration.

3481 Invalid frame configuration.

3482 Frame has no modules.

9-70 Agilent B1500 User’s Guide, Edition 7



3483
3484
3485
3486
3487
3488
3489
3490
3500
3501
3502
3503
3504
3505
3506
3507
3508
N760
N761
N762
N763
N764
N765
N766
N767
N768
N769
N770

If You Have a Problem
Error Codes

PLL not locked in slave module.

Reference lineis not connected.

Sync lineis not connected.

Sync Reserve lineis not connected.

Interrupt line is not available.

Module service request assertion test failed.
Module service request detection test failed.
Emergency interrupt is not available.
WGFMU calibration failed.

ADC gain calibration failed.

CMR calibration failed.

IM offset calibration failed.

VM offset calibration failed.

VF gain calibration failed.

VF offset calibration failed.

Reference ADC does not exist. Cannot perform WGFMU calibration.
WGFMU, RSU cable length calibration failed.
SMU failed function test.

SMU failed VF/VM function test.

SMU failed IF/IM function test.

SMU failed loop status test.

SMU failed temperature sensor test.

SMU failed CMR amplifier calibration.

SMU failed CMR amplifier adjustment.

SMU failed CMR 100 V range full output test.
SMU failed VF/VM calibration.

SMU failed VM offset calibration.

SMU failed VM gain calibration.
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Error Codes

N771 SMU failed VF offset calibration.
N772 SMU failed VF gain calibration.
N773 SMU failed VF gain calibration at 20 V range.

N774 SMU failed VF filter offset calibration.

N775 SMU failed H-SPEED ADC self-calibration.
N776 SMU failed H-SPEED ADC VM offset calibration.
N777 SMU failed H-SPEED ADC VM gain calibration.
N778 SMU failed IF/IM calibration.

N779 SMU failed calibration bus test.

N780 SMU failed IM offset calibration.

N781 SMU failed IM gain calibration.

N782 SMU failed IF offset calibration.

N783 SMU failed IF gain calibration.

N784 SMU failed IDAC filter offset calibration.
N785 SMU failed oscillation detector test.

N786 SMU failed | bias test.

N787 SMU failed common mode rejection test.

N789 SMU failed high voltage detector test.

N790 SMU failed zero voltage detector test.

N791 SMU failed V hold test.

N792 SMU failed V switch test.

N800 CMU failed NULL DC offset adjustment.

N801 CMU failed NULL DC offset measurement.
N802 CMU failed VRD DC offset adjustment.

N803 CMU failed VRD heterodyne offset adjustment.
N804 CMU failed NULL gain/phase adjustment.
N805 CMU failed MODEM offset adjustment.

N806 CMU failed relative Z adjustment.
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N807
N808
N809
N810
N811
N812
N813
N814
N820
N830
N831
N832
N833
N834
N835
N836
N837
N838
N839
N840
N841
N842
N843
N844
N845
N846
N847
N848

If You Have a Problem
Error Codes

CMU failed Vch full scale measurement.
CMU failed nominal gain measurement

CMU failed extent range X 3 adjustment.

CMU failed range resistor 50ohm adjustment.
CMU failed range resistor 1kohm adjustment.
CMU failed range resistor 10kohm adjustment.
CMU failed range resistor 100kohm adjustment.
CMU failed relative Z calculation.

CMU failed correction.

CMU failed configuration test.

SCUU failed SCUU configuration test.
SCUU failed SMU configuration test.

SCUU failed CMU configuration test.

CMU failed digital function test.

CMU failed CPLD test.

CMU failed FPGA test.

CMU failed EEPROM test.

CMU failed PLLL/PLL2 test.

CMU failed PLL DET low state test.

CMU failed PLL DET high state test.

CMU failed PLL1 lock test

CMU failed PLL2 lock test.

CMU failed PLL2 lock test.

CMU failed Hcur DC and VRD ADC test.
CMU failed DC offset test.

CMU failed DC bias OV test.

CMU failed DC bhias-25V test.

CMU failed DC bias +25V test.
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Error Codes

N849 CMU failed PLLO test.
N850 CMU failed PLLO lock test.
N851 CMU failed PLLO lock test.
N852 CMU failed DDS test.
N853 CMU failed DDSL test.

N854 CMU failed DDS2 test.

N855 CMU failed VRD normalizer test.
N856 CMU failed RA1 test.

N857 CMU failed RA2 test.

N858 CMU failed ExR test.

N859 CMU failed R_LPF2 1 test.
N860 CMU failed MODEM DAC test.
N861 CMU failed N_II_DAC test.

N862 CMU failed N_QI_DAC test.
N863 CMU failed N_IQ DAC test.
N864 CMU failed N_QQ_DAC test.

N865 CMU failed TRD normalizer test.
N866 CMU failed NA1 test.

N867 CMU failed NAZ2 test.

N868 CMU failed NA3 test.

N869 CMU failed N_LPF1 2 test.
N870 CMU failed N_LPF1 f3 test.
N871 CMU failed N_LPF1 f4 test.
N872 CMU failed N_LPF1 f5 test.
N873 SCUU failed EEPROM test.
N874 SCUU failed output relay test.
N875 SCUU failed control test.
N876 SCUU failed CG2 test.
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Error Codes

N877 SCUU falled LRL test.

N880 CMU failed Hcur AC and VRD Fm test.
N881 CMU failed SA/RA 32mV test.

N882 CMU failed SA/RA 64mV test.

N883 CMU failed SA/RA 125mV test.

N884 CMU failed SA/RA 250mV test.
N885 CMU failed ExR test.

N886 CMU failed Bias_chg test.

N887 CMU failed R_LPF2/R_HPF vs test.
N8s8 CMU failed VRD IF test.

N889 CMU failed IRM loca Odeg test.
N890 CMU failed IRM local 90deg test.

N891 CMU failed S_LPF1f1 120kHz test.
N892 CMU failed S_LPF1f2 500kHz test.
N893 CMU failed S_LPF1f3 2MHz test.
N894 CMU failed S_LPF1f4 5SMHz test.
N895 CMU failed TRD MODEM test.

N896 CMU failed VG local 90deg test.
N897 CMU failed VG local Odeg test.
N898 CMU failed NA4 test.

N899 CMU failed NA5 X1/4 test.
N900 CMU failed NA5 X 1/8 test.

N901 CMU failed N_LPF2 2 500kHz test.
N902 CMU failed N_LPF2 f3 5MHz test.
N903 CMU failed MODEM PSD test.

N904 CMU failed PSD Odeg test.
N905 CMU failed PSD 90deg test.
N906 CMU failed Rr/Rf 1000hm test.
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Error Codes

N907 CMU failed Rr/Rf 1kohm test.
N908 CMU failed Rr/Rf 10kohm test.
N909 CMU failed Rr/Rf 100kohm test.
N910 CMU failed TRD IVAmMp test.

N911 CMU failed N_HPF1/N_LPF1 10kHz test.
N912 CMU failed N_HPF1/N_LPF1 200kHz test.
N913 CMU failed N_HPF1/N_LPF1 1IMHz test.
N914 CMU failed N_HPF1/N_LPF1 2MHz test.
N915 CMU failed N_HPF1/N_LPF1 5MHz test.
N916 CMU failed NA1 test.

N917 CMU failed NAZ2 test.

N918 CMU failed NA3 test.

N919 CMU failed IV saturation detector test.
N920 CMU failed normal status test.

N921 CMU failed normal status test.

N922 CMU failed IV saturation status test.
N923 CMU failed 1V saturation status test.
N924 CMU failed unbalance detector test.

N925 CMU failed normal status test.

N926 CMU failed normal status test.

N927 CMU failed unbalance status test.

N928 CMU failed unbalance status test.

N929 CMU failed over current detector test.
N930 CMU failed normal status test.

N931 CMU failed normal status test.

N932 CMU failed over current status test.

N933 CMU failed over current status test.
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Setup File Converter Execution Error

The followings are the error code for the setup file converter
(SetupFileConverter.exe). See “ SetupFileConverter.exe” on page 10-53.

#01
#02
#03
#04
#05

Maximum length for the file path is 256 characters.

fopen failure. Could not open sourcefile.

Specify a proper source file. The specified file is unsupported.
Specify a proper source file. The specified fileis corrupt.

fopen failure. Could not open destination file.
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Application Library and Utilities

This chapter introduces the application library and utility programsincluded in the
Agilent B1500A/EasyEXPERT software.

» “Application Test Definitions’

»  “QSCV Measurement Supplemental Data’
» “License Management Tool”

» “Setup File Converter”

e “Utility Programs”

» “Desktop EasyEXPERT"
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NOTE

Application Library and Utilities
Application Test Definitions

Application Test Definitions

Adgilent EasyEXPERT software contains the application library which supports the
characteristic measurements of CMOS devices, TFT, BJT, diode, resistor, capacitor,
varactor, memory, nanotechnology devices such as CNT FET, and so on. The
application library includes more than one hundred test definitions. And they are
classified into the following categories. Table 10-1 lists all test definitions belonging
to the category. Each test definition requires the modules and instruments shown in
the table.

BJT

CMOS
Discrete
Generic Test
Memory
Mixed Signal
Nano Tech
Power Device
Reliability
10. Structure

1. TFT

12. Utility

13. WGFMU

© © N o o ~ WO D P

Application Library

The application library is a set of test definitions effective for the EasyEXPERT
application test execution mode. The application test can be performed by selecting
atest definition and setting the test condition for the actual DUT (device under test).
And the setup can be saved as the dedicated test setup for the DUT.

All test definitions are just sample. If the samples damage your devices, Agilent
Technologiesis NOT LIABLE for the damage.
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Application Library and Utilities
Application Test Definitions

Table 10-1 Application Test Definitions
Category Test definition name Supported analyzer Required equipment and quantity

BJT BC Diode Fwd B1500A,4155B/C,4156B/C SMU 2
BC Diode Rev B1500A ,4155B/C,4156B/C SMU 2
BVcho B1500A ,4155B/C,4156B/C SMU 2
BVcei B1500A ,4155B/C,4156B/C SMU 3
BVceo B1500A ,4155B/C,4156B/C SMU 2
BVebo B1500A ,4155B/C,4156B/C SMU 2
CSDiode Fwd B1500A ,4155B/C,4156B/C SMU 2
CSDiode Rev B1500A ,4155B/C,4156B/C SMU 2
Ctc-Freg Log B1500A MFCMU 1
Ctc-Vc B1500A MFCMU 1
Cte-Ve B1500A MFCMU 1
Cts B1500A MFCMU 1
EB Diode Fwd B1500A ,4155B/C,4156B/C SMU 2
EB Diode Rev B1500A ,4155B/C,4156B/C SMU 2
G-Plot ConstV ce Pulse B1500A ,4155B/C,4156B/C SMU 4
G-Plot ConstV ce Pulse[3] B1500A ,4155B/C,4156B/C SMU 3
G-Plot ConstVce B1500A ,4155B/C,4156B/C SMU 4
G-Plot ConstVce[ 3] B1500A ,4155B/C,4156B/C SMU 3
G-Plot Vbc=0V Pulse B1500A,4155B/C,4156B/C SMU 4
G-Plot Vbc=0V Pulse[3] B1500A ,4155B/C,4156B/C SMU 3
G-Plot Vbc=0V B1500A ,4155B/C,4156B/C SMU 4
G-Plot Vbc=0V[3] B1500A ,4155B/C,4156B/C SMU 3
hfe-Vbe ConstVce B1500A ,4155B/C,4156B/C SMU 4
hfe-Vbe Vbc=0V B1500A ,4155B/C,4156B/C SMU 4
lc-Velb B1500A ,4155B/C,4156B/C SMU 4
Ic-Ve Ib[3] B1500A ,4155B/C,4156B/C SMU 3
Ic-Vc Pulse Ib B1500A ,4155B/C,4156B/C SMU 4
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Application Library and Utilities
Application Test Definitions

Category Test definition name Supported analyzer Required equipment and quantity
BJT Ic-Vc Pulse Ib[3] B1500A ,4155B/C,4156B/C SMU 3
lc-Ve Pulse Vb B1500A ,4155B/C,4156B/C SMU 4
Ic-Vc Pulse Vb[3] B1500A ,4155B/C,4156B/C SMU 3
lc-Ve Vb B1500A ,4155B/C,4156B/C SMU 4
lc-Ve Vh[3] B1500A ,4155B/C,4156B/C SMU 3
Rb B1500A ,4155B/C,4156B/C SMU 4
Ret+Rc B1500A ,4155B/C,4156B/C SMU 4
Re B1500A ,4155B/C,4156B/C SMU 4
Simple Gummel Plot B1500A ,4155B/C,4156B/C SMU 3
Vbe-Le B1500A SMU 4, B2200A/B2201A 1
Vbe-We B1500A SMU 4, B2200A/B2201A 1
CMOS BVdss B1500A,4155B/C,4156B/C SMU 4
BVgso B1500A ,4155B/C,4156B/C SMU 3
Cgb-AC Level B1500A MFCMU 1, SMU 1
Cgb-Freq Log B1500A MFCMU 1, SMU 1
Cgb-Vg HighVoltage B1500A MFCMU 1, SMU 3, SCUU 1, GSWU 1
Cgb-Vg B1500A MFCMU 1, SMU 1
Cgc-Freq Log B1500A MFCMU 1, SMU 1
Cgc-Vg B1500A MFCMU 1, SMU 1
Cgg-Freg Linear B1500A MFCMU 1
Cgg-Freq Log B1500A MFCMU 1
Cgg-Vg 2Freq B1500A MFCMU 1
Cgo-Vg B1500A MFCMU 1
|dRdsGds B1500A ,4155B/C,4156B/C SMU 4
1d-Vd pulse B1500A ,4155B/C,4156B/C SMU 4
Id-vd pulse[3)] B1500A,4155B/C,4156B/C | SMU 3
1d-vd B1500A ,4155B/C,4156B/C SMU 4
1d-Vd[3] B1500A ,4155B/C,4156B/C SMU 3
1d-Vg pulse B1500A ,4155B/C,4156B/C SMU 4
Id-Vg Vpulse[3] B1500A,4155B/C,4156B/C | SMU 3
1d-Vg B1500A ,4155B/C,4156B/C SMU 4
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Application Test Definitions

Category Test definition name Supported analyzer Required equipment and quantity
CMOS 1d-Vg[3] B1500A ,4155B/C,4156B/C SMU 3
lonloffSlope B1500A ,4155B/C,4156B/C SMU 4
Isub-Vg B1500A ,4155B/C,4156B/C SMU 4
QSCV[4] B1500A SMU 5
QSCV C Offset Meas B1500A SMU 2
Simple Cgb B1500A MFCMU 1
Simple Vth B1500A ,4155B/C,4156B/C SMU 4
Vth Const Id B1500A ,4155B/C,4156B/C SMU 4
Vth gmMax B1500A ,4155B/C,4156B/C SMU 4
VthAndCgg-Vg ASU B1500A MFCMU 1, SMU 1, HRSMU/ASU 2
VthAndCgg-Vg SCUU B1500A MFCMU 1, SMU 3, SCUU 1, GSWU 1
Vth-Lg B1500A SMU 4, B2200A/B2201A 1
Vth-Wg B1500A SMU 4, B2200A/B2201A 1
Discrete BJT GummelPlot B1500A ,4155B/C,4156B/C SMU 3
BJT Ic-Vc b B1500A ,4155B/C,4156B/C SMU 3
Diode IV Fwd B1500A,4155B/C,4156B/C SMU 2
Diode IV Rev B1500A ,4155B/C,4156B/C SMU 2
FET Id-vd B1500A,4155B/C,4156B/C SMU 3
FET Id-Vg B1500A ,4155B/C,4156B/C SMU 3
GenericTest Generic C-f B1500A MFCMU 1
Generic C-t B1500A MFCMU 1
Memory Flash Ccf-V B1500A MFCMU 1
Flash Cfb-V B1500A MFCMU 1
Flash Cgg-Vcg B1500A MFCMU 1
NandFlash2 Endurance 3devices | B1500A SMU 3, B2200A/B2201A 1, 81110A (2
outputs) 1
NandFlash2 Endurance B1500A HRSMU/ASU 3, 81110A (2 outputs) 1
NandFlash2 IV-Erase-1V B1500A SMU 1, HRSMU/ASU 2, 81110A (2
outputs) 1
NandFlash2 IV-Write-|V B1500A SMU 2, HRSMU/ASU 1, 81110A (2
outputs) 1
NandFlash2 B1500A SMU 1, HRSMU/ASU 2, 81110A (2

Retention(ErasedCell)

outputs) 1
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Category Test definition name Supported analyzer Required equipment and quantity
Memory NandFlash2 B1500A SMU 2, HRSMU/ASU 1, 81110A (2
Retention(WrittenCell) outputs) 1
NandFlash2 B1500A SMU 1, HRSMU/ASU 2, 81110A (2
Vth(ErasingTimeDependence) outputs) 1
NandFlash2 B1500A SMU 2, HRSMU/ASU 1, 81110A (2
Vth(WritingTimeDependence) outputs) 1
NandFlash2 B1500A HRSMU/ASU 3, 81110A (2 outputs) 1
WordDisturb(ErasedCell)
NandFlash2 B1500A SMU 2, HRSMU/ASU 1, 81110A (2
WordDisturb(WrittenCell) outputs) 1
NandFlash3 Endurance B1500A [SPGU 1, HRSMU/ASU 3] or
[SPGU 1, SMU 3, 16440A/16445A 2]
NandFlash3 I V-Erase-1V B1500A [SPGU 1, SMU 1, HRSMU/ASU 2] or
[SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 I V-Write-1V B1500A [SPGU 1, SMU 2, HRSMU/ASU 1] or
[SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 B1500A [SPGU 1, SMU 1, HRSMU/ASU 2] or
Retention(ErasedCell) [SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 B1500A [SPGU 1, SMU 2, HRSMU/ASU 1] or
Retention(WrittenCell) [SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 B1500A [SPGU 1, SMU 1, HRSMU/ASU 2] or
Vth(ErasingTimeDependence) [SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 B1500A [SPGU 1, SMU 2, HRSMU/ASU 1] or
Vth(WritingTimeDependence) [SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 B1500A [SPGU 1, HRSMU/ASU 3] or
WordDisturb(ErasedCell) [SPGU 1, SMU 3, 16440A/16445A 2]
NandFlash3 B1500A [SPGU 1, SMU 2, HRSMU/ASU 1] or
WordDisturb(WrittenCell) [SPGU 1, SMU 3, 16440A/16445A 1]
NorFlash Endurance B1500A [SPGU 2, SMU 1, HRSMU/ASU 3] or
[SPGU 2, SMU 4, 16440A/16445A 2]
NorFlash IV-Erase-1V B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or
[SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash IV-Write-1V B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or
[SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash Retention(ErasedCell) | B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or
[SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash Retention(WrittenCell) | B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or

[SPGU 1, SMU 4, 16440A/16445A 1]
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Category Test definition name Supported analyzer Required equipment and quantity
Memory NorFlash B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or
Vth(ErasingTimeDependence) [SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or
Vth(WritingTimeDependence) [SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or
WordDisturb(ErasedCell) [SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or
WordDisturb(WrittenCell) [SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash B1500A [SPGU 2, SMU 1, HRSMU/ASU 3] or
DataDisturb(ErasedCell) [SPGU 2, SMU 4, 16440A/16445A 2]
NorFlash B1500A [SPGU 1, SMU 2, HRSMU/ASU 2] or
DataDisturb(WrittenCell) [SPGU 1, SMU 4, 16440A/16445A 1]
MixedSignal BJT Varactor CV Mismatch B1500A MFCMU 1
Diff-R Mismatch B1500A SMU 8
Diode IV Fwd Mismatch B1500A SMU 3
Diode IV Rev Mismatch B1500A SMU 3
G-Plot ConstVce Mismatch B1500A SMU 6
G-Plot ConstVce Mismatch[3] B1500A SMU 5
G-Plot Vbc=0V Mismatch B1500A SMU 6
G-Plot Vbc=0V Mismatch[3] B1500A SMU 5
Ic-Vc Ib Mismatch B1500A SMU 6
Ic-Vc Ib Mismatch[3] B1500A SMU 5
Ic-Vec Vb Mismatch B1500A SMU 6
Ic-Vec Vb Mismatch[3] B1500A SMU 5
1d-Vd Mismatch B1500A SMU 5
1d-Vd Mismatch[3] B1500A SMU 4
1d-Vg Mismatch B1500A SMU 5
1d-Vd Mismatch[3] B1500A SMU 4
MIM CV Mismatch B1500A MFCMU 1
MOS Varactor CV Mismatch B1500A MFCMU 1
Poly-R Mismatch B1500A SMU 7
NanoTech CNT Differential R[AC] B1500A MFCMU 1
CNT Gate Leak B1500A ,4155B/C,4156B/C SMU 2
CNT Id-Time B1500A,4156B/C SMU 4
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Application Library and Utilities
Application Test Definitions

Category Test definition name Supported analyzer Required equipment and quantity
NanoTech CNT Id-vd B1500A ,4155B/C,4156B/C SMU 4
CNT Id-Vg B1500A ,4155B/C,4156B/C SMU 4
CNT Id-Vg-Time B1500A ,4156B/C SMU 4
CNT IV Sweep B1500A ,4155B/C,4156B/C SMU 2
CNT R-I Kelvin 2SMU B1500A ,4155B/C,4156B/C SMU 2
CNT R-V Kelvin 2sMU B1500A,4155B/C,4156B/C SMU 2
CNT Vth gmMax B1500A ,4155B/C,4156B/C SMU 4
PwrDevice BVdsg[3] PwrDevice B1500A SMU 3
BVgso[3] PwrDevice B1500A SMU 2
1d-Vd pulse[3] PwrDevice B1500A SMU 3
1d-Vd[3] PwrDevice B1500A SMU 3
1d-Vg pulse[3] PwrDevice B1500A SMU 3
Id-Vg[3] PwrDevice B1500A SMU 3
Vth Const Id[3] PwrDevice B1500A SMU 3
Vth gmMax[3] PwrDevice B1500A SMU 3
Reliability BJT EB RevStress 3devices B1500A SMU 6, B2200A/B2201A 1
BJT EB RevStress 3deviceq[3] B1500A SMU 5, B2200A/B2201A 1
BJT EB RevStress B1500A SMU 4
BJT EB RevStress2 B1500A SMU 4
BJT EB RevStress[3] B1500A SMU 3
BJT EB RevStress2[3] B1500A SMU 3
BTI 3devices B1500A SMU 5, B2200A/B2201A 1
BTI 3devices[3] B1500A SMU 5, B2200A/B2201A 1
BTI B1500A SMU 4
BTI2 B1500A SMU 4
BTI[3] B1500A SMU 3
BTI2[3] B1500A SMU 3
Charge Pumping B1500A SMU 2, 81110A (2 outputs) 1
Charge Pumping2 B1500A SMU 2, SPGU 1
EM lIstress B1500A SMU 4
EM lstress2 B1500A SMU 4
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Category Test definition name Supported analyzer Required equipment and quantity

Reliability | EM Istress[2] B1500A SMU 2
EM lIstress2[2] B1500A SMU 2
EM lstress[6] B1500A SMU 6
EM Istress2[6] B1500A SMU 6
EM Vstress B1500A SMU 4
EM Vstress2 B1500A SMU 4
EM Vstress[2] B1500A SMU 2
EM Vstress2[2] B1500A SMU 2
EM Vstress[6] B1500A SMU 6
EM Vstress2[6] B1500A SMU 6
HCI 3devices B1500A SMU 8
HCI B1500A SMU 4
HCI2 B1500A SMU 4
J-Ramp B1500A SMU 2
TDDB Istress 3devices B1500A SMU 4
TDDB Istress2 3devices B1500A SMU 4
TDDB Istress B1500A SMU 2
TDDB Istress2 B1500A SMU 2
TDDB Vstress 3devices B1500A SMU 4
TDDB Vstress2 3devices B1500A SMU 4
TDDB Vstress B1500A SMU 2
TDDB Vstress2 B1500A SMU 2
Timing On-the-fly NBTI B1500A SMU 4
TZDB B1500A SMU 2
V-Ramp B1500A SMU 2

Structure BVgb ThinOx B1500A ,4155B/C,4156B/C SMU 2
BVgb B1500A ,4155B/C,4156B/C SMU 2
Cgb-Freq[2] Log B1500A MFCMU 1
Cgb-Vg 2Freq B1500A MFCMU 1
Cgb-Vg[2] B1500A MFCMU 1
Cj-Freq Log B1500A MFCMU 1
Cj-v B1500A MFCMU 1

10-10
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Category Test definition name Supported analyzer Required equipment and quantity
Structure Diode BVANdCj-V ASU B1500A MFCMU 1, HRSMU/ASU 2

Diode BVANdCj-V SCUU B1500A MFCMU 1, SMU 2, SCUU 1, GSWU 1
1g-Vg Iforce B1500A ,4155B/C,4156B/C SMU 2
1g-Vg Vforce B1500A ,4155B/C,4156B/C SMU 2
Interconnect CouplingCap B1500A MFCMU 1
Interconnect OverlapCap B1500A MFCMU 1
Junction BV B1500A ,4155B/C,4156B/C SMU 2
Junction DcParam B1500A ,4155B/C,4156B/C SMU 2
Junction IV Fwd B1500A ,4155B/C,4156B/C SMU 2
Junction IV Rev B1500A ,4155B/C,4156B/C SMU 2
QSCV[2] B1500A SMU 3
QSCV C Offset Meas B1500A SMU 2
Rdiff-1 kelvin B1500A SMU 5
Rdiff-1 B1500A ,4155B/C,4156B/C SMU 3
Rdiff-V kelvin B1500A SMU 5
Rdiff-V B1500A ,4155B/C,4156B/C SMU 3
R-I DVM B1500A SMU 2, 3458A 1
R-1 kelvin B1500A ,4155B/C,4156B/C SMU 4
R-I B1500A ,4155B/C,4156B/C SMU 2
R-V DVM B1500A SMU 2, 3458A 1
R-V kelvin B1500A ,4155B/C,4156B/C SMU 4
R-V B1500A ,4155B/C,4156B/C SMU 2
VanDerPauw Square B1500A ,4155B/C,4156B/C SMU 4

TFT TFT ld-Vd B1500A,4155B/C,4156B/C SMU 3
TFT 1d-Vg B1500A ,4155B/C,4156B/C SMU 3

Utility ForcePG1 B1500A ,4155B/C,4156B/C 81110A (2 outputs) 1
ForcePG2 B1500A ,4155B/C,4156B/C 81110A (2 outputs) 1
ForcePG2P B1500A ,4155B/C,4156B/C 81110A (2 outputs) 1
ForcePG12 B1500A ,4155B/C,4156B/C 81110A (2 outputs) 1
ForcePG B1500A ,4155B/C,4156B/C 81110A (2 outputs) 1
ForcePGC B1500A ,4155B/C,4156B/C 81110A (2 outputs) 1
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Category Test definition name Supported analyzer Required equipment and quantity
Utility Measure Diff-V B1500A ,4155B/C,4156B/C 3458A 1
QSCV C Offset Meas B1500A SMU 2
ResetPG B1500A ,4155B/C,4156B/C 81110A (2 outputs) 1
Subsite move B1500A ,4155B/C,4156B/C Wafer prober 1
CVSweep4d284 a B1500A ,4155B/C,4156B/C 4284A 1 or E4980A 1
WGFMU Fast BTI(ACstress Id-Sampling) | B1500A WGFMU 1, RSU 2
dé?iﬁzaif Fast BTI(DCstress Id-Sampling) | B1500A WGFMU 1, RSU 2
WGFMU Fast BTI(ACstress 1d-V @) B1500A WGFMU 1, RSU 2
utility) Fast BTI(DCstress Id-Vg) B1500A WGFMU 1, RSU 2
TRANSIV DC ldvd B1500A SMU 2, WGFMU 1, RSU 2
TRANSIV DC ldvVg B1500A SMU 2, WGFMU 1, RSU 2
WGFMU Pattern Editor B1500A WGFMU 1, RSU 2
WGFMU Fast BTI Id-Sampling child B1500A WGFMU 1, RSU 2
(C:r::(i;ybe Fast BTI Id-Sampling child2 B1500A WGFMU 1, RSU 2
executed Fast BTI Id-Vg child B1500A WGFMU 1, RSU 2
directly)  I"Fag BTI 1d-vg child2 B1500A WGFMU 1, RSU 2
Fast BTI Pattern Editor Child B1500A WGFMU 1, RSU 2
DataDisplay
NOTE If you delete atest definition

Application library should be recovered. Import the test definition by using the
Import Test Definition... function of the Library button. The original test definitions
are stored in the following folder.

C:\Program Files\Agilent\B1500\EasyEXPERT\Application Tests
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NOTE

NOTE

Application Library and Utilities
QSCV Measurement Supplemental Data

QSCV Measurement Supplemental Data

This section provides the following supplemental data of the QSCV measurement.
You can perform the QSCV measurement by using the QSCV[2] application test.

e “Maximum Measurement Value”

» “Congidering Measurement Accuracy”

To obtain stable QSCV measurement results, use two source monitor units (SMU).
Assign the current meter and the voltage sweep source to the individual SMU.

M aximum M easurement Value

The maximum measurement value is not the specifications but the reference data.

Even if the capacitance iswithin this range, measurement may not be completed due
to influences on the measurement path such as extension cables, etc. The maximum
measurement value will be smaller depending on the |eakage current.

The maximum measurement val ue depends on the settings of the current
measurement range, the QSCV measurement voltage, and the integration time. See
Figure 10-1 to Figure 10-5. Each figure shows the characteristics of the capacitance
value vs. the QSCV measurement voltage by the integration time setting. Each line
in the graph specifies the maximum measurement value for each integration time
setting.

The graph datais applied to the measurement when the QSCV integration timeis set
to the same value as the LEAK integration time.
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Figure 10-1 Maximum M easurement Value Using 10 pA and 100 pA Range: HRSM U/ASU
1.00E-06
1.00E-07 :
T Integration
_ 1.00E-08 .y Time
% 1.00E-09 7] T 1 —e g
§ 1.00E-10 nii:***:j.‘ — =re —=— s
g 1.00E-11 \\:\3 ] i ] —— 500ms
& L00E-12 T = | —— 300ms
L] —

1.00E-13 i il

1.00E-14 T

1.00E-15

0.001 0.01 0.1 1
QSCV Measurement Voltage (V)

Figure 10-2 Maximum M easurement Value Using 1 nA Range:
HPSMU/MPSMU/HRSMU/ASU
1.00E-05 Integration
1.00E-06 3 - T'mez
l\t:\:::‘i S
c 1.00E-07 Qt\\\jh\:\\\ —a— 15
8 1.00E-08 | R TS —&— 500ms
< ' J ~ ~ | [T ~{_|
% \\\ T \\:::\ E:\::\v —*—300ms
g 1.00E-09 \~+\\\\\‘ Qt:\:i: —x— 100ms
© 1.00E-10 = T =¥ | —e—50ms
1.00E-11 L[ S0ms
1.00E-12
0.001 0.01 0.1 1
QSCV Measurement Voltage (V)

10-14 Agilent B1500 User’s Guide, Edition 7



Application Library and Utilities
QSCV Measurement Supplemental Data

Figure 10-3 Maximum M easurement Value Using 10 nA Range:
HPSMU/MPSMU/HRSMU/ASU
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Figure 10-4 Maximum M easurement Value Using 100 nA Range:
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Figure 10-5 Maximum Measurement Value Using 1 uA Range:
HPSMU/MPSMU/HRSM U/ASU
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Considering M easurement Accuracy

NOTE The measurement accuracy is not the specifications but the reference data.
Applicable conditions for supplemental data: Leak current compensation function
ON, Offset cancel function ON, QSO mode OFF

The capacitance measurement accuracy can be calculated by the following formula:
Measurement accuracy = A (%) + B (F)
A: Reading accuracy. % accuracy of the measured value.

B: Offset accuracy.

Bp+ Cpx ijfeg+0pxm
A=A Tleak
= p+
Vstep
Bo+ Bocx Cg+ (Co+ Cocx Cg)x Tinteg+ (Do+ Docx Cg) x Tinteg
B = Ao + Tleak
Rdut Vstep
where,

Tinteg: Integration time for the capacitance measurement, in seconds
Tleak: Integration time for the leakage current measurement, in seconds
Vstep: QSCV measurement voltage, in V

Rdut: Equivalent paralel resistance of DUT, in Q

Cg: Guard capacitance of the measurement path, in F

Ax, Bx, Cx, and Dx values are the constant. For the values, see Table 10-2 for the
high resolution SMU (HRSMU), and Table 10-3 for the medium power/high power
SMU (MPSMU and HPSMU).

Calculation examples of the measurement accuracy are shown in Figure 10-6
through Figure 10-30. Conditions of the calculation are shown in Table 10-5.

NOTE Settings for the QSCV Measurement Mode

The measurement mode should be selected based on the measurement conditions.
Normal mode is effective for large leakage currents. The 4155C/4156C compatible
mode is effective if the leakage current islow, or the QSCV measurement voltageis
low.
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Table 10-2 Constant Value for Calculating the M easurement Accuracy: HRSMU/ASU
Me?qwa;zrgmt Congiant Voltage Output Range QSCV Operating
05V | 2V | 5V | 20V | 40V | 100V Mode
10 pA Ap 047 | 047 | 047 | 047 | 048 0.48
Bp 0.014 | 0.029 | 0.051 | 0.15 | 0.30 0.72 Normal
0.009 | 0.011 | 0.015 | 0.03 | 0.06 0.13 4155C/4156C
compatible
Cp 0.013
Dp 0.001
Ao 0.04 Normal
0.07 4155C/4156C
compatible
Bo 1.3E-16
Boc 1.1E-05
Co 5.4E-15
Coc 2.4E-05
Do 1.3E-16
Doc 1.1E-05
100 pA Ap 031 | 031 | 031 | 031 | 032 0.32
Bp 0.014 | 0.029 | 0.051 | 0.153 | 0.298 | 0.720 Normal
0.009 | 0.011 | 0.015 | 0.033 | 0.056 | 0.131 4155C/4156C
compatible
Cp 0.009
Dp 0.002
Ao 0.03 Normal
0.071 4155C/4156C
compatible
Bo 4.7E-16
Boc 3.5E-05
Co 1.3E-14
Coc 9.8E-05
Do 4.7E-16
Doc 3.5E-05
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Table 10-3 Constant Value for Calculating the M easurement Accuracy:
MPSMU/HRSM U/ASU
Mealqstjagzrgent Constant Voltage Output Range QSCV Operating
05V | 2V | 20V | 40V | 100V | 200V Mode
1nA Ap 011 | 011 | 011 | 011 0.12 0.12
Bp 0.014 | 0.029 | 0.051 | 0.153 | 0.298 | 0.720 Normal
0.009 | 0.011 | 0.015 | 0.033 | 0.056 | 0.131 4155C/4156C
compatible
Cp 0.026
Dp 0.014
Ao 0.03 Normal
0.04 4155C/4156C
compatible
Bo 1.7E-15
Boc 1.3E-04
Co 5.9E-14
Coc 4.5E-04
Do 1.7E-15
Doc 1.3E-04
10nA Ap 011 | 011 | 011 | 011 0.12 0.12
Bp 0.014 | 0.029 | 0.051 | 0.153 | 0.298 | 0.720 Normal
0.009 | 0.011 | 0.015 | 0.033 | 0.056 | 0.131 4155C/4156C
compatible
Cp 0.031
Dp 0.015
Ao 0.03 Normal
0.04 4155C/4156C
compatible
Bo 1.7E-15
Boc 7.3E-05
Co 3.9E-14
Coc 1.9E-04
Do 1.7E-15
Doc 7.3E-05
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M e%waazrgent Conctant Voltage Output Range QSCV Operating
05V | 2V | 20V | 40V | 100V | 200V Mode
100 nA Ap 0.06 | 006 | 0.06 | 0.06 0.07 0.07
Bp 0.014 | 0.029 | 0.051 | 0.153 | 0.298 | 0.720 Normal
0.009 | 0.011 | 0.015 | 0.033 | 0.056 | 0.131 4155C/4156C
compatible
Cp 0.209
Dp 0.023
Ao 0.03 Normal
0.04 4155C/4156C
compatible
Bo 2.4E-15
Boc 2.0E-04
Co 8.7E-12
Coc 4.6.0E-04
Do 2.4E-15
Doc 2.0E-04
1uA Ap 006 | 006 | 006 | 0.06 0.07 0.07
Bp 0.014 | 0.029 | 0.051 | 0.153 | 0.298 | 0.720 Normal
0.009 | 0.011 | 0.015 | 0.033 | 0.056 | 0.131 4155C/4156C
compatible
Cp 0.125
Dp 0.021
Ao 0.03 Normal
0.04 4155C/4156C
compatible
Bo 11E-14
Boc 4.0E-05
Co 3.1E-12
Coc 3.5.0E-04
Do 1.1E-14
Doc 4.0E-05
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Table 10-4 Constant Value for Calculating the M easurement Accuracy: HPSMU
M eas;lagzent Constant Voltage Output Range QSCV Operating
2V 20V | 40V | 100V | 200V Mode
1nA Ap 0.11 0.1 0.12 0.12 0.14
Bp 0.033 | 0.149 | 0.293 | 0.717 1.459 Normal
0.0100 | 0.03 0.05 0.12 0.2347 4155C/4156C
compatible
Cp 0.026
Dp 0.014
Ao 0.03 Normal
0.04 4155C/4156C
compatible
Bo 1.7E-15
Baoc 1.3.0E-04
Co 5.9E-14
Coc 4.,5.0E-04
Do 1.7E-15
Doc 1.3.0E-04
10nA Ap 0.11 0.11 0.12 0.12 0.14
Bp 0.033 | 0.149 | 0.293 | 0.717 1.459 Normal
0.0100 | 0.03 0.05 0.12 0.2347 4155C/4156C
compatible
Cp 0.031
Dp 0.015
Ao 0.03 Normal
0.04 4155C/4156C
compatible
Bo 1.7E-15
Boc 7.3E-05
Co 3.9E-14
Coc 1.9.0E-04
Do 1.7E-15
Doc 7.3E-05
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M ea;;z:ent Conctant Voltage Output Range QSCV Operating
2V 20V | 40V | 100V | 200V Mode
100 nA Ap 0.06 0.06 0.07 0.07 0.09
Bp 0.033 | 0.149 | 0.293 | 0.717 1.459 Normal
0.0100 | 0.03 0.05 0.12 | 0.2347 4155C/4156C
compatible
Cp 0.209
Dp 0.023
Ao 0.01 Normal
0.04 4155C/4156C
compatible
Bo 24E-15
Boc 2.0E-04
Co 8.7E-12
Coc 4.6.0E-04
Do 24E-15
Doc 2.0E-04
1pA Ap 0.06 0.06 0.07 0.07 0.09
Bp 0.033 | 0.149 | 0.293 | 0.717 1.459 Norma
0.0100 | 0.03 0.05 0.12 | 0.2347 4155C/4156C
compatible
Cp 0.125
Dp 0.021
Ao 0.01 Normal
0.04 4155C/4156C
compatible
Bo 1.1E-14
Boc 4.0E-05
Co 3.1E-12
Coc 3.5.0E-04
Do 1.1E-14
Doc 4.0E-05
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Table 10-5 Conditionsfor Calculating M easurement Accuracy
Conditions
Measurament Equivalent Guard Measur.ternmt
range QSCV Output par alle capacitance of H RSlli/rI]iJ}ASU
operating mode range resistance of measurement
DUT path
10 pA Normal 20V 10 T ohm 200 pF | Figure 10-6
100 pA Normal 20V 10 T ohm 200 pF | Figure 10-7
Normal 20V 10 T ohm 1nF | Figure10-8
Normal 20V 100 G ohm 200 pF | Figure 10-9
1nA Normal 20V 10 T ohm 200 pF | Figure 10-10
Normal 20V 10 T ohm 1nF | Figure10-11
Normal 20V 10 G ohm 200 pF | Figure 10-12
Normal 20V 1 G ohm 200 pF | Figure 10-13
10nA Normal 20V 10T ohm 200 pF | Figure 10-14
Normal 20V 10 G ohm 200 pF | Figure 10-15
Normal 20V 1 G ohm 200 pF | Figure 10-16
100 nA Normal 20V 10 T ohm 200 pF | Figure 10-17
Normal 20V 1 G ohm 200 pF | Figure 10-18
Normal 20V 100 M ohm 200 pF | Figure 10-19
Normal 20V 10 M ohm 200 pF | Figure 10-20
1pA Normal 20V 10 T ohm 200 pF | Figure 10-21
Normal 20V 1Gohm 200 pF | Figure 10-22
Normal 20V 100 M ohm 200 pF | Figure 10-23
Normal 20V 10 M ohm 200 pF | Figure 10-24
10 pA 4155C/4156C 20V 10 T ohm 200 pF | Figure 10-25
100 pA compatible 20V 10 T ohm 200 pF | Figure 10-26
1nA 20V 10 T ohm 200 pF | Figure 10-27
10 nA 20V 10 T ohm 200 pF | Figure 10-28
100 nA 20V 10 T ohm 200 pF | Figure 10-29
1uA 20V 10 T ohm 200 pF | Figure 10-30

Calculation example data shown in Figure 10-6 through Figure 10-30 is applied to
the measurement data when the QSCV integration timeis set to the same value as

the LEAK integration time.
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Figure 10-6 Calculation Example of M easurement Accuracy: HRSM U/ASU
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QSCV Operating Mode: Normal

Measurement Range: 10 pA

Output Range: 20 V

Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 T ohm

Guard Capacitance of Measurement Path: 200 pF
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Figure 10-7 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-8 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-9 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Equivalent Parallel Resistance of DUT: 100 G ohm
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Figure 10-10 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-11 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Guard Capacitance of Measurement Path: 1 nF
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Figure 10-12 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-13 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-14 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-15 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-16 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-17 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-18 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-19 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-20 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-21 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-23 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-24 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-25 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-26 Calculation Example of M easurement Accuracy: HRSM U/ASU
14
12 \\
< 10 \\
S
g s
=
g
g°® 3
\
x 4
2
0 * .H_"-'“‘l_‘——t::j!
0.001 0.01 0.1 1 10
QSCV Measurement Voltage (V)
1.E-10
L
[
5\
1.E-11 :
c R \
S &Q
S RN
3 LE12 N\ w N
: ENNAN
& N
o N
1.E-13 NN
N
t\k\‘
LE-14 oy
0.001 0.01 0.1 1 10
QSCV Measurement Voltage (V)
Conditions:

QSCV Operating Mode: 4155C/4156C compatible

M easurement Range: 100 pA

Output Range: 20 V

Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 T ohm

Guard Capacitance of Measurement Path: 200 pF

10-44 Agilent B1500 User’s Guide, Edition 7



Application Library and Utilities
QSCV Measurement Supplemental Data

Figure 10-27 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-28 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-29 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Figure 10-30 Calculation Example of M easurement Accuracy: HRSM U/ASU
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Install icon
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Application Library and Utilities
License Management Tool

L icense Management Tool

The licence management tool is the program used to install the license of the

Agilent B1540A-002 EasyEXPERT Plus edition or the Agilent B1541A-002

Desktop EasyEXPERT Plus edition. This program is also used to confirm the
licenses already installed and the host 1D of the B1500A or the controller for

Desktop EasyEXPERT.

Click Start > All Programs > Agilent B1500A EasyEXPERT >
Licence Management Tool.

Click Installed Licenses tab on the Licence Management Tool. The installed
licenses will be displayed.

Click Information tab on the Licence Management Tool. The host ID will be
displayed.

The following procedure installs the license.

1. Click Instal icon, or click File > Install License File to open a dialog box.
2. Specify thelicensefile (lic file) of the B1540A-002 or the B1541A-002.
3. Click Open.

License Management Tool GUI

Install License File Opensadialog box used to specify the licensefile.

Exit Closes the Licence Management Tool.

About Opens the About dialog box.
Opens adialog box used to specify the licensefile.

Displaysthe license already installed.

Displaysthe host ID of the B1500A or the controller for Desktop EasyEXPERT.
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To launch setup
file converter

To create XTS file

To read XTS file

Conversion results

Application Library and Utilities
Setup File Converter

Setup File Converter

The setup file converter is the program which converts the Agilent 4155A/4156A/
4155B/4156B/4155C/4156C setup file (extension: DAT or MES) and creates the
EasyEXPERT setup file (extension: XTS). This program can convert the setup
information but cannot convert the test result data.

Click Start > All Programs > Agilent B1500A EasyEXPERT > 4155,4156 Setup
File Converter. This executes SetupFileConverterW.exe in the following fol der.
C:\Program Files\Agilent\B1500\EasyEX PERT\415xC\Conversion\

This program can be executed on a PC installed with Windows X P Professional SP2
(Microsoft .NET Framework 2.0 runtime library is required) or Windows Vista
Business SP1.

To execute this program, the SetupFileConverter.exe, SetupFileConverter\W.exe,
and SetupFileConverterW.exe.config files must be stored in the same folder.

The following procedure converts the 4155/4156 setup file (.DAT or .MES) and
creates the XTSfilein the folder the setup fileis stored.

1. Click Select icon, or click File> Select Files to open the Select 4155/4156 MES
Files or DAT Files dialog box.

2. Specify the 4155/4156 setup files to convert. Multiple files can be selected.

3. Click Open on the Select 4155/4156 MES Files or DAT Files dialog box.

4. Click Convert icon, or click File > Convert Files.

Instead of the step 1 to 3, you can use the drag and drop operation from Explorer to
the Selected Files area on the Setup File Converter.

Use the import function to read the created .XTS file on the EasyEXPERT.

Open the Import Test Setup window by clicking File > Import Test Setup... on the
Classic Test screen. Specify the XTSfile to be imported, and click Open.

For details about the conversion results, see “ SetupFileConverter.exe” on page
10-53.
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File menu

Help menu

Icons

Create XTS for

Selected Files

Log

Application Library and Utilities
Setup File Converter

Setup File Converter GUI

The setup file converter provides the following GUI.

Select Files Opensthe Select 4155/4156 MES Files or DAT Files dialog box
used to specify the 4155/4156 setup files to convert.

Convert Files Performs conversion and creates X TS file. This program
overwrites the file of the same name.

Clear Clears the Selected Files area and the Log area.

Quit Closes the setup file converter.

About Opens the About dialog box.

Select Opensthe Select 4155/4156 MESFiles or DAT Filesdialog box

used to specify the 4155/4156 setup files to convert.

Convert Performs conversion and creates X TS file. This program
overwrites the file of the same name.

Clear Clears the Selected Files area and the Log area.

Specifies the type of the X TSfile to create.
B1500A XTSfilefor the B1500A
4155B/C XTSfilefor the 4155A/B/C

4155B/C with HPSM U XTSfile for the 4155A/B/C. The HPSMU in the
MES/DAT fileis converted to SMU5: HP.

4156B/C XTSfilefor the 4156A/B/C

4156B/C with HPSM U XTSfile for the 4155A/B/C. The HPSMU in the
MES/DAT fileis converted to SMU5: HP.

Lists the 4155/4156 setup filesto convert. Drag and drop operation is allowed.

Displays the execution log.
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Utility Programs

Utility Programs

The following useful programs are stored in the following folder on the Agilent
B1500A internal hard disk drive. Remember that they are just sample programs.

C:\Program Files\Agilent\B1500\EasyEX PERT\UTtilities\

*  “Prober Control”

» “SetupFileConverter.exe”
o “deep.exe”

o “XSLT”

Prober Control

The C:\Program Files\Agilent\B1500\EasyEX PERT\Utilities\ProberControl folder
stores the execution files used to control the following probers.

» Cascade Microtech Summit 12K or S300
e SUSS MicroTec PA200 or PA300
* Vector Semiconductor VX-2000 or VX-3000

You can use the execution files when you perform arepeat measurement by using
Agilent B1500A/EasyEXPERT and a prober listed above. The execution files
control the prober chuck movement (down, move, and up) by defining them in the
Repeat Measurement Setup window. See “ Repeat M easurement Setup” on page
4-31. Also see the readme.mht file in the ProberControl folder to use the prober
control script.

Thisfolder also stores the source files and the document files. See the pdf filesin the
ProberControl\xxxx\doc folder for more details or if you create your own prober
control script by referring to the source code; xxxx is cascade, suss, or vector.
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Execution
environment

Syntax

Parameter

Execution
examples

Table 10-6

Application Library and Utilities
Utility Programs

SetupFileConverter.exe

This program is the script version of the setup file converter. This program converts
the 4155A/4156A/4155B/4156B/4155C/4156C setup file (.DAT or .MES) and
creates the EasyEXPERT setup file (XTS). This program can convert the setup
information but cannot convert the test result data.

Windows 2000 Professional, Windows X P Professional or Home edition

Set upFi | eConverter.exe [option] [file]

option : Execution options. See Table 10-6. Multiple options can be set. Both
/4155 and /4156 cannot be set for one execution.
file: 4155/4156 setup file name

You can specify multiple files by using a space as the separator.
Wildcard can be used.

If no parameter is specified, the Usage message is displayed.

C:\415xConvert >Set upFi | eConverter.exe MOS1. MES
C.\ 415xConvert >Set upFi | eConverter. exe MOS*. DAT MOS*. MES
C:\415xConvert >Set upFi | eConverter.exe /4156 /HP *. MES

Option Parameter

Option Description

(no option) | Performs normal operation.

14155 Creates the X TS file for the 4155, not for the B1500A.
14156 Creates the X TS file for the 4156, not for the B1500A.
/HP Converts HPSMU in the MES/DAT fileto SMUS5: HP. For creating

the XTSfile for the 4155/4156.

IS L eaves Command Prompt open after execution. For the XTSfile
creation example 2. See NOTE below.
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XTS file creation
example 1

XTS file creation
example 2

NOTE

Application Library and Utilities
Utility Programs

The .XTSfile can be created by using Command Prompt as shown below.

1. Create your working folder (for example, C:\415xConvert\ ).

2. Copy the 4155/4156 setup files to be converted and the SetupFileConverter.exe
file, and paste them to the working folder.

3. Open Command Prompt.

4. On Command Prompt, execute SetupFileConverter.exe as shown below. This
creates the XTSfile in the working folder and displays the message as follows.

C:\415xConvert >Set upFi | eConverter. exe | DVG MES

Set upFi | eConverter. exe : Version A 02.10
Start Conversion : | DVG MES
ExportFile : I DVG xts

Set upVer si on . HP4155_Q03. 06
Conver si on successfully conpl et ed.

The .XTSfile can be created by using the shortcut on the Desktop as shown below.
Before the procedure, create the following shortcut on the Desktop.

Target file:
C:\Program Files\Agilent\B1500\EasyEX PERT\Utilities\SetupFileConverter.exe

Shortcut name: SetupFileConverter

1. Copy the 4155/4156 setup files to be converted, and paste them on the Desktop.

2. Dragtheicon of the setup file and drop it on the SetupFileConverter icon. This
creates the . XTSfile and itsicon on the Desktop, and opens Command Prompt
for digplaying the status message one moment.

To set options to the SetupFileConverter shortcut
If you want to leave Command Prompt open, add the /S option as shown below.

1. Right-click on the SetupFileConverter icon and select Propertiesto open the
Properties window.

2. Onthe Shortcut tab screen, add /S to the end of the string in the Target field as
follows.

"C:\ Program Fi | es\ Agi | ent\ B1500\ EasyEXPERT\ Uti liti es\ SetupFile
Converter.exe" /S

3. Click OK.
If you want to make the XTSfile for the 4155/4156, insert /4155 or /4156 before /S.
If you want to add /HP option, insert /HP before /S.
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Use the import function to read the created .X TS file on the EasyEX PERT.
Open the Import Test Setup window by clicking File > Import Test Setup... on the
Classic Test screen. Specify the . XTSfile to be imported, and click Open.

The setup file conversion is not complete. The following are the expected
differences. When you use the .XTSfile, you will see differencesin the operation,
performance, measurement result data, and so on.

» Channel number may be changed. For example, the HPSMU channel number is
5 for the 4155/4156 but 1 for the B1500A.

»  Setup valueis changed to the value available for the B1500A and EasyEXPERT.

» Voltage Source and Monitor Unit (two channels of VSU and two channels of
VMU) is converted to four channels of MPSMU.

» Pulse Generator Unit (PGU) setup is del eted.
*  Unused module information is deleted.
» Functions only for the 4155/4156 are deleted.

» For converting the setup data which satisfies the following two conditions,
SMUS is converted to HPSMU. Else, SMUS is converted to MPSMU.

1. SMUG6 information is not included in the setup data.
2. SMUS5 information contains the value available only for the HPSMU.

If an inconvertible setup parameter is found during the setup file conversion, a
message will be displayed. If an inconvertible setup file is specified, the file
conversion is not performed for the file and a message will be displayed.

If the /4155 or /4156 option is specified, there are the following differences between
the conversion results.

e Channel number is not changed.

»  Setup value will be changed to the value available for the 4155/4156 and
Desktop EasyEXPERT.

* VSU/VMU is converted to VSU/VMU respectively.
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deep.exe
This execution fileis used to put await time in the test execution flow of an
application test.

Agilent EasyEXPERT application test execution environment

C:\Program Files\Agilent\B1500\Easy EX PERT\Utilities\sleep.exe

Thefollowing parameters are available for thisfile. To use sleep.exe, the parameters
must be defined in the Local Variables Definition statement of the Test Contents tab
in the Test Definition window.

WAIT : List input parameter. Vector variable (1 x 1) to store the data passed
to sleep.exe. Enter await timein ms.

PassFail : Value output parameter. Numeric variable to store the execution
result. 0 is always returned.

ReturnValue: Value output parameter. Numeric variable to store the data returned
by executing sleep.exe. 1 isreturned after execution.

To execute sleep.exe, the following setup should be done in the Command
Execution element, Miscellaneous component, Test Contents tab in the Test
Definition window.

Windows Command Execution

Command Filename:| C:\Program Files\Agilent\B1500\EasyEX PERT\ULtilities\sleep.exe
Argument:

Write Type: String X | List

Read Type: String x | Vaue List None
WriteList

Values: WAIT

Format:

Read Value

Result: PassFail Value: ReturnValue
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XSLT

The XSLT (XSL-Transformation, eXtensible Stylesheet Language Transformation)
filter files are used to export test records. The fifteen filter files listed below are
stored in the C:\Program Files\Agilent\B1500\EasyEX PERT\Utilities\X SLT folder.
See Table 10-7.

Filter filesthat contain csv in the file name export test record in the format that uses
acomma(,) as data separator.

Filter filesthat contain tab-sv in the file name export test record in the format that
uses a tab as data separator.

Filter filesthat contain xmlss in the file name export test record in the XML Spread
Sheet format.

Test record can be exported by the following procedure.

1. Openthe Export in My Format (p. 4-22) dialog box by clicking Results >
Transport Data > Export in My Format....

2. Enter the XSLT filter file name, and click the Export As... button.
3. Onthe Export Asdialog box, specify the file name and file type for the export
data, and click Save.

The exported data file can be opened and read with a spreadsheet software. The
procedure for opening the export data with a spreadsheet software is as follows.

» For data separated by a comma

Specify the data separated by a comma for the original data format.
» For data separated by atab

Specify the data separated by atab for the original data format.
» For datainthe XML Spread Sheet format

Specify the XML file for the file type.

After reading thefile, all datain thefile will be entered into independent cells on the
spreadsheet software.
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Table 10-7 XSLT Filter Files
Group File name Description
1 meas-csv.xsl Filter files for exporting the measurement data only
meas-tab-sv.xd Classic test record export example is shown in Table 10-8.
meas-xmiss.xsl
2 meas-index-csv.xsl Filter files for exporting the measurement data with the index
meas-index-tab-sv.xsl Classic test record export example is shown in Table 10-9.
meas-index-xmiss.xd
3 meas-meta-csv.xsl Filter Files for exporting the measurement data with the meta
meas-meta-tab-sv.xd data
meas-meta-xmiss.xs The meta data contains the test name, the setup name, the
record time of the test results, the device ID, the counter
number, the flag of the test results, and the remarks on the test
results.
Classic test record export example is shown in Table 10-10.
4 meas-index-meta-csv.xsl | Filter files for exporting the measurement data with the index
mess-index-meta-tab-sv.xd and the meta data
measindex-metaxmissxd The meta data contains the test name, the setup name, the
record time of the test results, the device ID, the counter
number, the flag of the test results, and the remarks on the test
results.
Classic test record export example is shown in Table 10-11.
5 csv.xsl Filter files for exporting all dataincluding the test setup
ggs\e/d b{ trfl%port As Application test record export example is shown in Table
fun C'[IOFIF; 10-12. Datain thefirst cell isthelabel for the data components
in that row. The following cells are the data corresponding to
tab-sv.xdl the label. Table 10-15 and Table 10-16 list the components
available for the exported datafile.
xmiss.xdl
(used by the Export As
XML Spread Sheet... (p.
4-16) function)
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Table 10-8 Example of the data exported by using the XSLT Filter File Group 1
Vd Vg Index Time Id ABS ID Slope
0 1 1 0.00264 -0.00012 0.00012 0.004346
0.06 1 2 0.01265 0.000398 0.000398 0.004346
0.12 1 3 0.02265 0.000902 0.000902 0.004346
Table 10-9 Example of the data exported by using the XSLT Filter File Group 2
No. vd Vg Index Time Id ABS ID Slope
1 0 1 1 0.00264 | -0.00012 0.00012 | 0.004346
2 0.06 1 2 0.01265 | 0.000398 | 0.000398 | 0.004346
3 0.12 1 3 0.02265 | 0.000902 | 0.000902 | 0.004346
Table 10-10 Example of the data exported by using the XSLT Filter File Group 3
I/V Sweep Trng Id-Vd
Record Time | 04/04/2007
08:36:42
Device D
Count 2
Flag
Remarks
vd Vg Index Time Id ABS ID Slope
0 1 1 0.00264 -0.00012 0.00012 0.004346
0.06 1 2 0.01265 0.000398 0.000398 0.004346
0.12 1 3 0.02265 0.000902 0.000902 0.004346
Agilent B1500 User’s Guide, Edition 7 10-59



Application Library and Utilities

Utility Programs

Table 10-11 Example of the data exported by using the XSLT Filter File Group 4
I/V Sweep Trng Id-Vd
Record 04/04/2007
Time 08:36:42
DevicelD
Count 2
Flag
Remarks
No. vd Vg Index Time Id ABS_ ID | Slope
0 0.00264 | -0.00012 | 0.00012 | 0.004346
0.06 0.01265 | 0.000398 | 0.000398 | 0.004346
0.12 0.02265 | 0.000902 | 0.000902 | 0.004346
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Filter File Modification Example

This section explains the modification example of afilter file. In this example, a
filter file of group 5is used.

The group 5 filter files will export the data that contains the test setup information.
To obtain the data without the setup information, modify the filter file as shown
below, also see Figure 10-31, and export data by using the filter file after
modification.

The data will not contain the TestParameter, DutParameter, MetaData, and
AnalysisSetup of the Application test result record, and the TestParameter,
MetaData, and AnalysisSetup of the Classic test result record.

1. Modify the following template elements for sta: TestParameter List to
sta: Terminal List as shown below.

<xsl :tenpl ate match="sta: Test Par anet er Li st ">
</ xsl:tenpl at e>

<xsl:tenpl ate match="sta: Dut Par anet erLi st">
</ xsl:tenpl at e>

<xsl:tenpl ate match="sta: Anal ysi sPar anet er Li st">
</ xsl:tenpl at e>

<xsl :tenpl ate match="sta: Met aDat a/ st a: Paranmet er Li st">
</ xsl:tenpl at e>

<xsl :tenpl ate match="sta: Term nal Li st">
<xsl|:apply-tenplates />
</ xsl:tenpl at e>

2. Comment out the whole of the following template element.

<l--
<xsl :tenpl ate match="sta: Paraneter">
</ xsl Eténbl ate>
-->
Exported data examples of Classic test result record are shown in Table 10-12 and
Table 10-13.

Table 10-14 explainsthe reference name used in thefilter file and shows the relation
to the parameter name used in the data file exported by using thefilter file.
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tion Example

M odifi

Figure 10-31

Before modification

After modification

<xsl:template match="sta:TestParameterList">
<xsl:apply-templates select="sta:Parameter">
<xsl:with-param name="parmtag">TestParameter</xsl:with-param>
</xsl:apply-templates>
</xsl:template>

<xsl:template match="sta:TestParameterList">
</xsl:template>

<xsl:template match="sta:DutParameterList">
<xsl:apply-templates select="sta:Parameter">
<xsl:with-param name="parmtag">DutParameter</xsl:with-param>
</xsl:apply-templates>
</xsl:template>

<xsl:template match="sta:DutParameterList">
</xsl:template>

<xsl:template match="sta:AnalysisParameterList">
<xsl:apply-templates select="sta:Parameter">
<xsl:with-param name="parmtag">AnalysisSetup</xsl:with-param>
</xsl:apply-templates>
</xsl:template>

<xsl:template match="sta:MetaData/sta:ParameterList">

<xsl:template match="sta:AnalysisParameterList">
</xsl:template>

<xsl:apply-templates select="sta:Parameter">
<xsl:with-param name="parmtag">MetaData</xsl:with-param>
</xsl:apply-templates>
</xsl:template>

<xsl:template match="sta:TerminalList">

<xsl:template match="sta:MetaData/sta:ParameterList">
</xsl:template>

<xsl:template match="sta:TerminalList">

<xsl:apply-templates select="sta:Terminal" />
</xsl:template>

<xsl:template match="sta:Parameter">

<xsl:param name="parmtag">UnknownParameter</xs
<xsl:if test="@Index='0'">
<xsl:variable name="parmname" select="@Name" />
<xsl:text xml:space="preserve">
</xsl:text>
<xsl:value-of select="$parmtag" />
<xsl:text>, </xsl:text>
<xsl:value-of select="$parmname" disable-output-escaping="yes" />
<xsl:apply-templates />
<xsl:for-each select="../sta:Parameter[@Name=Sparmname and @Index>'0"']">
<xsl:sort select="@Index" data-type="number" />
<xsl:apply-templates />
</xsl:for-each>
</xsl:if>
</xsl:template>

:param>

B <xsl:apply-templates />
</xsl:template>

<xsl:template match="sta:Parameter">
<xsl:param name="parmtag">UnknownParameter</xsl:param>
<xsl:if test="@Index='0'">
<xsl:variable name="parmname" select="@Name" />
<xsl:text xml:space="preserve">
</xsl:text>
<xsl:value-of select="$parmtag" />
<xsl:text>, </xsl:text>
<xsl:value-of select="$parmname" disable-output-escaping="yes" />
<xsl:apply-templates />
<xsl:for-each select="../sta:Parameter[@Name=$parmname and @Index>'0"'
<xsl:sort select="@Index" data-type="number" />
<xsl:apply-templates />
</xsl:for-each>
</xsl:if>
</xsl:template>

G

>
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Table 10-12 Example of the data exported by using thefilter file before modification
SetupTitle Trng 1d-Vd

PrimitiveTest | 1/V Sweep

TestParameter | Channel.Unit SMUL:HP SMU2:HP SMUS3:HR SMU4:HR
TestParameter | Channel.IName |1d lg Is Isub
TestParameter | Channel.VName|Vd Vg Vs Vsub
MetaData TestRecord.Entr | true

AnalysisSetup |Analysis.Setup. |true

Dimensionl 51 51 51 51 51
Dimension2 3 3 3 3 3
DataName vd Vg Index Time Id
DataValue 0 1 1 0.00251 0
Datavalue 0.06 1 2 0.01251 3.35E-05
Table 10-13 Example of the data exported by using thefilter file after modification
SetupTitle Trng Id-Vd

PrimitiveTest | 1/V Sweep

Dimensionl 51 51 51 51 51
Dimension2 3 3 3 3 3
DataName vd Vg Index Time Id
DataValue 0 1 1 0.00251 0
Datavalue 0.06 1 2 0.01251 3.35E-05
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Table 10-14 Filter File Reference Name
Reference name Description
staTestData Indicates atest result data saved in an EasyEXPERT test result record
sta:MeasurementData Indicates a measurement result data saved in atest result data
sta: DataVectorSet Indicates a set of vector data saved in ameasurement result data
sta TestSetup Indicates atest setup data saved in atest result data
staTitle Indicates test setup name, SetupTitlein export data

staPrimitiveTest

Indicates aclassic test data set, PrimitiveTest in export data

sta:ApplicationTest

Indicates an application test data set, ApplicationTest in export data

sta: TestParameterList

Indicates a set of Test Parameters definitions, TestParameter in export
data

sta:DutParameterList

Indicates aset of Device Parameters definitions, DutParameter in
export data

sta:AnalysisParameterList

Indicates a set of display and analysis data, AnalysisSetup in export
data

sta:MetaData/sta: ParameterList

Indicates a set of system data, MetaData in export data

staTerminalList Indicates a set of terminal information
sta:Parameter Indicates a parameter
staNumber Indicates an integer data
staDouble Indicates areal data

sta:String Indicates astring data
sta:Boolean Indicates aboolean data
staDateTime Indicates adate time data
staBinary Indicates abinary data
sta:Channel Indicates a channel information
staTerminal Indicates aterminal information
sta:Port Indicates aport information
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Table 10-15 Export Data Componentsfor Classic Test Result
L abel Description Example (csv output)

SetupTitle Title of thistest setup Trng_ld_Vd

PrimitiveTest Setup name of this classic test I/V Sweep

TestParameter Parameter name and setup value of Channel Channel.Unit, SMU1:HP,
Setup, Measurement Setup, Function Setup, Auto | SMU2:HP, SMU3:HR,
Analysis Setup, and Display Setup. SMU4:HR
Datafile contains alot of rows for TestParameter.
One setup item per row.

MetaData Data for system use. Test record entry point, TestRecord.EntryPoint, true
record time, test target, iteration index,
preservation, flag, remarks, and link key.

AnalysisSetup Parameter name and setup value of the data Analysis.Setup.Vector.Graph.E
display and analysis setup. nabled, true
Datafile contains alot of rows for
AnalysisParameter. One setup item per row.

Dimensionl Size of data variable. For dimension 1. Order 51,51, 51,51, 51
sensitive. 51 for all data variablesin Example.

Dimension2 Size of data variable. For dimension 2. Order 3,3333
sensitive. 1 for al data variablesin Example.

DataName Measurement parameter names or data variable Vd, Vg, Index, Time, I1d
names. Order sensitive. For example, Vgate=-0.5
in Example.

Datavalue Measurement result data. Order sensitive. For 0,1, 1,0.00251, 0

example, Vgate=-0.5 in Example.

Datafile contains a lot of rows for DataVal ue.
One data set per row.
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Table 10-16 Export Data Componentsfor Application Test Result
Label Description Example (csv output)
SetupTitle Title of thistest setup Trng_Id_Vd
ApplicationTest | Setup name of this application test Trng_ld_Vd, Public
TestParameter Two rows. The upside is for the test parameter Name, VdStart, VdStop,
names. The downside is for the test parameter VdStep, VgStart, VgStop,
values. Order sensitive. For example, Vd=0.1in VgStep, Vs
Example.
Vaue, 0, 3,0.06, 1,2,05,0
DutParameter Two rows. The upside is for the device parameter | Name, Polarity, Lg, Wg, Temp,
names. The downside is for the device parameter | IdMax
values. Order sensitive. For example, Temp=25in
Value, 1, 1.00E-07, 1.00E-05,
Example.
25, 0.005
MetaData Data for system use. Test record entry point, TestRecord.EntryPoint, true
record time, test target, iteration index,
preservation, flag, remarks, and link key.
AnalysisSetup Parameter name and setup value of the data Analysis.Setup.Vector.Graph.E
display and analysis setup. nabled, true
Datafile contains alot of rowsfor
AnalysisParameter. One setup item per row.
Dimensionl Size of data variable. For dimension 1. Order 51,51, 51, 51,51
sensitive. 51 for all data variablesin Example.
Dimension2 Size of data variable. For dimension 2. Order 3,3333
sensitive. 1 for all datavariablesin Example.
DataName Measurement parameter names or data variable Vd, Vg, Index, Time, Id
names. Order sensitive. For example, Vgate=-0.5
in Example.
Datavalue Measurement result data. Order sensitive. For 0,1, 1,0.00251, 0

example, Vgate=-0.5 in Example.

Datafile contains a lot of rows for DataValue.
One data set per row.
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Desktop EasyEXPERT

The Desktop EasyEXPERT software CD-ROM isincluded with Agilent B1500A.
This section describes the following topics.

» “About Desktop EasyEXPERT”

e “System Requirements’

» “Tolnstall Desktop EasyEXPERT”

» “Before Starting Desktop EasyEXPERT”

e “To Start Desktop EasyEXPERT”

» “Execution Mode dialog box”

o “Start EasyEXPERT window”

» “To Change Execution Mode and GPIB Settings”
* “ToMovethe EasyEXPERT Database’

e “Using 4155B/4156B/4155C/4156C"

Desktop EasyEXPERT Standard Edition

There are two editions Plus and Standard for Desktop EasyEXPERT. The Standard
edition does not support the Agilent E5250A Switching Matrix.

Software Update and Database Backup

To perform software update of Desktop EasyEXPERT, see “Updating
EasyEXPERT” on page 9-22.

To make and restore EasyEXPERT database, see “ Data Backup and Recovery” on
page 9-14.

About privilege to use Desktop EasyEXPERT

The Desktop EasyEXPERT revision A.03.20 does not require the administrator
privilege which is required by the revision A.03.11 and previous revisions.
However, if the software is updated from a previous revision to the revision
A.03.20, it still requires the administrator privilege.
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About Desktop EasyEXPERT

The Desktop EasyEXPERT software provides the following additional advantages
to the B1500A, alowing you to minimize the amount of offline tasks performed on
B1500A and increase the working ratio for measurements.

e Allows B1500A to be controlled from an external computer via GPIB while
online.

» Allowstest setup to be created on an external computer while offline.
» Allows dataanalysisto be performed on an external computer while offline.

The Desktop EasyEXPERT can use the 4155B, 4156B, 4155C, or 4156C instead of
the B1500A. Then, there are some differences in the functions and operations
compared with when the B1500A is used. See “ Using 4155B/4156B/4155C/4156C”
on page 10-74.

Using Desktop EasyEXPERT

Clean Room

Agilent B1500A

ey

To export test record
To import/export test setup
via LAN

via GPIB

Office

Desktop EasyEXPERT
Data server
To control B1500A

Vs

LAN =

—

= --

| = =
=

| i

Desktop EasyEXPERT
Data server
Print server

HUB
Line Printer

Note: The B1500A cannot be controlled via LAN.

NOTE

Desktop EasyEXPERT supports most B1500A/EasyEXPERT functions. However,
some functions are not supported on an external computer due to differencesin
hardware and so on.
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System Requirements

The following are the minimum requirement for executing Desktop EasyEXPERT
revision A.03.20 or later.

Operating system Microsoft Windows XP Microsoft Windows Vista
and service pack Professional SP2 Business SP1
Processor Intel Celeron 2 GHz Vista certified PC with 1 GB
memory
Memory 512 Megabytes DDR266
Display XGA 1024x768 (SXGA 1280x1024 recommended)

HDD 1 GB free space on the C drive, 10 GB (30 GB
recommended) free space on adrive for test setup/result
data storage.

.NET Framework | Microsoft NET Microsoft .NET Framework
Framework Ver 2.0 Ver 3.0
Redistributable Package
Microsoft .NET
Framework 2.0 SP1
GPIB interface | Agilent 82350B GPIB interface, for Online execution
10O libraries Agilent 1O Libraries Suite 15.0, for Online execution

NOTE

If your computer does not install a software, install the software in the above order.
For example, if your computer does not install Microsoft NET Framework 2.0 SP1,
install it and Agilent 10 Librariesin this order. If you do not use the Online
execution mode, you do not need to install the 10 Libraries.

Prepare the Agilent 10O Libraries software CD-ROM provided with Agilent GPIB
interface to install the 10 Libraries.

Open the Desktop EasyEXPERT Prerequisites folder to get installation packages for
the other required software.
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To Install Desktop EasyEXPERT
To install Desktop EasyEXPERT onto your computer, follow the procedure below.

1. Insert the Desktop EasyEXPERT software CD-ROM into the CD-ROM drive.
2. Execute Setup.exe and follow the instructions of the setup wizard.

3. Wait for installation to complete, and remove the CD-ROM from the CD-ROM
drive.

To set the same module configuration as B1500A

The module configuration of the B1500A can be set to the Desktop EasyEXPERT in
the offline mode. Copy the following file on the B1500A internal HDD to the same
location on the PC which the Desktop EasyEXPERT runs.

\ Docunents and Settings\All Users\Application Data\Agilent
Technol ogi es, | nc\ EasyEXPERT\ Uni t Confi gB1500A. xml

Before Starting Desktop EasyEXPERT
Note the following when you use Desktop EasyEXPERT.

* When using the Offline mode, use the dataimport/export function to transfer
your test setup data files and test result records.

*  When using the Online mode, do not send a control command to the analyzer
(B1500A, 4155B, 4156B, 4155C, or 4156C) by using a programming
environment except for Desktop EasyEXPERT.

» Do not send a control command to the analyzer by using the GPIB |10 statement
in the application test definitions.

e To control the B1500A by using Desktop EasyEXPERT, exit EasyEXPERT on
B1500A. The Start EasyEXPERT window (button) must be displayed or be
minimized to the Windows task bar on the B1500A screen.
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To Start Desktop EasyEXPERT
To launch Desktop EasyEXPERT, follow the procedure below.

1. Doubleclick the Start EasyEXPERT icon or click Start > All Programs > Start
EasyEXPERT. The Execution Mode dialog box is displayed.

2. Select the execution mode, Online or Offline.

If you select the Online mode, set the GPIB configuration. See “Execution
Mode dialog box” on page 10-71.

3. Click the OK button. The Start EasyEXPERT window is displayed.
4. Click the Start EasyEXPERT button to launch Desktop EasyEXPERT.

Execution M ode dialog box

The Execution Mode dialog box provides the following graphical user interface.

Click the Online radio button to select the online execution mode. Then the
following fields are available.

VISA interface D VISA interface ID of the GPIB interface installed
in your computer. Select one from the pop-up
menu.

GPIB address GPIB address of the analyzer (B1500A, 4155B,

4156B, 4155C, or 4156C). Select one from the
pop-up menu. 0 to 30 are available.

Click the Offline radio button to select the offline execution mode. And select the
analyzer assumed by the Desktop EasyEXPERT in the offline mode.
M odel Select B1500A, 4155B, 4156B, 4155C, or 4156C.

@ANALY ZER Function

This function returns the present Model setting. It can be used in the application test
definitions. The return value can be read by using a string variable (e.g. Stringl) as
shown below.

Example: Stringl=@ANALYZER
The return value is B1500A, 4155B, 4156B, 4155C, or 4156C.
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Sart EasyEXPERT window
The Start EasyEXPERT window provides the following graphical user interface.

This button launches Desktop EasyEX PERT.

Exit closes the Start EasyEXPERT window.

Execution Maode opens the Execution M ode dial og box.

EasyEXPERT Database provides the following three functions.

Backup EasyEXPERT Database

Opens the EasyEXPERT Database Backup Creation Wizard used to make
backup of the EasyEXPERT database. You can make backup easily by following
the wizard. Required time depends on the database size.

Restore EasyEXPERT Database

Opens the EasyEXPERT Database Restoration Wizard used to restore the
EasyEXPERT database backup. You can restore the backup easily by following
the wizard. Required time depends on the database size.

Move EasyEXPERT Database

Opens the EasyEXPERT Database dialog box used to move the EasyEXPERT
database. To move the database, enter the destination folder name into the Move
To field. For example, enter C:\EasyEXPERT _user_1\database.

EasyEXPERT Database is the folder used to store your test setup data and such.
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To Change Execution Mode and GPIB Settings

To change the Desktop EasyEXPERT execution mode or the GPIB configuration,
follow the procedure below.

1

Launch Start EasyEX PERT.

If the Execution Mode dialog box is not opened, click Option > Execution
Mode.

If Desktop EasyEXPERT isrunning, exit it. And in the Start EasyEXPERT
window, click Option > Execution Mode.

Select the execution mode, Online or Offline.

If you select the Online mode, set the GPIB configuration. See “Execution
Mode dialog box” on page 10-71.

Click the OK button to set the changes.
Click the Cancel button to cancel the setup changes.

To Movethe EasyEXPERT Database

When the HDD (hard disk drive) is full, add a humongous HDD and move the
EasyEXPERT database to it. To move the database, follow the procedure below.
Required time depends on the database size.

1

Launch Start EasyEX PERT.
If the Execution Mode dialog box is opened, click the Cancel button.

If Desktop EasyEXPERT is running, exit it to open the Start EasyEXPERT
window.

Click Option > EasyEXPERT Database > Move EasyEXPERT Database. The
EasyEXPERT Database dialog box is displayed.

Enter the destination folder name into the Move To field. For example, enter
C:\EasyEXPERT _user_1\database.

Click the OK button to start the database move operation.

Click the Cancel button to cancel the move operation.
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Using 4155B/4156B/4155C/4156C

This section describes the notices when using Desktop EasyEXPERT and
4155/4156.

4155/4156 firmware revision supported by Desktop EasyEXPERT

e HOSTC: 03.08 or |ater
e SMUC: 04.08 or |later

4155/4156 functions unsupported by Desktop EasyEXPERT

* Log sampling measurement and Thinned out sampling measurement
» Functionsusing R Box

» Differentia voltage measurement using VMU (Voltage Monitor Unit)
» DC bias output using PGU (Pulse Generator Unit)

*  Other functions unavailable for the B1500A

Classic tests available for 4155/4156

* 1/V Sweep, I/V-t Sampling, and Switching Matrix Control for 4155C/4156C
* 1/V Sweep and Switching Matrix Control for 4155B/4156B
Desktop EasyEXPERT functions unavailable for 4155/4156

» Functionsusing SMU Series Resistor

» Functionsusing ASU (Atto Sense Unit)

» Functionsusing SCUU (SMU CMU Unify Unit)

» Functions using CMU (Capacitance Measurement Unit)

e Functions using SPGU (Semiconductor Pulse Generator Unit)

PGU can be used instead of SPGU for the I/V Sweep and 1/V-t Sampling classic
tests. The Load Z function and the ALWG output are not supported. The Output
Impedance dialog box is available to set the output impedance of the PGU.

» Functions using WGFMU (Waveform Generator/Fast M easurement Unit) and
RSU (Remote-sense and Switch Unit)
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Differences on Calibration window

» Calibration window provides Module Self Calibration screen only.
» Module Self Calibration screen provides Enable Auto Calibration only.

Differences on Configuration window Main Frame screen
e Line Freguency just displays the setting of 4155/4156.
» Firmware Rev. displays asfollows.

[HOSTC Rev.]:[SMUC Rev.];[ADC Rev.]

e Main Frame Diagnosisis not supplied.

Differences on Configuration window Module screen

»  Self-test cannot be performed.

» Status, SCUU, and Notes columns are not supplied.

» Start Self Test and Recover Module buttons are not supplied.

» Accessory Configuration is not supplied.

Differences on I/V Sweep Classic Test

» Time Stamp Namefield is not supplied for 4155B/4156B.
» SMU Pulse Period and Width value must satisfy Period > Width + 4 ms.

Differences on 1/V-t Sampling Classic Test

e Log samplingis not supported.

e Samplinginterval must be 60 usto 65.535 s.
*  Number of samples must be 1 to 10001.

e Base hold time must be 0 sec.

Differences on A/D Converter & Integration Time Setup
» ADC always shows HR ADC.
» High Resolution ADC is set as shown in Table 10-17.

For the sampling measurement of Interval <2 ms, the Integration Time setting is
ignored.
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Table 10-17

NOTE
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Differences on Advanced Setup

» Series R always shows NONE.
» Wait Time Control is not supplied.

There are the following restrictions for the Desktop EasyEXPERT Standard edition.
* I/V-t Sampling classic test is not supported.

* VSU, VMU, and PGU are not supported.

» Agilent E5250A Switching Matrix is not supported.

Setting of High Resolution ADC

Mode Factor Setting of 4155/4156

AUTO - MEDIUM

MANUAL | 1< N < 127 | SHORT, TIME=80 usx N

PLC 1 MEDIUM

N>2 LONG, NPLC=N

To reuse the test setup for B1500A
Perform the following procedure to reuse the test setup created for the B1500A.

1. Launch Desktop EasyEXPERT with the condition Set Analyzer=B1500A.
2. Export the test setups to be reused. And exit Desktop EasyEXPERT.

3. Launch Desktop EasyEXPERT with the condition Set Analyzer=4155B, 4156B,
4155C, or 4156C.

4. Import the test setups exported at the step 2.
5. Set the channel for the analyzer to use.

Also, the procedure made by replacing the step 1 with the step 3 can be used to reuse
the test setup created for the 4155/4156.
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